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PER INIZIARE

APPRENDERE MUSESCORE
Visite guidate
Partitura Come iniziare
Video tutorial
Altri tutorial

VIDEO

OTTENERE SUPPORTO
Manuale
Aiuto contestuale
Forum
Come fare
Pubblicare una domanda
Segnalare un errore

INSTALLAZIONE
Installazione
Preferenze iniziali

INSTALLARE SU WINDOWS
Installazione

Avvio di MuseScore

Disinstallare
Risoluzione dei problemi
Collegamenti esterni

INSTALLARE SU MACOS
Installare
Disinstallare
Installare con Apple Remote Desktop

INSTALLARE SU LINUX
AppImage

Fase 1 - Download
Fase 2 - Permessi di esecuzione
Fase 3 - Eseguilo!
Installa l’AppImage (facoltativo)
Come usare le opzioni linea di comando

Pacchetti distribuzione
Debian
Fedora
KDE neon 18.04 (bionic)
Ubuntu, Kubuntu, Xubuntu, …

Collegamenti esterni

INSTALLARE SU CHROMEBOOK
Programma desktop

LINGUE, TRADUZIONI ED ESTENSIONI
Cambia lingua
Gestione delle risorse

Installa/disinstalla estensioni
Aggiorna traduzioni

Vedi anche
Collegamenti esterni

CONTROLLO AGGIORNAMENTI
Controllo automatico della disponibilità di aggiornamenti
Controllo aggiornamenti
Vedi anche

NOZIONI DI BASE

CREA UNA NUOVA PARTITURA
Finestra di avvio
Crea una nuova partitura

Inserisci informazioni partitura
Seleziona file modello
Scegli strumenti

Aggiungi strumenti
Aggiungi rigo / Aggiungi rigo collegato
Cambia l’ordine degli strumenti
Elimina uno strumento

Scegli un'armatura di chiave
Scegli indicazione metrica, metronomo, battuta in levare, e numero di battute

Modifiche alla partitura dopo la creazione
Aggiungi / rimuovi / modifica battute
Aggiungi / rimuovi testo
Cambia strumenti
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Nascondi un rigo
Modifica impaginazione e formattazione

File modello
Cartella file modello di sistema
Cartella file modello dell’utente

Vedi anche
Collegamenti esterni

INSERIMENTO NOTE
Inserimento note: elementi basilari

Passo 1. Selezionare una posizione di partenza
Passo 2. Entrare in modalità inserimento note
Passo 3. Selezionare una durata
Passo 4. Inserire la nota o la pausa

Selezionare la durata di una nota/pausa
Durate addizionali

Dispositivi di inserimento
Tastiera del computer

Inserire note/pause
Spostare le note su/giù
Aggiungere alterazioni
Accordi
Inserire note
Cancellare note
Scorciatoie da tastiera

Mouse
Tastiera MIDI
Tastiera virtuale per pianoforte

Modalità inserimento note
Colorazione delle note fuori estensione
Note piccole /Teste-note piccole
Modificare note o pause già inserite

Cambiare durata
Cambiare altezza
Cambiare voce
Cambiare pause in note e viceversa

Proprietà delle note
Vedere anche
Collegamenti esterni

AREE DI LAVORO
Cambiare area di lavoro
Aggancio/sgancio
Creare una nuova area di lavoro
Modificare un’area di lavoro
Salvare un’area di lavoro personalizzata
Vedere anche

MODALITÀ DI MODIFICA
Entrare in modalità di modifica

MuseScore versione 3.4 e superiori
MuseScore versioni precedenti la 3.4

Uscire da modalità modifica
Testo
Linee
Note

Spostamento di note
Regolare la lunghezza del gambo della nota

Scorciatoie da tastiera
Vedere anche

TAVOLOZZE
Visualizzare o nascondere le Tavolozze
Aprire/chiudere una tavolozza

Modalità tavolozza singola

Applicare simboli da una tavolozza
Personalizzare l'elenco delle tavolozze

Cambiare l'ordine dei nomi delle tavolozze nella lista
Creare una nuova tavolozza
Nascondere una tavolozza dalla lista
Mostrare nella lista una tavolozza nascosta
Cancellare una tavolozza

Personalizzare le Tavolozze
Aggiungere un elemento della partitura ad una tavolozza
Aggiungere un simbolo a una tavolozza dalla Tavolozza generale
Cambiare l’ordine dei simboli in una tavolozza
Cambiare la posizione e la dimensione di un simbolo in una cella della tavolozza
Rimuovere un simbolo da una tavolozza

Menù della tavolozza
Comportamento del testo e delle linee applicate
Vedere anche

ISPETTORE
Visualizzare l’Ispettore
Cosa fa l'Ispettore
Pulsanti "Ripristina allo stile predefinito" e "Imposta come stile"
Categorie di Ispettore

Elemento
Gruppo di Elementi
Segmento

3



56
57
57
57
57
57
58
58
58

58
58

58
58
58
59

59
59
59

59
59
59

59
59
59
59

59
59
60
60
60
61
61
61
61
61
61

61
61
61
61

62

62
62
62
62
63
63

63
63
63
64
64

64

64
64
64
64
65
65
65

65
65
65

65
65
65
66
66
66

66
66
66
67
67

67
67
67
67
67
67
67
68
68

68
68

Accordo
Nota
Seleziona
Travatura gruppo note
Chiave
Articolazione
Diagramma chitarra
Linea
Dettagli linea di testo

Finestre di dialogo delle proprietà
Vedere anche

OPERAZIONI SULLE BATTUTE
Selezionare

Singola battuta
Intervallo di battute

Inserire
Inserire una battuta vuota nella partitura
Inserire più battute

Aggiungere
Aggiungere una battuta vuota alla fine della partitura
Aggiungere più battute alla fine della partitura

Rimuovere
Rimuovere una singola battuta
Rimuovere un intervallo di battute
Rimuovere le battute finali vuote

Cancellare i contenuti di una battuta
Proprietà

Righi
Durata della battuta
Altro

Escludi dal conteggio battute
Interrompi battuta d’aspetto
Modalità numerazione battute
Larghezza battuta
Aggiungi al numero di battuta
Conteggio ripetizione

Numerazione
Dividere e unire

Unire battute
Dividere una battuta

Collegamenti esterni

VOCI
Come vengono visualizzate le voci
Quando usare le voci
Come inserire le note in voci diverse
Cancellare e nascondere pause

Ripristino pause cancellate

Scambio voci di note
Spostare le note in un'altra voce (senza scambiarle)
Navigare tra le voci
Vedi anche
Collegamenti esterni

ANNULLA E RIPETI

COPIA E INCOLLA
Sommario dei comandi
Note

Copiare o tagliare
Incollare
Scambio con Appunti
Copiare solo l’altezza di una singola nota

Altri elementi
Copiare o tagliare
Incollare

Ripetizione rapida
Duplicare
Incollare metà/doppia durata (versione 3.1 e superiori)
Filtro di selezione
Vedere anche
Collegamenti esterni

MODALITÀ DI SELEZIONE
Selezionare un oggetto singolo

Selezionare una singola nota
Selezionare un accordo
Selezionare una singola battuta

Selezionare un elemento sovrapposto
Selezionare un intervallo continuo di oggetti

1. Selezione con Maiusc + click
Selezionare i simboli degli accordi, i testi, ecc. (a partire dalla versione 3.5)
Selezionare un intervallo di battute

2. Selezioni con Maiusc
3. Selezione per trascinamento (Drag)
4. Selezionare Tutto
5. Selezionare sezione

Selezionare un elenco di oggetti
Modificare una selezione esistente (a partire dalla versione 3.5)
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Selezionare tutti gli elementi simili
Le selezioni utili per:
Vedere anche

VISUALIZZAZIONE E NAVIGAZIONE
Menu Visualizza

Mostra barre laterali/pannelli
Zoom avanti/indietro
Barra degli strumenti

Mostrare/nascondere barre degli strumenti
Personalizzare l'area della barra degli strumenti

Area di lavoro
Visualizza barra di stato
Documenti affiancati
Mostra elementi invisibili
Segna battute irregolari
Schermo intero

Visualizzazione di Pagina/Continua/Singola pagina
Visualizzazione di Pagina
Visualizzazione continua
Singola pagina

Pannelli laterali
Navigazione

Comandi
Navigatore
Successione cronologica
Trovare / Andare a

Vedere anche

PARTITURA IN DO
Vedere anche
External links

APRI/SALVA/ESPORTA/STAMPA
Aprire
Salvare
Esportare
Stampare
Vedere anche

SHARE SCORES ONLINE
Create an account
Share a score directly from MuseScore
Upload a score on MuseScore.com
Edit a score on MuseScore.com

Switch to the direct method of updating an online score

External links

NOTAZIONE

ARMATURE DI CHIAVE
Aggiungere una nuova armatura di chiave

Aggiungere una nuova armatura di chiave a tutti i righi
Aggiungere una nuova armatura di chiave a un solo rigo

Sostituire una armatura di chiave esistente
Sostituire una armatura di chiave esistente per tutti i righi
Sostituire una armatura di chiave esistente per un solo rigo

Rimuovere una armatura di chiave
Bequadro sui cambi di armatura di chiave
Cambi armatura di chiave e battute di aspetto
Armature di chiave di cortesia
Armature di chiave personalizzate

CHIAVI
Aggiungere una chiave

Aggiungere/cambiare la chiave all'inizio di una battuta
Aggiungere/cambiare una chiave intermedia in una battuta

Rimuovere una chiave
Chiavi “di cortesia”
Nascondere le chiavi

Visualizzare la chiave solo nella prima battuta (per tutti i pentagrammi)
Visualizzare la chiave solo nella prima battuta (per pentagrammi particolari)
Nascondere tutte le chiavi in un pentagramma particolare

STANGHETTE
Cambiare il tipo di stanghetta
Inserire una stanghetta

Dividere una battuta

Stanghette personalizzate
Collegare le stanghette
Vedere anche

ALTERAZIONI (O ACCIDENTI )
Aggiungere una alterazione
Cambiare la notazione enarmonica
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Ridefinire (enarmonicamente) le altezze
Vedere anche
Collegamenti esterni

INDICAZIONE METRICA
Aggiungere o sostituire una indicazione metrica
Cancellare una indicazione metrica
Creare una indicazione metrica

Dalla tavolozza Indicazione metrica
Dalla Tavolozza generale (Master)

Indicazioni metriche frazionarie
Proprietà dell’indicazione metrica

Cambiare la travatura preimpostata
Indicazioni metriche aggiuntive (composte)
Indicazioni metriche locali

Ridimensionare una indicazione metrica
Battute in levare e cadenze
Cambi indicazioni metriche e interruzioni di sezione
Vedere anche
Collegamenti esterni

ARPEGGI E GLISSANDO
Aggiungere un simbolo
Regolare le dimensioni
Personalizzare simboli
Arpeggi
Glissando (slides)

Regolare i punti di inizio e fine di un glissando

Articolazioni degli strumenti a fiato
Slide in/out
Collegamenti esterni

ARTICOLAZIONI E ABBELLIMENTI
Articolazioni
Abbellimenti
Aggiungere articolazioni/abbellimenti

Aggiungere accidenti a un abbellimento
Aggiungere una corona a una stanghetta di battuta
Scorciatoie da tastiera

Regolare la posizione
Proprietà delle Articolazioni e degli Abbellimenti
Vedere anche
Collegamenti esterni

BEND
Applicare un bend
Modificare bend

Proprietà testo e linea
Forma e larghezza del bend

Modificare visualizzazione grafica

Modificare l’altezza
Regolare la posizione
Personalizzare bend
Collegamenti esterni

CODE
Modificare la travatura automatica delle note (raggruppamento)
Modifica raggruppamento di note singole
Simboli di raggruppamento e loro effetti
Modifica dell’angolo di travatura
Regolare l’altezza della travatura
Forzare una travatura in posizione orizzontale
Regolare le travature convergenti/divergenti
Ridefinire impaginazione locale
Capovolgere una travatura
Ripristino modalità di raggruppamento
Vedere anche
Collegamenti esterni

PARENTESI (RAGGRUPPAMENTO RIGHI)
Aggiungere
Cancellare
Cambiare
Modificare
Stile
Vedere anche
Collegamenti esterni

NOTE DI ABBELLIMENTO
Creare note di abbellimento

Aggiungere una nota di abbellimento
Aggiungere un accordo di note di abbellimento

Cambiare altezza (intonazione)
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Cambio durata
Regolazione manuale

Posizione orizzontale
Altre regolazioni

Collegamenti esterni

RESPIRI E CESURE
Aggiungere un simbolo
Regolare la lunghezza della cesura

BATTUTE D'ASPETTO
Pausa di battuta intera

Creare una o più pause di battuta intera
Creare una pausa di battuta intera in una voce particolare

Pausa di più battute (Battuta d’aspetto)
Visualizzare battute d’aspetto
Interrompere battute d’aspetto

FORCELLE
Aggiungere una forcella
Modificare lunghezza e altezza
Linee di Cresc. e Dim.
Copiare forcelle
Modificare le proprietà di una forcella
Riproduzione sonora delle forcelle

LINEE
Applicare linee alla partitura

Applicare una linea a una sola nota
Applicare una linea ad una serie di note
Applicare una linea da una nota alla fine della battuta
Applicare una linea a una serie di battute

Linee e proprietà di riproduzione sonora
Regolare la posizione verticale
Cambiare lunghezza

Utilizzo delle scorciatoie da tastiera
Per trascinamento (a partire dalla versione 3.5)
Regolazione fine

Linee di testo
Linee personalizzate
Copiare linee
Linee di ornamento estese
Collegamenti esterni

LINEE DI OTTAVA
Applicare una linea di ottava
Cambiare lunghezza
Linee personalizzate
Collegamenti esterni

LEGATURE DI PORTAMENTO
Aggiungere legature di portamento in modalità inserimento note
Aggiungere legature di portamento in modalità normale

Metodo 1
Metodo 2

Regolare legature di portamento
Legature estese (N.d.T.: dette anche “di frase” o “di espressione”)
Legature punteggiate e tratteggiate
Vedere anche

LEGATURE DI VALORE
Aggiungere legature di valore in modalità inserimento note
Aggiungere legature di valore in modalità normale

Metodo 1
Metodo 2

Aggiungere ulteriori note a un accordo precedentemente legato
Aggiungere legature di valore a note all’unisono
Capovolgere una legatura di valore
Vedere anche
Collegamenti esterni

TREMOLO
Aggiungere un Tremolo

Tremolo di singola nota/accordo
Tremolo di due note/accordi

Collegamenti esterni

GRUPPI IRREGOLARI
Creare un gruppo irregolare

Creare una terzina in modalità normale
Creare una terzina in modalità inserimento note
Creare altri gruppi irregolari
Gruppi irregolari personalizzati
Esempi di terzine
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Cancellare un gruppo irregolare
Cambiare visualizzazione dei gruppi irregolari

Tramite l’Ispettore
Tramite la finestra di dialogo Stile

Collegamenti esterni

RIPETIZIONI E SALTI
Ripetizioni semplici
Finali 1° e 2°
Riproduzione sonora

Attivare/disattivare la riproduzione ripetuta
Regolare la riproduzione sonora di sezioni ripetute

Simboli di ripetizione e testo
Salti
Marcatori
Esempi di salti
Vedere anche
Collegamenti esterni

VOLTA
Aggiungere una Volta alla partitura
Cambiare il numero di battute comprese in una linea di Volta
Proprietà di Volta
Riproduzione sonora

Conteggio ripetizione

Collegamenti esterni

TRASPOSIZIONE
Trasposizione manuale
Trasposizione automatica

Trasposizione Cromatica
Alla tonalità
Per Intervallo

Trasposizione Diatonica
Opzioni

Strumenti traspositori
Tonalità “da concerto”
Cambiare la trasposizione di un pentagramma

Collegamenti esterni

INTAVOLATURE
Creare un nuovo rigo d'Intavolatura

Con la procedura guidata nuova partitura
Con la finestra Strumenti
Cambiando tipo di rigo

Modificare i dati delle corde
Cambiare l'accordatura
Aggiungere una corda
Cancellare una corda
Marcare una corda libera come "vuota"
Cambiare il numero di tasti dello strumento

Cambiare l'aspetto di un'intavolatura
Da Proprietà Rigo/Parte…
Dalla finestra Strumenti

Combinare il rigo pentagramma con l'intavolatura
Creare una nuova coppia rigo pentagramma/intavolatura con la Procedura guidata nuova partitura
Creare una nuova coppia rigo pentagramma/intavolatura in una partitura esistente
Creare una nuova coppia rigo pentagramma/intavolatura da un rigo esistente

Inserire note nell'intavolatura
Con la tastiera del computer

Intavolature storiche
Con il mouse
Scegliere la durata della nota

Modificare le note
Cambiare cifra di tasto
Cambiare il numero di corda
Note stoppate

Riepilogo dei comandi da tastiera
Modalità inserimento note
Modalità normale

Collegamenti esterni

NOTAZIONE PERCUSSIONI
Tipi di rigo per percussioni
Metodi di inserimento note

Tastiera MIDI
Tastiera Pianoforte (virtuale)
Tastiera del computer
Mouse

Tavolozza inserimento note percussioni
Modifica set percussioni
Sticking (diteggiatura)
Aggiungere un rullo di tamburo
Collegamenti esterni

SOUND AND PLAYBACK
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EXTERNAL LINKS

CAMBIO STRUMENTO LUNGO IL RIGO
Effetto del cambio di strumento
Aggiungere un cambio di strumento
Vedere anche
Collegamenti esterni

MIXER
Aprire il Mixer
Area Tracce

Guadagno generale
Freccia di visualizzazione del canale
Muto e Solo
Bilanciamento
Volume
Nome traccia

Area dettagli
Nome
Canale
Batteria
Suono
Volume
Bilanciamento
Colore della traccia

Controlli MIDI
Porta e Canale
Riverbero / Coro
Silenzia voce
Pulsante Nascondi dettagli

Cambiamento di suono lungo il rigo (pizz., con sordino, ecc.)
Vedere anche
Collegamenti esterni

PIANO ROLL EDITOR
Opening the Piano Roll Editor
Overview
Navigation
Selecting Notes
Editing Notes
Controls

First Row
Second Row

Keyboard
Customization

LIBRERIE DI SUONI E FILE SFZ
SoundFonts (Librerie di suoni)

Installare un SoundFont
Disinstallare

SFZ
Installare un SFZ
Disinstallare un SFZ

Sintetizzatore
Mixer
Elenco dei SoundFont scaricabili

GM SoundFont
SoundFont orchestrali
SoundFont per Piano

SF2 Piano
SFZ Piano

Decomprimere i soundfont scaricati

Risoluzione dei problemi
Vedere anche
Collegamenti esterni

METRONOMO (INDICAZIONI DI TEMPO)
Aggiungere una indicazione di Metronomo
Modificare il Metronomo
Modificare il testo del Metronomo
Sovrascrivere l’indicazione di Metronomo
Riproduzione di Ritardando e Accelerando
Corona
Vedere anche
Collegamenti esterni

MODALITÀ RIPRODUZIONE SONORA
Barra degli strumenti di controllo riproduzione
Comandi Riproduzione

Avviare/interrompere riproduzione
Durante la riproduzione
Riproduzione ciclica

Pannello Controlli riproduzione

RIPRODUZIONE SONORA: SIGLE ACCORDALI / SISTEMA NUMERICO NASHVILLE
Attivare/disattivare la riproduzione

9



142
142
142
142

143
143
143
143
144
144

144
144
144
145
145
145
145

146
146
146
146
147

147
147
148
148

148
148
149

150
150
151

151
151
151
151
152
152

152
152
152

152
152
153
153
153

153

153
153
154

154
155

155

155
155
155
156
156

156
156
157
158
158

158
158
158

159
159

159
159

159
159
160

Per tutte le partiture (a partire dalla versione 3.5.1)
Per le partiture correnti

A partire dalla versione 3.5.1
A partire dalla versione 3.5

Cambiare il suono della riproduzione
Cambiare il volume di riproduzione / Traccia muta
Attivare/disattivare il suono della sigla durante la modifica
Interpretazione e Realizzazione delle Sigle accordali
Vedere anche
Collegamenti esterni

SINTETIZZATORE
Panoramica
Salvare/Caricare le impostazioni del Sintetizzatore
Fluid

Per caricare una libreria suoni (SoundFont)
Per riordinare i SoundFont
Per rimuovere un SoundFont

Zerberus
Volume
Effetti

Riverbero Zita 1
Compressore SC4

Accordatura
Dinamiche (versione 3.1 e superiori)
Vedere anche
Collegamenti esterni

SWING
Applicare lo swing a una sezione della partitura

Terzina nella marcatura del tempo

Ritorno al ritmo normale (Preciso)
Applicare lo swing globalmente
Collegamenti esterni

DINAMICHE
Aggiungere una dinamica
Regolare le proprietà di una dinamica

Modificare l’intensità di una dinamica
Modificare l’ambito di applicazione (“Gamma” nell’Ispettore)
Cambiare il posizionamento (sopra o sotto il pentagramma)

Personalizzare una dinamica
Dinamiche Singola Nota (SND)
Collegamenti esterni

RIPRODUZIONE (SONORA) DEL CAPOTASTO MOBILE
Aggiungere un capotasto a un singolo rigo
Aggiungere il capotasto al rigo/intavolatura collegati
Aggiungere il capotasto al rigo/intavolatura non collegati
Rimuovere il capotasto

TESTO

MODIFICA DEL TESTO
Entrare/uscire dalla modalità di modifica del testo

Scorciatoie da tastiera

Simboli e caratteri speciali
Scorciatoie con caratteri speciali

Vedere anche

TESTO, NOZIONI DI BASE
Aggiungere testo
Formattazione del testo
Regolare la posizione degli oggetti di testo
Ancoraggi di testo

STILI DEL TESTO E PROPRIETÀ
Stili del testo
Oggetti di testo
Salvare e caricare stili di testo
Vedere anche

TESTO DI RIGO E TESTO DI ACCOLLATURA
Testo di rigo

Proprietà del testo di rigo

Testo di accollatura
Proprietà del testo di accollatura

Vedere anche
Collegamenti esterni

SIGLE ACCORDALI
Inserire una Sigla accordale

Comandi da tastiera
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160
160

160
160
160
161
161
161

161
161

162
162
162
162

163
163

163
163
163
163
164
164
164

164

164
164
164
164
165
165
165
165

166
166
166
166
167
167
167

167
167
167
167
167
168

168
168
168
168
168

168

168
168
169
169
170
171
171
171
171
172
172
172
172
172
173
173
173
173
173
174
174
174
174
174
174
175
175
175
175
175
175
175
175
176

Sintassi delle Sigle accordali
Modificare una Sigla accordale

Trasposizione di una Sigla accordale
Testo delle Sigle accordali
Stile delle Sigle accordali

Aspetto
Ortografia delle note

Maiuscolo Automatico
Posizionamento
Posizione capotasto

Sistema Numerico Nashville
Analisi in Numeri Romani

Inserire l'ANR
Esempi di ANR

Riproduzione (a partire dalla versione 3.5)
Collegamenti esterni

DITEGGIATURA
Aggiungere diteggiatura a una singola nota
Aggiungere la diteggiatura a più note
Modalità di inserimento della diteggiatura facilitato (versione 3.1 e superiori)
Regolare la posizione della diteggiatura

Diteggiatura singola
Diteggiatura multipla

Modifica testo diteggiatura

TESTO CANTATO
Inserire una linea di testo cantato

Prima riga
Linee (strofe) successive
Caratteri speciali
Numerazione strofe
Melisma
Legatura di elisione (o di Testo) / Sinalèfe

Modificare testi cantati
Regolare le proprietà dei testi cantati
Regolare la posizione delle singole linee di testo
Copiare testi cantati negli appunti
Incollare testi cantati dagli appunti
Vedere anche
Link esterni

NUMERI/LETTERE DI CHIAMATA
Aggiungere un segno di prova

Posizionamento manuale
Posizionamento automatico

Aggiungere un segno di prova alfanumerico
Aggiungere segni di prova coincidenti ai numero-battuta

Risequenziazione automatica dei segni di prova
Stile di testo
Ricerca per un numero/lettera di chiamata
Vedere anche
Collegamenti esterni

FORMATTAZIONE

IMPAGINAZIONE E FORMATTAZIONE
Modi per influenzare l'impaginazione
Stile

Partitura
Pagina
Ulteriori possibilità introdotte con la versione 3.6
Dimensioni
Intestazione, Piè di pagina
Numeri delle battute
Accollatura
Chiavi
Alterazioni
Battuta
Stanghette
Note
Gruppi di note (travature)
Gruppi irregolari
Arpeggi
Legature (“di portamento” e “di valore”)
Forcelle
Volta
Ottava
Pedale
Trillo
Vibrato
Bend
Linea del testo
Linea testo di accollatura
Articolazioni e abbellimenti
Corona
Testo di rigo
Testo Tempo
Testo cantato
Dinamiche

11



176
176
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177
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178
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179
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179
179
179

180
181
181
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182
182
182
182
182

182
183
183
183

183
183
184
184

184

184
184
184
184
184

185
185
185
185
185
185
186

186
186
186

186
186

186
186
187
187
187

187
187
187
187
187
187

187
188
188
189
189

189
189

189

Numero di chiamata
Basso continuo
Sigle accordali
Diagrammi chitarra
Stile del testo
Tasti OK / Annulla / Applica a tutte le parti

Impostazioni pagina
Aggiungi/Rimuovi interruzioni di accollatura
Larghezza

Aumenta/Diminuisci larghezza impaginazione
Ripristino larghezza

Ripristina stile del testo (sovrascrivi)
Ripristina gambi (travature)
Ripristina forme e posizioni
Carica/Salva stile
Vedere anche
Collegamenti esterni

BATTUTE
Introduzione
Opzioni

IMPOSTAZIONI PAGINA
Dimensione pagina
Margini pagine dispari/pari
Ridimensionamento
Unità (di misura)
Numero prima pagina
Applica a tutte le parti

INTERRUZIONI E DISTANZIATORI
Interruzioni

Aggiungere una interruzione a una battuta
Usare una scorciatoia da tastiera
Usare un simbolo di interruzione dalla tavolozza

Aggiungere una interruzione a una cornice
Cancellare interruzioni
Spostare una interruzione
Interruzione di sezione

Distanziatori
Aggiungere un distanziatore
Regolare un distanziatore
Cancellare un distanziatore

Vedere anche

CORNICI
Cornice orizzontale

Inserire/aggiungere una Cornice orizzontale
Regolare la larghezza di una Cornice orizzontale
Aggiungere testo o un'immagine a una Cornice orizzontale

Cornice verticale
Inserire/aggiungere una Cornice Verticale
Regolare l'altezza di una Cornice verticale
Modificare le proprietà di una Cornice verticale
Aggiungere testo o immagini a una Cornice verticale
Inserire una Cornice orizzontale in una Cornice verticale
Cornice "Titolo"

Cornice di testo
Inserire/aggiungere una Cornice di testo
Modificare le proprietà di una Cornice di testo

Creare una Cornice
Inserire una Cornice in partitura

Aggiungere una Cornice alla partitura
Cancellare una Cornice
Applicare un'Interruzione
Vedere anche
Link esterni

IMMAGINI
Aggiungere immagini
Tagliare/copiare e incollare immagini
Modificare immagini
Vedere anche
Collegamenti esterni

ACQUISIZIONE IMMAGINI
Salvare una istantanea
Menù cattura immagine
Vedere anche
Collegamenti esterni

ALLINEAMENTO DEGLI ELEMENTI
Aggancia alla griglia

ARGOMENTI AVANZATI
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201
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203
203
203
203

204
204
205
205
205
205
206

206
206
207
208
208
209

210

210
210

ACCESSIBILITY
Introduction
Initial setup
Finding your way around
The score window
Score reading

Moving forwards or backwards in time
Moving between notes at a given point in time
Filtering score reading

Score playback
Score creation and editing

Creating a new score
Note input
Selection
Palettes
Menus and Shortcuts

Customization
External links

ALBUMS
Create album
Load album
Print album
Join scores
Save album

ATTREZZI
Trasporto
Esplodi
Implodi

Applicare implodi a un singolo rigo
Applicare implodi a più righi

Realizza sigle accordali
Voci
Battuta
Rimuovi l’intervallo selezionato
Riempi con barre ritmiche
Attiva/Disattiva notazione barre ritmiche
Sostituzione enarmonica delle alterazioni
Raggruppa ritmi
Risequenzia numeri/lettere di chiamata
Svolgi le ripetizioni (versione 3.1 e successive)
Copia il testo cantato negli appunti
Acquisizione immagine
Rimuovi battute vuote finali
Vedere anche
Collegamenti esterni

BASSO CONTINUO
Aggiungere una nuova indicazione di Basso Continuo
Formato del testo

Cifre
Accidenti
Cifre alterate
Parentesi
Linee di continuazione
Durate

Modifica di un Basso continuo esistente
Stile
Correttezza di sintassi
Tabella dei comandi

CAMBIO TIPO DI RIGO
Aggiungere un Cambio tipo di rigo
Proprietà del Cambio tipo di rigo
Esempio

DIAGRAMMI DEGLI ACCORDI
Panoramica dei diagrammi degli accordi
Panoramica della tavolozza di accordi standard per chitarra
Panoramica sulla creazione di accordi modificati o personalizzati
Aggiungere un Diagramma degli accordi

Sigle Accordali collegate a Diagrammi degli accordi
Uso delle Sigle accordali con i Diagrammi degli accordi

Regolare le proprietà degli elementi di un diagramma degli accordi (posizione, colore, ordine di impilatura...)
Regolare le proprietà globali/predefinite di stile un diagramma degli accordi (posizione, colore, ordine di impilatura...)
Modificare un diagramma degli accordi

Modificare le proprietà del Diagramma degli accordi
Modifica dei punti di pressione delle dita (uso di base)
Modifica dei punti di pressione delle dita (uso avanzato)

Collegamenti esterni

FRETBOARD DIAGRAMS (PRIOR TO VERSION 3.1)
Add a fretboard diagram
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214
214
214

215
215
216
216
216
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224
225
225
225
225

226
226
226
226

226
226

Edit a fretboard diagram
To adjust a diagram's element properties
To adjust a diagram's style properties

FILE FORMATS
MuseScore native format

MuseScore format (*.mscz)
Uncompressed MuseScore format (*.mscx)
MuseScore backup file (.*.mscz,) or (.*.mscx,)

Graphic files (export only)
PDF (*.pdf)
PNG (*.png)
SVG (*.svg)

Audio files (export only)
WAV audio (*.wav)
MP3 (*.mp3)
FLAC audio (*.flac)
Ogg Vorbis (*.ogg)

Share with other music software
MusicXML (*.musicxml, *.xml)
Compressed MusicXML (*.mxl)
MIDI (*.mid, *.midi, *.kar)
MuseData (*.md) (import only)
Capella (*.cap, *.capx) (import only)
Bagpipe Music Writer (*.bww) (import only)
BB (*.mgu, *.sgu) (import only)
Overture (*.ove) (import only)
Guitar Pro (various—import only)
Power Tab Editor (*.ptb) (import only)

See also
External links

FILE RIPRISTINATI
Salvataggio dopo il recupero della sessione
Trovare i file recuperati
Vedere anche
Collegamenti esterni

FUNZIONALITÀ PER LA MUSICA ANTICA
Notazione non barrata (o non misurata)

Esempio

Mensurstrich
Ambitus
Indicazioni metriche mensurali
Intavolature d’epoca
Vedere anche

GRUPPO DI NOTE TRA RIGHI
Vedere anche
Collegamenti esterni

LIVELLO (SPERIMENTALE)
Vedi anche

MIDI IMPORT
Available operations

MODALITÀ INSERIMENTO NOTE
Un passo alla volta
Modifica altezze
Ritmo
Tempo reale (automatico)
Tempo reale (manuale)

Scorciatoia Avanzamento Tempo reale

Inserire
Modalità normale
Vedere anche
Collegamenti esterni

PARTI
Riproduzione sonora della parte
Creare tutte le parti
Creare parti specifiche
Personalizzare le parti

Aggiungere strumenti a una parte
Rimuovere strumenti da una parte
Selezionare i righi per uno strumento
Selezionare le voci per uno strumento

Cancellare una parte
Esportare parti
Salvare parti
Stampare una parte

PLUGIN
Cosa sono i Plugin?
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241
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242
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243
243
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244

244
245

245

247
247
247
247
247
248
248
248

248

248
249
249

Installazione
Windows
macOS
Linux

Abilitare/disabilitare i Plugin
Creare/modificare/eseguire i plugin
Plugin installati di default

ABC Import
Notes → Color Notes
Create Score
helloQml
Notes → Note Names
Panel
random/random2
run
scorelist
ScoreView
Walk

Vedere anche
Collegamenti esterni

PREFERENZE
Generale
Area di visualizzazione
Inserimento note

Inserimento note
Controllo remoto MIDI

Partitura
File predefiniti
Vista

I/O e suoni
PortAudio (API / Dispositivo)
Ingresso / Uscita / Latenza MIDI
Usa Jack Audio Server
Motore Audio

Importazione
Esporta
Scorciatoie da tastiera
Aggiorna
Avanzata
Vedere anche

POSIZIONAMENTO AUTOMATICO
Posizione predefinita

Cambiare il posizionamento predefinito di un elemento

Regolazioni manuali
Regolare la posizione dell'elemento
Posizionare l'elemento sopra/sotto il rigo

Disabilitare posizionamento automatico
Ordine di impilatura

PROPRIETÀ RIGO / PARTE
Tipi di rigo
Proprietà Rigo / Parte: tutti i righi
Proprietà Rigo / Parte: solo corde pizzicate
Stile, proprietà avanzate…

Modelli
Opzioni per Rigo Standard e Rigo per le Percussioni
Opzione per Rigo d'intavolatura
Opzione per Rigo d'intavolatura: cifre di tasto
Opzioni rigo di intavolatura: Valori delle note
Anteprima

Cambio strumento
Collegamenti esterni

PROPRIETÀ PARTITURA
Modifica dei meta-dati
Meta-dati preesistenti

Inserimento meta-dati Lavoro / Movimento / Parte

Intestazione / Piè di pagina
Vedere anche

SCHEMI TESTE DI NOTA

TESTE DELLE NOTE
Gruppi di teste nota
Cambio gruppo testa nota
Cambio tipo testa della nota
Teste di note condivise

Cambiare teste di nota non condivise (spostate) in condivise
Esempi di condivisione della testa della nota
Rimuovere capotasti duplicati

Collegamenti esterni

STRUMENTO DI CONFRONTO PARTITURE
Introduzione
Scegliere le partiture
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254
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256

256
256
256
256
256

256

256
257
257
257
257
257
258

258
258
258
258
258
258
259

259
259
259
260

Scegliere la visualizzazione
Visualizzazione del confronto
Uscire dal confronto
Esempio

TAVOLOZZA GENERALE
Simboli

Trovare un simbolo
Applicare un simbolo
Collegare simboli

Vedere anche

TIMELINE
Introduction
Overview

Meta labels
Instrument labels
Meta rows
Main grid
Meta

Basic interaction
Select a measure
Select multiple measures

Drag selection
[Shift] selection
[Ctrl] selection

Clearing selection
Meta values selection

Scrolling
Standard scrolling
[Shift] scrolling
[Alt] scrolling
Dragging

Labels interaction
Rearranging meta labels
Collapsing the meta labels
Hiding instruments

Zooming
Context menus

Meta labels context menu
Meta rows context menu
Instrument context menu

SUPPORT

HELPING TO IMPROVE TRANSLATIONS
Software translation
Website and handbook translation
See also

RIPRISTINARE LE IMPOSTAZIONI PREDEFINITE INIZIALI
Via menu
Via linea di comando

Istruzioni per Windows
Istruzioni per MacOS
Istruzioni per Linux

Vedere anche

BUG REPORTS AND FEATURE REQUESTS
Bug reports
Feature requests
Cross linking issues
External links

APPENDIX

SCORCIATOIE DA TASTIERA
Navigazione
Inserimento note

Durata nota/pausa
Voci
Altezza
Intervallo

Visualizzazione (layout)
Articolazioni
Inserimento Testo
Inserimento Testo cantato
Visualizzazioni
Miscellanea
Vedere anche

COMMAND LINE OPTIONS
NAME
SYNOPSIS
DESCRIPTION
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263
264
264
264
264

264
264
265
265
265
265
265

265
265
265
266
266
267

268
268
269

269
269
269
270
270
271

271
271
271
271
271
271

271
272
272
272

272
272
272
273
273
273
273
273
274
274
274
274
274
274
274
274

274
275
275
275
275
275

275
275
275
275
275

276
276
276
276
276
276
277

277
277
278
278
278
278

Batch conversion job JSON format
ENVIRONMENT
FILES
EXAMPLES

Convert a score to PDF from the command line
Run a batch job converting multiple documents
MIDI import operations

DIAGNOSTICS
SEE ALSO
STANDARDS
HISTORY
AUTHORS
CAVEATS
BUGS

NUOVE FUNZIONALITÀ IN MUSESCORE 3.6
Nuove caratteristiche di configurazione e impaginazione della partitura

Ordinamento automatico degli strumenti
Parentesi quadrate e graffe
Giustificazione verticale dei pentagrammi
Indentazione (rientro) della prima accollatura

Applicare nuove caratteristiche a spartiti esistenti
Applicazione nuovo automatismo di ordinamento strumenti e corretta applicazione parentesi
Applicazione della giustificazione verticale dei pentagrammi

Altre modifiche tipografiche in 3.6
Spaziatura travature (Beam spacing)
Lunghezza del taglio addizionale (Ledger line)
“Attacchi” dei gambi e posizioni delle codette (Stem caps and flag positions)
Parentesi di alterazioni
Alterazioni in Emmentaler

NEW FEATURES IN MUSESCORE 3
Automatic Placement

Default position
Manual adjustments
Disabling automatic placement
Stacking order

Text Formatting
Text Styles
Text Properties
Custom Formatting

Staff Type Change
Temporary and Cutaway Staves
System Dividers
Staff Spacing
Don't Break
Parts from Voices
Explode and Implode
Insert mode
Split/Join Measures
Timeline
Score Comparison Tool
Mixer
Piano Roll Editor
Capo changes
Fretboard Diagrams
External links

KNOWN LIMITATIONS OF MUSESCORE 3.X
Local time signatures
Regroup Rhythms
Tablature staff linked with standard staff
Mixer
Header & footer

UPGRADE FROM MUSESCORE 1.X OR 2.X
How to upgrade MuseScore
Opening 1.x or 2.x scores in MuseScore 3
Relayout
Getting the sound from MuseScore 1.x

KNOWN INCOMPATIBILITIES
Hardware incompatibilities
Software incompatibilities

AVG Internet Security hangs MuseScore
Font problem on macOS
Font problem on Linux
Save As dialog empty on Linux

GLOSSARY
A
B
C
D
E
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279
279
280
280
280
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F
G
H
I
J
K
L
M
N
O
P
Q
R
S
T
U
V
External links
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Pubblicato su MuseScore (https://musescore.org)

Questo è il manuale per MuseScore versione 3.0 e successive. È mantenuto dalla comunità di MuseScore. Scopri come
puoi collaborare . In caso di dubbi consultare la versione online del manuale in inglese .

(Se si sta ancora usando MuseScore 2.x, si può accedere al vecchio manuale Manuale per la versone 2.x ).

Per iniziare
Questo capitolo ti aiuterà ad installare ed eseguire MuseScore per la prima volta. Esso ti introdurrà alle varie risorse per
imparare e per chiedere aiuto

Apprendere MuseScore

MuseScore fornisce una serie di risorse di apprendimento per aiutare il nuovo utente a iniziare ad usare il software e a
produrre partiture.

Visite guidate

Quando si installa MuseScore per la prima volta, appare una Procedura guidata di avvio per aiutarvi a impostare alcune
funzionalità di base del programma. Una di queste funzionalità si chiama Visite guidate, e, come si puo dedurre dal nome,
fornisce una visita guidata del programma.

-Per attivare questa funzionalità, sulla pagina Visite guidate, seleziona "Sì".

Questo permetterà alle Visite guidate di essere eseguite all'apertura del programma, introducendoti alle caratteristiche
principali dell'interfaccia utente.

Per concludere le Visite guidate: premere il pulsante Chiudi.
Per fermare le Visite guidate mostrate quando si avvia Musescore: Deselezionare "Continua a seguire le Visite
guidate".
Per riattivare le Visite guidate (quando si riapre il programma): Selezionare Aiuto→Visite guidate→Mostra Visite guidate .
Per vedere di nuovo tutte le Visite guidate (quando si riapre il programma): Selezionare Aiuto→Visite
guidate→Ripristina Visite guidate .

Visite guidate attualmente offerte:

Introduzione all'interfaccia utente.
Inserimento di note e pause in una partitura.
Inserimento di simboli da una tavolozza.
Navigare la partitura con Timeline.
Navigare la partitura con la tastiera.
Inserimento pause multibattuta.
Posizionamento automatico dei simboli.
Modifica delle proprietà con l'ispettore.
Selezione elementi.
Aggiungi e modifica linee nella partitura.

Partitura Come iniziare

La partitura Come iniziare è un'introduzione pratica alle basi dell'inserimento di una partitura. Quando si apre MuseScore
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per la prima volta, verrà visualizzato nella finestra principale della Centro di Avvio: basta cliccare per aprirla. Segui le
istruzioni scritte in blu, e sarai guidato attraverso le fasi di base della scrittura partitura.

Nota: Se non viene visualizzata la partitura Come iniziare, è possibile trovarla nel pannello di destra del centro di avvio.
Fare clic sulle frecce destra o sinistra per sfogliare le opzioni fino a quando non appare.

Video tutorial

MuseScore offre una serie completa di video di istruzioni, ognuno dei quali copre un argomento specifico. È possibile
accedere a questi video in diversi modi.

Dalla pagina principale di MuseScore su MuseScore.org: Support/Tutorials
Nel Centro di Avvio: sfogliare la pagina Video nel pannello di destra.
Utilizzare l'elenco dei collegamenti nella sezione Video (di sotto).
Cercando direttamente su "MuseScore in Minutes" su You Tube

Altri tutorial

Nella sezione Tutorials  di musescore.org troverete anche tutorial su argomenti più specifici (es. MuseScore Drumline).

Video
Lezione 1 - Impostazione della partitura
Lezione 2 - Lavorare con MuseScore
Lezione 3 - Inserimento note
Lezione 4 - Inserimento da tastiera MIDI
Lezione 5 - Altre idee per l'immissione
Lezione 6 - Testo, parole e accordi
Lezione 7 - Tablatura e notazione percussioni
Lezione 8 - Ripetizioni e finali, parte 1
Lezione 9 - Ripetizioni e finali, parte 2
Lezione 10 - Articolazioni, dinamiche e testo
Lezione 11 - Impaginazione e parti

Ottenere supporto

Se si verifica un problema mentre si lavora con MuseScore, ci sono diversi modi per ottenere aiuto e supporto.

Manuale

Per accedere al Manuale :

Dal sito MuseScore : selezionare Supporto → Manuale dal menù.
Dal programma MuseScore: selezionare Aiuto → Manuale online dal menù.

È possibile sfogliare il Manuale utilizzando i menu, o fare una ricerca .

Aiuto contestuale

Se si seleziona un elemento della partitura e si preme F1, si apre una pagina web che mostra un elenco di collegamenti
associati a quell'elemento nella cartella Manuale .

Forum

MuseScore offre una serie di servizi on-line Forum  per la collaborazione degli utenti. Potresti essere in grado di trovare
qui una risposta al tuo problema tra i messaggi esistenti. Una ricerca generica  nel sito web restituirà una lista di risultati
rilevanti nei forum e nel Manuale.

Come fare

Alcuni interventi richiedono l'utilizzo di tecniche diverse. Per queste può essere difficile trovare risposte nel Manuale. Le
soluzioni per questi caso potrebbero essere trovate nella sezione Come fare

Pubblicare una domanda

Se non riesci a trovare la risposta al tuo problema, puoi fare una domanda nella sezione Supporto e segnalazioni di
bug  del forum.

Quando fai la tua domanda:
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Cerca di essere il più preciso possibile, quando descrivi quello che vuoi fare e quali passi hai già provato.
Allega la partitura che mostra il problema. Questo renderà molto più facile per gli altri comprendere il problema. —
usa il pulsante "Scegli un file" in fondo alla pagina, appena sopra l'opzione Salva e il pulsante Anteprima.

Segnalare un errore

Se si incontra qualcosa che si pensa sia un bug, il primo passo è quello di postarlo nella cartella del forum Supporto e
segnalazioni di bug . Questo permetterà ad altri di verificare se si tratta di un bug vero e di consigliare soluzioni
alternative, in modo che tu possa continuare a scrivere la partitura. Troverai maggiori dettagli su questo argomento su Bug
reports and Feature requests.

Installazione

MuseScore è disponibile per diversi sistemi operativi, tra cui Windows e macOS, così come per molte distribuzioni
Linux  e diverse varianti BSD . Sono tutte disponibili dalla pagina Scarica MuseScore .

Installazione

Una volta scaricato il software, seguire le istruzioni di installazione del sistema operativo:

Installare su Windows.
Installare su macOS.
Installare su Linux.
Installare su Chromebook .

Preferenze iniziali

La prima volta che si avvia MuseScore dopo l'installazione, vi verrà chiesto di confermare le vostre preferenze di base:

Le impostazioni per la lingua e il layout della tastiera vengono recuperate dall'installazione e normalmente non dovrebbero
essere modificate. Basta cliccare Successivo per continuare:
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seguito da:

La pagina Area di lavoro consente di specificare le barre degli strumenti e le tavolozze predefinite. Scegliere un'opzione
dall'elenco a discesa. Quindi fare clic su Successivo per continuare:
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Verrà ora chiesto se si desidera utilizzare l'opzione Visita guidata. Se sei nuovo su MuseScore tieni selezionata l'opzione
'Sì' e clicca su Successivo per continuare:

Infine, fare clic su Fine per avviare MuseScore.
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Installare su Windows

Installazione

Se siete su Windows 10, una versione a 32 bit di MuseScore può essere installata da Windows Store. Cliccando qui
aprirà la pagina di Musescore nell'app Store. Dovrai solo cliccare su Scarica l'applicazione e MuseScore verrà scaricato,
installato e successivamente aggiornato automaticamente.

Altrimenti è possibile scaricare il programma di installazione di Windows dalla pagina Scarica  del sito web di
MuseScore. Clicca sul collegamento per avviare il download (scegliete tra 64 bit o 32 bit). Il vostro browser Internet vi
chiederà di confermare il download di questo file. Fare clic su Salva File.

Al termine del download, fare doppio clic sul file per avviare l'installazione. Windows potrebbe attivare una finestra di
sicurezza per confermarlo prima di avviare il software. Clic su Esegui per continuare.
Il processo di installazione inizierà

Se si fa clic su Annulla, qui o dopo, vedrete:
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Se invece cliccate su Successiva per continuare, la procedura guidata di installazione visualizzerà i termini della licenza del
software libero.

Leggere i termini della licenza, assicurarsi che la casella accanto a "Accetto i termini dell'accordo di licenza" sia
selezionata e fare clic su Successiva per continuare. Successivamente il programma di installazione vi chiederà di
confermare la posizione in cui installare MuseScore.
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Se state installando una versione più recente di MuseScore ma volete mantenere la vecchia versione sul vostro
computer, allora dovreste cambiare la cartella (nota che MuseScore 3 può coesistere con MuseScore 2 e 1 senza bisogno
di modifiche). Altrimenti clic su Successiva per continuare.

Cliccare su Installa per continuare.

Concedere qualche minuto alla procedura guidata di installazione per installare i file e le configurazioni necessarie.
Vedrete
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e infine

Cliccare su Fine per uscire dall'installatore. È ora possibile eliminare il file di installazione scaricato.

Avvio di MuseScore

Per avviare MuseScore, dal menù, selezionare Avvio→Tutti i programmi→MuseScore 3→MuseScore 3.

Disinstallare

È possibile disinstallare MuseScore dal menù selezionando Start→Tutti i programmi→MuseScore 3→Disinstalla MuseScore; o
tramite il pannello di controllo di Windows. Nota che questo non rimuoverà le tue partiture e le tue impostazioni di
MuseScore.

Risoluzione dei problemi

Il programma di installazione potrebbe essere bloccato dal sistema. Se non si riesce a installare MuseScore, fare clic con
il tasto destro del mouse sul file scaricato e fare clic su Proprietà. Se c'è un messaggio "Questo file proviene da un altro
computer e potrebbe essere bloccato per proteggere questo computer ", fare clic su "Sblocca", "OK" e fare nuovamente
doppio clic sul file scaricato.

Collegamenti esterni

Come installare MuseScore su Windows senza diritti di amministratore
Come eseguire MuseScore come Amministratore su Windows
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Come risolvere un errore di installazione di MuseScore su Windows
Opzioni linea di comando MSI
Opzioni linea di comando standard

Installare su macOS

Installare

Troverete il file DMG (immagine disco) nella pagina download  del sito web di MuseScore. Cliccare sul link macOS per
avviare il download. Una volta completato il download, fare doppio clic sul file DMG per montare l'immagine disco.

Trascinare e rilasciare l'icona MuseScore sull'icona della cartella Applicazioni.

Se non avete effettuato il login come amministratore, macOS può richiedere una password: cliccare su Autenticati e inserire
la password per procedere.

Quando l'applicazione ha finito di copiare, espellere l'immagine del disco. È ora possibile avviare MuseScore dalla cartella
Applicazioni, Spotlight o Launchpad.

Nota: Fino a macOS 10.15 "Catalina", il sistema richiederà se si vuole permettere a Musescore di accedere alle parti
utente del sistema; ovviamente seleziona si, ma se per sbaglio salti questa procedura, puoi impostarlo tramite Preferenze
di Sistema > Sicurezza e Privacy > Privacy > File e Cartelle. Sblocca con le tue credenziali di Amministratore, poi naviga
a MuseScore (Qualunque versione/i tu abbia e voglia), aggiungilo/i alla lista delle app, e seleziona le cartelle "Documenti"
e "Downloads", o come preferisci.

Disinstallare

È sufficiente eliminare MuseScore dalla cartella Applicazioni.

Installare con Apple Remote Desktop

È possibile distribuire MuseScore su più computer con la funzione "Copia" di ARD. Poiché MuseScore è un'applicazione
autonoma, è sufficiente copiare l'applicazione nella cartella '/Applicazioni' sui computer di destinazione. È anche possibile
installare più versioni dell'applicazione, a condizione che i loro nomi siano diversi.

Installare su Linux
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I pacchetti MuseScore per varie distribuizioni di Linux sono disponibili dalla pagina download . La più semplice da
installare è la AppImage, che può essere eseguita su qualsiasi distribuzione Linux, ma una serie di altri pacchetti
specializzati sono disponibili se lo si preferisce. il manager pacchetti della tua distribuzione. Un'altra possibilità è
compilarla dalla sorgente .

AppImage

Il formato AppImage  è un nuovo modo per impacchettare le applicazioni per Linux. le AppImages sono portatili - non è
necessario installarle - e possono essere eseguite su (quasi) tutte le distribuzioni Linux. Le dipendenze sono incluse nel
file AppImage.

Fase 1 - Download

Prima di scaricare un file AppImage, devi conoscere l'architettura del tuo processore. Questi comandi del terminale te la
mostreranno:

    arch

o

    uname -m

L'output sarà qualcosa come "i686", "x86_64" o "armv7":

i686 (o simile) - processore 32-bit Intel/AMD (usato su dispositivi vecchi).
x86_64 (o simile) - processore 64-bit Intel/AMD (laptop e computer moderni, e la maggior parte dei Chromebooks).
armv7 (o simile) - processore ARM (telefoni e tablet, Raspberry Pi 2/3 con ubuntu Mate, dei Chromebooks,
solitamente 32-bit al momento).

Ora puoi recarti alla pagina di download  e trovare l'AppImage che più si adatta alla tua architettura. Una volta scaricato,
il file avrà il nome di "MuseScore-X.Y.Z-$(arch).AppImage".

Fase 2 - Permessi di esecuzione

Prima che tu possa usare l'AppImage, dovrai avere il permesso di eseguirla come programma.

Dal Terminal:

Questo comando dà il permesso all’utente (u) di eseguire (x) l'AppImage. Funziona su tutti i sistemi Linux.

    cd ~/Downloads
    chmod u+x MuseScore*.AppImage

Nota: Usa il comando "cd" per navigare alla cartella dove hai salvato l'AppImage.

Da un File Manager:

Se preferisci evitare la linea di comando, solitamente c'è un modo per fornire il permesso di esecuzione dall'interno di un
File Manager.

In GNOME File (Nautilus), semplicemente:

1. Fai click destro su AppImage e seleziona "Proprietà".
2. Apri la scheda “Permessi”.
3. Attiva l’opzione chiamata “Consenti l’esecuzione come programma”.

Il processo potrebbe variare in altri file manager.

Fase 3 - Eseguilo!

Ora dovresti riuscire a eseguire il programma facendoci doppio clic sopra!

Probabilmente quando hai scaricato l’AppImage è stata salvata nella tu cartella Downloads, ma puoi spostarla quando
vuoi (es. Potresti metterla sul Desktop per un accesso più facile). In caso decidessi di rimuoverla, ti basterà eliminarla.

Installa l’AppImage (facoltativo)

Puoi eseguire l’AppImage senza installarla, ma dovrai installarla se vuoi che sia completamente integrate con il tuo
ambiente desktop. Questa operazione ha i seguenti vantaggi:

Aggiunge l’AppImage al tuo Menu Applicazioni o Launcher
Imposta le icone corrette per i file di MuseScore (MSCZ, MSCX) e quelli MusicXML (MXL, XML)
Rende l’AppImage Disponibile nella voce “Apri con...” nel menu del tasto destro del tuo File Manager
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Per installarla, esegui l’AppImage dal Terminal con l’opzione "install" (vedi qua sotto). Questo copia un file desktop e varie
icone sul tuo computer. In caso volessi rimuoverle dovrai eseguire l'opzione "remove" prima di eliminare l'AppImage.
Questo non eliminerà nessuna partizione creata con qualunque versione di MuseScore.

Come usare le opzioni linea di comando

Eseguendo l’AppImage dalla linea di comando avrai la possibilità di usare varie opzioni. L’AppImage ha alcune opzioni
speciali oltre alle opzioni linea di comando di MuseScore.

Dovrai cambiare cartella usando cd per spostarti dove l’AppImage è salvata nel tuo sistema, ad esempio:

    cd ~/Desktop
    ./MuseScore*.AppImage [opzione...]

O potrai inserire il percorso dell’AppImage:

    ~/desktop/MuseScore*.AppImage [opzione...]

Usa le opzioni "--help" e "man" per ottenere ulteriori informazioni sulle opzioni della linea di comando disponibili:

    ./MuseScore*.AppImage --help   # mostra una lista completa di opzioni linea di comando
    ./MuseScore*.AppImage man      # mostra la pagina manuale (spiega cosa fa ogni opzione)

Pacchetti distribuzione

Debian

(Meglio prima, ma altrimenti durante o dopo) l’installazione di MuseScore, puoi installare uno o più soundfont (se non
verrà installato nessun soundfont, le dipendenze ne metteranno uno adatto automaticamente):

musescore-general-soundfont-small: il soundfont MuseScore_General standard in formato SF3, come nelle versioni di
Musescore per gli altri sistemi operativi
musescore-general-soundfont: il soundfont MuseScore_General ad alta qualità, come disponibile nel Manager estensioni
musescore-general-soundfont-lossless: il soundfont MuseScore_General ad alta qualità in formato SF2 non compresso:
occupa molto più spazio sul tuo hard disk, ma offre la migliore qualità di suono e tempi di avvio estremamente brevi
fluidr3mono-gm-soundfont: il vecchio soundfont usato in Musescore 2.0 (predecessore di MuseScore_General), usalo
solo se hai risorse estremamente minime o se ti serve
timgm6mb-soundfont: il vecchio soundfont usato in Musescore 1.3; non può sostituire gli altri, usalo solo se ti serve;
estremamente piccolo

Nota: solo il soundfont MuseScore_General (normale o alta qualità) supporta le dinamiche a singola nota (SND), e ti
serve almeno la versione 0.1.6 di quei soundfont (da versioni non stabili o retroadattati) perché supportino le SND.

Il comando sudo update-alternatives --config MuseScore_General.sf3 può essere usato ad ogni momento per selezionare il
soundfont predefinito usato da MuseScore se ne installi più di uno (nota che il soundfont timgm6mb-soundfont non può essere
selezionato).

Poi installa il pacchetto musescore3 per MuseScore 3.x (al momento la versione stabile), o musescore per MuseScore 2.x (c’è
anche musescore-snapshot per la versione instabile di anteprima). I pacchetti sono disponibili nelle seguenti distribuzioni:

musescore3: sid (unstable), bullseye (testing/Debian 11), buster-backports (stable/Debian 10), stretch-backports-
sloppy (oldstable/Debian 9)
musescore: buster (stable/Debian 10), stretch-backports (oldstable/Debian 9), jessie-backports-sloppy
(oldstable/Debian 8)
musescore-snapshot: experimental (usable on unstable)

Vedi https://backports.debian.org/Instructions/  per istruzioni su come aggiungere una repository ufficiale Debian di
retroadattazioni al tuo sistema e installare pacchetti da lì.

Nota: senza le retroadattazioni appropriate, le vecchie versioni potrebbero essere disponibili: MuseScore 2.0.3 su stretch,
MuseScore 1.3 su jessie. Usare la versione 2.3.2 per le partiture versione 2.x (o la conversione a 3.x) è fortemente
raccomandato!

Fedora

1. Importa la chiave GPG:

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve
 

2. Vai alla pagina di download  del sito MuseScore. Clicca sul link per la versione stabile per Fedora e scegli il
pacchetto rpm adatto alla tua architettura.
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3. In base alla tua architettura, usa uno dei due set di comandi per installare MuseScore

per arch i386

su
yum localinstall musescore-X.Y-1.fc10.i386.rpm
 

per arch x86_64

su
yum localinstall musescore-X.Y-1.fc10.x86_64.rpm
 

Se hai difficoltà con l’audio, vedi Fedora 11 e l’audio
Vedi anche I suggerimenti per le varie distribuzioni sulla pagina di download .

KDE neon 18.04 (bionic)

I pacchetti kde neon sono costruiti su una repository  separata da quella dei PPA normali di ubuntu, visto che questo è
per noi l’unico modo per costruire pacchetti per KDE neon. A causa di limitazioni del Servizio di costruzione OpenSuSE
usato, possiamo costruire solo per amd64 (PC a 64 bit), e non ARM (Slimbook o Pinebook remix).

Tutti I comandi seguenti devono essere inseriti in un terminal, ognuno in una linea

1. Rimuovi i PPAs di ubuntu (tutti e tre) dal tuo sistema se lo hai già configurato prima. Essi sono solitamente in
/etc/apt/sources.list o uno dei file sotto /etc/apt/sources.list.d/; se hai usato add-apt-repository (il metodo raccomandato) per
aggiungerli, potrai rimuoverli con: sudo rm -f /etc/apt/sources.list.d/mscore-ubuntu-ubuntu-mscore*

KDE neon non è compatibile con i PPAs di ubuntu!

2. Installa dei pacchetti standard (solitamente ci sono già, ma nel caso non ci fossero) per poter scaricare in modo
sicuro la chiave firma della repository:

  sudo apt-get install wget ca-certificates
 

3. Scarica (tramite connessione HTTPS sicura) e installa la chiave firma della repository:

  wget -O - https://download.opensuse.org/repositories/home:/mirabile:/mscore/bionic-neon/Release.key | sudo apt-key add -
 

4. Attiva la repository:

  echo deb https://download.opensuse.org/repositories/home:/mirabile:/mscore/bionic-neon ./ | sudo tee /etc/apt/sources.list.d/mscore.list
 

5. Rendi i nuovi pacchetti disponibili:

  sudo apt-get update
 

Ora è il momento di installare uno o più soundfont (idealmente dovresti installare il soundfont che vuoi prima di installare
MuseScore):

musescore-general-soundfont-small: il soundfont MuseScore_General standard in formato SF3, come nelle versioni di
Musescore per gli altri sistemi operativi

musescore-general-soundfont: il soundfont MuseScore_General ad alta qualità, come disponibile nel Manager
estensioni
musescore-general-soundfont-lossless: il soundfont MuseScore_General ad alta qualità in formato SF2 non
compresso: occupa molto più spazio sul tuo hard disk, ma offre la migliore qualità di suono e tempi di avvio
estremamente brevi
fluidr3mono-gm-soundfont: il vecchio soundfont usato in Musescore 2.0 (predecessore di MuseScore_General),
usalo solo se hai risorse estremamente minime o se ti serve
timgm6mb-soundfont: il vecchio soundfont usato in Musescore 1.3; non può sostituire gli altri, usalo solo se ti
serve; estremamente piccolo

Se salti questo procedimento, un soundfont adatto verrà installato automaticamente quando installi MuseScore.

Nota: solo il soundfont MuseScore_General (normale o alta qualità) supporta le dinamiche a singola nota (SND), e ti
serve almeno la versione 0.1.6 di quei soundfont (da versioni non stabili o retroadattati) perché supportino le SND.

Il comando sudo update-alternatives --config MuseScore_General.sf3 può essere usato ad ogni momento per selezionare il
soundfont predefinito usato da MuseScore se ne installi più di uno (nota che il soundfont timgm6mb-soundfont non può essere
selezionato).

Finalmente puoi installare l’ultima versione di MuseScore con sudo apt-get install musescore3 e quella vecchia 2.x con sudo apt-
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get install musescore (c’è anche musescore-snapshot per la versione instabile di anteprima).

Ubuntu, Kubuntu, Xubuntu, …

ATTENZIONE: queste istruzioni non sono per gli utenti di KDE neon (vedi sopra)!

MuseScore 2.x (la versione vecchia) è disponibile dalla versione 18.10 (cosmic) a 19.10 (eoan) senza setup necessario.
Versioni di ubuntu più vecchie hanno versioni di MuseScore più vecchie (18.04 (bionic) ha la 2.1, 16.04 (xenial) ha la 2.0,
14.04 (trusty) e 12.04 (precise) hanno la 1.3 e 1.2, rispettivamente). Similarmente alle istruzioni per Debian,
raccomandiamo di usare la versione 2.3.2 per le partiture versione 2.x (o di convertirli a 3.x).

Oltre alle versioni della distribuzione, il mantenitore Debian di MuseScore fornisce nuove versioni di MuseScore per
vecchie versioni di ubuntu nei PPAs ufficiali.

Per favore attiva la repository delle versioni stabili di MuseScore 3  sul tuo Sistema e poi installa il pacchetto musescore3,
disponibile per tutte le versioni dalla 18.04 (bionic) in poi. (Non è possibile fornire MuseScore 3 per versioni di ubuntu più
vecchie, poiché esse non hanno i requisiti minimi della versione di Qt necessaria a MuseScore 3)

Se desideri installare MuseScore 2, attiva la repository delle versioni stabili di MuseScore 2  e installa il pacchetto
musescore, disponibile per 12.04 (precise), 14.04 (trusty), 16.04 (xenial), e da 18.04 (bionic) in su. (Alcune versioni
intermedie potrebbero avere versioni di MuseScore più vecchie ancora disponibili, ma è meglio aggiornare alle versioni
LTS.) Sugli antichi 12.04 (precise) e 14.04 (trusty), questo aggiornerà la libreria Qt nel tuo Sistema, il che potrebbe
provocare il malfunzionamento di software non correlato (e sulla versione 12.04 addirittura anche le librerie C++ sono
aggiornate), intendiamoci; meglio aggiornare ad una nuova versione LTS.

C’è anche una repository di Versioni di MuseScore Notturne (versioni di sviluppo instabili) , da cui gli impavidi potranno
installare il pacchetto musescore-snapshot, solo per LTS 18.04 (bionic).

ATTENZIONE: queste PPAs sono solo per Ubuntu/Kubuntu/Xubuntu/… ma non per Debian o KDE neon!

Come con Debian, puoi installare uno o più soundfont (meglio prima di installare MuseScore, ma se non lo farai, ne verrà
installato uno adatto insieme a MuseScore):

musescore-general-soundfont-small: il soundfont MuseScore_General standard in formato SF3, come nelle versioni di
Musescore per gli altri sistemi operativi

musescore-general-soundfont: il soundfont MuseScore_General ad alta qualità, come disponibile nel Manager
estensioni
musescore-general-soundfont-lossless: il soundfont MuseScore_General ad alta qualità in formato SF2 non
compresso: occupa molto più spazio sul tuo hard disk, ma offre la migliore qualità di suono e tempi di avvio
estremamente brevi
fluidr3mono-gm-soundfont: il vecchio soundfont usato in Musescore 2.0 (predecessore di MuseScore_General),
usalo solo se hai risorse estremamente minime o se ti serve
timgm6mb-soundfont: il vecchio soundfont usato in Musescore 1.3; non può sostituire gli altri, usalo solo se ti
serve; estremamente piccolo

Nota: solo il soundfont MuseScore_General (normale o alta qualità) supporta le dinamiche a singola nota (SND), e ti
serve almeno la versione 0.1.6 di quei soundfont (da versioni non stabili o retroadattati) perché supportino le SND.

Il comando sudo update-alternatives --config MuseScore_General.sf3 può essere usato ad ogni momento per selezionare il
soundfont predefinito usato da MuseScore se ne installi più di uno (nota che il soundfont timgm6mb-soundfont non può essere
selezionato).

Collegamenti esterni

Come eseguire l’AppImage di MuseScore su Linux  - video

Installare su Chromebook

Programma desktop

Il programma desktop di MuseScore funziona nativamente sulla macchina virtuale Linux di Chrome OS chiamata Crostini.
Segui i procedimenti descritti nel video:

1. Installa la Macchina Virtuale Linux chiamata Crostini. Vai a Impostazioni -> Linux -> Attiva
2. Scarica il pacchetto AppImage di MuseScore
3. Configura l'AppImage per l'esecuzione. Imposta chmod +x per il file AppImage
4. Esegui l'AppImage con ./ seguito dal nome pacchetto Musescore
5. Installa le librerie richieste, se necessario
6. Installa l'AppImage per evitare di eseguirla dalla linea di comando linux ogni volta
7. Ben fatto!

Per maggiori informazioni guarda il video interattivo
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Lingue, traduzioni ed estensioni

MuseScore usa la tua lingua di sistema (quella usata per la maggior parte dei programmi, scelta alla base delle
impostazioni della regione e della lingua del tuo PC, o account).

Cambia lingua

1. Dal menu, seleziona Modifica→Preferenze... (Mac: MuseScore→Preferenze...);

2. Nella scheda Generale, seleziona dal menu a tendina nella sezione Lingua la lingua desiderata:

Gestione delle risorse

Il Gestore delle risorse serve a installare e disinstallare le estensioni, e per aggiornare le traduzioni. Per usarlo:

Dalla barra del menu, seleziona Aiuto→Gestione delle risorse.

Dalla barra del menu, seleziona Modifica→Preferenze... (Mac: MuseScore→Preferenze...), apri la scheda Generale, e premi su
Aggiorna traduzioni.
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Installa/disinstalla estensioni

Per installare o disinstallare un'estensione:

1. Seleziona la scheda Estensioni nella Gestione delle risorse.
2. Seleziona l'estensione.
3. Clicca sul pulsante Installa o Disinstalla.

Nota: Le estensioni sono MuseScore Drumline (MDL) (dalla versione 3.0) e il Soundfont MuseScore General HQ (dalla
versione 3.1).

Aggiorna traduzioni

Per aggiornare la/le traduzione/i:

1. Seleziona la scheda Lingue nella Gestione delle risorse.
2. Clicca sul/i pulsante/i Aggiorna relativo/i alla/e lingua/e che vuoi aggiornare.

Nota: Quasi tutti i menu e finestre di dialogo useranno la lingua selezionata immediatamente, ma alcuni non la useranno
fino a quando il programma non è aggiornato.

Vedi anche

Aiuta a migliorare le traduzioni

Collegamenti esterni

Come cambiare la lingua in MuseScore

Controllo aggiornamenti

Nota: Queste opzioni sono disponibili solo sulle versioni per Mac e Windows (tranne quelle da Windows Store), poichè
solo queste possono essere aggiornate direttamente da MuseScore.org. Le versioni per Linux (e Windows Store) hanno
modalità di aggiornamento differenti.

Per le versioni di MuseScore che possono essere aggiornate direttamente, ci sono due metodi per controllare la
disponibilità di aggiornamenti.

Controllo automatico della disponibilità di aggiornamenti

1. Dal menu, seleziona Modifica→Preferenze... (Mac: MuseScore→Preferenze...);
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2. Seleziona la scheda Aggiorna.
3. Verifica che l'opzione "Controlla la presenza di nuove versioni di MuseScore" sia selezionata (dovrebbe esserlo, se

non è stata modificata):

Se attivi questa opzione, MuseScore controllerà gli aggiornamenti ad ogni avvio. Sulle versioni per Mac e Windows
(esclusa quella per Windows Store), questa opzione attiva un auto-aggiornatore che scaricherà e installerà gli
aggiornamenti automaticamente.

Controllo aggiornamenti

1. Dal menu, seleziona Aiuto→Controlla aggiornamenti:

2. Comparirà una finestra di dialogo: o "Nessun aggiornamento disponibile" o "Un aggiornamento per MuseScore è
disponibile:" seguito da un link per scaricarlo.

Vedi anche

Preferenze: Aggiorna

Nozioni di base
Questo capitolo ti mostra come impostare una nuova partitura, usando la procedura guidata di MuseScore, e come
inserire e modificare la notazione musicale di base. Le varie parti della finestra del programma sono descritte - barre degli
strumenti, Ispaettore, tavolozze ecc. - così come le opzioni di visualizzazione e navigazione.

Crea una nuova partitura

Per creare una nuova partitura, apri la Procedura guidata nuova partitura (vedi Crea una nuova partitura, sotto):
accessibile anche dalla Finestra di avvio.

Finestra di avvio

Questa è la finestra che si apre se avvii MuseScore per la prima volta:
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Per aprire la finestra di avvio (nel caso che non fosse visibile), usa una delle opzioni seguenti:

Premi F4.
Dalla barra menù, seleziona File→Finestra di avvio

Per evitare che la Finestra di avvio venga mostrata all’apertura di MuseScore:

Dalla barra menù, seleziona Modifica→Preferenze... (Mac: MuseScore→Preferenze...) e deseleziona “Mostra finestra di
avvio" nella sezione Avvio programma della scheda “Generale”.

Dalla finestra di avvio puoi:

Creare una nuova partitura (cliccando sull’icona con un +).
Visualizzare un’anteprima delle partiture aperte precedentemente: cliccaci sopra per aprirla.
Aprire una partiture salvata sul tuo computer: clicca su Apri una partitura...
Aprire la partiture tutorial "Come iniziare". Usa le frecce nel pannello a destra per aprire il link.
Cercare partiture su musecore.com .
Accedere ad altre risorse (vedi il pannello a destra).

Crea una nuova partitura

Per aprire la Procedura guidata nuova partitura quando la finestra di avvio non è aperta, puoi:

Cliccare sull’icona Nuova Partitura nella barra degli strumenti in alto a sinistra;
Usare la scorciatoia Ctrl+N (Mac: Cmd+N);
Selezionare dal menù File→Nuovo....

Inserisci informazioni partitura
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Fase 1: Inserisci informazioni partitura.

Inserisci titolo, compositore, o qualunque altra informazione come nell’immagine precedente, poi clicca su Successivo >.
Questo passaggio è opzionale: puoi aggiungere queste informazioni anche dopo la creazione della partitura (vedi Cornice
verticale).

Seleziona file modello

Fase 2: Seleziona file modello.

Nella colonna di sinistra c’è una lista di file modello per solo, banda e orchestra, divise in categorie a seconda dello stile
musicale. Se hai salvato dei file modello personalizzati nella tua cartella di file modello, essi verranno visualizzati nella
categoria "File modello personalizzati". Puoi anche usare la Casella di ricerca (in alto a sinistra) per trovare file modello
specifici.

Per scegliere un file modello:

Clicca sul nome di un file modello per selezionarlo, poi clicca su Successivo >; in alternativa, puoi fare doppio click sul
nome del file modello. Questo ti porterà alla pagina successiva della procedura guidata (vedi Scegli un'armatura di
chiave, sotto).
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Se vuoi creare un file modello da zero, clicca su "Scegli strumenti" (in "Generale"), poi clicca su Successivo >;
alternativamente, fai doppio click su “Scegli strumenti."

Scegli strumenti

La finestra __ Scegli strumenti__ è divisa in due colonne:

La colonna di destra contiene una lista di strumenti, o voci tra cui scegliere. Questa lista è categorizzata per
famiglie di strumenti, e cliccando una categoria verrà mostrata la lista di strumenti di quella categoria.

La categoria selezionata di default è “Comuni”, ma puoi scegliene altre, tra cui “Jazz” e “Early music”. Sotto alla lista c’è
una casella di ricerca: qui puoi scrivere il nome di uno strumento, ed esso verrà cercato in “Tutti gli strumenti”.

La colonna di destra all’inizio è vuota, ma puoi aggiungere strumenti nell’ordine in cui appariranno.

Aggiungi strumenti

Per aggiungere strumenti alla partiture, usa una delle seguenti opzioni:

Seleziona uno o più strumenti nella Colonna di sinistra e clicca su Aggiungi.
Fai doppio click su uno strumento della colonna di sinistra.

I nomi degli strumenti, e i righi corrispondenti, sono ora presenti nella lista della colonna di destra. Se necessario, puoi
aggiungere più strumenti o voci. Ogni strumento aggiunto in questo modo ha il suo canale nel Mixer.

Nota: Se vuoi che più righi condividano lo stesso strumento, usa i comandi Aggiungi rigo o Aggiungi rigo collegato (vedi
sotto).

Aggiungi rigo / Aggiungi rigo collegato

Per aggiungere un rigo a uno strumento già presente nello spartito:

1. Seleziona un rigo nello spartito dalla colonna di destra (es. vedi “Rigo 1” nell’immagine sottostante). Clicca Aggiungi
rigo o Aggiungi rigo collegato .

2. Modifica il Tipo di rigo, se necessario.
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Sommario dei comandi:

Comando Rigo
aggiunto

Modifica righi
indipendentemente?

Condividono lo stesso
canale Mixer? Esempi

Aggiungi rigo Non
collegato Si Si Rigo/intavolatura chitarra, Rigo

pianoforte a coda
Aggiungi rigo
collegato Collegato No. Una modifica in un rigo

modificherà anche gli altri. Si Rigo/intavolatura chitarra

Vedi anche, Combina un rigo con una intavolatura.

Cambia l’ordine degli strumenti

Per cambiare l’ordine degli strumenti (o righi) nella partitura:

Premi sul nome dello strumento o rigo nella colonna di destra e usa i pulsanti etichettati con delle frecce per
muoverlo più in alto/basso.

Elimina uno strumento

Per eliminare uno strumento, o spartito, dalla partitura:

Seleziona uno strumento, o spartito, nella colonna di destra, e premi Togli.

Scegli un'armatura di chiave
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Step 3: Scegli un’armatura di chiave.

La procedura guidata chiede due cose: l’armatura di chiave iniziale e il (metronomo) tempo della partitura.
Dopo averli selezionati premi su Prossimo > per continuare.

Scegli indicazione metrica, metronomo, battuta in levare, e numero di battute

Step 4: Scegli indicazione metrica ecc.

Qui puoi impostare la tua indicazione metrica iniziale. Se la partitura inizia con una battuta in levare (anche chiamata
anacrusi), clicca sulla casella relativa alla Battuta in levare e imposta la “Durata” a tuo piacimento.

Battute l’impostazione standard è di 32: puoi cambiare questo numero ora, o aggiungere/rimuovere battute dopo dalla
partitura.

Anche qui può essere impostato un metronomo iniziale.

Clicca su Fine per creare la tua nuova partitura.

Modifiche alla partitura dopo la creazione

Ogni modifica che fai alla partitura nella Procedura guidata nuova partitura può essere cambiata anche mentre ci lavori
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sopra:

Aggiungi / rimuovi / modifica battute

Inserisci battute.
Aggiungi battute.
Elimina battute.
Crea una battuta in levare.

Aggiungi / rimuovi testo

Aggiungi testo (Text basics).
Modifica testo.

Cambia strumenti

Per aggiungere, rimuovere, o cambiare l’ordine degli strumenti:

Seleziona dal menù Modifica→Strumenti...; o usa la scorciatoia tastiera, I. Questo apre la finestra Strumenti che è
praticamente identica alla finestra Scegli strumenti nella Procedura guidata nuova partitura (vedi sopra).

Vedi anche Cambia strumenti (Proprietà rigo).

Nascondi un rigo

Per nascondere un rigo permanentemente: Apri la finestra Strumenti (I) e deseleziona la casella “Visibile” per
quello spartito.
Per nascondere un rigo sotto certe condizioni: Vedi le opzioni “Nascondi” nella finestra Finestra spartito, e
Proprietà rigo.

Modifica impaginazione e formattazione

Per modificare la distanza tra spartiti e sistemi, impostare i margini della pagina ecc., vedi Impaginazione e formattazione

File modello

Un File modello è semplicemente un file Musescore standard che è stato salvato in una di due cartelle di “file modello”: i
file in queste cartelle vengono visualizzati automaticamente nella pagina "Scegli file modello" della Procedura guidata
nuova partitura. Due cartelle di file modello vengono create automaticamente:

Una cartella file modello di sistema.
Una cartella file modello dell’utente.

Cartella file modello di sistema

Questa cartella contiene i file modello installati con MuseScore e non dovrebbero essere modificati. Essa può essere
trovata nelle seguenti posizioni:

Windows: Solitamente sotto C:\Program Files\MuseScore 3\templates.

Linux: Sotto /usr/share/mscore-xxx se installato dal manager pacchetti. Se hai compilato MuseScore su Linux tu stesso,
allora controlla sotto a /usr/local/share/mscore-xxx (xxx è il numero della versione che stai usando).

MacOS: Sotto /Applications/MuseScore 3.app/Contents/Resources/templates.

Cartella file modello dell’utente

Ogni file modello che crei per un futuro utilizzo dovrebbero essere salvati qui. Una volta che sono nella cartella di “file
modello” dell’utente, essi appariranno automaticamente sulla pagina "Scegli file modello” della Procedura guidata nuova
partitura—sotto a “File modello personali”

La posizione standard della cartella dei file modello personali è la seguente:

Windows: %HOMEPATH%\Documenti\MuseScore3\Templates.

MacOS e Linux: ~/Documents/MuseScore3/Templates.

Per configurare la posizione della tua cartella dei file modello privati:

Dal menù, seleziona Modifica→Preferenze...→Generale.
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Vedi anche

Armatura di chiave
Indicazione metrica
Chiave
Tempo
Proprietà Rigo / Parte

Collegamenti esterni

Video tutorial: MuseScore in Minutes: Lesson 1 – Impostazione partitura

Inserimento Note

MuseScore permette di inserire la notazione musicale da ognuno dei quattro dispositivi di input: tastiera del computer,
mouse, tastiera MIDI, o tastiera del piano virtuale. La modalità predefinita di inserimento e' un passo alla volta, con la
quale le note o le pause sono inserite una per volta. Sono comunque disponibili altre modalità di inserimento.

Dopo l’uscita dalla Procedura guidata per nuova partitura, detta nuova partitura consisterà in una serie di battute riempite
di pause di battuta:

Mentre vengono inserite le note in una battuta, le relative pause assumono di pari passo valori appropriati al fine di
riempire correttamente la parte di battuta restante:

Le note di diversa durata sullo stesso battito vengono inserite utilizzando le voci:

Inserimento note: elementi basilari

Questa sezione introduce alle basi dell'inserimento di note e pause una per volta dalla tastiera del computer. Si
raccomanda anche di consultare i vari tutorial, disponibili nella Finestra di avvio.

Passo 1. Selezionare una posizione di partenza

Selezionare una posizione di partenza per l'inserimento delle note cliccando con il mouse su una nota o una pausa,
oppure selezionando una battuta. Se non viene selezionato un punto di partenza, il cursore si posiziona automaticamente
all'inizio dello spartito non appena si entra in modalità Inserimento note ("Passo 2" sotto).

Passo 2. Entrare in modalità inserimento note

Per entrare in modalità Inserimento note, usare una delle seguenti opzioni:

Cliccare sull’icona "N" (all’estrema sinistra della barra degli strumenti Inserimento note).
Premere N sulla tastiera del computer.

Per uscire dalla modalità Inserimento note, usare una delle seguenti opzioni:

Premere N.
Premere Esc.
Cliccare l’icona "N" nella barra degli strumenti.

Passo 3. Selezionare una durata

Sempre in modalità Inserimento Note, selezionare la durata della nota usando uno dei seguenti metodi:

Cliccare sull'icona della nota corrispondente nella barra inserimento note (direttamente sopra la finestra del
documento):
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Inserire la scorciatoia da tastiera per la durata voluta (vedere sotto).

Passo 4. Inserire la nota o la pausa

Per inserire una nota di altezza da A-G, basta cliccare sulla corrispondente lettera della tastiera.
Per inserire una pausa, premere 0 (zero).

Questo metodo di inserimento funziona anche se non si è in modalità di inserimento note, a patto che vi sia una
nota/pausa selezionata, o che la partitura sia stata appena creata (nel qual caso l'inserimento delle note avverrà per
default all'inizio).

Selezionare la durata di una nota/pausa

Le seguenti scorciatoie da tastiera sono usate per selezionare la durata della nota/pausa in modalità Inserimento note:

64° (semibiscroma): 1
32° (biscroma): 2
16° (semicroma): 3
Ottavo (croma): 4
Quarto (semiminima): 5
Metà (minima): 6
Intero (semibreve): 7
Doppio intero (breve): 8
Longa: 9
Punto: . (cambia la selezione in nota/pausa puntata)

Vedere anche: Gruppi irregolari.

Durate addizionali

Punti doppi, tripli e quadrupli: Applicare dalla barra di inserimento note nell'area di lavoro avanzata; oppure
tramite scorciatoia da tastiera personalizzata.
128° nota (fusa): come sopra.
durate 256°, 512° o 1024°: Inserire prima una nota da 1/128° (o più grande), poi dimezzarla quante volte necessario
tramite la scorciatoia Q.

Dispositivi di inserimento

La notazione musicale può essere inserita da:
* Tastiera del computer.
* Mouse.
* Tastiera MIDI.
* Tastiera virtuale pianoforte.
* Qualsiasi combinazione di quanto sopra.

Tastiera del computer

Questa sezione amplia "Inserimento note: elementi basilari" (vedere sopra) e introduce all'intera gamma di comandi
disponibili per inserire note o pause dalla tastiera del computer.

Inserire note/pause

È possibile inserire una nota digitando la lettera corrispondente sulla tastiera. Perciò, dopo essere entrati in modalità
Inserimento note, digitare: 5 C D E F G A.

Nota: Quando si inserisce una nota usando la tastiera, MuseScore la colloca in posizione più vicina alla nota precedente
inserita (sopra o sotto).

Per inserire una pausa, digitare "0" (zero). Perciò, dopo essere entrati in modalità Inserimento note, digitare: 5 C D 0 E.
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Nota: La durata selezionata nella barra inserimento note si applica sia alle note che alle pause.

Se si vuole inserire una nota puntata, premere . (punto) dopo aver selezionato la durata.

Per esempio, dopo essere entrati in modalità Inserimento note, digitare: 5 . C 4 D E F G A.

Se si vuole inserire un gruppo irregolare (come una terzina): vedere Gruppi irregolari.

Se si vuole scrivere musica con due o più linee simultanee di melodia indipendente sullo stesso pentagramma, vedere
Voci.

Spostare le note su/giù

Per spostare una nota su o giù di un semitono:

Premere le frecce ↑ o ↓.

Per spostare una nota in alto o in basso diatonicamente:

Premere Alt+Maiusc+↑ o Alt+Maiusc+↓.

Per spostare una nota in alto o in basso di un'ottava:

Premere Ctrl+↑ (Mac: Cmd+↑) o Ctrl+↓ (Mac: Cmd+↓).

Aggiungere alterazioni

Quando una nota viene spostata in alto o in basso con un tasto freccia (vedi sopra), qualsiasi alterazione necessaria
viene generata automaticamente dal programma. Le alterazioni possono comunque essere aggiunte anche manualmente
- vedere Alterazioni.

Accordi

Se si vuol aggiungere una nota di accordo sopra quella precedentemente inserita:

Tenere premuto Maiusc, poi inserire una nota tra A e G.

Così, digitando C, D, Maiusc+F, Maiusc+A, E, F si ottiene:

Per aggiungere una nota ad un intervallo specifico sopra o sotto una o più note:

1. Assicurarsi che una o più note siano selezionate;
2. Utilizzare una delle seguenti opzioni:

Dal menù, selezionare Aggiungi→Intervalli e scegliere un intervallo dalla lista;
Premere Alt+1-9 per gli intervalli superiori (l’inserimento di intervalli inferiori è possibile anche aggiungendo le
relative scorciatoie nella lista in Preferenze).

Note: Per creare accordi con note di differente durata, sarà necessario utilizzare più di una Voce.

Inserire note

Normalmente, quando si inserisce musica in MuseScore, qualsiasi nota o pausa esistente viene sovrascritta. Ci sono,
comunque, diversi modi per inserire note:

Inserire battute aggiuntive nella partitura.
Tagliare e incollare una sezione della partitura in avanti, poi inserire la musica nello spazio vuoto.
Per inserire una nota, premere Ctrl + Maiusc (Mac: Cmd + Maiusc) + il nome della nota (da A a G). Questo inserirà una
nota della durata selezionata e sposterà le restanti note verso destra nella medesima battuta. Se la battuta eccede
la durata dell’Indicazione metrica in vigore, il segno “+” (più) apparirà sopra la battuta a destra come in Modalità
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Inserimento.

Cancellare note

Per cancellare una singola nota:

Selezionare la nota e premere Canc (Mac: Backspace).

Per cancellare un accordo:

1. Premere Esc per accertarsi di essere in Modalità normale.
2. Premere Maiusc e cliccare su una nota per selezionare l’accordo.
3. Premere Canc (Mac: Backspace).

I comandi di cancellazione possono essere applicati anche a intervalli di note/accordi.

Scorciatoie da tastiera

Ecco una lista di utili scorciatoie di editing disponibili in modalità Inserimento note:

↑ (Su): Aumenta l’altezza di una nota di un semitono (utilizza ♯).
↓ (Giù): Diminuisce l’altezza di una nota di un semitono (utilizza ♭).
Alt+1-9: Aggiunge un intervallo (dall'unisono alla nona) sopra la nota corrente.
J: Cambia una nota in alto o in basso nel suo enarmonico equivalente (per esempio D♯ to E♭). Questo altera la
rappresentazione grafica sia nella tonalità “da concerto” che nei modi trasposti. Vedere Accidenti e Partitura in
Do .
Ctrl+J (Mac Cmd+J): Cambia una nota in alto o in basso nel suo enarmonico equivalente. Questo altera la
rappresentazione grafica solo nella modalità corrente. Vedere Accidenti.
Alt+Maiusc+↑: Aumenta l’altezza di una nota secondo gli intervalli di scala dell’armatura di chiave in vigore.
Alt+Maiusc+↓: Diminuisce l’altezza di una nota secondo gli intervalli di scala dell’armatura di chiave in vigore.
R: Ripete l’ultima nota inserita.
Q: Dimezza la durata dell'ultima nota inserita.
W: Raddoppia la durata dell'ultima nota inserita.
Maiusc+Q: Diminuisce la durata di un punto (per esempio, una nota da un quarto puntata diventa una nota da un
quarto e una nota da un quarto diventa un ottavo puntato).
Maiusc+W: Aumenta la durata di un punto (per esempio una nota da un ottavo diventa un ottavo puntato e una nota
da un ottavo puntato diventa un quarto).
Backspace: Annulla l’ultimo inserimento di nota.
Maiusc+←: Scambia l'ultima nota inserita con la nota precedente (ripetere per continuare a spostare la nota prima).
Maiusc+→: Scambia la nota spostata con Maiusc+← con la nota che la segue.
X: Inverte la direzione del gambo della nota (può essere riportato in posizione Auto nell’Ispettore).
Maiusc+X: Sposta la testa della nota sul lato opposto del gambo (può essere riportato in posizione Auto nell’Ispettore).
Ctrl+Alt+1-4: Passa alla corrispondente voce).

Mouse

Inserire le note con il mouse è facile, ma non è il modo più veloce per trattarne quantità elevate.

1. Cliccare sul simbolo di durata della nota desiderata nella Barra inserimento note.
2. Cliccare sul pentagramma per aggiungere una nota della durata selezionata all’altezza voluta.
3. Per aggiungere altre note a un accordo esistente, basta ripetere il passo 2.
4. Per sostituire un accordo esistente (piuttosto che aggiungerlo), premere Maiusc prima di cliccare.
5. Per aggiungere una pausa, cliccare con il tasto destro del mouse.

Nota: Passando il cursore sulla partitura in modalità di inserimento delle note, apparirà un'anteprima della nota o della
pausa che si sta per aggiungere.

Tastiera MIDI

Le note possono inserire anche usando una tastiera MIDI.

1. Collegare la tastiera MIDI al computer ed accenderlo
2. Avviare MuseScore (questo deve essere fatto dopo aver acceso la tastiera)
3. Creare una nuova partitura
4. Cliccare sulla pausa (selezionandola) in battuta 1 per indicare dove si vuole iniziare ad inserire le note
5. Premere N per entrare in “Modalità inserimento note”
6. Selezionare una durata di nota, come ad esempio 5 per semiminime (crotchets), come descritto sopra
7. Premere una nota sulla tastiera MIDI.

La nota dovrebbe essere aggiunta alla partitura.

Nota: Il metodo di inserimento predefinito, un passo alla volta permette di inserire una nota per volta. Sono comunque
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disponibili altri metodi: vedere Modalità inserimento note.

Se vi sono più dispositivi MIDI collegati al computer, potrebbe sorgere la necessità di informare MuseScore su quale sia
la tastiera MIDI:

1. Dal menù, selezionare Modifica→Preferenze… (Mac: MuseScore→Preferenze...).
2. Cliccare sulla scheda I/O e selezionare il dispositivo corretto, nel campo etichettato "Ingresso MIDI" sotto la sezione

“PortAudio”.
3. Cliccare OK per uscire. Per applicare la modifica MuseScore dovrà essere riavviato.

Tastiera virtuale per pianoforte

È possibile inserire le note anche utilizzando la tastiera del pianoforte sullo schermo.

Per attivarne o disattivarne la visualizzazione: Premere P (oppure selezionare Visualizza→Tastiera Pianoforte).
Per ridimensionare la tastiera: Posizionare il puntatore del mouse sui tasti del pianoforte, tenere premuto Ctrl (Mac:
Cmd) e muovere la rotella del mouse verso l’alto (per ingrandire) o verso il basso (per ridurre).

Il metodo di inserimento delle note è simile a quello di una tastiera MIDI:

1. Assicurarsi di essere in Modalità inserimento note.
2. Per inserire:

una nota singola: Cliccare sull’appropriato tasto del pianoforte.
un accordo: Selezionare la nota su cui si vuol costruire l’accordo, tenere premuto Maiusc, poi cliccare sul tasto
del pianoforte corrispondente alla seconda nota dell’accordo (nelle versioni precedenti la 2.1, usare Ctrl (Mac:
Cmd). Ripetere se necessario.

Modalità inserimento note

MuseScore offre una varietà di modalità inserimento note oltre a quella di default Un passo alla volta. Sono tutte
accessibili cliccando la piccola freccia vicino al pulsante "N" sulla sinistra della barra degli strumenti Inserimento Note:

Un passo alla volta (default): La modalità preimpostata di inserimento note. Vedere Inserimento note: elementi
basilari (sopra).
Modifica altezze: Sostituisce le altezze senza cambiare il ritmo.
Ritmo: Inserisce le durate con un solo clic o con la pressione di un tasto.
Tempo reale (automatico): Esegue il pezzo a un tempo fisso indicato da un battito di metronomo.
Tempo reale (manuale): Esegue il pezzo battendo un tasto o un pedale per impostare il ritmo.
Inserire: (Chiamato "Timewise" fino alla versione 3.0.2) Inserisce e cancella note e pause all'interno delle battute,
spostando automaticamente la musica successiva in avanti o indietro.

Colorazione delle note fuori estensione

A seconda dell'abilità del musicista, alcune note sono considerate al di fuori della normale estensione di un particolare
strumento. Per scopi informativi, MuseScore opzionalmente colora le note di rosso se sono fuori dall’estensione di un
musicista "professionista", e verde oliva/giallo scuro se fuori dall’estensione di un "principiante". I colori appaiono sullo
schermo del computer, ma non sulle copie stampate.

Per abilitare/disabilitare la colorazione delle note e impostare le estensioni note "professionale" e "amatoriale", vedere

46



Estensione note utilizzabile (Proprietà pentagramma: tutti i pentagrammi).

Note piccole /Teste-note piccole

1. Selezionare la nota (o le note, se più di una) che si vogliono in formato piccolo.
2. A seconda della necessità, spuntare una delle due caselle di controllo "Piccolo" dell’Ispettore: quella nella sezione

“Nota” è usata per ridurre la dimensione della testa della nota individuale; quella nella sezione “Accordo” riduce
dimensione a testa nota, gambo, travatura, e coda tutte insieme.

Per default, la dimensione “piccola” è impostata al 70% della grandezza normale. È possibile modificare questa
impostazione in Formato → Stile→Dimensioni.

Modificare note o pause già inserite

Cambiare durata

Versione 3.3.3 e superiori
1. Assicurarsi di essere in Modalità Normale.
2. Selezionare una o più note/pause, o gambi/code di note. Applicare la durata desiderata tramite scorciatoia (elencate
sopra), oppure cliccare sull'icona di durata equivalente nella barra degli strumenti.

Prima della versione 3.3.3
1. Assicurarsi di essere in Modalità Normale.
2. Cliccare su una nota o una pausa. Applicare la durata desiderata tramite scorciatoia (elencate sopra), oppure cliccare
sull'icona di durata equivalente nella barra degli strumenti.

Nota: Aumentando la durata si sovrascrivono le note o le pause che seguono; diminuendo la durata si aggiungono pause
tra nota modificata e note o pause che la seguono.

Per esempio, per cambiare tre pause di sedicesimo in una sola pausa di ottavo puntato:

1. Cliccare sulla prima pausa di sedicesimo.
2. Premere 4 per trasformarla in pausa di ottavo.
3. Premere . per ottenere la pausa di ottavo puntato.

Man mano che la durata aumenta, sovrascrive le altre due pause di sedicesimi che la seguono.

Cambiare altezza

Per cambiare l’altezza di una singola nota:

1. Assicurarsi di non essere in modalità inserimento note e che non vi siano altre note selezionate.
2. Selezionare la nota desiderata e usare uno dei seguenti metodi:

Trascinare la testa della nota verso l’alto o verso il basso con il mouse;
Premere frecce della tastiera: ↑ (su) o ↓ (giù);
Digitare la lettera corrispondente alla nuova nota (A…G). Usare Ctrl+↓ o Ctrl+↑ per correggere l’intervallo di
ottava, se necessario (Mac: Cmd+↓ or Cmd+↑). Questo attiverà automaticamente la modalità di inserimento note.

Per cambiare la grafia enarmonica di una nota, selezionarla e usare il comando J. Per maggiori informazioni, vedere
Alterazioni.

Per cambiare di un intervallo costante le altezze di un passaggio musicale, si può usare Trasposizione.

Per cambiare le altezze di un passaggio musicale con una melodia diversa, mantenendo invariato il ritmo, usare la
modalità Modifica altezze.

Se lo spartito contiene molte alterazioni scritte male (senza seguire le regole enarmoniche), provare il comando
“Sostituzione enarmonica delle alterazioni” (vedere Alterazioni: Ridefinire le altezze).

Cambiare voce

Per cambiare una o più note in una voce diversa, vedere Voci.

Cambiare pause in note e viceversa

Per cambiare una pausa in una nota della stessa durata:

1. Assicurarsi di non essere in modalità inserimento note (premere Esc per uscire).
2. Selezionare la pausa.
3. Inserire la nota voluta digitando la corrispondente lettera, A–G.

Per cambiare una nota in una pausa della stessa durata:
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1. Assicurarsi di non essere in modalità inserimento note (premere Esc per uscire).
2. Selezionare la nota.
3. Premere 0 (Zero).

Proprietà delle note

Per regolare la posizione orizzontale di una nota/accordo: vedere Offset note.
Per modificare le proprietà delle note in generale (spaziatura, offset, dimensione, colore, direzione della nota,
riproduzione sonora, ecc.): vedere Ispettore e proprietà degli oggetti.
Per regolare la disposizione di tutte le note nella partitura: vedere Impaginazione e formattazione, specialmente le
sezioni riguardanti note, alterazioni e gruppi irregolari.

Vedere anche

Modalità inserimento note
Notazione percussioni
Intavolatura
Gruppi irregolari
Voci
Teste di nota condivise
Preferenze

Collegamenti esterni

How to enter a chord  (MuseScore HowTo)
How to enter a rest  (MuseScore HowTo)
How to span a stem over two staves  (MuseScore HowTo)
How to add cue notes  (MuseScore HowTo)
Video tutorial: MuseScore in Minutes: Lesson 3 - Note input
Video tutorial: MuseScore in Minutes: Lesson 4 - MIDI Keyboard Input
Video tutorial: MuseScore in Minutes: Lesson 5 - More Input Ideas
Video: Semi-Realtime MIDI Demo Part 1: New note entry modes

Aree di lavoro

L’ area di lavoro è costituita da diversi componenti, il principale dei quali è l’area della tavolozza situata a sinistra della
finestra del documento.

Ogni tavolozza è una cartella contenente simboli musicali (di solito correlati) che possono essere applicati alla partitura.

Per aprire o chiudere una tavolozza: Cliccare sulla freccia accanto al nome della tavolozza o premere doppio click
sul suo nome (nelle versioni precedenti a MuseScore 3.3, cliccare una volta sulla freccia o sul nome della
tavolozza).

Per visualizzare o nascondere le “Tavolozze” nell’area di lavoro:

Premere, F9; in alternativa, selezionare dal menu Visualizza → Tavolozze.
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MuseScore fornisce due aree di lavoro preimpostate Base o Essenziale (l'opzione predefinita) e Avanzata (una versione
con più tavolozze e simboli). Entrambe contengono simboli tratti dalle varie sezioni della Tavolozza generale. In aggiunta
è possibile creare aree di lavoro personalizzate (sotto).

Cambiare area di lavoro

Utilizzare uno dei seguenti metodi:

(N.d.T.: accertarsi che la casella “Area di lavoro”, di cui al comando Visualizza → Barra degli strumenti sia contrassegnata
dal segno di spunta). Selezionare una nuova area di lavoro dal menu a discesa a destra della Barra strumenti
inserimento note, (nelle versioni precedenti alla 3.3. questa scelta si trova nella parte inferiore del pannello
principale, in fondo all’elenco tavolozze).
Dal menu, selezionare Visualizza → Area di lavoro, e cliccare su una delle opzioni.

Aggancio/sgancio

Per “agganciare” o “sganciare” un’area di lavoro, vedere Pannelli laterali.

Creare una nuova area di lavoro

Per creare una nuova area di lavoro:

1. Selezionare un’area di lavoro esistente (utilizzando Cambiare area di lavoro se necessario);
2. Cliccare il pulsante + (accanto all’elenco a discesa) e apparirà la seguente finestra di dialogo:

Nota: lo stesso risultato può essere ottenuto tramite menu: Visualizza→Area di lavoro→Nuova…;
3. Inserire un nome per la nuova area di lavoro;
4. Spuntare i componenti che si vogliono unire all'area di lavoro, cioè

Barre degli strumenti: Permette di personalizzare la visualizzazione dei pulsanti degli strumenti e l'ordine in
cui vengono visualizzati. Vi si accede tramite Visualizza→Barre degli strumenti→Personalizza barre degli strumenti.
Barra dei menu: Permette di cambiare i menu e le voci di menu visualizzati nella barra dei menu. NON
ANCORA IMPLEMENTATO;
Componenti GUI: Salva nella nuova area di lavoro le informazioni relative alla posizione dei componenti GUI
(Graphical user interface), e se sono aperti o meno (per esempio, Ispettore, Cronologia);
Preferenze GUI: Salva le preferenze selezionate per i componenti GUI in Modifica→Preferenze, come le
impostazioni di Tema e Area di visualizzazione;

5. Premere Salva. La nuova area di lavoro viene aggiunta al panello.

Modificare un’area di lavoro

Note: Nelle versioni di MuseScore precedenti la 3.3, possono essere modificate solo le nuove aree di lavoro, quelle Base
e Avanzata sono fisse (preimpostate). Vedere Creare una nuova Area di lavoro.

Per cambiare la visualizzazione delle tavolozze: vedere il menu Tavolozze.

Per modificare i contenuti delle tavolozze: vedere Tavolozze personalizzate.

Per cambiare la visualizzazione generale delle aree di lavoro: Selezionare Visualizza→Area di lavoro→Modifica.
Questo visualizza una finestra di dialogo con le stesse opzioni della analoga che compare in Creare una nuova Area
di lavoro (sopra).

Salvare un’area di lavoro personalizzata

Qualsiasi modifica apportata agli spazi di lavoro viene automaticamente salvata nel programma (non sono richieste
ulteriori azioni). Ogni spazio di lavoro personalizzato viene salvato come file separato in una cartella chiamata
"workspaces". La sua posizione è la seguente:

Windows: C:\Users\[USERNAME]\AppData\Local\MuseScore\MuseScore3\(actually %LOCALAPPDATA%\MuseScore\MuseScore3)
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MacOS: ~/Library/Application\ Support/MuseScore/MuseScore3/.
Linux: ${XDG_DATA_HOME:-~/.local/share}/MuseScore/MuseScore3/.

Vedere anche

Tavolozze
Tavolozza principale

Modalità di modifica

Modalità di modifica permette di eseguire una vasta gamma di operazioni di edizione sui singoli elementi della partitura,
come ad esempio:

Regolare la lunghezza e la forma di legature, linee, stanghette, ecc.
Aggiungere, cancellare e formattare il testo negli elementi di testo.
Regolare la posizione della maggior parte degli elementi della partitura (ma non testo).

Entrare in modalità di modifica

MuseScore versione 3.4 e superiori

Per linee, forcelle, legature, gambi di note, travature di note e stanghette, usare uno dei seguenti metodi:

Fare clic su un elemento.
Cliccate con il tasto destro del mouse su un elemento e, dal menù, selezionate Modifica Elemento.

Per altri elementi, usate uno dei seguenti metodi:

Fare doppio clic su un elemento.
Fare clic su un oggetto già selezionato (solo oggetti basati su testo).
Fare clic destro su un elemento e, dal menù, selezionare Modifica elemento.
Cliccare su un elemento e premere Alt+Maiusc+E.

MuseScore versioni precedenti la 3.4

Utilizzare uno dei seguenti metodi:

Doppio click su un elemento.
Fare click destro su un elemento e, dal menù, selezionare Modifica Elemento.
Cliccare su un elemento e premere Alt+Maiusc+E.

Uscire da modalità modifica

Per uscire dalla modalità modifica usare uno dei modi seguenti:

Premere Esc.
Cliccare su un’area vuota della finestra della partitura.

Testo

Per modalità modifica testo, vedere Modifica del testo.

Linee

Vedere Linee: Modifica lunghezza, e Modifica legature di portamento.

Note

Spostamento di note

Alcune volte è necessario spostare una nota a destra o a sinistra per evitare una collisione con un altro elemento oppure
per annullare la condivisione automatica testa della nota per esempio:

1. Entrare in modalità modifica sulla nota desiderata;
2. Premere il tasto freccia corrispondente alla direzione (sinistra o destra) in cui si desidera spostare la nota (oppure

usare Ctrl+← or Ctrl+→ per regolazioni più ampie);
3. Premere il tasto Esc. Questo permetterà di ridisegnare il gambo della nota.

In alternativa, è possibile selezionare la testa della nota e modificare l' "Offset orizzontale" (nella sezione "Accordo")
dell’Ispettore.
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Regolare la lunghezza del gambo della nota

1. Entrare in modalità modifica sul gambo-nota desiderato;
2. Utilizzare le scorciatoie da tastiera (sotto illustrate) per estendere o accorciare il gambo;
3. Uscire dalla modalità modifica.

In alternativa, è possibile selezionare il gambo ed eseguire il "Cambio della lunghezza" (nella sezione "Gambo") tramite
Ispettore.

Per riposizionare un gambo di nota, bisogna selezionarlo e regolare i valori di "X" e "Y" di "Offset" (sotto "Posizionamento
automatico") nella sezione "Elemento" dell’Ispettore.

Scorciatoie da tastiera

In modalità modifica le seguenti combinazioni di tasti possono essere utilizzate per cambiare la posizione di (1) un
elemento della partitura (esempio: Abbellimenti, Accidenti, etc.) o di (2) una maniglia di regolazione (esempio: legature
di valore, linee, etc.):

←: Sposta a sinistra di 0.1 spazio di rigo (sp. in seguito).
→: Sposta a destra di 0.1 sp.
↑: Sposta verso l’alto di 0.1 sp.
↓: Sposta verso il basso di 0.1 sp.
Ctrl+← (Mac: Cmd+←): Sposta a sinistra di uno sp.
Ctrl+→ (Mac: Cmd+→): Sposta a destra di uno sp.
Ctrl+↑ (Mac: Cmd+↑): Sposta verso l’alto di uno sp.
Ctrl+↓ (Mac: Cmd+↓): Sposta verso il basso di uno sp.
Alt+←: Sposta a sinistra di 0.01 sp.
Alt+→: Sposta a destra di 0.01 sp.
Alt+↑: Sposta verso l’alto di 0.01 sp.
Alt+↓: Sposta verso il basso di 0.01 sp.

I seguenti comandi si applicano solo alle maniglie di regolazione:

Maiusc+←: Sposta l’ancoraggio di fine maniglia a sinistra di una nota/pausa.
Maiusc+→: Sposta l’ancoraggio di fine maniglia a destra di una nota/pausa.
Tab: Va alla maniglia successiva.

Per annullare tutte le modifiche, accertarsi di non essere in modalità di modifica e premere Ctrl+R.

Vedere anche

Editazione di testo
Legature di portamento
Parentesi
Linee
Code
Forcelle

Tavolozze

La Tavolozza è una cartella contenente simboli musicali che possono essere applicati alla partitura. Le tavolozze
predefinite di Musescore contengono collezioni di simboli correlati, ma è possibile personalizzarle in modo da poter
visualizzare quasi ogni tipo di simbolo, linea o testo. Le tavolozze formano la parte principale di un'area di lavoro.
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Musescore viene fornito con due set di tavolozze preimpostate: un set di Base e uno Avanzato (contenuti in aree di
lavoro dal nome simile). Ma questo è solo l'inizio. Si possono aggiungere i propri simboli e testi sia alle tavolozze esistenti
che a quelle create in nuove aree di lavoro. In altre parole è possibile personalizzare ogni area di lavoro per soddisfare
esattamente le proprie particolari esigenze volte alla redazione di partiture. Vedere Personalizzare le tavolozze.

Visualizzare o nascondere le Tavolozze

La posizione predefinita dell'area Tavolozze è a sinistra della finestra del documento. Per visualizzarla o nasconderla:

Dal menù, selezionare Visualizza → Tavolozze, oppure utilizzare la scorciatoia da tastiera F9.

Per sganciare l'area delle tavolozze:

Cliccare il simbolo doppia-cuspide (cerchiato nell’immagine sopra riportata), oppure doppio clic sulla barra superiore
del pannello.

Per riagganciare il pannello, fare di nuovo doppio clic sulla barra superiore. Vedere Pannelli laterali per maggiori
informazioni.

Aprire/chiudere una tavolozza

Cliccare sulla freccia accanto al nome della tavolozza, o fare doppio clic sul nome della tavolozza (nelle versioni
precedenti a MuseScore 3.3, cliccare una volta sulla freccia o sul nome della tavolozza).

I simboli assegnati alla tavolozza sono mostrati in una griglia sotto il nome della tavolozza stessa. Se una delle tavolozze
predefinite di Musescore è stata personalizzata, cliccando su Di più verranno mostrati tutti i simboli cancellati.

Modalità tavolozza singola

Se si vuole visualizzare una tavolozza aperta alla volta, fare clic sul pulsante ... e selezionare la casella “Apri solo una
tavolozza alla volta”. Qualsiasi tavolozza aperta ora si chiuderà quando ne aprirete un'altra.

Applicare simboli da una tavolozza

Versione 3.4 o superiori

Selezionare uno o più elementi della partitura, poi cliccare sul simbolo della tavolozza desiderato. Oppure,
trascinare e rilasciare il simbolo sull'elemento desiderato nel rigo musicale.

Versioni precedenti la 3.4

Selezionare uno o più elementi della partitura, poi doppio clic sul simbolo della tavolozza desiderato. Oppure, trascinare e
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rilasciare il simbolo sull'elemento desiderato nel rigo musicale.
Se si sta trascinando un simbolo sulla partitura e si decide di non volerlo applicare, premere Esc.

Suggerimento: Per prevenire errate/involontarie riorganizzazioni accidentali dei contenuti durante l'uso, fare clic con il
tasto destro del mouse sul nome di una tavolozza e deselezionare Abilita modifica.

È possibile cercare i simboli o i nomi delle tavolozze digitando nella casella Cerca in cima alla lista. In fase di digitazione, i
simboli e/o le tavolozze con nomi corrispondenti ai caratteri digitati vengono visualizzati in basso, aggiornandosi
continuamente al variare dell'input digitato. I simboli visualizzati possono provenire da qualsiasi tavolozza, il che rende
questo un modo potente per individuare simboli senza cercare visivamente tra le varie tavolozze.

I simboli possono essere applicati direttamente dai risultati della ricerca come descritto sopra.

Per ripristinare la lista dei nomi delle tavolozze, che è temporaneamente nascosta dai risultati della ricerca, fare clic su X
nella casella di ricerca.

Qualsiasi elemento aggiunto alla partitura da una tavolozza può essere copiato, incollato e duplicato: vedere Copia e
incolla.

Personalizzare l'elenco delle tavolozze

Cambiare l'ordine dei nomi delle tavolozze nella lista

Trascinare il nome della tavolozza in alto o in basso nella posizione desiderata.

Creare una nuova tavolozza

1. In cima all’elenco delle tavolozze, fare clic su Aggiungi tavolozze→Crea tavolozza personalizzata. Oppure, fare clic con il
tasto destro del mouse in un punto qualsiasi dell'elenco dei nomi delle tavolozze e scegliere Inserisci nuova tavolozza .

2. Digitare il nome della nuova tavolozza nella finestra di dialogo Crea tavolozza.
Vedere Tavolozze personalizzate per imparare ad aggiungere simboli alla nuova tavolozza.

Nascondere una tavolozza dalla lista

Come nascondere una tavolozza dipende dal fatto che sia una di quelle predefinite di Musescore o una propria, creata
successivamente con il metodo di cui sopra.

Per nascondere una tavolozza predefinita di Musescore:

Cliccare con il tasto destro del mouse sul nome della tavolozza che si vuole nascondere e cliccare su Nascondi
tavolozza.

Nascondere una propria tavolozza (non predefinita):

Fare clic con il tasto destro del mouse sul nome della tavolozza che si vuole nascondere, cliccare su Nascondi/Cancella
tavolozza, poi cliccare su Nascondi nella finestra di dialogo.

Mostrare nella lista una tavolozza nascosta

Fare clic su Aggiungi tavolozze in cima all’elenco e cliccare su Aggiungi accanto al nome della tavolozza.

Cancellare una tavolozza

Possono essere cancellate solo le proprie tavolozze (non quelle predefinite).

Cliccare con il tasto destro del mouse sul nome della tavolozza che si vuole cancellare, cliccare su Nascondi/cancella
tavolozza, poi cliccare su Cancella permanentemente nella finestra di dialogo.

Non è possibile cancellare le tavolozze predefinite di Musescore. Se non si intende usare una tavolozza predefinita,
nascondere invece il suo nome dalla lista.

Personalizzare le Tavolozze

È possibile modificare qualsiasi tavolozza predefinita di Musescore o creata dall'utente. I simboli possono essere aggiunti
o cancellati e i layout possono essere riorganizzati.

Da MuseScore 3.3 in poi, tutte le tavolozze preimpostate nelle aree di lavoro Base e Avanzata possono essere
personalizzate direttamente (se si sta usando una versione precedente dovrà prima essere creata una nuova area di
lavoro).

Prima di personalizzare una tavolozza:
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1. Cliccare con il tasto destro del mouse sul nome della tavolozza e assicurarsi che Abilita modifica sia spuntato. Questa
casella viene automaticamente spuntata per le tavolozze create da utente.

2. Assicurarsi che la tavolozza sia aperta.

Aggiungere un elemento della partitura ad una tavolozza

Tenere premuto Ctrl+Maiusc (Mac: Cmd+Maiusc), poi trascinare l’elemento dalla partitura alla tavolozza. Elementi della
partitura potrebbero essere un simbolo, una linea, un testo, una dinamica, un diagramma della tastiera, una
immagine importata, ecc.

Aggiungere un simbolo a una tavolozza dalla Tavolozza generale

1. Se la Tavolozza generale non è visibile, selezionare Visualizza → Tavolozza generale dal menù, oppure usare la
combinazione Maiusc+F9 (Mac: fn+Maiusc+F9).

2. Trascinare il simbolo dalla finestra della Tavolozza generale a quella di destinazione.

Cambiare l’ordine dei simboli in una tavolozza

Trascinare il simbolo nella cella in cui si vuole visualizzarlo. I simboli vicini si sposteranno automaticamente per fare
spazio.

Cambiare la posizione e la dimensione di un simbolo in una cella della tavolozza

Cliccare con il tasto destro del mouse sulla cella e poi cliccare su Proprietà. Viene visualizzata la seguente finestra di
dialogo:

Nome: la descrizione che appare quando si passa il mouse sulla cella.
Offset contenuto X, Y: Regola la posizione del simbolo nella cella.
Dimensioni contenuto: Fa apparire il simbolo più grande o più piccolo nella cella.
Disegna rigo: Disegna le cinque linee del rigo dietro il simbolo.

Nota: La modifica di questi valori influisce solo sull'aspetto dei simboli all'interno della tavolozza. Non cambia le loro
dimensioni o gli offset sulla pagina dello spartito.

Rimuovere un simbolo da una tavolozza

Cliccare con il tasto destro del mouse sul simbolo e cliccare su Cancella. Oppure, selezionare il simbolo e cliccare
sull’icona del cestino a destra del nome della tavolozza.

Il comando Di più funziona diversamente in una tavolozza creata dall'utente. Visualizza una tavolozza alla volta dalla lista,
permettendo di aggiungere simboli da quella tavolozza trascinandoli oppure selezionando un elemento e cliccando sul
pulsante Aggiungi a (nome tavolozza) . Usare < e > per spostarsi tra le tavolozze.

Menù della tavolozza

Il seguente menù appare cliccando con il tasto destro del mouse sul nome di una tavolozza o cliccando sul pulsante ... a
destra del nome:

Nascondi tavolozza: Rimuove il nome della tavolozza dalla lista delle tavolozze disponibili.
Nascondi/Cancella tavolozza: Permette di nascondere o eliminare definitivamente una tavolozza creata da utente.
Mostrato al posto della voce di menù di cui sopra.
Inserisci nuova tavolozza: Crea una nuova tavolozza vuota. Identico a Aggiungi tavolozze→Crea tavolozza personalizzata.
Abilita modifica: Permette di modificare il contenuto e la configurazione della tavolozza.
Ripristina tavolozza: Elimina qualsiasi personalizzazione fatta a una tavolozza e ripristina il suo contenuto e la
configurazione predefinita.
Salva tavolozza...: Salva la tavolozza corrente come file .mpal.
Carica tavolozza...: Carica una tavolozza da un file .mpal e ne visualizza il nome nella lista.
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Proprietà tavolozza: Visualizza la seguente finestra di dialogo, dove è possibile regolare l'aspetto di una tavolozza:

Nome: Il nome mostrato nella lista delle tavolozze.
Dimensioni Cella: Larghezza, Altezza: Le dimensioni di ogni singola cella nella tavolozza.
Offset elemento: Regola lo scostamento verticale di tutti i simboli nella tavolozza.
Ridimensiona: Fa apparire tutti i simboli della tavolozza più grandi o più piccoli.
Mostra griglia: Disegna un bordo intorno ad ogni cella della tavolozza.

Comportamento del testo e delle linee applicate

Se il simbolo che si sta aggiungendo alla partitura da una tavolozza contiene un elemento di testo (per esempio testo di
rigo, dinamica, diteggiatura, volta ecc.), allora proprietà come tipo di carattere, dimensione del carattere, colore del testo e
allineamento si adatteranno secondo le seguenti regole:

1. Le proprietà del testo che non sono state modificate dall'utente adotteranno i relativi stili di testo.

2. Le proprietà di testo personalizzate - quelle modificate dall'utente prima di salvare il simbolo in una tavolozza
personalizzata - rimangono come personalizzate.

Al contrario, le proprietà di linea delle linee applicate da una tavolozza rimangono sempre invariate (cioè come impostate
dall'utente prima di salvare in un’area di lavoro personalizzata, o come predefinite nelle aree di lavoro Base/Avanzata).

Vedere anche

Tavolozza generale

Ispettore

Visualizzare l’Ispettore

L’ Ispettore appare di default sulla destra dello schermo. Per mostrarlo o nasconderlo:

Dal menu, selezionare Visualizza e spuntare o deselezionare Ispettore; in alternativa, usare la scorciatoia F8 (Mac:
fn+F8).

Per sganciare il pannello dell’Ispettore:

Cliccare sul simbolo “doppia cuspide” (cerchiato in rosso nella seguente immagine) oppure fare doppio click sulla
barra superiore del pannello.

Per riattaccare il pannello fare di nuovo doppio clic sulla barra superiore. Vedere anche: Pannelli laterali.

Cosa fa l'Ispettore

Quando viene selezionato un qualsiasi oggetto nella finestra della partitura, le sue proprietà vengono automaticamente
visualizzate nell’Ispettore, dove possono essere modificate. Possono anche essere selezionati e modificati insieme più
elementi, purché siano dello stesso tipo. Tuttavia, se gli oggetti selezionati sono di tipo diverso, l'Ispettore limiterà le
modifiche solo al colore, alla visibilità e al posizionamento automatico.

Pulsanti "Ripristina allo stile predefinito" e "Imposta come stile"

Quando si seleziona un oggetto della partitura, due tipi di pulsanti sono chiaramente visibili sul lato destro dell'Ispettore:

Ripristina allo stile predefinito: . Premere questo pulsante per ripristinare una particolare proprietà al valore
predefinito, cioè quello mostrato nel menu Stile.
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Imposta come stile: . Premere questo pulsante per rendere il valore di una particolare proprietà il nuovo default
per lo stile. Questo aggiornerà il menu Stile e tutti gli altri oggetti governati da quello specifico stile.

Nota: è possibile anche modificare gli stili direttamente dal menu Stile.

Categorie di Ispettore

Le proprietà sono convenientemente elencate nei riquadri delle categorie dell’Ispettore. Dette Categorie sono
identificabili dai caratteri in grassetto. Se si seleziona ad esempio una stanghetta, nella parte superiore dell'Ispettore si
vedrà quanto segue:

Per i dettagli delle varie categorie e le loro proprietà, vedere sotto:

Elemento

Tutti gli elementi della partitura, eccetto le cornici, le interruzioni e i distanziatori, visualizzano questa categoria
nell'Ispettore quando vengono selezionati. Le opzioni sono le seguenti:

Visibile: Deselezionare questa casella per rendere invisibili gli elementi selezionati; in alternativa, usare la
scorciatoia V (commutazione da visibile e invisibile e viceversa). Gli elementi invisibili non appaiono nella musica
quando vengono stampati o esportati come PDF o immagine. Se si vuole comunque che rimangano visualizzati
nella finestra del documento, assicurarsi che l’opzione "Mostra Invisibili" sia selezionata in Visualizza → Mostra Invisibili.
Gli elementi invisibili assumeranno la colorazione grigio chiaro.

Colore: Cliccare sul rettangolo per aprire la finestra di dialogo "Seleziona il colore". Regolare il colore e l'opacità
degli elementi selezionati.

Posizionamento automatico: Vedere Posizionamento automatico.

Distanza minima: Distanza minima da altri elementi quando il posizionamento automatico è attivo.

Offset X/Y: Permette di posizionare esattamente gli elementi selezionati (in termini di unità di spazio di rigo). Un
numero positivo sposta gli elementi a destra o in basso; un numero negativo sposta gli elementi a sinistra o in alto.
Vengono inoltre forniti anche i pulsanti Abilita aggancia alla griglia.

Ordine di impilatura (Z): Vedere Posizionamento automatico: Ordine di impilatura

Gruppo di Elementi

Questa categoria viene visualizzata solo quando si seleziona una “miscela” di diversi tipi di elementi, e permette di
modificare solo il colore, la visibilità e il posizionamento automatico.

Segmento

Spazio precedente: Serve per aumentare o diminuire lo spazio prima di un elemento. Questo influisce anche su
qualsiasi sillaba associata.

Accordo
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Offset X/Y: Cambia la posizione di ogni nota nella stessa voce della nota o delle note selezionate. Se si vuol
cambiare la posizione di una sola nota, utilizzare invece la categoria [Elemento].
Piccolo: Rimpicciolisce le teste delle note e il gambo.
Senza gambo: Rende l’accordo senza gambo.
Direzione del gambo: Perette di scegliere la direzione del gambo tra Automatico, Su, oppure Giù.

Nota

Questa categoria permette di apportare modifiche alle note selezionate (per la posizione della singola nota vedere
Elemento). Contiene le seguenti proprietà:

Piccola: Rimpicciolisce la testa della nota (è possibile specificare la dimensione relativa di tutte le note piccole
tramite il menu: Formato → Stile… → Dimensioni).
Schema della testa: Vedere [node: 283677,title=" Schema della testa "].
Gruppo testa della nota: Vedere Gruppo testa della nota.
Tipo testa della nota: Vedere Tipo testa della nota.
Rovescia la testa della nota: Posiziona la testa della nota a sinistra o a destra del gambo (default è "Automatico").
Fissa alla linea: Quando è spuntata, la nota è fissata alla riga superiore del pentagramma standard a 5 linee.
Linea: Un numero positivo sposta la nota "fissata" verso il basso; un numero negativo la sposta verso l'alto.
Riproduci: Deselezionando questa casella si silenzia la nota.
Accordatura: Regola l’accordatura della nota al più vicino cent.
Tipo di intensità: Imposta direttamente la velocità MIDI delle note. Scegli una delle due opzioni:

Bilanciato: Rende il valore mostrato in "Intensità" relativo alla precedente marcatura dinamica.
Utente: Rende il valore mostrato in "Intensità" assoluto (cioè la intensità MIDI non è influenzata dalle
marcature dinamiche).

Intensità: Imposta l’intensità MIDI secondo l’opzione visualizzata in "Tipo di intensità."

Seleziona

Questa categoria appare in modo diverso a seconda della selezione operata:

Se viene selezionata la testa di una nota, la categoria "Seleziona" mostra una serie di pulsanti che permettono di
passare facilmente alla selezione del Gambo, del “Gruppo note” (travatura), dell'uncino, del punto (o dei punti) di
durata o del “numero” che contrassegna un gruppo irregolare associato alla testa di una nota (vedi immagine sotto).

Se si seleziona un intervallo di battute, la categoria "Seleziona" permette di selezionare tutte le Note, le Note di
abbellimento, o le Pause.

Travatura gruppo note

Questa sezione viene visualizzata nell'Ispettore quando si seleziona una o più travature di collegamento tra note, e
permette di operare regolazioni fini della posizione e dell’angolo della travatura; permette inoltre di modificare la
spaziatura tra le note appartenenti alla travatura.

Chiave

Questa sezione appare quando si seleziona una chiave: la casella di spunta permette di attivare/disattivare la
visualizzazione di una precedente chiave di cortesia.

Articolazione
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Questa categoria appare quando si seleziona una articolazione o un ornamento. Sono disponibili le seguenti opzioni:

Direzione: Se il simbolo punta in alto o in basso: applicabile solo ad alcuni simboli.
Ancoraggio: Posizionamento verticale del simbolo.
Riproduci: Attiva/disattiva l'effetto di riproduzione.
Aumenta tempo: Applicabile solo alle fermate. Permette di variare la pausa nella riproduzione.
Stile abbellimenti: Scelta di riproduzione tra stile predefinito o stile barocco.

Diagramma chitarra

Vedere Diagrammi chitarra.

Linea

Questa categoria viene visualizzata quando viene selezionata una linea. Qui si possono impostare varie proprietà
generali.

Visibile: Nasconde o visualizza solo la linea: qualsiasi testo rimane visibile.
Consenti diagonale: L'impostazione predefinita è orizzontale (non spuntata). Spuntare nel caso si voglia modificare
la linea e consentire la creazione di una pendenza.
Colore/Spessore/Stile della linea: Imposta varie proprietà della linea.

Dettagli linea di testo

Questa categoria viene visualizzata quando è selezionata una linea. Permette di impostarne la dicitura, modificare le
proprietà del testo, impostare i ganci (cediglie) di linea e allineare il testo in relazione alla linea stessa.

Cediglia iniziale / Altezza: All'inizio della linea, specificare Nessuno, 90° (verticale), 45° (angolato), o 90° centrato;
impostare la lunghezza della cediglia.

Cediglia finale / Altezza: Idem come sopra.

Inizio Testo / Continua Testo / Fine Testo: Si riferisce al testo all'inizio della linea; all'inizio di qualsiasi linea di
continuazione; o alla fine dell'ultima linea. Tutti hanno le stesse proprietà, come segue:

Testo: Crea o modifica il testo associato alla linea.
Font di caratteri / Grandezza / Stile: Imposta le proprietà del testo, e/o modifica lo stile del testo della linea.
Allineamento: Imposta l'allineamento orizzontale e verticale del testo rispetto alla linea.
Posizione: Posiziona il testo sopra (Sopra/Sotto), o a sinistra della linea.
Offset X / Y: Regola le compensazioni (offset) x e y per un posizionamento esatto.

Finestre di dialogo delle proprietà

Alcuni tipi di oggetti hanno proprietà aggiuntive. Queste sono accessibili cliccando con il tasto destro del mouse
sull'oggetto e scegliendo l'opzione "... proprietà" dal menu contestuale. Le impostazioni disponibili in queste finestre di
dialogo sono spiegate nella descrizione del tipo di oggetto nei capitoli Notazione o Argomenti avanzati.
Vedere:

Articolazioni e ornamenti
Indicazioni metriche
Testo di pentagramma e testo di accollatura
Operazioni sulle battute
Proprietà di Pentagramma/Parte

Vedere anche

Inserimento note
Layout e formattazione
Parti

Operazioni sulle battute

Nota: Per assicurarsi che le battute inserite o aggiunte siano visualizzate correttamente, Crea battute d’aspetto deve
essere settato a off (premere più volte M).

Selezionare

Singola battuta

Per selezionare una singola battuta, cliccare su uno spazio vuoto all'interno della stessa.

58



Intervallo di battute

Per selezionare un intervallo continuo di battute, vedere Selezione con Maiusc+ clic e Selezione con Maiusc.

Inserire

Inserire una battuta vuota nella partitura

Utilizzare una delle seguenti possibilità:

Selezionare una battuta o una cornice, quindi premere Ins (Mac: Maiusc+I).
Selezionare una battuta o una cornice, quindi scegliere dal menù: Aggiungi→Battute→Inserisci una battuta .

Inserire più battute

Utilizzare una delle seguenti possibilità:

Selezionare una battuta o una cornice, quindi premere Ctrl+Ins (Mac: Maiusc+Canc+I); compilare il campo "Numero di
battute da inserire" e premere OK.
Selezionare una battuta o una cornice, quindi scegliere dal menù: Aggiungi→Battute→Inserisci Battute...; compilare il
campo "Numero di battute da inserire" e premere OK.

Aggiungere

Aggiungere una battuta vuota alla fine della partitura

Utilizzare una delle seguenti possibilità:

Premere Ctrl+B (Mac: Cmd+B).
Selezionare dal menù: Add→Battute→Aggiungi una battuta .

Aggiungere più battute alla fine della partitura

Utilizzare una delle seguenti possibilità:

Premere Alt+Maiusc+B (Mac: Alt+Maiusc+B); compilare il campo "Numero di battute da aggiungere" e premere OK.
Selezionare dal menù: Add→Battute→Aggiungi battute... ; compilare il campo "Numero di battute da aggiungere" e
premere OK.

Rimuovere

Rimuovere una singola battuta

Selezionare la battuta, e premere Ctrl+Canc (Mac: Cmd+Canc).

Rimuovere un intervallo di battute

1. Selezionare un intervallo di battute;
2. Premere Ctrl+Canc (Mac: Cmd+Canc).

Nota: Nelle partiture a più righi, la cancellazione di una battuta rimuove anche tutte le battute corrispondenti negli altri righi
dell'accollatura;

Rimuovere le battute finali vuote

Per rimuovere automaticamente tutte le battute vuote alla fine della partitura:

Dal menù, selezionare Attrezzi→Rimuovi battute vuote finali .

Cancellare i contenuti di una battuta

Per cancellare solo i contenuti di una battuta (e non la battuta stessa):

1. Selezionare una o più battute;
2. Premere Canc.

Proprietà

Per modificare le proprietà di una battuta, cliccare con il tasto destro del mouse su una zona vuota della battuta e
selezionare Proprietà battuta...:
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Si possono utilizzare i tasti , in basso a sinistra della finestra-dialogo, per passare alla battuta precedente o a
quella successiva.

Righi

Visibile: Selezionare/deselezionare per mostrare/nascondere le note e le linee del rigo per la battuta selezionata.
senza gambo: Selezionare/deselezionare per mostrare/nascondere tutti i gambi delle note per la battuta
selezionata.

Durata della battuta

Questa sezione della finestra-dialogo permette di regolare la durata di una singola battuta indipendentemente
dall'indicazione metrica visualizzata (in vigore). Utilizzare la funzionalità per creare battute in levare (dette anche
anacrusi), cadenze, sezioni ad lib, etc.

Nominale è l’indicazione metrica in vigore, e non può essere modificata.
Attuale può essere impostata su qualsiasi indicazione metrica si voglia, indipendentemente dall'indicazione
nominale.

Esempio: Nell’immagine di seguito, La battuta in levare con nota da 1/4 ha un’indicazione metrica nominale di 4/4, ma
una attuale di 1/4. Le battute nel mezzo sono in tempo normale di 4/4. La battuta complementare alla fine del rigo, con
nota da 1/2 punteggiata, ha un tempo attuale effettivo di 3/4.

Note: Un piccolo segno - o + compare sopra la battuta quando la sua durata è diversa da quella visibile nell’indicazione
metrica (vedi immagine seguente). Questi segni non compaiono in nessuna stampa o copia PDF. È possibile disattivare
questi segni deselezionando "Segna battute irregolari" nel menù Visualizza.
Anche premere Ctrl+Canc su una nota o una pausa riduce la durata della battuta, mentre tramite modalità inserimento si
può aumentare la durata della battuta.

Altro
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Escludi dal conteggio battute

Escludi dal conteggio battute: Spuntare per escludere la battuta selezionata dalla numerazione delle battute
(esempio una battuta in levare).

Interrompi battuta d’aspetto

Interrompi battuta d’aspetto: Spuntare per evitare la creazione di una battuta d’aspetto all’inizio della battuta
selezionata. Questa opzione dovrebbe essere scelta prima di attivare "Crea battute d’aspetto" in
Formato→Stile...→Partitura. La selezione predefinita (del campo “Crea battute d’aspetto”) è OFF (disattivata) per le
partiture e ON (attiva) per le parti.

Nota: Le battute d'aspetto si interrompono automaticamente in presenza di segni importanti come marcatori di riferimento,
cambi di indicatori di tempo, doppie stanghette, battute irregolari, ecc.

Modalità numerazione battute

Questa funzionalità permette di controllare se e come i numeri di battuta vengono visualizzati sulla battuta selezionata:

Automatico: Segue l’impostazione stabilita in Formato→Stile...→ Numeri delle battute.
Mostra sempre: Forza la visualizzazione del numero.
Nascondi sempre: Nasconde il numero.

Larghezza battuta

Larghezza battuta: Controlla la quantità di spazio orizzontale tra gli elementi della partitura (note, pause, ecc.).

Questa impostazione permette un grado di controllo più preciso di quello offerto dai comandi Aumenta/Diminuisci
larghezza impaginazione (PC: Ctrl+Alt+Maiusc+] e Ctrl+Alt+Maiusc+[. Mac: Alt+Maiusc+] e Alt+Maiusc+[).

Aggiungi al numero di battuta

Aggiungi al numero di battuta: Inserire un numero positivo o negativo per cambiare il numero della battuta
selezionata e di quelle successive. Inserire un valore pari a "-1" ha lo stesso effetto di segnare la battuta stessa
come da escludere dal conteggio (delle battute).

Conteggio ripetizione

Conteggio ripetizione: Se una battuta è alla fine di una ripetizione, questo valore controlla il numero di volte che
l'intera sezione di ripetizione viene riprodotta: vedere anche, Salti e Ripetizioni.

Numerazione

MuseScore inserisce automaticamente la numerazione nella prima battuta di ogni accollatura (eccettuata la prima battuta
di ogni sezione) (N.d.T.: per default la numerazione non è visibile neppure sulla prima battuta della partitura, di fatto la
battuta con il numero 1); sono però disponibili altre opzioni di numerazione: vedere Formato→Stile...→Numeri delle battute.

Dividere e unire

Per rendere la durata di una battuta più lunga o più corta rispetto a quella in vigore – senza modificare l’indicazione
metrica – è possibile adattarne le sue Proprietà Battuta. Lo stesso risultato è ottenibile unendo o dividendo battute (di
seguito).

Unire battute

Metodo A. Unione di due sole battute:

Selezionare la stanghetta divisoria tra le due battute e premere Ctrl+Canc.

Metodo B. Unire un qualsiasi numero di battute:

1. Selezionare le battute che si vogliono unire;
2. Dalla barra dei menù, selezionare Attrezzi→Battuta→Unisci le battute selezionate .

Note: (1) Se si selezionano battute su un solo rigo in una partitura con più righi, saranno unite anche le battute
corrispondenti degli altri righi dell'accollatura. (2) Le travature di unione note possono essere modificate automaticamente.
(3) Se sono state già generate le parti, questa opzione è disabilitata.

Dividere una battuta
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Scegliere uno dei seguenti metodi:

Selezionare una nota; premere Ctrl e cliccare su una Stanghetta nella relativa tavolozza (doppio-clic in versioni
precedenti a 3.4).
Tenere premuto Ctrl e trascinare una Stanghetta (dalla relativa tavolozza) sulla nota che inizierà la battuta
successiva.
Selezionare una nota; quindi, dalla barra del menù, selezionare Attrezzi→Battuta→Dividi la battuta prima della nota/pausa
selezionata.

Nota: Se si seleziona solo una nota su un solo rigo in una partitura con più righi, saranno divise nello stesso punto anche
le battute corrispondenti degli altri righi dell'accollatura.

Collegamenti esterni

Come estendere una battuta su più accollature  ( (MuseScore HowTo, 1.x)
Come cancellare battute  (MuseScore HowTo)
Come ottenere spartiti senza indicazione metrica (e chiave) (MuseScore HowTo)

Voci

Una voce è una linea musicale o una parte che può avere un proprio ritmo indipendentemente da altre voci sullo stesso
rigo. Le voci sono talvolta chiamate "layers" (livelli) in altri software di notazione.

Si possono avere fino a 4 voci su ogni rigo. In una battuta polifonica, normalmente voce 1 (e 3) sono contraddistinte dalle
note con il gambo rivolto verso l’alto mentre voce 2 (e 4) dalle note con il gambo rivolto verso il basso.

N.B. Attenzione a non confondere il concetto di voci di MuseScore (1, 2, 3, 4) con l'ordine delle voci che si trova nelle
partiture vocali SATB:

In Partitura completa SATB (in cui quattro righi sono usati per le quattro voci), si utilizza la voce 1 in ogni rigo.
In Partitura stretta (ridotta) SATB (in cui due righi sono usati per le quattro voci, ad esempio come negli inni),
usare solo (MuseScore) le voci 1 e 2 per entrambi i righi superiore e inferiore.
Non c'è bisogno di usare (MuseScore) le voci 3 e 4 a meno che non ci siano più di due parti nello stesso rigo.
Questo significa che nella chiave di basso di una "partitura stretta", il tenore è la voce 1 e il basso è la voce 2 - i
principianti spesso senza pensare assegnano il basso alla 1, con conseguente confusione di direzione del gambo, o
assegnano il tenore alla voce 3 e il basso alla voce 4, scelta che poi porta a confondere le pause che appaiono nella
voce 1 (che non possono essere cancellate).

Come vengono visualizzate le voci

Selezionando una sezione della partitura, ogni voce viene evidenziata con un colore diverso: voce 1 blu, voce 2 verde,
voce 3 arancione e voce 4 viola.

Quando usare le voci

Se su un singolo rigo, all'interno di un accordo, si vuole che i gambi puntino in direzioni opposte.
Se, all'interno di un rigo, si vuole che note di diversa durata suonino simultaneamente.

Come inserire le note in voci diverse

Le seguenti istruzioni mostrano come scrivere un passaggio di musica a due voci:

1. Inserire prima le note della voce 1: Assicurarsi di essere in modalità modalità inserimento note : il pulsante Voce 1

viene evidenziato in blu nella barra degli strumenti.  Inserire prima le note nella prima voce. Durante
l'inserimento, alcune note possono avere i gambi in basso, ma questi si capovolgeranno automaticamente quando
verrà aggiunta la seconda voce.

Il seguente estratto mostra un rigo per gli alti con le sole note della voce 1 inserite:
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2. Spostare il cursore all'inizio della sezione: Una volta terminato di inserire una sezione di note della voce 1,
premete ripetutamente il tasto ← per muovere indietro il cursore, nota per nota, fino alla prima nota della sezione; in
alternativa utilizzare Ctrl+← (Mac:Cmd+←) per spostare il cursore indietro di una battuta alla volta. Oppure si può
semplicemente uscire da modalità inserimento note (premere Esc) e cliccare direttamente sulla prima nota.

3. Inserire le note della voce 2: Assicurarsi di essere in modalità inserimento note e che la nota della voce 1 all'inizio

della sezione sia selezionata. Cliccare sul tasto "Voce 2"  (sulla destra della barra degli strumenti), oppure
utilizzare la combinazione Ctrl+Alt+2 (Mac: Cmd+Alt+2). Inserire tutte le note della parte vocale inferiore (gambi in
basso).

L'immagine seguente mostra l'esempio precedente dopo l'aggiunta delle note della voce 2:

Cancellare e nascondere pause

Tutte le pause possono essere rese invisibili (nascoste), se necessario: selezionare gli elementi da nascondere e premere
V, o deselezionare la casella "Visibile" nell’ Ispettore. Le pause delle voci 2, 3 e 4 (ma non quelle di voce 1) oltre ad essere
nascoste possono essere cancellate (selezionandole e premendo Canc) ma non è raccomandato: rendetele invece
nascoste.

Una pausa della voce 1 può essere cancellata solo rimuovendo dalla partitura anche quella parte della battuta in cui è
contenuta: vedere Rimuovere intervallo selezionato; oppure Cancellare battuta(e).

Ripristino pause cancellate

Se una pausa è stata cancellata nelle voci 2-4, sarà necessario ripristinarla prima di inserire una nota su quella battuta in
quella voce (il problema può presentarsi, per esempio, in files importati XML o MIDI). Il modo più semplice per correggere
tale battuta è quello di scambiare quella voce con la voce 1 due volte. Per il metodo esatto, vedi Scambio voci di note
(sotto).

Scambio voci di note

Per scambiare le note tra due voci qualsiasi:

1. Selezionare una o più battute continue (oppure un intervallo di note);
2. Dalla barra dei Menu, selezionare Attrezzi → Voci;
3. Selezionare l'opzione per le due voci che si vogliono scambiare.

Note: (a) La selezione può comprendere il contenuto di qualsiasi voce, ma ne saranno scambiate solo due alla volta. (b)
Nel caso di battuta selezionata solo parzialmente, l'operazione sarà comunque applicata all'intera battuta.

Spostare le note in un'altra voce (senza scambiarle)

Si possono anche spostare le note da una voce all'altra (senza scambio di note):

1. Accertarsi di non essere in modalità inserimento note.
2. Selezionare una o più teste di nota (in qualsiasi voce).
3. Cliccare sulla voce di destinazione nella barra degli strumenti Inserimento Note oppure usare la combinazione

Ctrl+Alt+1–4 (Mac: Cmd+Alt+1-4).

Nota: Perché uno spostamento note possa correttamente andare a buon fine, devono essere soddisfatte le seguenti
condizioni:

L'accordo nella voce di destinazione deve avere la stessa durata della nota che lì deve essere spostata.
In alternativa, se la voce di destinazione è occupata da una pausa, questa deve essere di durata sufficiente ad
accogliere la nota spostata.
Le note non devono essere tied (legate).

Navigare tra le voci

Per selezionare una nota in una voce di numero superiore a quella corrente:

1. Utilizzare Alt + ↓, per spostare la selezione verso la nota più bassa dell’accordo;
2. Premere Alt + ↓, per passare alla voce di numero superiore;
3. Ripetere uno qualsiasi dei passaggi precedenti, se necessario, fino a selezionare la nota desiderata.
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Per selezionare una nota in una voce di numero inferiore a quella corrente:

1. Utilizzare Alt + ↑, per spostare la selezione la nota più alta dell’accordo;
2. Premere Alt + ↑, per passare alla voce di numero inferiore.
3. Ripetere uno qualsiasi dei passaggi precedenti, se necessario, fino a selezionare la nota desiderata.

Vedi anche

Scorciatoie da tastiera: Voci
Teste delle note: Teste di note condivise

Collegamenti esterni

How to merge/combine/implode two staves in one with two voices  (MuseScore HowTo)
How to input multiple notes on a staff with different durations  (MuseScore HowTo)
Video tutorial: How To Write Two Parts On One Staff: Voices

Annulla e ripeti

MuseScore ricorda un numero illimitato di azioni Annulla/Ripeti.

Le scorciatoie standard sono:

Annulla Ctrl+Z (Mac: Cmd+Z)
Ripeti Ctrl+Maiusc+Z oppure Ctrl+Y (Mac: Cmd+Maiusc+Z)

Oppure utilizzare i pulsanti della barra degli strumenti:: 

Copia e Incolla

MuseScore supporta le operazioni standard di copia, taglia, incolla e scambio con appunti. Questi comandi possono
essere applicati a una serie di:

Note Musicali: e.g. per ripetere una sezione di musica, o spostare un passaggio o una battuta.
Altri elementi della partitura: come articolazioni, testo del pentagramma, dinamiche, diteggiatura, etc.

I comandi di copia/taglia/incolla/scambia sono accessibili in tre modi:

Dal menu Modifica (sopra la finestra del documento) (Mac: il menu MuseScore).
Dal menu visualizzato cliccando con il tasto destro del mouse su un elemento o una serie di elementi.
Usando una delle scorciatoie da tastiera. standard.

Sommario dei comandi

Comando Comb. tasti (Win) Comb. tasti (Mac) Menu-click destro Menu princ.
Taglia Ctrl+X Cmd+X Taglia Modifica → Taglia
Copia Ctrl+C Cmd+C Copia Modifica → Copia
Incolla Ctrl+V Cmd+V Incolla Modifica → Incolla
Scambia con
Appunti Ctrl+Shift+X Cmd+Shift+X

Scambia con
Appunti

Modifica → Scambia con
Appunti

Nota: Prima di eseguire una procedura di copia, taglio, incolla o scambio, accertarsi di essere in modalità Normale.
Premere il tastoEsc per portarsi in tale modalità.

Note

È possibile tagliare, copiare, incollare o scambiare note come segue:

Copiare o tagliare

Copiare/tagliare un singolo accordo

1. Premere Shift e cliccare su una nota nell’accordo.
2. Applicare una delle opzioni Copia o Taglia (vedere tabella precedente).

Copiare/tagliare un intervallo di accordi

1. Click sulla prima nota o battuta che si vuole selezionare.
2. Shift+Click sull'ultima nota o battuta che si vuole selezionare. Un rettangolo blu evidenzia la regione selezionata.
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3. Applicare una delle opzioni Copia o Taglia (vedere tabella precedente).

Incollare

1. Click sulla nota o battuta di destinazione.
2. Applicare una delle opzioni Incolla (vedere tabella precedente).

Scambio con Appunti

L’operazione di scambio con appunti combina due comandi in uno solo: (1) Dapprima sovrascrive una parte selezionata
della partitura con il contenuto degli appunti, proprio come il comando incolla; (2) In secondo luogo, trasferisce la parte
sovrascritta della partitura di nuovo negli appunti, proprio come il comando copia.

Può essere utilizzata, ad esempio, per scambiare due sezioni di uguale lunghezza di una partitura, A e B:

1. Selezionare la sezione A e applicare il comando taglia;
2. Deselezionare l’area tagliata (premendo Esc o cliccando su un'area vuota della finestra del documento);
3. Premere Shift e cliccare su una nota all’inizio della sezione B. Oppure, se B inizia con una battuta, si può anche

semplicemente selezionare la battuta;
4. Applicare l’opzione Scambia con Appunti (vedere tabella precedente).
5. La sezione B si trova ora negli appunti. Incollarla ora nell’area vuota della partitura lasciata con il passo "1."

Copiare solo l’altezza di una singola nota

È possibile copiare la sola altezza di una nota (e non le altre proprietà), cliccando sulla testa della nota e applicando copia
e incolla standard; la stessa operazione è inoltre eseguibile con la procedura Copia e Scambia con Appunti. L’altezza
della nota di destinazione cambia corrispondentemente a quella della nota copiata ma la sua durata rimane la stessa.

Altri elementi

Alcuni elementi come il testo del pentagramma, le dinamiche, le diteggiature, ecc. possono essere tagliati, copiati e
incollati solo uno alla volta. Tuttavia, altri elementi supportano Taglia/Copia/Incolla con "selezione multipla": come le
articolazioni (sforzato, staccato etc.), schemi tastiera (diagrammi accordi), e i simboli degli accordi.

Nota: Il comando Scambia con Appunti è destinato solo all’utilizzo con sezioni di musica e non con altri elementi della
partitura.

Copiare o tagliare

1. Selezionare l’elemento (o gli elementi).
2. Applicare una delle opzioni Copia o Taglia (vedere tabella precedente).

Incollare

1. Click sulla nota di inizio destinazione della selezione da incollare.
2. Applicare una delle opzioni Incolla (vedere tabella precedente).

Nel caso delle articolazioni, esse vengono incollate alle note di destinazione esattamente nello stesso ordine (continuo o
intermittente) in cui erano nella selezione iniziale.

Ripetizione rapida

Per copiare e incollare rapidamente una nota, una battuta o un passaggio:

1. Selezionare un accordo, una misura o un passaggio come descritto sopra.
2. Premere R .

MuseScore copia e incolla la notazione selezionata nel punto immediatamente dopo l'ultima nota della selezione.
Qualsiasi musica esistente nell'intervallo di destinazione viene sostituita.

Duplicare

Per copiare e incollare istantaneamente un elemento di testo, una linea o un altro oggetto:

1. Tenere premuti Ctrl+Shift (Mac: Cmd+Shift), cliccare sull'elemento e trascinarlo in qualsiasi punto dello spartito.
2. Rilasciando il pulsante del mouse, l'elemento selezionato viene clonato nella nuova posizione.

Incollare metà/doppia durata (versione 3.1 e superiori)

Questi comandi permettono di copiare/tagliare una sezione della partitura, poi incollarla di nuovo ovunque con tutte le
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durate delle note dimezzate o raddoppiate.

1. In modalità Normale, selezionare un intervallo di note nella partitura;
2. Tagliare o copiare l’intervallo;
3. Selezionare una nota di destinazione (o una battuta);
4. Dal menu, selezionare una delle seguenti opzioni:

Modifica→Incolla metà durata  (Mac: MuseScore→Incolla metà durata ).
Modifica→Incolla doppia durata  (Mac: MuseScore→Incolla doppia durata).

Filtro di selezione

Il Filtro selezione permette di scegliere esattamente quali voci ed elementi includere nella selezione.

Per visualizzare il Filtro selezione premere F6 (Mac: Fn+F6); oppure scegliere dal menu, Visualizza→Filtro selezione.

Il Filtro selezione appare di default sotto le Tavolozze. Per cambiare la posizione di visualizzazione, vedere
Visualizzazione e navigazione: Pannelli laterali.

Esempio: Supponiamo di voler copiare le battute 1 e 2 del seguente passaggio (vedi immagine), per ottenere le misure 3
e 4:

1. Assicurarsi che il Filtro di selezione sia visualizzato (vedi sopra);
2. Deselezionare le caselle "Articolazioni" e "Legature di portamento";
3. Copiare e incollare le battute desiderate (in questo esempio, 1-2 in 3-4).

Nota: Il Filtro selezione funziona anche con il comando Scambia con Appunti.

Vedere anche

Se si vogliono cambiare le note senza alterare il ritmo, si può combinare la modalità Modifica Altezze con Copia e Incolla.

Collegamenti esterni

Video tutorial: Lyrics, copying & dynamics

Modalità di selezione

Gli oggetti nella partitura - come note, battute, articolazioni ecc. - possono essere selezionati in diversi modi: (1) uno alla
volta, (2) come intervallo continuo, oppure (3) come lista.
La selezione viene invariabilmente usata prima di applicare comandi come cancella, copia/taglia e incolla, trasponi e così
via.

Selezionare un oggetto singolo

La maggior parte degli oggetti della partitura può essere selezionata semplicemente cliccando su di essi in modalità
Normale.

Selezionare una singola nota

In modalità Normale, cliccare sulla testa di una nota.

Nota: Selezionando una singola nota e poi copiandola e incollandola, si copierà e incollerà solo l'altezza, non la durata o
altre proprietà (come l'assenza di gambo). Per copiare l'intera nota, comprese tutte le proprietà, è necessario tenere
premuto Maiusc— come per la selezione degli accordi (sotto).
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Selezionare un accordo

In modalità Normale, tenere premuto Maiusc, poi cliccare sulla testa di una nota nell'accordo.

Selezionare una singola battuta

Clicca su uno spazio vuoto all'interno della battuta.

Nota: Per selezionare un intervallo di battute consecutive, vedere selezioni con Maiusc e selezioni con Maiusc + click
(sotto).

Selezionare un elemento sovrapposto

Per selezionare un elemento da un gruppo di elementi sovrapposti:

Premere Ctrl e cliccare fino a selezionare l'elemento desiderato.

Selezionare un intervallo continuo di oggetti

Ci sono diversi modi per selezionare un intervallo continuo di note, accordi o battute etc:

1. Selezione con Maiusc + click

Per selezionare un intervallo di note o pause:

1. Assicurarsi di essere in modalità Normale;
2. Cliccare sulla prima nota o pausa dell'intervallo;
3. Tenere premuto Maiusc, poi cliccare sull'ultima nota o pausa desiderata.

Nota: L’insieme da selezionare può trovarsi nello stesso pentagramma o in pentagrammi sopra o sotto la nota/pausa
iniziale. Tutti gli elementi selezionati saranno racchiusi in un rettangolo blu, comprese le linee e le articolazioni associate
(escluse le “volte”). Si può ripetere l'operazione per estendere l'intervallo selezionato come desiderato.

Selezionare i simboli degli accordi, i testi, ecc. (a partire dalla versione 3.5)

A partire da MuseScore 3.5, il metodo “Maiusc + click” è stato perfezionato per rendere più facile la selezione di una serie
continua di elementi come simboli di accordi, testi ecc. Per esempio:

1. Cliccare sul primo simbolo di accordo nell'intervallo desiderato.
2. Maiusc + cliccare sul simbolo dell'ultimo accordo dell'intervallo.

Risultato Vengono selezionati tutti i simboli degli accordi in quell'intervallo e nessun altro.

Selezionare un intervallo di battute

1. Cliccare su uno spazio vuoto nella prima battuta desiderata;
2. Tenere premuto Maiusc, poi cliccare su uno spazio nell'ultima battuta dell'intervallo desiderato.

Nota: Come per la selezione delle note, l’intervallo può essere esteso sia verticalmente che orizzontalmente.

2. Selezioni con Maiusc

1. Assicurarsi di essere in modalità Normale;
2. Selezionare il/la primo/a nota, accordo, pausa o battuta dell’intervallo. Si può estendere la selezione su o giù verso i

pentagrammi adiacenti, se necessario, utilizzando Maiusc+↑ o ↓;
3. Poi scegliere una delle seguenti opzioni:

Per far avanzare la selezione di un accordo alla volta verso destra: Premere Maiusc+→.
Per far avanzare la selezione di un accordo alla volta verso sinistra: Premere Maiusc+←.
Per far avanzare la selezione di una battuta alla volta verso destra: Premere Maiusc+Ctrl+→ (Mac:
Maiusc+Cmd+→).
Per far avanzare la selezione di una battuta alla volta verso sinistra: Premere Maiusc+Ctrl+← (Mac:
Maiusc+Cmd+←).
Per far avanzare la selezione all'inizio della linea di accollatura: Premere Maiusc+Home (Mac: Maiusc+Fn+←).
Per far avanzare la selezione alla fine della linea di accollatura: Premere Maiusc+End (Mac: Maiusc+Fn+→).
Per estendere la selezione fino all'inizio della partitura: Premere Maiusc+Ctrl+Home (Mac: Maiusc+Cmd+Fn+←).
Per estendere la selezione alla fine della partitura: Premere Maiusc+Ctrl+End (Mac: Maiusc+Cmd+Fn+→).

3. Selezione per trascinamento (Drag)

Questo metodo può essere usato per selezionare le note o le pause, o, indipendentemente, per selezionare simboli “non-
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nota” come punti di staccato, testi, etc:
* Tenere premuto Maiusc, quindi trascinare il cursore attraverso l’area desiderata.

4. Selezionare Tutto

Questo metodo seleziona l’intera partitura musicale, comprese le note, le pause e gli elementi associati. Utilizzare una
delle seguenti opzioni:

Premere Ctrl+A (Mac: Cmd+A).
Dalla barra dei menu, selezionare Modifica → Seleziona tutto.

5. Selezionare sezione

Questo metodo è usato per selezionare una sezione — ovvero una regione della partitura che inizia e/o finisce con una:
pausa di sezione :

1. Cliccare su uno spazio vuoto in una battuta nella sezione;
2. Dalla barra dei menu, selezionare Modifica → Selezione Sezione.

Nota: Vedere Copia e incolla: Filtro di selezione per disabilitare alcune tipologie di elementi dall'essere selezionati in un
intervallo di selezione.

Selezionare un elenco di oggetti

Per selezionare una lista (o un intervallo discontinuo) di elementi della partitura:

1. Cliccare sul primo elemento;
2. Tenere premuto Ctrl (Mac: Cmd) e cliccare successivamente sugli elementi aggiuntivi desiderati.

Nota: Questo metodo non può essere usato per selezionare le battute; per queste utilizzare invece selezione singola o di
intervallo.

Modificare una selezione esistente (a partire dalla versione 3.5)

È possibile usare il metodo Ctrl + click per “aggiungere a” o “sottrarre da” una selezione esistente. Per esempio:

1. Effettuare una selezione nello spartito usando uno dei metodi di cui sopra.
2. Per aggiungere alla selezione un ulteriore elemento, premere Ctrl e cliccare sull’elemento stesso. Ripetere per ogni

ulteriore elemento da aggiungere.
3. Per rimuovere un elemento già selezionato, premere Ctrl e cliccare sull’elemento stesso. Ripetere per ogni ulteriore

elemento da deselezionare.

Selezionare tutti gli elementi simili

Per selezionare tutti gli elementi di un tipo specifico (ad esempio, tutte le stanghette, tutti gli elementi di testo, tutti i segni
di staccato):

1. Selezionare un elemento;
2. Cliccare con il tasto destro del mouse e scegliete Seleziona…;
3. Sono disponibili diverse opzioni:

Tutti gli elementi simili: Seleziona tutti gli elementi nella partitura simili all'oggetto scelto.
Tutti gli elementi simili nel pentagramma: Seleziona tutti gli elementi nel pentagramma simili all'oggetto
scelto.
Tutti gli elementi simili nell’intervallo scelto: si applica solo se è stato prima selezionato un intervallo.
Seleziona tutti gli elementi nell'intervallo simili all'oggetto scelto.
Di più...: apre una finestra di dialogo che permette di scegliere più opzioni. Per esempio, se è stata selezionata
una testa di nota, la finestra di dialogo avrà un aspetto simile a questo:
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Seleziona
Stessa testa di nota: In questo esempio, saranno selezionate solo le teste di nota dello stesso gruppo; gruppo;
Stessa altezza: Verranno selezionate solo le teste di nota della stessa altezza;
Stessa corda: (solo tablature) seleziona i capotasti (fretmarks) sulla stessa corda.
Stesso tipo: Tutte le teste di nota (di qualsiasi gruppo) saranno selezionate;
Stessa durata: Verranno selezionate solo le teste di nota della stessa durata;
Stesso nome nota: Saranno selezionate le teste di note con lo stesso nome in tutte le ottave;
Stesso pentagramma: Saranno selezionate solo le note dello stesso pentagramma.
Nella selezione;
Stessa voce: Saranno selezionate tutte le note della stessa voce.
Stessa accollatura: Saranno selezionate tutte le note della stessa accollatura.
Stesso battito: Saranno selezionate le teste di note di pari movimento (o tempo) nelle battute della partitura.
Stessa battuta: Saranno selezionate tutte le note della stessa battuta nella partitura.
Azione
Sostituisci selezione: Opzione predefinita: avvia la selezione da capo;
Aggiungi alla selezione: Mantiene tutto ciò che è già stato selezionato e vi aggiunge la selezione attuale;
Cerca nella selezione;
Sottrai alla selezione: toglie la selezione corrente e quanto era stato in precedenza selezionato.

Le selezioni utili per:

Copia e incolla
modalità Modifica
Ispettore e proprietà dell'oggetto
Attrezzi

Vedere anche

capitolo Nozioni di base, esp. Inserimento note
capitolo Notazione, esp. Accidenti
capitolo Testo, esp. Editore di testo e Movimento basato sulla griglia di simboli e testo di pentagramma

Visualizzazione e navigazione

Questo capitolo descrive le opzioni disponibili nel menu Visualizza, e nei menu Zoom e Vista Pagina/Vista
Continua/Singola Pagina (situati nella barra degli strumenti sopra lo spartito). Descrive inoltre in dettaglio i vari comandi
e funzioni di navigazione.

Menu Visualizza

Mostra barre laterali/pannelli
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Tavolozze: F9
Tavolozza generale: Shift+F9 (Mac: Fn+Shift+F9)
Ispettore: F8 (Mac: Fn+F8)
Controlli riproduzione: F11 (Mac: Fn+F11)
Navigatore
Successione cronologica: F12
Mixer: F10 (Mac: Fn+F10)
Sintetizzatore
Filtro selezione: F6 (Mac: Fn+F6)
Tastiera pianoforte: P
Strumento di confronto partiture

Zoom avanti/indietro

Ci sono diversi modi per ingrandire o ridurre la partitura:

Scorciatoie da tastiera:

Zoom Avanti: Ctrl++ (Mac: Cmd ++)
Zoom Indietro: Ctrl +- (Mac: Cmd +-).

menu Visualizza:

Zoom Avanti: Visualizza→Zoom avanti
Zoom Indietro: Visualizza→Zoom indietro.

Mouse

Zoom Avanti: Scorrere verso l'alto con la rotella del mouse tenendo premuto Ctrl (Mac: Cmd)
Zoom Indietro: Scorrere verso il basso con la rotella del mouse tenendo premuto Ctrl (Mac: Cmd).

Menu a discesa: Per impostare uno zoom specifico, utilizzare il menu a tendina nella barra degli strumenti standard
per impostare l'ingrandimento della vista dello spartito (25-1600 %) o visualizzarlo usando le opzioni "Larghezza
pagina", "Pagina intera" o "Due pagine".

Se nel campo a discesa se il livello di zoom desiderato non è disponibile di default, è possibile digitare una % di
zoom personalizzata.

Per tornare allo zoom del 100%: Utilizzare la combinazione scorciatoia Ctrl+0 (Mac: Cmd+0).

Barra degli strumenti

L’area della Barra degli strumenti si trova fra la Barra del Menu e la finestra del documento.

Contiene le seguenti barre degli strumenti:

Operazioni su file: Crea nuova partitura, Carica partitura da file, Salva la partitura nel file, Stampa partitura/parte,
Annulla utima modifica, Ripristina l’ultimo Annulla.
Zoom/Visualizzazione di pagina.
Controlli di riproduzione: Attiva/Disattiva ingresso MIDI, Riavvolgi alla posizione iniziale, Inizia/Ferma la
riproduzione, Attiva/Disattiva riproduzione ciclica, Riproduci le ripetizioni, Segui la partitura automaticamente, Attiva
Metronomo durante la ripetizione.
Partitura in DO: Visualizza la partitura in tonalità scritta o da esecuzione per gli strumenti traspositori.
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Cattura Immagine: Permette di scattare una istantanea di una parte dello spartito.
Inserimento Note: modalità Inserimento Note, Durata, Legatura di valore, Pause, Accidenti, Inversione direzione
gambi note, Voce (1, 2, 3, 4).

Mostrare/nascondere barre degli strumenti

Per mostrare o nascondere alcune barre degli strumenti:

Selezionare Visualizza→Barre degli strumenti, e spuntare/deselezionare le opzioni desiderate.
In alternativa, cliccare con il tasto destro del mouse su uno spazio vuoto nell'area della barra degli strumenti, o sulla
barra del titolo dell'Ispettore, e, dal menu, selezionare o deselezionare le opzioni richieste.

Nota: Questa opzione permette inoltre di mostrare o nascondere la Successione cronologica, lo Strumento di confronto
delle partiture, Tavolozze, Ispettore, la tastiera del pianoforte, il Mixer.

Personalizzare l'area della barra degli strumenti

Selezionare Visualizza→Barra degli strumenti, e cliccare su "Personalizza barre degli strumenti"

La finestra di dialogo mostra a sinistra le barre degli strumenti che possono essere personalizzate, al centro i pulsanti
degli strumenti correnti per la barra degli strumenti selezionata e, a destra, i pulsanti che possono essere aggiunti. Una
volta selezionata la barra degli strumenti da modificare nel pannello di sinistra, è possibile fare una delle seguenti azioni:

Rimovere un pulsante strumenti: Selezionare il pulsante nel pannello centrale e premere →.
Aggiungere un pulsante strumenti: Selezionare il pulsante nel pannello a destra e premere ←.
Spostare un pulsante strumenti: Selezionare il pulsante nel pannello centrale e spostarlo in alto o in basso usando
↑ oppure ↓.

Nota: la barra degli strumenti non può essere personalizzata a meno che non sia selezionato uno spazio di lavoro
personalizzato (vedi sotto).

Area di lavoro

Selezionare questa opzione per creare un’area di lavoro personalizzata o per modificare un’area di lavoro esistente.

Visualizza barra di stato

La Barra di stato, situata nella parte inferiore dello schermo, fornisce informazioni sugli elementi selezionati della
partitura. Spuntare/deselezionare questa opzione per visualizzarla o nasconderla.

Documenti affiancati

È possibile dividere la visualizzazione del documento in modo da visualizzare due documenti contemporaneamente o due
parti diverse dello stesso documento. Le schede permettono di scegliere quale documento visualizzare in ogni vista. È
possibile trascinare il confine che separa le due partiture per regolare la quantità di spazio nella finestra dedicata a
ciascuna:

Documenti affiancati: Divide la finestra verticalmente in due viste di partitura.
Documenti Sovrapposti: Divide la finestra orizzontalmente in due viste di partitura, una sopra l'altra.
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Mostra elementi invisibili

Questa sezione permette di visualizzare o nascondere vari elementi non stampabili:

Mostra elementi invisibili: Visualizza/nasconde gli elementi che sono stati resi invisibili per la stampa e
l’esportazione. Se questa opzione è spuntata, gli elementi invisibili sono mostrati nella finestra della partitura in grigio
chiaro.
Mostra elementi non stampabili: Mostra/nasconde interruzioni e simboli di spaziatura.
Mostra i bordi delle cornici: Mostra/nasconde i contorni tratteggiati delle cornici.
Mostra margini di pagina: Mostra/nasconde i Margini di pagina.

Segna battute irregolari

Un trattino in alto a destra di una battuta indica che la sua durata differisce da quella stabilita dall'indicazione del tempo
(metronomo).

Schermo intero

La modalità Schermo intero espande MuseScore al fine di riempire la schermata in modo che più contenuto possibile sia
visibile.

Visualizzazione di Pagina/Continua/Singola pagina

Si può passare da una vista all'altra dello spartito usando l'elenco a discesa nell'area della barra degli strumenti:

Per scorrere la partitura

Verticalmente: Spostare la rotella del mouse verso l'alto o verso il basso.
Orizzontalmente: Premere Shift e spostare la rotella del mouse verso l'alto o verso il basso.

Visualizzazione di Pagina

In Vista Pagina, la partitura è formattata come apparirà quando verrà stampata o esportata come file PDF o immagine:
cioè, pagina per pagina, con i margini. MuseScore applica automaticamente le interruzioni di sistema (riga) e di pagina,
secondo le impostazioni presenti in Impostazioni pagina… e Stile. In aggiunta, possono essere applicate ulteriori
interruzioni di sistema (linea), di pagina o di sezione personalizzate (in funzione del risultato grafico che si vuole ottenere).

Per scegliere tra scorrimento orizzontale o verticale, vedere Preferenze MuseScore, Area di visualizzazione, Scorri le
pagine.

Visualizzazione continua

In Visualizzazione continua, la partitura viene mostrata come un sistema ininterrotto. Anche se il punto di partenza non è
in vista, i numeri di misura, i nomi degli strumenti, le chiavi, il tempo e le firme delle chiavi saranno sempre visualizzati
sulla sinistra della finestra.

Nota: Poiché il layout è più semplice, MuseScore può essere più veloce in Visualizzazione Continua che in Visualizz.
Pagina.

Singola pagina

In Vista Singola Pagina lo spartito viene mostrato come una singola pagina con un'intestazione ma senza margini, e con
un'altezza di pagina infinita. Le interruzioni di sistema (di riga) sono aggiunte automaticamente, secondo le impostazioni
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presenti in Impostazioni pagina… e Stile. In aggiunta, possono essere applicate ulteriori interruzioni di sistema (linea), di
pagina o di sezione personalizzate (in funzione del risultato grafico che si vuole ottenere).

Pannelli laterali

Aree di lavoro, Ispettore e Filtro selezione sono convenientemente visualizzati come pannelli laterali a sinistra e a
destra della finestra di partitura. Per sganciare un pannello laterale usare uno dei seguenti metodi:

Trascinare il pannello;
Cliccare sulla doppia cuspide nella parte superiore del pannello;
Doppio clic nell'area del titolo nella parte superiore del pannello.

Per agganciare un pannello utilizzare una delle seguenti procedure:

Trascinare il pannello in cima/in fondo a un pannello laterale esistente e si impilerà verticalmente sopra/sotto quel
pannello.
Trascinare il pannello al centro di un pannello laterale esistente e si sovrapporrà a quel pannello. Entrambi i pannelli
sono poi accessibili tramite schede.

In alternativa, un doppio clic sulla barra del titolo del pannello lo riporta alla sua posizione precedentemente agganciata.

Navigazione

Comandi

Sono disponibili vari comandi per rendere più semplice la navigazione nello spartito. Sono elencati sotto Scorciatoie
tastiera: Navigazione.

Navigatore

Navigatore è un pannello opzionale che visualizza le miniature delle pagine dello spartito in basso o a destra della
finestra del documento.

Per visualizzare o nascondere il Navigatore, selezionare Visualizza→Navigatore; oppure creare/usare una scorciatoia
personalizzata.

Il Navigatore appare in fondo alla finestra del documento se si scorrono le pagine orizzontalmente; o a destra se si
scorrono le pagine verticalmente. (vedere Preferenze: Area di visualizzazione).

Il riquadro blu rappresenta l'area della partitura che è attualmente visibile nella finestra del documento: trascinare il
riquadro, o cliccare direttamente sul pannello di navigazione per portare in vista un'altra parte della partitura. È possibile
anche trascinare la barra di scorrimento.

Successione cronologica

Il pannello Successione cronologica fornisce una panoramica dettagliata della partitura, con maggiori possibilità di
navigazione e interazione.

Per visualizzare la Successione cronologica, premere F12; oppure selezionare Visualizza→Successione cronologica.

Per i dettagli vedere Successione cronologica.

Trovare / Andare a

La funzione Trova / Vai a permette di navigare velocemente verso una battuta specifica, un numero di chiamata o un
numero di pagina nella partitura:

1. Premere Ctrl+F (Mac: Cmd+F), oppure selezionare Modifica→Trova / Vai a . Questo apre la barra Trova (o Vai a) nella
parte inferiore dell’area di lavoro.

2. Utilizzare una delle seguenti opzioni:
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Per andare a una specifica battuta: inserire il numero della battuta (contando ogni battuta, a partire da 1,
indipendentemente dalle battute in levare, dalle interruzioni di sezione o dalle modifiche manuali agli offset del
numero di battuta).
Per andare ad una specifica pagina: inserire il numero di pagina usando il formato pXX (dove XX è il
numero di pagina).
Per andare ad uno specifico numero di chiamata: inserire il numero usando il formato rXX (dove XX è il
nome del numero di chiamata).
Per andare ad un numero di chiamata che inizia con una lettera: inserire il nome del numero di chiamata
(la ricerca è insensibile alle maiuscole).

N.B.: È meglio evitare di nominare i segni di prova con le singole lettere "R", "r", "P", "p", o una di queste lettere con
un numero intero (per esempio "R1" o "p3"), poiché questo può confondere l'algoritmo di ricerca.

Vedere anche

Salva/Esporta/Stampa
Formato File
Layout e formattazione

Partitura in DO

Nel caso di partiture con strumenti traspositori è possibile scegliere di visualizzarne le relative parti sia in tonalità scritta
che in tonalità da concerto (trasposta). La tonalità da concerto mostra la partitura come dovrebbe apparire quando viene
stampata per essere letta dai musicisti. Tuttavia, durante la preparazione potrebbe essere più comodo vedere gli
strumenti trasposti annotati come suonano, senza trasposizione. In questo caso basta selezionare l'opzione "Partitura in
DO".

Per alternare la visualizzazione dello spartito tra la tonalità scritta e quella da concerto:

Premere il pulsante Partitura in DO (situato in alto a destra nell'area della barra degli strumenti). Quando questo
pulsante è evidenziato gli spartiti degli strumenti traspositori appariranno in tonalità scritta.

Prima di stampare la partitura, esportarla in PDF o salvarla online, assicurarsi che il pulsante Partitura in DO sia off (non
evidenziato), e che le singole parti siano trasposte correttamente.

Vedere anche

Trasposizione: strumenti traspositori
Sostituzione enarmonica delle alterazioni

External links

Concert pitch  (Wikipedia article)
Transposing Instrument  (Wikipedia article)
Concert pitch or not?  (MuseScore forum discussion)

Apri/Salva/Esporta/Stampa

Nel menù File si trovano le opzioni per aprire, salvare, esportare e stampare i propri file:
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Aprire

Oltre ai file in formato nativo (*.mscz and *.mscx), MuseScore può aprire anche file MusicXML, MusicXML compressi e
MIDI , così come una varietà di file in altri formati.

Per aprire qualsiasi file supportato:

1. Scegliere una delle seguesti opzioni:
Premere Ctrl+O.
Cliccare sull’icona "Carica partitura da file" situata sul lato sinistro dell'area della barra degli strumenti.
Dalla barra dei menù, selezionare File→Apri.

2. Selezionare un file e cliccare Apri; oppure semplicemente fare doppio click sul nome del file.

Apri Recenti permette di scegliere da una lista di spartiti aperti di recente.

Salvare

Salva, Salva Come…, Salva una copia… e Salva selezione… servono per il salvataggio dei file MuseScore nativi
(.mscz and .mscx).

Salva: Salva la partitura corrente nel file in uso.
Salva Come...: Salva la partitura corrente su un nuovo file.
Salva una copia...: Salva la partitura corrente su un nuovo file, ma continua ad utilizzar il file originale.
Salva selezione...: Salva le battute selezionate su un nuovo file.
Salva online...: Permette di salvare e condividere le proprie partiture sul sito web MuseScore.com . Per dettagli,
vedere Condividi partiture online.

Esportare

Esporta... permette di creare file non-MuseScore, come PDF, MusicXML, MIDI, e vari formati audio e immagine. Nella
finestra di dialogo Esporta puoi scegliere in quale formato esportare.

Esporta...: Esporta la partitura corrente nel formato scelto prima.

MuseScore memorizza quale formato è stato scelto l'ultima volta e lo rende predefinito per la volta successiva.

Stampare

Stampa... permette di stampare il file MuseScore direttamente su una stampante. A seconda della stampante saranno
disponibili diverse opzioni, tra le quali, generalmente, la definizione dell'intervallo di pagine, il numero di copie e la
fascicolazione.

Se sul computer è installata una stampante PDF, si potrebbe anche "esportare" in PDF usando Stampa; di solito però è
meglio usare l'opzione PDF nativo in Esportazione in quanto la resa è più accurata. Nota: perché questo funzioni
correttamente con Adobe PDF, assicurarsi di deselezionare "Affidati solo ai font di sistema, non usare i font del
documento" nelle proprietà della stampante.
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Vedere anche

Formato dei file
Estrazione delle parti

Share scores online

Musescore.com  allows you to:

View and listen to scores from a large repository created by the MuseScore community.
Download any score in a variety of formats—MuseScore, MusicXML, PDF, MIDI, MP3.
Upload your own scores: control whether to share them publicly or privately (via a secret link).
Synchronize your score with a YouTube video ("Videoscores").

Note: A MuseScore Pro account is required for all scores not marked as PD (Public Domain) or "Original" work, the latter
must also have the approval of the score owner.

Create an account

1. Visit MuseScore.com  and click on "Create new account ". Pick a username and enter a valid email and press
"Create New Account".

2. Wait a few minutes for an email from MuseScore.com support. If no email arrives, check your spam folder.
3. Click the link in the email and visit your user profile  to change your password.

Share a score directly from MuseScore

To save a score online:

1. Make sure that the Concert Pitch button is off, and that the individual parts are correctly transposed.

2. From the menu, select File→Save Online.... The "Log in to MuseScore" dialog will appear:

3. Enter your email address or MuseScore username, and password, then click OK. Note: If you don't have a
MuseScore account yet, create one first by clicking on the "Create an account" link. That will open your browser app
and bring you to musescore.com/user/register .

4. Upon successfully logging in, you'll be able to enter your score information.
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Title: The title of the score.
Description: The descriptive text that will appear next to it.
Make the score private: If ticked, the score can only be viewed via a private link. If unticked, the score is
visible to all.
License: Choose an appropriate copyright license from the drop-down list. Note: Creative Commons
license , allows people to use your scores under certain restrictions.
Tags: You can add tags to help identify scores on MuseScore.com. Use commas to separate multiple tags.

5. If the score already exists online, it will be updated automatically—you can add additional information in the
changelog section of the dialog if required. This can retrieved on MuseScore.com under "Revision history" for that
score. Uncheck Update the existing score to save online as a new score.

6. If you are using a different SoundFont than the default one and if you are able to export MP3 files (may not be the
case on some Linux versions), a checkbox Upload score audio will be visible:

If the checkbox is checked, MuseScore will render the audio of the score using the current synthesizer settings and
upload the audio to MuseScore.com.

Upload a score on MuseScore.com

You can also upload a score MuseScore.com itself:

1. Click the Upload link  on MuseScore.com.
2. You have the same options as with the Save Online menu.
3. You also have access to more information, such as Genre.

Edit a score on MuseScore.com

If you want to make changes to one of your scores on MuseScore.com, edit the MuseScore file on your own computer,
save it, and then do the following:
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If you originally shared the score directly from within MuseScore, simply go to File→Save Online... again to update the
online score.
If you originally uploaded the score via the Upload page  on MuseScore.com, then you must follow these steps to
update the online score:

1. Go to the score page on MuseScore.com.
2. Click the three dots menu ⋮ on the right and choose "Update this score".
3. In the form, you can upload a replacement score file as well as change the accompanying information and

privacy settings.

Switch to the direct method of updating an online score

It is much more convenient to update online scores from directly within MuseScore than by updating the score manually
from the score page. Follow these steps if you originally uploaded the score via the Upload page  and now want to
switch to the direct method:

1. Go to the score page on MuseScore.com and copy the URL.
2. Open the score file on your computer with MuseScore.
3. From the menu, select File→Score Properties... and paste the URL into the "Source" field.

Now whenever you want to update the online score simply go to File→Save Online....

External links

How to delete a score saved on MuseScore.com  (MuseScore HowTo)
Score download becomes a part of the Pro subscription
Download becomes a part of the Pro subscription

Notazione
In the previous →"Basics" chapter you learned how to enter notes and interact with the palettes. The "Notation" chapter
describes the different types of notation in more detail, including more advanced music notation.

See also →"Advanced topics".

Armature di chiave

Le armature di chiave standard sono disponibili nella tavolozza Armature di chiave delle aree di lavoro Base o Avanzata.
È comunque possibile creare armature di chiave personalizzate (più avanti).

Aggiungere una nuova armatura di chiave

Aggiungere una nuova armatura di chiave a tutti i righi

Utilizzare uno dei seguenti metodi:

Trascinare una armatura di chiave dalla tavolozza a una parte vuota della battuta.
Selezionare una battuta e cliccare su una armatura di chiave nella tavolozza (doppio clic nelle versioni precedenti
alla 3.4)).
Selezionare una nota e cliccare su una armatura di chiave nella tavolozza (doppio clic nelle versioni precedenti alla
3.4)).

Aggiungere una nuova armatura di chiave a un solo rigo

Nel caso si debba cambiare l’armatura di chiave di una solo rigo, lasciando le altre invariate:

Premere Ctrl (Mac: Cmd) e tenere premuto mentre si trascina un’altra armatura di chiave dalla tavolozza alla battuta
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interessata.

Sostituire una armatura di chiave esistente

Sostituire una armatura di chiave esistente per tutti i righi

Utilizzare uno dei seguenti metodi:

Trascinare una armatura di chiave dalla tavolozza sull’armatura di chiave da sostituire (o sulla battuta che contiene
l’armatura da sostituire).
Selezionare l’armatura di chiave da sostituire e cliccare una nuova armatura di chiave dalla tavolozza (doppio clic
nelle versioni precedenti alla 3.4).

Sostituire una armatura di chiave esistente per un solo rigo

Nel caso si voglia sostituire l’armatura di chiave di un solo rigo, lasciando invariate le altre:

Premere Ctrl (Mac: Cmd) e tenere premuto mentre si trascina un’armatura di chiave dalla tavolozza all’armatura da
sostituire (o su una battuta che la contiene).

Rimuovere una armatura di chiave

Utilizzare uno dei seguenti metodi:

Cliccare su una armatura di chiave esistente e premere Canc.
Trascinare l’armatura di chiave vuota ("aperta/atonale", senza alterazioni) dalla tavolozza (nell'area di lavoro
avanzata) sulla battuta.

Bequadro sui cambi di armatura di chiave

Per impostazione predefinita, MuseScore mostra le rimozioni di alterazione (bequadro) solo quando la tonalità cambia in
C Maggiore/A minore (senza diesis o bemolle). In tutti gli altri casi, mostra semplicemente la nuova tonalità senza simboli
di bequadro sulle alterazioni rimosse:

Tuttavia, si può scegliere di visualizzare i simboli di bequadro sulle alterazioni rimosse per tutti i cambi di tonalità:

1. Dal menù, selezionare Formato → Stile → Accidenti. Appariranno le seguenti opzioni:

2. Selezionare una delle tre opzioni.

3. Se si sta modificando una parte e si vuole che la nuova scelta venga applicata a tutte le parti, cliccare sul pulsante
Applica a tutte le parti.

4. Cliccare OK per uscire.

Per esempio, selezionando l’opzione "Prima dell’armatura di chiave se cambia a un minor numero di diesis o
bemolli" si ottiene:

Con l’opzione "Dopo l’armatura di chiave se cambia a un minor numero di diesis o bemolli. Prima se cambia tra
diesis e bemolle" si ottiene:
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Cambi armatura di chiave e battute di aspetto

Le Battute d’aspetto vengono interrotte in caso di cambio armatura di chiave:

Armature di chiave di cortesia

Per disattivare la visualizzazione di una particolare armatura di chiave di cortesia:

Selezionare l’armatura di chiave rilevante pertinente e deselezionare "Mostra cortesia" nella sezione "Tonalità
(armatura di chiave)" dell’Ispettore.

Per disattivare la visualizzazione di tutte le armature di chiave di cortesia:

Dal menù, selezionare Formato → Stile → Pagina, e deselezionare "Crea armatura di chiave di cortesia".

Nota: Le armature di chiave di cortesia non vengono visualizzate alle interruzioni di sezione.

Armature di chiave personalizzate

Per creare una armatura di chiave personalizzata:

1. Premere Shift+K per visualizzare la sezione Armature di chiave nella Tavolozza generale.

2. Nel pannello Crea armatura di chiave, per ottenere la nuova armatura desiderata trascinare gli accidenti necessari
dalla tavolozza al rigo situato al di sopra. Nota: La chiave di violino è solo decorativa; qui si possono creare
armature di chiave personalizzate per qualsiasi tipo di rigo.

3. Utilizzare il pulsante Pulisci, se necessario, per rimuovere tutti gli accidenti dal "rigo".
4. Per aggiungere la nuova armatura di chiave alla libreria (pannello al centro), premere Aggiungi. Per cancellare

un’armatura di chiave dalla libreria, cliccarla con il tasto destro del mouse (Mac: Ctrl-click) e, nel menù a discesa,
selezionare Cancella.

Nota: Un limite delle armature di chiave personalizzate è che non possono essere trasposte nel modo usuale. Se è
necessaria una trasposizione, o se c'è un cambio di chiave, dovrà essere creata una nuova armatura di chiave
personalizzata.

Per spostare una armatura di chiave dalla tavolozza generale a una tavolozza personalizzata :

Trascinare e rilasciare l’armatura di chiave sulla tavolozza.
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Per applicare una armatura di chiave alla partitura direttamente dalla tavolozza generale, usare uno dei seguenti metodi:

Selezionare una battuta e cliccare su una armatura di chiave nella tavolozza generale (doppio clic nelle versioni
precedenti alla 3.4).
Trascinare una armatura di chiave dalla tavolozza generale su una misura; in alternativa, per applicarla ad un solo
rigo, tenere premuto Ctrl (Mac: Cmd) mentre la si trascina.

Chiavi

Le Chiavi usate più comunemente (Violino, Basso, Alto, Tenore) si trovano nella tavolozza Chiavi dell’area di lavoro
Base. Per una gamma più completa, vedere la tavolozza Chiavi nell'area di lavoro Avanzata (immagine sotto riportata).

Aggiungere una chiave

Aggiungere/cambiare la chiave all'inizio di una battuta

Selezionare una battuta e cliccare su un simbolo di chiave nella tavolozza (doppio clic nelle versioni precedenti alla
3.4).
Trascinare una chiave dalla tavolozza alla battuta di destinazione.
Selezionare una chiave esistente e cliccare su una chiave nella tavolozza (doppio clic nelle versioni precedenti alla
3.4).
Trascinare una nuova chiave dalla tavolozza a una chiave esistente.

Aggiungere/cambiare una chiave intermedia in una battuta

Cliccare sulla nota da cui inizia il cambio di chiave, quindi cliccare sulla nuova chiave nella tavolozza (doppio clic
nelle versioni precedenti alla 3.4).
Se una chiave intermedia è già presente nella misura si può anche:

Selezionarla e cliccare su una chiave nella tavolozza (doppio clic nelle versioni precedenti alla 3.4).
Trascinare una nuova chiave dalla tavolozza alla chiave da sostituire.

Nota: Le chiavi "intermedie" sono sempre più piccole della chiave di sistema principale.

Esempio: Nell'immagine seguente, il pentagramma superiore inizia con una chiave di violino e passa immediatamente
alla chiave di basso, poi dopo una nota e una pausa, cambia di nuovo in chiave di violino.

Nota: Il cambio di una chiave non modifica l'altezza di nessuna nota; sono invece le note che si spostano per preservare
l'intonazione. Se necessario, congiuntamente al cambio chiave è possibile usare le Trasposizione.

Rimuovere una chiave

Selezionare la chiave e premere Del.

Chiavi “di cortesia”

Quando un cambio di chiave si verifica all’inizio di una accollatura, al termine dell’accollatura precedente sarà
automaticamente generata una chiave di cortesia.
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Per mostrare o nascondere tutte le chiavi di cortesia:

1. Dal menu, selezionare Formato→Stile→Pagina;
2. Spuntare/Deselezionare "Crea chiave di cortesia".

È inoltre possibile mostrare/nascondere le chiavi di cortesia caso per caso:

1. "Crea chiave di cortesia" nel menu “Generale” dovrebbe essere già spuntato (vedere sopra);
2. Selezionare una chiave e spuntare/deselezionare "Mostra cortesia" nell’Elemento Chiave dell’Ispettore.

Nascondere le chiavi

Visualizzare la chiave solo nella prima battuta (per tutti i pentagrammi)

1. Dal menu, selezionare Formato→Stile→ Pagina;
2. Deselezionare "Crea chiave per tutte le accollature."

Visualizzare la chiave solo nella prima battuta (per pentagrammi particolari)

1. Cliccare con il tasto destro del mouse sul pentagramma (Mac: Ctrl-clic), selezionare Proprietà Pentagramma/Parte e
deselezionare "Mostra chiave";

2. Aprire la tavolozza principale e selezionare la sezione "Simboli";
3. Trascinare e rilasciare una chiave dalla palette principale sulla prima misura del pentagramma; OPPURE

selezionare la prima nota e cliccare su una chiave nella palette principale (doppio clic nelle versioni precedenti alla
3.4).

Note: Questa opzione può essere utile per gli utenti TAB che non vogliono che la chiave di violino si ripeta su ogni riga
successiva.

Nascondere tutte le chiavi in un pentagramma particolare

1. Cliccare con il tasto destro del mouse sul pentagramma (Mac: Ctrl-clic), e selezionare Proprietà Pentagramma/Parte ;
2. Deselezionare "Mostra chiave".

Stanghette

Nella tavolozza Stanghette è disponibile una gamma di simboli di stanghette divisorie sufficienti per la maggior parte degli
scopi ordinari (area di lavoro Base); solo le stanghette di ritornello sono disponibili anche nella tavolozza Salti e
Ripetizioni (sia in area Base che Avanzata). Ulteriori simboli sono disponibili nella tavolozza Stanghette dell’area di
lavoro Avanzata. È inoltre possibile creare le proprie stanghette personalizzate (vedere sotto).

Cambiare il tipo di stanghetta

Per cambiare una stanghetta esistente, usate una delle seguenti opzioni:

Selezionare la stanghetta, o la battuta, nella partitura, poi cliccare un’icona nella tavolozza Stanghette (doppio-click
in versioni precedenti la 3.4).
Trascinare un'icona dalla tavolozza Stanghette su una stanghetta, o una battuta, nella partitura.
Selezionare una stanghetta esistente nella partitura, poi regolare "Stile" nella sezione "Stanghetta" dell'Ispettore.

Per cambiare una stanghetta “non singola” (doppia, ritornello, ecc) in singola:

Selezionarla e premere Del.

Per nascondere una stanghetta:

Selezionarne la linea e premere V, oppure deselezionare Visibile nella sezione “Elemento” dell’Ispettore.

Inserire una stanghetta

Per inserire una nuova stanghetta tra due esistenti utilizzare una delle due seguenti possibilità:
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Trascinare un'icona dalla tavolozza Stanghette su una nota o una pausa.
Selezionare una nota o una pausa, poi cliccare su un'icona nella tavolozza Stanghette (doppio clic nelle versioni
precedenti alla 3.4)

Dividere una battuta

È possibile inserire una stanghetta per dividere una battuta in due separate. Usare uno dei seguenti metodi:

Premere Ctrl (Mac Cmd) e trascinare la relativa linea dalla tavolozza Stanghette alla prima nota della nuova battuta.
Selezionare la prima nota della nuova battuta e premere Ctrl (Mac Cmd) mentre si clicca su una stanghetta della
relativa tavolozza (doppio clic nelle versioni precedenti alla 3.4).

Nota: A partire dalla versione 3.1 (o precedente), tutte le stanghette aggiunte in questo modo vengono inserite come
Normali. Vedere anche Dividere una battuta.

Stanghette personalizzate

È possibile creare stanghette personalizzate selezionandone una o più e regolandone le proprietà nella sezione
"Stanghetta" dell’Ispettore:

Stile: Scegliere tra la gamma di stanghette preimpostate.
Estendi al rigo successivo: Unisce la stanghetta selezionata alla corrispondente del rigo sottostante.
Estendi da: Fissa la posizione superiore della stanghetta (N.d.T: con riferimento alle linee di un Rigo pentagramma).
"0" è il rigo superiore. I numeri positivi identificano i righi più sotto, quelli negativi i righi più sopra.
Estendi a: Fissa la posizione inferiore della stanghetta. (N.d.T: con riferimento alle linee di un Rigo pentagramma
"0" qui è il rigo inferiore). (vedere "Estendi da").
Impostare scelte predefinito: Utilizzare i pulsanti per applicare le stanghette personalizzate preimpostate.

Vedere anche Mensurstrich.

Tramite l’Ispettore possono essere apportate anche modifiche al colore e al posizionamento orizzontale/verticale.

Collegare le stanghette

Le stanghette possono estendersi su più righi , come nel “Rigo di Pianoforte", o in una partitura orchestrale per unire
strumenti appartenenti alla stessa sezione. Per unire le linee di battuta:

1. Entrare in modalità Modifica su una stanghetta.

2. Cliccare sulla maniglia blu inferiore e trascinarla verso il rigo a cui si vuole collegarla. La maniglia scatta
automaticamente in posizione e quindi non c'è bisogno di posizionarla esattamente.

3. Premere Esc per uscire dalla modalità modifica.Verranno aggiornate anche tutte le altre stanghette pertinenti.

Vedere anche

Operazioni sulle battute
Salti e Ripetizioni per dettagli sulle stanghette di ripetizioni-ritornelli
Aggiungere una corona a una stanghetta di battuta

Alterazioni (o Accidenti )

I più comuni tipi di alterazioni sono disponibili nella barra degli strumenti Alterazioni sopra la partitura e nella tavolozza
Alterazioni nell’area di lavoro di base.
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Una gamma più completa può essere trovata nella tavolozza Alterazioni nell'area di lavoro avanzata.

Aggiungere una alterazione

Le Alterazioni vengono aggiunte automaticamente a una nota, in modo appropriato, quando si aumenta o si diminuisce
la sua altezza:
* ↑: Accresce l’altezza di una nota di un semitono (favorisce i diesis).
* ↓: Diminuisce l'altezza di una nota di un semitono (favorisce i bemolle).

Per aggiungere (i) un doppio bemolle o un doppio diesis, (ii) una “alterazione di cortesia” (nota anche come alterazione
precauzionale o promemoria) o (iii) una alterazione non-standard, usare una delle seguenti opzioni:

Selezionare una nota e cliccare su una alterazione nella barra degli strumenti sopra la partitura.
Selezionare una nota e cliccare su una alterazione nella tavolozza Alterazioni (doppio clic nelle versioni precedenti
alla 3.4).
Trascinare una alterazione dalla tavolozza Alterazioni alla nota interessata.

Se si volessero aggiungere parentesi ad una alterazione precauzionale, utilizzare una delle seguenti possibilità:

Selezionare l'alterazione nella partitura e cliccare sul simbolo delle parentesi nella tavolozza Alterazioni (doppio clic
nelle versioni precedenti alla 3.4).
Trascinare il simbolo delle parentesi dalla tavolozza sull'alterazione.
Selezionare l’alterazione e scegliere il Tipo di parentesi dal menu a tendina nell’Ispettore.

Se necessario, le alterazioni possono essere cancellati cliccando su di esse e premendo Canc.

Cambiare la notazione enarmonica

Per cambiare la notazione enarmonica di una nota, o di più note, sia nella tonalità scritta che in quella trasposta (N.d.T.:
vedere Partitura in Do per migliore comprensione dell'argomento):

1. Selezionare una note, o un gruppo di note;
2. Premere J;
3. Continuare a premere J per passare alle notazioni enarmoniche equivalenti.

Per cambiare la notazione enarmonica nella vista dell'altezza scritta, senza influenzare la vista dell'altezza trasposta, o
viceversa:

1. Selezionare una nota, o un gruppo di note;
2. Premere Ctrl+J (Mac: Cmd+J);
3. Continuare a premere la stessa combinazione di tasti per passare alle notazioni enarmoniche equivalenti.

Nota: Se le altezze delle note selezionate non sono tutte uguali, l'effetto può essere imprevedibile.

Ridefinire (enarmonicamente) le altezze

Dal menu, selezionare Attrezzi→Sostituzione enarmonica delle alterazioni.
(N.d.T: MuseScore “esplora” la partitura effettuando automaticamente le possibili migliorie di notazione enarmonica).

Vedere anche

Armature di chiave: Sostituire

Collegamenti esterni

Accidental  at Wikipedia
Enharmonic  at Wikipedia

Indicazione metrica

Le Indicazioni metriche si trovano in una Tavolozza avente lo stesso nome sia nell’area di lavoro Base che in quella
Avanzata.
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Aggiungere o sostituire una indicazione metrica

Utilizzare uno dei seguenti metodi:

Selezionare un'indicazione metrica, una battuta, una nota o una pausa e cliccare su un'indicazione metrica della
tavolozza (doppio clic nelle versioni precedenti alla 3.4).
Trascinare e rilasciare un'indicazione metrica dalla tavolozza su uno spazio in una battuta, o su un'indicazione
metrica esistente.

Cancellare una indicazione metrica

Per cancellare un’indicazione metrica nella partitura, selezionarla e premere Canc.

Creare una indicazione metrica

Se l’indicazione metrica richiesta non è disponibile in nessuna delle tavolozze esistenti, può essere creata usando uno dei
seguenti metodi:

Dalla tavolozza Indicazione metrica

Disponibile a partire dalla versione 3.3.

1. Nella tavolozza Indicazione metrica cliccare su "Di più", quindi, nella tavolozza supplementare che compare, cliccare
sul pulsante "Crea indicazione metrica";

2. Nella riga superiore, inserire il Numeratore, il Denominatore e il Testo (quest'ultimo è opzionale; serve nel caso vi
sia necessità di visualizzare una indicazione metrica diversa da quella reale).

3. Regolare le travature di default nella sezione Gruppi di Note. Per ripristinare il modello di travature predefinito,
premere Ripristina;

4. Premere il pulsante "Aggiungi" per trasferire l’indicazione metrica appena creata nella tavolozza Indicazione metrica.

Dalla Tavolozza generale (Master)

1. Premere Maius+T per visualizzare la sezione Indicazione metrica nella Tavolozza generale;
2. Selezionare una indicazione metrica da modificare nel pannello centrale;
3. Nella riga superiore del pannello Crea indicazione metrica, inserire Numeratore, Denominatore e Testo (quest'ultimo

è opzionale; serve nel caso vi sia necessità di visualizzare una indicazione metrica diversa da quella attuale).
4. Regolare le travature di default nella sezione Gruppi di Note. Per ripristinare il modello di travature predefinito,

premere Ripristina;
5. Premere Aggiungi per trasferire l’indicazione metrica appena creata nel pannello centrale. Per cancellare una

indicazione metrica dal pannello centrale, cliccare su di essa con il tasto desto del mouse (Mac: Ctrl-click) e
selezionare Cancella.

6. Trascinare e rilasciare l’indicazione metrica dalla tavolozza principale alla tavolozza Indicazione metrica. È inoltre
possibile trascinare l'indicazione metrica direttamente nella partitura.

Indicazioni metriche frazionarie

A partire dalla versione 3.5.1 c'è un supporto limitato per le indicazioni metriche frazionarie. In questo momento sono
supportati solo i valori ½ e ¼. Se la tastiera non dispone di questi caratteri, per alcuni sistemi operativi è comunque
possibile inserirli usando Alt+0189 per ½ e Alt+0188 per ¼. Si possono anche copiare/incollare da qui.

Proprietà dell’indicazione metrica

Per visualizzare la finestra di dialogo Proprietà indicazione metrica usare uno dei seguenti metodi:

Selezionare l’indicazione metrica, quindi cliccare su "Proprietà" nella sezione “Indicazione metrica" dell’Ispettore.
Cliccare con il tasto destro del mouse (Mac: Ctrl-click) su una indicazione metrica e selezionare Proprietà indicazione
metrica.
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Valore globale: Mostra il valore globale dell’indicazione metrica e viene impostato automaticamente quando si
aggiunge una indicazione metrica alla partitura. È il riferimento per i battiti o movimenti (come mostrato nella barra di
stato N.d.T.: quando viene selezionata una nota dello spartito) e per le indicazioni di Metronomo.
Valore reale: Mostra l'indicazione metrica associata a un particolare pentagramma. Normalmente coincide con il
Valore globale, ma può essere impostata con valore indipendente, se necessario. Vedere Indicazioni metriche locali.
Aspetto: Permette di modificare il testo visualizzato senza influenzare l'indicazione metrica sottostante. Per un
esempio, vedere Indicazioni metriche aggiuntive.
Gruppi di note: Permette di modificare la “travatura” preimpostata delle note associate ad una indicazione metrica.
Vedere Cambiare la travatura preimpostata.

Cambiare la travatura preimpostata

Per modificare la travatura delle note di una particolare indicazione metrica:

1. Selezionare l’indicazione metrica, poi "Proprietà" nella sezione "Indicazione metrica" dell’Ispettore; oppure cliccare
sull’indicazione metrica con il tasto destro del mouse (Mac: Ctrl-click) e selezionare, Proprietà indicazione metrica ;

2. Per interrompere una travatura nel pannello Gruppi di note, cliccare sulla testa della prima nota da separare (Nd.T.
esempio: cliccando sulla terza nota di un gruppo di 4 note si otterranno due gruppi di due note ciascuno). Per
riportare la travatura allo stato originale, cliccare nella medesima posizione. In alternativa, è possibile modificare
travature trascinando una delle icone presenti in “Proprietà gruppo note” sulla testa di una nota, come di seguito:

 Inizia travatura da questa nota.

 Non terminare la travatura a questa nota.

 Travatura da 1/8 a sinistra di questa nota.

 Travatura da 1/16 a sinistra di questa nota.

Spuntare la casella per "Cambia anche le note più brevi", significa che qualsiasi cambiamento di travatura a un livello
viene applicato automaticamente anche alle durate più brevi. Il pulsante Ripristina annulla qualsiasi cambiamento fatto in
quella sessione.

Indicazioni metriche aggiuntive (composte)

Le indicazioni metriche aggiuntive (o composte) sono talvolta usate per chiarire la divisione dei battiti all'interno di una
battuta. Per creare una indicazione metrica aggiuntiva:

1. Cliccare con il tasto destro del mouse (Mac: Ctrl-click) su una indicazione metrica nella partitura e selezionare
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Proprietà indicazione metrica… ;
2. Nella sezione Aspetto, regolare la proprietà "Testo" come richiesto;
3. Modificare la travatura nella sezione Gruppi di note se necessario.

Nota: La sezione Indicazione metrica della Tavolozza generale permette anche di creare indicazioni metriche aggiuntive
(vedere sopra).

Indicazioni metriche locali

In certi casi una partitura può mostrare pentagrammi con diverse indicazioni metriche che corrono allo stesso tempo. Per
esempio, nella Variazione Goldberg 26 di Bach:

Nell'esempio precedente, l’indicazione metrica globale è 3/4, mentre quella del pentagramma superiore è stata impostata
indipendentemente a 18/16.

Per impostare una indicazione metrica locale per un solo pentagramma:

Tenere premuto Ctrl (Mac: Cmd) e trascinare una indicazione metrica dalla tavolozza su una battuta vuota.

Ridimensionare una indicazione metrica

Selezionare una o più indicazioni metriche e, nella sezione "Indicazione metrica" dell'Ispettore, regolare i valori
"Scala X" (larghezza) e "Scala Y" (altezza).

Battute in levare e cadenze

Occasionalmente potrebbe sorgere l’esigenza di diminuire o aumentare la durata di una misura senza cambiare
l'indicazione metrica, per esempio, in una battuta in levare (anacrusi) o in una cadenza ecc. Vedere Operazioni sulle
battute: durata della battuta.

Cambi indicazioni metriche e interruzioni di sezione

Quando si incontra una indicazione metrica le Battute d’aspetto vengono interrotte. Inoltre, una interruzione di sezione
impedirà che una indicazione metrica di cortesia sia mostrata alla fine della battuta precedente.

Vedere anche

Armature di chiave

Collegamenti esterni

How To Using Polyrhythm, mixed meters and local time signatures in MuseScore  (MuseScore HowTo)
Additive meters  in Wikipedia.

Arpeggi e glissando

I simboli di Arpeggio e Glissando sono disponibili nella tavolozza "Arpeggi e Glissando" nell’area di lavoro avanzata.
Questa tavolozza include inoltre frecce direzioni arpeggio, una parentesi (di arpeggio), articolazioni strumenti a fiato e
simboli slide in/slide out.
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Aggiungere un simbolo

Per aggiungere un arpeggio, glissando etc. alla partitura, utilizzare uno dei seguenti metodi:

Selezionare una o più note, poi cliccare su un simbolo nella tavolozza (doppio clic nelle versioni precedenti alla 3.4).
Trascinare un simbolo dalla tavolozza a una nota.

Regolare le dimensioni

Per regolare la lunghezza e l’altezza del simbolo:

Entrare in modalità Modifica per il simbolo, e regolare le maniglie utilizzando le scorciatoie da tastiera.

Personalizzare simboli

Dopo aver selezionato un simbolo, varie utili proprietà possono essere regolate nella sezione "Glissando" o "Arpeggio"
dell’Ispettore.

Glissando

Tipo: Scegliere fra linea precisa o ondulata;
Mostra testo: Spuntare questa casella se si vuole che il simbolo visualizzi del testo. Impostare quindi la dicitura, il
font di caratteri, la dimensione e lo stile (sottoelencati). Nota: Se non c’è abbastanza spazio tra le note, il testo non
viene visualizzato;
Riproduci: Spuntare/deselezionare la casella per attivare o disattivare la riproduzione.
Riproduci stile: Scegliere come il glissando deve essere riprodotto. Sono presenti cinque opzioni: Cromatico, Tasti
bianchi, Tasti neri, Diatonico, Portamento;

Arpeggio

Velocità: Aumentare questo valore per allungare la durata dell'arpeggio.
Riproduci: Deselezionare se non si vuole che il simbolo venga riprodotto.

Se utile per un uso futuro, è possibile salvare il risultato in una tavolozza personalizzata.

Arpeggi

Quando un arpeggio o una freccia di direzione arpeggio vengono aggiunti alla partitura, inizialmente si estendono su una
sola voce. Per cambiarne l’altezza, vedere Regolare le dimensioni (sopra). Riproduci: La riproduzione del simbolo può
essere attivata o disattivata nell'Ispettore.

Glissando (slides)

Un Glissando o, più informalmente, una slide, si estende su due note consecutive. Può essere ondulato o preciso, con o
senza testo. Es.

Regolare i punti di inizio e fine di un glissando

Per spostare una maniglia finale verticalmente o orizzontalmente, da una nota all'altra:

1. Entrare in modalità modifica sul simbolo;
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2. Cliccare sulla maniglia iniziale o su quella finale:
Usare Maiusc+↑↓ per spostare la maniglia in alto o in basso, da nota a nota.
Usare Maiusc+←→ per spostare la maniglia orizzontalmente, da una nota all'altra.

Usare questo comando per creare glissando trasversali. Oppure per correggere le posizioni delle maniglie finali quando
si applicano glissando multipli agli accordi.

Articolazioni degli strumenti a fiato

Sono disponibili i simboli Fall, Doit, Plop e Scoop (N.d.T.: trattasi di articolazioni Jazz). Per cambiare la lunghezza e la
curvatura, selezionare il simbolo, entrare in modalità modifica e regolare le maniglie come descritto in Modalità modifica:
Linee.

Slide in/out

Anche le linee Slide in e Slide out si trovano nella tavolozza "Arpeggi e Glissando". Per modificare la lunghezza e
l’angolazione di una linea fare doppio clic su di essa e trascinare la maniglia (oppure utilizzare l'Ispettore o le frecce della
tastiera per una regolazione più fine).

Collegamenti esterni

Arpeggio  su Wikipedia
Glissando  su Wikipedia

Articolazioni e abbellimenti

Il set completo di simboli si trova nella tavolozza Articolazioni nell'area di lavoro Avanzata:

e nella tavolozza Abbellimenti (sempre in area di lavoro Avanzata):

C'è anche una versione abbreviata di Articolazioni nell'area di lavoro Base.

Articolazioni

Le Articolazioni sono i simboli aggiunti alla partitura che indicano come devono essere suonate una nota o un accordo
particolari. I principali simboli di questo gruppo sono:

Corone
Accenti (>)
Staccato e varianti - incluse mezzo-staccato (portato), staccatissimo.
Tenuto
Marcato

Sono incluse anche articolazioni speciali per archi e strumenti a pizzico, strumenti a fiato, ecc.

Abbellimenti

Abbellimenti include:
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Mordenti, Mordenti invertiti, Pralltrills (trilli corti e veloci o “mezzi trilli”)
Trilli
Gruppetti
Bends

Nota: Appoggiature e acciaccature si trovano nella tavolozza Note di abbellimento.

Aggiungere articolazioni/abbellimenti

Usare uno dei seguenti metodi:

Selezionare una nota o un intervallo di note, poi cliccare su un simbolo in una tavolozza (doppio clic nelle versioni
precedenti alla 3.4).
Trascinare un simbolo dalla tavolozza su una nota.

Aggiungere accidenti a un abbellimento

Applicare un accidente a un ornamento esistente, come un trillo:

1. Selezionare la nota alla quale è collegato l'ornamento;
2. Aprire la sezione Simboli della tavolozza generale;
3. Cercare e applicare l’accidente desiderato alla partitura (gli accidenti più piccoli si possono trovare usando il termine

di ricerca "figured bass");
4. Trascinare l'accidente in posizione (o riposizionarlo usando le scorciatoie da tastiera o l’Ispettore).

Aggiungere una corona a una stanghetta di battuta

Usare uno dei seguenti metodi:

Selezionare una stanghetta, poi cliccare su un simbolo di corona nella tavolozza (doppio clic nelle versioni
precedenti alla 3.4).
Trascinare un simbolo di corona dalla tavolozza su una stanghetta nella partitura.

Nota: L’inserimento di corone sulle stanghette non influisce sul playback.

Scorciatoie da tastiera

Attivare/disattivare Staccato: Maiusc+S
Attivare/disattivare Tenuto: Maiusc+N
Attivare/disattivare Sforzato (accento): Maiusc+V
Attivare/disattivare Marcato: Maiusc+O
Aggiungere Acciaccatura (grace note): /

Le scorciatoie da tastiera possono essere personalizzate nelle Preferenze di MuseScore.

Regolare la posizione

Subito dopo aver aggiunto un'articolazione o un abbellimento da tavolozza, il simbolo viene selezionato automaticamente:
Può quindi essere spostato in alto o in basso dalla tastiera come segue:

Premere le frecce direzionali su/giù per un ottenere un posizionamento preciso (0.1 spazi alla volta);
Premere Ctrl+↑ or Ctrl+↓ (Mac: Cmd+↑ or Cmd+↓) per regolazioni verticali più ampie (1 spazio alla volta).
Per capovolgere un simbolo sull'altro lato della nota (se applicabile), selezionarlo e premere X.

Per abilitare le regolazioni in tutte le direzioni dalla tastiera:

1. Entrare in modalità Modifica sul simbolo;
2. Premere le frecce direzionali per ottenere un posizionamento preciso (0.1 spazi alla volta); oppure premere

Ctrl+Freccia (Mac: Cmd+Freccia) per regolazioni più ampie (1 spazio alla volta).

I valori di offset orizzontale e verticale possono essere modificati anche nell’Ispettore. Per posizionare più di un simbolo
alla volta, selezionare i simboli desiderati e regolarne i valori di offset nell'Ispettore.

Nota: Un simbolo può anche essere riposizionato cliccando e trascinando, ma per un controllo più preciso, usare i metodi
di cui sopra.

Proprietà delle Articolazioni e degli Abbellimenti

Queste possono essere modificate nella sezione Articolazioni dell’Ispettore e possono includere:

Posizionamento: Sopra o sotto il pentagramma.
Direzione: Automatica / Su / Giù.
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Ancoraggio: Regola il posizionamento verticale del simbolo.
Aumenta tempo: Per le corone, regola la lunghezza della pausa.
Stile Abbellimento: Predefinito o Barocco.
Riproduci: Attiva o disattiva il playback (riproduzione).

Per le proprietà delle Bend vedere Bends.

Si possono trovare ulteriori impostazioni globali di stile per articolazioni e abbellimenti sotto Articolazioni, Abbellimenti.

Vedere anche

Note di abbellimento

Collegamenti esterni

How to create trills and ornaments with accidentals (and playback)  (MuseScore HowTo)
Ornaments  su Wikipedia
Abbellimento  su Wikipedia

Bend

Con lo strumento Bend  possono essere create Bend di vari tipi. Lo strumento è situato nella tavolozza Articolazioni
dell’area di lavoro Avanzata. Ogni bend applicato alla partitura può essere personalizzato nella sezione Bend
dell’Ispettore.

Applicare un bend

Per applicare uno o più bend alla partitura, usare una delle seguenti opzioni:

Selezionare una o più note e fare doppio clic su un simbolo di bend nella tavolozza.
Trascinare un simbolo di bend dalla tavolozza su una nota.

Modificare bend

Proprietà testo e linea

1. Selezionare il bend;
2. Regolare le seguenti proprietà nella sezione Bend dell’Ispettore:

Spessore linea.
Carattere, Grandezza, Stile: Proprietà del testo.
Riproduci (casella di spunta): Se il bend influisce sulla riproduzione o meno.

Le proprietà globali del testo e della linea per tutti i bend nella partitura possono essere modificate in Formato→Stile→Bend.

Forma e larghezza del bend

Versione 3.4 e successive

1. Assicurarsi che il bend sia selezionato.
2. Nella sezione "Bend" dell’Ispettore usare il menù a tendina Tipo di bend per scegliere da una serie di

preimpostazioni. "Bend" è l’opzione predefinita.
3. Effettuare le regolazioni, se necessario, alla visualizzazione grafica del bend nell’Ispettore: vedere Modificare

visualizzazione grafica (sotto).

Versioni precedenti la 3.4

1. Selezionare il bend e cliccare su Proprietà nell’Ispettore; In alternativa, cliccare con il tasto destro del mouse sul
bend e selezionare "Proprietà Bend".
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2. Scegliere tra una serie di preimpostazioni sotto Tipo bend. "Bend" è l'opzione predefinita.
3. Effettuare le regolazioni, se necessario, alla visualizzazione grafica del bend: vedere Modificare visualizzazione

grafica (sotto).

Modificare visualizzazione grafica

Il bend è rappresentato da un grafico composto da linee grigie collegate da nodi quadrati blu (vedere immagine sopra). La
pendenza della linea indica il tipo di curva:

Pendenza ascendente = bend ascendente
Pendenza discendente = bend discendente
Horizontal line = Hold Linea orizzontale = tenuto

L’asse verticale del grafico rappresenta quanto il bend tende verso l'alto o verso il basso: una unità equivale a un quarto
di tono, 2 unità a un semitono, 4 unità a un tono intero, e così via. L’asse orizzontale del grafico indica la lunghezza del
bend: ogni segmento di linea grigia si estende per 1 spazio (sp) nella partitura.

Un bend viene modificato aggiungendo o eliminando nodi nel grafico:

Per aggiungere un nodo, cliccare su un'intersezione vuota.
Per cancellare un nodo, cliccare su di esso.

Aggiungendo un nodo si allunga il bend di 1 sp; cancellando un nodo lo si accorcia di 1 sp. I punti di inizio e fine del bend
possono essere spostati solo verso l'alto e verso il basso.

Modificare l’altezza

L'altezza del simbolo del bend è regolata automaticamente in modo che il testo appaia appena sopra il rigo. Questa
altezza può essere modificata, se necessario, con una soluzione alternativa:

1. Creare un'altra nota verticalmente sopra la nota (accorciando la linea) o sotto la nota (estendendo la linea) in cui si
vuole che il bend abbia inizio.

2. Applicare il bend alla nota creata.
3. Per regolare l'altezza della curva, spostare questa nota creata verticalmente in modo che il simbolo del bend abbia

l'altezza desiderata.
4. Trascinare il simbolo della curva nella posizione corretta (sulla nota originale).
5. Contrassegna la nota creata come invisibile e silenziosa (tramite l’Ispettore).

Regolare la posizione

Per regolare la posizione utilizzare una delle seguenti opzioni:

Trascinare il simbolo del bend con il mouse.
Cliccare sul simbolo e regolare gli offset orizzontali e verticali nell’Ispettore.
Fare doppio clic sul simbolo; oppure cliccare su di esso e premere Ctrl+E (Mac: Cmd+E); oppure cliccare con il tasto
destro del mouse sul simbolo e selezionare "Modifica elemento". Usare quindi i tasti freccia per posizionamento
preciso (0,1 sp alla volta); oppure Ctrl+Freccia (Mac: Cmd+Freccia) per regolazioni più ampie (1 sp alla volta).

Personalizzare bend

Dopo che un bend è stato creato nella partitura, può essere salvato per un uso futuro trascinando e rilasciando il relativo
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simbolo in una tavolozza tenendo premuto Ctrl+Maiusc (Mac: Cmd+Maiusc). Vedere Area di lavoro personalizzata.

Collegamenti esterni

Bending  su wikipedia

Code

Modificare la travatura automatica delle note (raggruppamento)

Per default, MuseScore raggruppa le note in accordo con le impostazioni fissate nella finestra di dialogo Proprietà
indicazione metrica. Per modificare questo automatismo vedere Cambiare la travatura preimpostata.

Modifica raggruppamento di note singole

MuseScore permette di “sovrascrivere” il raggruppamento preimpostato di qualsiasi nota utilizzando i simboli di
raggruppamento nella tavolozza Proprietà gruppo note delle aree di lavoro “Essenziale” o “Avanzata”:

Per modificare il raggruppamento o “travatura” di una o più note (eccettuate le travature convergenti e divergenti,
sotto descritte), utilizzare uno dei seguenti metodi:

Trascinare e rilasciare un simbolo di raggruppamento dalla tavolozza Proprietà gruppo note ad una nota o pausa
nella partitura.
Selezionare una o più note e/o pause nella partitura e cliccare il simbolo desiderato nella tavolozza Proprietà
gruppo note (doppio clic nelle versioni precedenti alla 3.4).

Per applicare travature convergenti e/o divergenti, utilizzare uno dei seguenti metodi:

Trascinare e rilasciare uno dei due relativi simboli dalla tavolozza _Proprietà gruppo note__ sulla travatura prescelta
nella partitura.
Selezionare una o più travature nella partitura, poi cliccare su uno dei due relativi simboli nella tavolozza Proprietà
gruppo note (doppio clic nelle versioni precedenti alla 3.4).

Note: (1) Le travature convergenti/divergenti necessitano di 2 o 3 linee a seconda del tempo e della velocità di
cambiamento desiderati; (2) Per creare travatura convergente/divergente con 2 linee è necessario partire con
l’esecuzione continua di note di sedicesimi (semicrome) appartenenti ad una medesima travatura; (3) Per creare travatura
convergente/divergente con 3 linee è necessario partire con l’esecuzione continua di note di trentaduesimi (biscrome)
appartenenti ad una medesima travatura; (4) La riproduzione sonora di questa tipologia di travature non è supportata.

Simboli di raggruppamento e loro effetti

Icona Nome Descrizione

Inizio travatura Se la nota era collegata alla precedente interrompe il collegamento.

Collega gruppo
note

Crea travatura dalla nota selezionata a quella precedente (se applicabile). Applicabile anche a
gruppi di sedicesimi + inferiori e a gruppi di trentaduesimi + inferiori.

Nessuna travatura Interrompe travatura prima e dopo la nota selezionata.

Trav. Semicroma
sub Da questa nota inizia la travatura di secondo livello.

Trav. Biscroma
sub Da questa nota inizia la travatura di terzo livello.

Travatura
automatica

Applica la travatura predefinita come determinato dalla indicazione metrica in vigore (vedere
sopra).

Travatura
convergente, più
lento

Inizio di travatura convergente per indicare un tempo gradualmente più lento.

Travatura
divergente, più
veloce

Inizio di travatura divergente per indicare un tempo gradualmente più veloce.

Note: È necessario sapere che la possibilità di effettuare il raggruppamento/travatura tra due note/pause è determinato
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dalle caratteristiche di entrambe le note. Per esempio: Due note consecutive entrambe contrassegnate come “Inizio
travatura” non potranno essere collegate tra loro con travatura. Se le due note consecutive sono predisposte per
connettersi l'una con l'altra si genererà la travatura, se una di loro non è predisposta, le due note non potranno
raggrupparsi.

Modifica dell’angolo di travatura

Regolazione tramite tastiera o mouse:

1. Entrare in modalità modifica sulla travatura; la maniglia destra di regolazione resta automaticamente selezionata.
2. Usare le frecce su/giù oppure trascinare la maniglia destra per cambiare l'angolo di travatura;
3. Premere Esc per uscire da modalità modifica.

Regolazione con l’Ispettore:

1. Cliccare su una travatura.
2. Spuntare la casella-box "Posizione personalizzata" nella sezione "Gruppo" dell’ Ispettore;
3. Variare i valori di "Posizione" per ottenere l’angolo di travatura desiderato.

Regolare l’altezza della travatura

Regolazione tramite tastiera o mouse:

1. Entrare in modalità modifica sulla travatura; la maniglia destra di regolazione resta automaticamente selezionata.
2. Premere Maiusc+Tab oppure cliccare la maniglia sinistra per selezionarla;
3. Usare le frecce su/giù oppure trascinare la maniglia sinistra per cambiare l'altezza della travatura;
4. Premere Esc per uscire da modalità modifica.

Regolazione con l’Ispettore:

1. Cliccare sulla travatura.
2. Spuntare la casella-box "Posizione personalizzata" nella sezione "Gruppo" dell’ Ispettore;
3. Variare i valori di "Posizione" per ottenere il risultato desiderato.

Forzare una travatura in posizione orizzontale

1. Selezionare una travatura
2. Spuntare la casella-box "Forza orizzontalmente" nella sezione "Gruppo" dell’Ispettore;

Nota: "Forza orizzontale" nella sezione "Gruppo" dell’Ispettore può essere selezionata solo se la casella "Posizione
personalizzata" è stata precedentemente deselezionata. Questa impostazione sovrascrive i valori di “Posizione
personalizzata” e imposta automaticamente la barra orizzontale alla sua altezza originale.

Se si vuole che tutte le travature di raggruppamento delle note in partitura restino orizzontali, in Formato→Stile→Gruppi di note
è presente l’opzione “Appiattisci tutte le travature”. Se questa opzione non è selezionata, le travature assumeranno una
inclinazione automatica dipendente dall’altezza delle note collegate. Questa impostazione globale può essere annullata
per singole travature tramite i metodi descritti precedentemente.

Regolare le travature convergenti/divergenti

Per regolare questo tipo di travature:

1. Selezionare una travatura.
2. Modificare i valori nelle caselle "Aumenta a sinistra" e "Aumenta a destra" della sezione "Gruppo" nell’ Ispettore.

Ridefinire impaginazione locale

MuseScore spazia fra loro le note in accordo con il loro valore, comprensivo degli eventuali accidenti, testi cantati, etc.
Nelle accollature dove è presente più di un pentagramma, il risultato potrebbe essere una irregolare spaziatura delle note,
come nel seguente esempio:

La ridefinizione di impaginazione locale è una casella di spunta nell’ Ispettore che permette di specificare in quali
passaggi nella partitura si vuole che la spaziatura delle note sia indipendente rispetto agli altri pentagrammi
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dell’accollatura. Applicando "Ridefinisci impaginazione locale" alla travatura che collega le note nel pentagramma
superiore dell’esempio precedente si ottiene una più uniforme distribuzione delle note:

Per effettuare una reimpaginazione localizzata:

1. Selezionare una o più travature di collegamento.
2. Spuntare l’opzione Ridefinisci impaginazione locale nella sezione "Gruppo" dell’ Ispettore.

Capovolgere una travatura

Per capovolgere una travatura di raggruppamento da sopra a sotto le note, o viceversa:

1. Selezionare una o più travature.
2. Utilizzare una delle seguenti opzioni:

Premere il tasto X;

Premere l’icona "Inverti direzione gambi note", , nella barra degli strumenti.
Selezionare una "Direzione" (Automatico, Su o Giù) nella sezione "Gruppo" dell’ Ispettore.

Ripristino modalità di raggruppamento

Per ripristinare le modalità di raggruppamento note in quelle definite nella indicazione metrica in vigore:

1. Selezionare la sezione della partitura che si vuole ripristinare. Se non viene selezionato nulla, l’operazione verrà
applicata all’intera partitura;

2. Selezionare Formato→Ripristina gambi.

Vedere anche

Gruppo di note tra pentagrammi
Modalità di modifica
Inserimento note
Cambiare la travatura preimpostata

Collegamenti esterni

How beams work  (MuseScore Tutorial)
How to add a beam over a rest  (MuseScore HowTo)
How to place a beam between notes  (MuseScore HowTo)

Parentesi (Raggruppamento righi)

(N.d.T.: attualmente le definizioni di parentesi relative a questo argomento non corrispondono alla comune nomenclatura
in lingua italiana. Vengono infatti definite tutte “Graffa”. In attesa di chiarimenti porre attenzione in caso di modifiche. Nel
corso della traduzione ho comunque cercato di essere il più chiaro possibile. Per la parentesi quadra più piccola e per
l’argomento in generale, vedere il link indicato nei Collegamenti esterni).

Per il raggruppamento di righi nell’accollatura MuseScore rende disponibili la parentesi quadra e la parentesi graffa
nella tavolozza Graffe (area di lavoro Avanzata).

Quando una nuova partitura viene creata usando un modello, MuseScore imposta automaticamente le parentesi corrette.

Aggiungere

Per aggiungere una parentesi ad una accollatura, usare uno dei due metodi seguenti:

Selezionare una battuta del rigo al quale si vuole aggiungere la nuova parentesi e cliccare l’icona desiderata nella
tavolozza (doppio click nelle versioni precedenti la 3.4).
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Trascinare l’icona relativa alla parentesi desiderata dalla tavolozza al rigo al quale la si vuole aggiungere.

Cancellare

Selezionare la parentesi e premere Canc.

Cambiare

Trascinare l’icona della nuova parentesi dalla tavolozza alla parentesi da sostituire nella partitura.

Modificare

Quando si applica per la prima volta una parentesi, questa si collega solo a un rigo. Per estendere ad altri righi:

1. Entrare in modalità modifica.
2. Trascinare la maniglia verso il basso per espandere ai righi voluti. La maniglia scatta in posizione, quindi non è

necessario un posizionamento preciso.

Stile

Lo spessore predefinito delle parentesi e la loro distanza dall’accollatura possono essere regolati in Formato → Stile →
Accollatura.

Nella sezione Parentesi di accollatura si possono modificare le proprietà per le parentesi quadre nelle due caselle a
sinistra, e le proprietà per le parentesi graffe nelle due caselle a destra.

Vedere anche

Nuove funzionalità di MuseScore 3.6

Collegamenti esterni

Partitura (https://it.wikipedia.org/wiki/Partitura ) su Wikipedia

Note di abbellimento

Una nota di abbellimento è un tipo di ornamento musicale, solitamente stampato con dimensioni inferiori rispetto alle
note regolari. La nota di abbellimento breve, o Acciaccatura, appare come una piccola nota con un tratto attraverso il
gambo. La nota di abbellimento lunga, o Appoggiatura, non ha tratto.

Creare note di abbellimento

Le note di abbellimento si trovano nella tavolozza "Note di abbellimento" nell'area di lavoro Essenziale o Avanzata.

Aggiungere una nota di abbellimento

Usare uno dei seguenti metodi:

Selezionare una nota normale e cliccare su una nota di abbellimento nella relativa Tavolozza (doppio clic nelle
versioni precedenti alla 3.4).
Trascinare un simbolo di nota di abbellimento dalla relativa tavolozza a una nota regolare.
Selezionare una nota e premere / per creare solo una acciaccatura.

Questo aggiungerà una nota di abbellimento della stessa altezza della nota regolare. Per aggiungere una sequenza di
note di abbellimento a una nota normale, ripetete semplicemente le azioni di cui sopra tante volte quanto necessario. Vedi
anche Cambio altezza (sotto).
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Nota : Quando viene aggiunta alla partitura una nota di abbellimento, la relativa legatura non viene creata
automaticamente con essa; deve quindi essere aggiunta separatamente. Vedere Legature.

Aggiungere un accordo di note di abbellimento

Gli accordi di note di abbellimento sono costruiti come gli accordi normali:

1. Inserire la prima nota dell'accordo come mostrato sopra;
2. Selezionare questa prima nota di abbellimento e inserire le successive come per qualsiasi altro accordo regolare

(cioè Maiusc+A...G).

È possibile creare un accordo di note di abbellimento al punto 2 anche usando le scorciatoie per aggiungere intervalli:
Alt+1...9 per intervalli da un unisono a una nona superiore.

Cambiare altezza (intonazione)

L’altezza della nota di abbellimento può essere regolata come per una nota normale:

1. Selezionare una o più note di abbellimento;
2. Regolare l'intonazione usando i comandi freccia della tastiera, cioè:

↑ o ↓ per aumentare o diminuire l’intonazione di un semitono;
Alt+Maiusc+↑ oppure Alt+Maiusc+↓ per aumentare o diminuire l’intonazione un passo alla volta, in accordo con la
scala legata all’armatura di chiave in vigore.

Cambio durata

Selezionare la nota di abbellimento e cliccare su un'icona di durata nella barra degli strumenti, oppure applicare la
durata con la scorciatoia da tastiera appropriata: cioè 1...9 (vedere inserimento note).

Regolazione manuale

Posizione orizzontale

Per regolare lo spazio orizzontale fra una nota di abbellimento e la sua “nota madre” utilizzare una delle seguenti
possibilità:

Andare in modalità modifica sulla nota di abbellimento, poi usare i tasti freccia sinistra/destra per riposizionare come
desiderato.
Selezionare la nota di abbellimento e modificare il valore di offset X nella sezione Accordo dell’Ispettore.

Altre regolazioni

Tramite l’Ispettore possono essere regolate altre varie proprietà delle note di abbellimento (vedere le sezioni "Elemento,"
"Accordo", e "Nota"), tra le quali la posizione verticale, la dimensione, le proprietà del gambo, ecc. Fa eccezione il valore
"Spazio precedente", nella sezione Segmento, che si applica solo alle note normali.

Collegamenti esterni

Grace note  su Wikipedia
Appoggiatura  su Wikipedia
Acciaccatura  su Wikipedia

Respiri e Cesure

I simboli di Respiro e Cesura sono disponibili nella tavolozza Respiri e Cesure (area d lavoro Avanzata).

Aggiungere un simbolo

Per aggiungere un respiro, o una cesura (altrimenti nota come caesura / linee di tram nel Regno Unito / binari ferroviari
negli Stati Uniti) allo spartito, utilizzare una delle seguenti opzioni:

Selezionare una nota o una pausa e cliccare su un simbolo di respiro o di cesura nella tavolozza (doppio clic nelle
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versioni precedenti alla 3.4).
Trascinare un simbolo di respiro o di cesura dalla tavolozza su una nota o una pausa nella partitura.

Il simbolo viene posizionato dopo la nota. La sua posizione può essere regolata modificando il valore di offset X e Y
nell’Ispettore, oppure, in modalità modifica, utilizzando i tasti freccia.

Regolare la lunghezza della cesura

È possibile regolare la lunghezza della cesura (in secondi) del simbolo aggiunto tramite l’Ispettore.

Battute d'aspetto

(N.d.T.: il titolo dell’argomento in inglese è “Measure rests”, ovvero letteralmente “Pause di battuta (intera)”. Il capitolo
dapprima descrive come ottenere tali battute, necessarie per il processo di raggruppamento e creazione delle vere e
proprie “Battute d’aspetto” successivamente trattate. Vedere Battuta d’aspetto  su Wikipedia).

Pausa di battuta intera

Una pausa intera di semibreve, centrata all'interno di una battuta (mostrata sotto), è usata per indicare che un'intera
battuta (o una voce all'interno di una battuta) è silenziosa, indipendentemente dall'indicazione del tempo.

Creare una o più pause di battuta intera

Usare il seguente metodo se tutte le misure selezionate sono "standard", cioè senza durate personalizzate:

1 Selezionare una battuta, o un intervallo di battute.
2. Press Canc.

Se una o più battute hanno una durata personalizzata, usare invece il seguente metodo:

1. Selezionare una battuta, o un intervallo di battute.
2. Premere Ctrl+Maiusc+Canc (Mac: Cmd+Maiusc+Canc).

Creare una pausa di battuta intera in una voce particolare

1. Nella voce appropriata inserire una pausa con durata pari a quella dell’intera battuta.
2. Assicurarsi che la pausa sia selezionata, quindi premere Ctrl+Maiusc+Canc (Mac: Cmd+Maiusc+Canc).

Pausa di più battute (Battuta d’aspetto)

Una Battuta d’aspetto indica un periodo di silenzio per uno strumento: il numero di battute è indicato dal numero sopra il
pentagramma.

Le Battute d’aspetto vengono automaticamente interrotte in punti importanti, come le doppie stanghette, numeri di
chiamata, cambi di Chiave o di Indicazione metrica, interruzioni di sezione etc. Si interrompono anche nelle battute
appositamente impostate allo scopo (vedere: interrompi battute d’aspetto).

Visualizzare battute d’aspetto

Per attivare o disattivare la visualizzazione di battute d’aspetto:

Premere M sulla tastiera.

In alternativa:

1. Dal menu, scegliere Formato→Stile.
2. Cliccare su "Partitura", se non già selezionata;
3. Spuntare/deselezionare "Crea battute d’aspetto". Qui è inoltre possibile fissare il numero minimo di battute vuote da

combinare in una unica battuta d’aspetto (vedere anche Impaginazione e formattazione: Partitura).

Nota: Si raccomanda di inserire tutte le note nella partitura prima di abilitare le battute d’aspetto.

Interrompere battute d’aspetto

Potrebbe verificarsi la necessità di dividere in due una battuta d’aspetto:
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1. Assicurarsi che l’opzione “Crea battute d’aspetto” in Formato→Stile → Partitura sia deselezionata (vedere sopra).
2. Cliccare con il tasto destro del mouse sulla battuta dove si vuole che inizi la seconda battuta d’aspetto;
3. Dal menu, scegliere Proprietà battuta e spuntare "Interrompi la battuta d’aspetto".

Vedere anche: Operazioni sulle battute: Interrompere battute d’aspetto.

Forcelle

Le forcelle sono simboli utilizzati per indicare modifiche graduali del volume nella partitura. Sono di due tipi: crescendo
(sempre più forte) e decrescendo (sempre più silenzioso).

Aggiungere una forcella

1. Selezionare un intervallo di note o di battute;
2. Usare una delle seguenti scorciatoie:

<: per creare una forcella di crescendo.
>: per creare una forcella di diminuendo (decrescendo).

In alternativa, usare una delle seguenti opzioni:

Selezionare un intervallo di note o di battute, e cliccare una forcella nella tavolozza Linee (doppio-click nelle versioni
precedenti la 3.4).
Trascinare e rilasciare una forcella dalla tavolozza su una linea di pentagramma.

Modificare lunghezza e altezza

Una forcella è un tipo di Linea con proprietà di riproduzione sonora, e la sua lunghezza si modifica nello stesso modo:

1. Entrare in modalità modifica sulla forcella. Cliccare quindi sulla maniglia finale che si desidera spostare:

2. Usare una delle seguenti scorciatoie:

Maiusc+→ per spostare la maniglia finale, e il suo ancoraggio, a destra di una nota o pausa.
Maiusc+← per spostare la maniglia finale, e il suo ancoraggio, a sinistra di una nota o pausa;

Questo modo di estendere o accorciare la forcella mantiene l’integrità di riproduzione sonora e le permette di
superare le interruzioni di linea:

3. Per mettere a punto in modo preciso la posizione orizzontale di una maniglia finale (senza cambiare la riproduzione
sonora), usare le seguenti scorciatoie:

→ per spostare la maniglia a destra di 0.1 sp.
← per spostare la maniglia a sinistra di 0.1 sp.
Ctrl+→ (Mac: Cmd+→) per spostare la maniglia a destra di uno sp.
Ctrl+← (Mac: Cmd+→) per spostare la maniglia a sinistra di uno sp.

Per cambiare l’altezza di una forcella:

Regolare la maniglia inferiore alla bocca della forcella (per esempio il quadrato blu qui sotto):

Linee di Cresc. e Dim.
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In aggiunta alle forcelle, nella tavolozza Linee sono disponibili – con le stesse funzioni – le linee cresc.   _     _     _ e dim.  
_     _     _. È possibile regolarne il testo, se necessario, tramite le opzioni nella sezione Dettagli linea di testo
dell’Ispettore.

Per trasformare una forcella nella sua equivalente linea di testo:

Selezionare la forcella e, nella sezione Forcella dell’Ispettore, selezionare la linea appropriata tra le opzioni della
casella "Tipo".

Copiare forcelle

A partire dalla versione 3.1, una forcella può essere tagliata, copiata e incollata come un elemento di testo: vedere
Sommario dei comandi taglia / copia / incolla.

Per le versioni precedenti la 3.1, una forcella può essere solo duplicata: vedere Copiare linee.

Modificare le proprietà di una forcella

Le proprietà di una forcella possono essere modificate tramite l’Ispettore, come di seguito:

Elemento: Modificare il valore Y per cambiare la distanza della forcella sopra o sotto il pentagramma.
Linea: Modifica proprietà della linea quali colore, stile e spessore.
Dettagli linea di testo: Aggiungere testo e fissarne le proprietà.
Forcella:

Tipo: Cambia il tipo di forcella: crescendo, decrescendo o testo.
Punta cerchiata: Spuntare la casella box per attivarla.
Altezza: Ampiezza alla bocca della forcella.
Altezza continua: Ampiezza della forcella alla fine di una accollatura, prima che continui sulla accollatura
successiva.
Posizione: Imposta la posizione della forcella sopra o sotto il pentagramma.
Gamma dinamica: Specifica se la riproduzione sonora relativa alla forcella si applica a pentagramma, parte
(scelta predefinita) o accollatura.
Cambio intensità: … lungo l’arco della forcella; da 0 a 127.
Usa la dinamica di una singola nota (a partire dalla versione 3.1): Quando attiva (predefinito), permette alla
forcella di modificare la dinamica di una singola nota se lo strumento consente tale tipo di dinamica.
Metodo della dinamica (a partire dalla versione 3.1): Imposta il metodo usato per riprodurre la dinamica:
Lineare (predefinito), Facilita entrata/uscita, Facilita entrata, Facilita uscita, o Esponenziale.

Riproduzione sonora delle forcelle

Per impostazione predefinita, una forcella influisce sempre sulla riproduzione sonora quando si estende su una serie di
note separate. Inoltre, per gli strumenti che supportano la dinamica di una singola nota (ad esempio archi, ottoni ecc.), la
riproduzione sonora è abilitata anche per singola nota o per una serie di note legate . (Nota: Nelle versioni precedenti la
3.1 le forcelle influenzavano solo la riproduzione sonora tra note, non quella di note singole o legate).

Una forcella influisce sulla riproduzione sonora solo se prima e dopo di essa sono presenti dinamiche appropriate. Per
esempio, un crescendo fra le dinamiche p e f avrà effetto sulla riproduzione sonora; al contrario un diminuendo tra p e f
verrà ignorato. E se tra p e f sono presenti due o più Crescendo, saranno tutti ignorati ad eccezione del primo.

Una forcella può essere usata senza segni dinamici, regolando il "Cambio intensità" nell'Ispettore (valori compresi
nell’intervallo da 0 a 127).

Linee

La tavolozza Linee nell’area di lavoro Avanzata contiene i seguenti oggetti:
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Come si può vedere, la tavolozza include: Legature, Forcelle, Linee di Volta, Linee di ottava, e molte altre.

Applicare linee alla partitura

La maggior parte delle linee (eccettuate le Legature, Linee di Volta e l'Ambitus) può essere applicata da tavolozza nei
seguenti modi:

Applicare una linea a una sola nota

1. Cliccare su una nota, poi Ctrl+Clic sulla nota successiva;
2. Nella relativa tavolozza, cliccare su una linea (doppio clic nelle versioni precedenti la 3.4).

Applicare una linea ad una serie di note

1. Selezionare un intervallo di note;
2. Nella relativa tavolozza, cliccare su una linea (doppio clic nelle versioni precedenti la 3.4).

Applicare una linea da una nota alla fine della battuta

Utilizzare uno dei seguenti metodi:

Cliccare su una nota, poi, nella relativa tavolozza, cliccare su una linea (fare doppio clic su quest'ultimo nelle versioni
precedenti la 3.4).
Trascinare e rilasciare la linea sulla partitura.

Applicare una linea a una serie di battute

1. Selezionare una o più battute;
2. Nella relativa tavolozza, cliccare su una linea (doppio clic nelle versioni precedenti la 3.4).

Linee e proprietà di riproduzione sonora

Alcune linee, come Forcelle, Volta, Ottava ecc., hanno effetto anche sulla riproduzione sonora della partitura stessa. Ogni
maniglia finale è collegata, tramite una linea tratteggiata, ad un’ancora sul pentagramma (visibile in modalità modifica).
Queste “ancore” indicano l’ estensione dell’effetto sulla riproduzione sonora.

Regolare la posizione verticale

In modalità normale, applicare uno dei seguenti metodi:

Cliccare su una o più linee e modificare l'offset verticale nell’Ispettore;
Cliccare su una linea, tenere premuto Maiusc e trascinarla su/giù con il mouse.

Nota: È possibile regolare la posizione verticale anche in modalità Modifica.
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Cambiare lunghezza

Nota: I due seguenti metodi la fine della linea e la sua ancora insieme. Questo assicura che sia mantenuta (se applicabile)
la corretta riproduzione sonora della partitura e che la linea possa estendersi tra più accollature se necessario.

Utilizzo delle scorciatoie da tastiera

1. Entrare in modalità modifica e cliccare su una maniglia finale;
2. Applicare una delle seguenti scorciatoie da tastiera:

Maiusc+→ per muovere la maniglia finale, e la sua ancora, a destra di una nota (o, nel caso di Volta, una
battuta);
Maiusc+← per muovere la maniglia finale, e la sua ancora, a sinistra di una nota (o, nel caso di “Volta”, una
battuta);

Per trascinamento (a partire dalla versione 3.5)

Cliccare sulla maniglia finale di una linea e trascinarla con il mouse.

Regolazione fine

Per effettuare regolazioni fini alla posizione dell’estremità della linea (senza modificare la posizione dell’ancora):

1. Entrare in modalità modifica e cliccare su una maniglia finale;
2. Applicare una delle seguenti scorciatoie da tastiera:

→ per spostare la maniglia a destra di 0.1 sp (1 sp = uno spazio di pentagramma = distanza tra due linee di un
pentagramma).
← per spostare la maniglia a sinistra di 0.1 sp.
Ctrl+→ (Mac: Cmd+→) per spostare la maniglia a destra di uno sp.
Ctrl+← (Mac: Cmd+→) per spostare la maniglia a sinistra di uno sp.

Linee di testo

Una linea di testo è una linea che ha del testo incorporato come volta, ottava, linea barré per chitarra, ecc.

Quando si applica una linea di testo alla partitura da una tavolozza, le proprietà della linea rimangono sempre invariate,
mentre quelle del testo, in alcune circostanze, possono assumere le stesse proprietà di stile delle linee di testo correnti.
Per maggiori dettagli, vedere Comportamento del testo e delle linee applicate.

Linee personalizzate

Qualsiasi linea nello spartito può essere personalizzata regolando le sue proprietà nell' Ispettore, come segue:

1. Selezionare la linea;
2. Se necessita visualizzare le cediglie, effettuare le opportune selezioni in Cediglia iniziale, Cediglia finale e relativa

Altezza (nella sezione Dettagli linea di testo);
3. Per aggiungere testo, spuntare le caselle Inizio testo, Continua testo o Fine testo, quindi digitare nella casella

"Testo" che appare:
Inizio: Il testo qui aggiunto appare all’inizio della linea;
Continua: Il testo qui aggiunto appare all’inizio di una linea di continuazione nella accollatura successiva (nel
caso di linee che si estendono su più di una accollatura);
Fine: Il testo qui aggiunto appare alla fine della linea;

4. Modificare le proprietà del testo e allineamento se necessario;
5. Modificare Posizione: "Sopra" o "Sotto" fissa la posizione del testo sulla linea. "Sinistra" posiziona il testo a sinistra

della linea;
6. Regolare il colore, lo spessore e lo stile della linea (continua, tratteggiata, ecc.) nella sezione Linea section.

L’opzione Consenti diagonale permette di creare una linea diagonale trascinandone le maniglie finali;
7. Per salvare il risultato per utilizzi successivi, vedere Tavolozze personalizzate.

Copiare linee

Una volta applicate alla partitura, le linee non possono essere copiate con le normali procedure copia e incolla. Tuttavia è
possibile duplicare linee presenti in partitura:

Tenere premuto Ctrl+Maiusc (Mac: Cmd+Maiusc), cliccare sulla linea e trascinarla nella posizione desiderata.

Linee di ornamento estese

Per aggiungere un accidente ad un abbellimento esteso (esempio una linea di trillo), selezionare la linea e cliccare su u
simbolo nella tavolozza Alterazioni (doppio clic nelle versioni precedenti la 3.4).
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Collegamenti esterni

Piano pedal marks  su Wikipedia
Guitar Barre  su Wikipedia

Linee di Ottava

Le Linee di Ottava sono usate per indicare che una sezione di musica deve essere suonata una o più ottave sopra o
sotto l'altezza scritta; la linea può essere tratteggiata o piena. Sono disponibili nella tavolozza Linee delle aree di lavoro
Essenziale e Avanzata.

8─────┐or 8va─────┐: Eseguire un’ottava sopra l’altezza scritta
8─────┘or 8va─────┘: Eseguire un’ottava sotto l’altezza scritta

Le linee 8va alta/bassa sono molto comuni nelle partiture per pianoforte, anche se a volte sono utilizzate anche in altra
musica strumentale.1 Occasionalmente vengono utilizzate anche le linee 15ma alta (2 ottave sopra) e 15ma bassa (2
ottave sotto)

MuseScore regola automaticamente la riproduzione sonora della partitura sotto la linea di ottava all'altezza corretta.

Applicare una linea di ottava

Vedere Applicare linee alla partitura.

Per regolare la posizione verticale, vedere Linee: Regolare la posizione verticale.

Cambiare lunghezza

Vedere Linee: Cambiare lunghezza.

Linee personalizzate

Le linee di Ottava possono essere personalizzate come qualsiasi altra linea. Vedere Linee personalizzate e proprietà
delle linee.

Le proprietà uniche delle linee di Ottava possono essere regolate nella sezione Ottava dell'Ispettore:

Tipo: Cambia il testo della linea di Ottava.
Posizione: Scelta tra "Sopra" o "Sotto" il pentagramma.
Solo numeri: Deselezionare per visualizzare sia numero che testo (es. "8va"). Spuntare per visualizzare solo il
numero (es. "8").

Collegamenti esterni

Octave  at Wikipedia

1. Gerou/Lusk. Essential Dictionary of Music Notation (Internet Archive ). ↩︎

Legature di portamento

Una legatura di portamento è una linea curva tra due o più note; indica che devono essere suonate in modo legato -
omogeneamente e senza separazione. Da non confondere con le Legature di valore, che uniscono due note della stessa
altezza.

Vi sono diversi modi per aggiungere una legatura a una partitura, e tutti possono essere utili a seconda del contesto (è
anche possibile – ma non consigliabile – farlo dalla tavolozza linee).

Aggiungere legature di portamento in modalità inserimento note
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1. In modalità inserimento note, inserire la prima nota appartenente all’intervallo da collegare;
2. Premere S per attivare la legatura tra note;
3. Inserire le rimanenti note da legare;
4. Premere S per terminare la legatura.

Aggiungere legature di portamento in modalità normale

Metodo 1

1. Assicurarsi di essere in modalità normale;

2. Selezionare la nota dalla quale si vuole far partire la legatura:

3. Premere S per aggiungere una legatura con la nota successiva:

4. (Facoltativo) Tenere premuto Maiusc e contemporaneamente premere → (tasto freccia destra) per estendere la
legatura alla nota successiva. Ripetere se necessario:

5. (Facoltativo) Premere X per invertire la direzione della legatura:

6. Premere Esc per uscire da modalità modifica:

Metodo 2

1. Assicurarsi di essere in modalità normale;
2. Selezionare la nota dalla quale si vuole far partire la legatura;
3. Scegliere una delle seguenti opzioni:

Per aggiungere una legatura a una sola voce: Tenere premuto Ctrl (Mac: Cmd) e selezionare l’ultima nota che si
vuole collegare.
Per aggiungere legature a tutte le voci: Tenere premuto Maiusc (Mac: Cmd) e selezionare l’ultima nota che si
vuole collegare.

4. Premere S.

Regolare legature di portamento

Se si vuole solamente regolare la posizione di una legatura:

1. Selezionare la legatura di portamento;
2. Utilizzare uno dei seguenti metodi:

Trascinare la legatura.
Regolare i valori di offset orizzontale e verticale nell’Ispettore.

Per regolare tutte le proprietà di una legatura (lunghezza, forma e posizione):

1. Assicurarsi di non essere in modalità inserimento note;
2. Entrare in modalità modifica sulla legatura;
3. Cliccare su una maniglia per selezionarla, oppure usare Tab per scorrere le maniglie;
4. Per spostare le maniglie sinistra e destra da una nota all’altra, usare le seguenti scorciatoie:
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Maiusc+→: Sposta alla nota successiva.
Maiusc+←: Sposta alla nota precedente.
Maiusc+↑: Sposta alla voce inferiore (da voce 2 a voce 1, ecc.).
Maiusc+↓: Sposta alla voce superiore (da voce 1 a voce 2, ecc.).

5. Per regolare la posizione di qualsiasi maniglia, utilizzare uno dei seguenti metodi:
Trascinare la maniglia.
Usare i tasti freccia pe la regolazione fine (0.1 sp. alla volta). Pe regolazioni più ampie (1 sp. alla volta) usare
Ctrl+→ ← ↑ ↓ .

6. Premere Esc per uscire da modalità modifica.

Nota: Le due maniglie esterne regolano l'inizio e la fine della legatura, mentre le tre maniglie sulla curva ne regolano la
forma. La maniglia centrale sulla linea retta è usata per spostare l'intera legatura su/giù/sinistra/destra.

Legature estese (N.d.T.: dette anche “di frase” o “di espressione”)

Una legatura può abbracciare diverse accollature e pagine. L'inizio e la fine di una legatura sono ancorati a una
nota/accordo o a una pausa. Se le note vengono riposizionate a causa di cambiamenti nel layout, nel tratto o nello stile,
anche la legatura si sposta e si adatta nelle dimensioni.

Questo esempio mostra una legatura di frase che si estende dalla chiave di basso a quella di violino. Usando il mouse,
selezionare la prima nota della legatura, tenere premuto Ctrl (Mac: Cmd) e selezionare l'ultima nota per la legatura;
premere quindi S per aggiungere la legatura.

X inverte la direzione della legatura selezionata.

Legature punteggiate e tratteggiate

Le legature punteggiate sono talvolta usate in pentagrammi per parti con Testo cantato le cui strofe hanno metriche
diverse e richiedono esecuzione di melismi (come la terza strofa dell’esempio sotto riportato). Le legature tratteggiate si
usano anche per indicare un suggerimento dell'editore (al contrario delle marcature originali del compositore). Per
cambiare una legatura esistente in una legatura punteggiata o tratteggiata, selezionarla e poi in “Ispettore” (F8) cambiare
Tipo di linee da Continuo a Punteggiata , Tratteggiata o Tratteggio largo.

Vedere anche

Legatura di valore
Modalità modifica
Inserimento note

Legature di valore

Una legatura di valore è una linea curva che unisce due note con la stessa altezza; indica che devono essere suonate
come un’unica nota di valore pari alla loro somma. (vedere Collegamenti esterni sotto). Le legature di valore collegano
normalmente note adiacenti appartenenti alla stessa voce; MuseScore, in aggiunta, permette anche legature di valore tra
note non adiacenti e tra note appartenenti a voci diverse.

In modalità inserimento note, se si definisce una legatura di valore subito dopo l’inserimento di una nota o di un accordo, il
programma automaticamente genera le corrette note di destinazione opportunamente collegate. In alternativa è possibile
creare una legatura di valore tra due note esistenti anche dopo il loro inserimento.

Nota: Le legature di valore, fatte per unire note della stessa altezza, non devono essere confuse con le legature di
portamento, che collegano note di differenti altezze per indicare legato come modalità di esecuzione.

Aggiungere legature di valore in modalità inserimento note

Il seguente comando aggiunge un accordo legato identico all'accordo selezionato.
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1. Assicurarsi che una nota sia selezionata (cioè evidenziata). Può trattarsi sia di singola nota che parte di un accordo.
2. Selezionare un nuovo valore di durata da assegnare alle note che si genereranno, se necessario (vedere la "Nota"

sotto riportata).

3. Premere + oppure l’apposita icona, .

Nota: Questa scorciatoia funziona, come sopra descritto, solo se non è presente alcun accordo subito dopo la nota
selezionata. In caso contrario (presenza di accordo) la durata viene ignorata e la nota viene collegata alla corrispondente
in altezza dell’accordo seguente.

Aggiungere legature di valore in modalità normale

Metodo 1

1. Selezionare una o più teste di nota nell’accordo di "partenza".

2. Premere +, o l’apposita icona nella barra degli strumenti, :

.

Si creeranno così le legature di valore tra note selezionate e successive disponibili della medesima altezza.

Per rimuovere le legature, a partire da MuseScore 3.3.3, usare lo stesso comando (bivalente: crea/rimuove).

Metodo 2

Questo metodo lega tutte le note nell'accordo "di partenza" (dove possibile):

1. Selezionare il gambo dell’accordo "di partenza";

2. Premere +, oppure cliccare sull’icona legature di valore  nella barra degli strumenti.

Si creeranno così le legature di valore tra tutte le note dell’accordo selezionato e successive disponibili della medesima
altezza.

Per rimuovere le legature, a partire da MuseScore 3.3.3, usare lo stesso comando (bivalente: crea/rimuove).

Aggiungere ulteriori note a un accordo precedentemente legato

Occasionalmente potrebbe essere necessario tornare su un accordo legato esistente per aggiungere una o più note
legate. In questo caso si usa un comando diverso. Per esempio:

1. Aggiungere le note in più al primo accordo. Per esempio:

2. In modalità inserimento note, e tramite selezione di una qualunque delle note del primo accordo, premere Alt++. Le
corrispondenti note vengono aggiunte e legate all’accordo seguente:

Aggiungere legature di valore a note all’unisono

Per creare questo tipo di legature si deve ricorrere a soluzione alternativa:
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1. Inserire la prima nota come al solito;
2. Per semplificare il processo, la nota addizionale che diventerà l’unisono è meglio che sia inserita inizialmente con un

intervallo diverso : esempio: seconda, terza, quarta, ecc.
3. Creare una legatura di accordo (come mostrato sopra); esempio:

4. Spostare la nota unisono in posizione; esempio:

Capovolgere una legatura di valore

X capovolge la direzione della legatura selezionata, da sotto a sopra la nota e viceversa.

Vedere anche

Legatura di portamento

Collegamenti esterni

How to create ties leading into a 2nd ending  (MuseScore HowTo)
Legatura di valore  su Wikipedia

Tremolo

Il Tremolo è la ripetizione rapida di una nota o di un accordo, o una rapida alternanza tra due note o accordi. I simboli del
Tremolo si trovano nella relativa tavolozza nell’ area di lavoro Avanzata: sono possibili tremoli sia di una nota che di due.

Il tremolo di una nota o di un accordo è indicato da tratti inclinati che attraversano il gambo della nota o dell’accordo
(oppure sopra/sotto in caso di nota intera senza gambo). Esempio:

Nel tremolo di due note o due accordi, i tatti inclinati si collocano tra le note interessate. Esempio:

I simboli di Tremolo sono inoltre utilizzati per annotare i rulli di tamburo.

Aggiungere un Tremolo

Tremolo di singola nota/accordo

1. Se a una singola nota, selezionare la nota; se di accordo, selezionare una nota qualsiasi nell’accordo;
2. Cliccare sul simbolo desiderato nella tavolozza Tremolo (doppio click nelle versioni precedenti la 3.4).

In alternativa, è possibile trascinare il simbolo di tremolo sulla nota a cui è applicabile.

Tremolo di due note/accordi

1. Inserire le note con durata pari alla metà della durata finale desiderata;
2. Se a una singola nota, selezionare la prima nota della coppia; se un accordo, selezionare una qualsiasi nota del

primo accordo;
3. Cliccare sul simbolo desiderato nella tavolozza Tremolo (doppio click nelle versioni precedenti la 3.4).

In alternativa, è possibile trascinare il simbolo di tremolo sulla nota a cui è applicabile.

Esempio: Per inserire un tremolo a due note con durata complessiva di 2/4 (minima), inserire due note da 1/4 quarto
(semiminima). Dopo l’applicazione del simbolo di tremolo alla prima nota, i valori delle note verranno automaticamente
duplicati al fine di ottenere la corretta rappresentazione grafica.
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Collegamenti esterni

Tremolo
How to create 'old style' and other special tremolos?  (MuseScore HowTo)

Gruppi irregolari

I Gruppi irregolari vengono utilizzati per scrivere ritmi al di là delle divisioni di battito normalmente consentite
dall’indicazione metrica. Per esempio, una terzina consiste in tre note nel tempo di due:

E una duina consiste in due note nel tempo di tre:

Creare un gruppo irregolare

L'esatto metodo di inserimento dei gruppi irregolari dipende dalla modalità - Modalità normale oppure Modalità inserimento
note - che si sta utilizzando. Inizieremo con un semplice esempio: la creazione di una terzina di ottavi (o crome).

Creare una terzina in modalità normale

1. Selezionare una nota o una pausa che abbia la durata complessiva del gruppo irregolare che si vuole inserire. Nel
caso di una terzina di ottavi, occorrerà selezionare una nota o una pausa di un quarto (o semiminima), come
nell'esempio qui sotto:

2. Premere la combinazione da tastiera per la terzina, Ctrl+3 (Mac: Cmd+3); in alternativa usare il menu, Aggiungi→Gruppi
irregolari→Terzina. Si otterrà il seguente risultato:

3. Il programma passa automaticamente alla modalità di inserimento note e seleziona la durata più appropriata, in
questo esempio un ottavo. Ora inserire la serie di note/pausa desiderata. Per esempio:

Creare una terzina in modalità inserimento note

1. Assicurarsi di essere in modalità inserimento note (premere N).
2. Navigare fino alla nota/pausa (o battuta vuota) dove si desidera inserire la terzina (utilizzare le frecce sinistra/destra

se necessario).
3. Selezionare la durata complessiva della terzina. Nel caso di terzina di crome, cliccare sulla semiminima nella barra

di strumenti inserimento note (oppure premere 5 sulla tastiera).
4. Premere la combinazione da tastiera per la terzina, Ctrl+3 (Mac: Cmd+3); in alternativa, usare il menu, Aggiungi→Gruppi

irregolari→Terzina. Si otterrà la predisposizione della terzina (caratterizzata da numero note e parentesi di
raggruppamento) ancora da completare, con appropriata divisione della nota/pausa originale (vedere l'immagine al
precedente punto 2).

5. Il programma seleziona automaticamente la durata più appropriata - in questo esempio una croma - consentendo di
iniziare immediatamente ad inserire la serie di note/pause che si desiderano.

Creare altri gruppi irregolari

Per creare altri tipi di gruppi irregolari sostituire uno dei seguenti comandi al passo pertinente di cui sopra:

Premere Ctrl+2–9 (Mac: Cmd+2–9). 2 per una duina, 3 per una terzina, etc.
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Dal menu, selezionare Aggiungi→Gruppi irregolari, quindi cliccare sulla opzione desiderata.

Per i casi più complessi vedere sotto.

Gruppi irregolari personalizzati

Per creare altri gruppi irregolari, oltre quelli predisposti già presenti, ad esempio 13 sedicesimi (semicrome) nello spazio di
un quarto (semiminima):

1. In Modalità inserimento note, selezionare una nota con durata pari a quella totale del gruppo irregolare; oppure, se
in Modalità normale, selezionare una nota o una pausa della durata complessiva desiderata;

2. Aprire la finestra di dialogo Crea gruppo irregolare dal menu: Aggiungi→Gruppi irregolari→Altri...;

3. Selezionare il rapporto numerico desiderato (ad esempio 13/4 per tredici sedicesimi nello spazio di un quarto di
nota) sotto "Rapporto" nella sezione "Tipo". Specificare “Numero” e "Quadra" (N.d.T.: molto meglio “Parentesi”,
come nell’Ispettore) utilizzando i pulsanti di opzione nella sezione "Formato";

4. Cliccare OK per chiudere la finestra di dialogo:

5. Inserire la serie di note/pause desiderata.

Esempi di terzine
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Cancellare un gruppo irregolare

Usare uno dei seguenti modi:

Selezionarne il numero o la parentesi e premere Canc.
Selezionare l’intero gruppo irregolare, utilizzando il metodo Maiusc + click, quindi premere Canc.
Selezionare un elemento qualsiasi del gruppo irregolare, poi in Ispettore, nell’angolo in basso a destra, premere il
pulsante “Gruppo irregolare”, infine premere Canc.

Cambiare visualizzazione dei gruppi irregolari

Tramite l’Ispettore

Per cambiare le proprietà di visualizzazione dei gruppi irregolari nella partitura, selezionarne i numeri o le parentesi, e
regolare le proprietà desiderate nella sezione "Gruppo irregolare" dell’Ispettore:

Direzione: 'Automatico' colloca parentesi e numero nella posizione di default. 'Su' colloca sempre parentesi/numero
sopra le teste delle note; 'Giù' colloca sempre parentesi/numero sotto le teste delle note.
Tipo di numero: Scelta di 'Numero', 'Rapporto', o 'Nessuna'.
Tipo di parentesi: 'Automatico' nasconde la parentesi per le note già collegate da travatura e mostra la parentesi se
il gruppo irregolare include note senza travatura o pause. 'Quadra' visualizza la parentesi. 'Nessuna' nasconde la
parentesi.

Tramite la finestra di dialogo Stile

Per effettuare regolazioni fini alle caratteristiche di visualizzazione di tutti i gruppi irregolari nella partitura: dal menu,
selezionare Formato → Stile→Gruppi irregolari.

La legenda sotto riportata illustra alcune delle proprietà che possono essere regolate nella finestra di dialogo dello stile dei
Gruppi irregolari:
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(2) Distanza verticale dal gambo.
(3) Distanza verticale dalla testa della nota.
(5) Distanza prima del gambo della prima nota.
(6) Distanza dopo il gambo dell'ultima nota.

Collegamenti esterni

How to create triplets and other tuplets  (MuseScore HowTo)
How to create nonstandard tuplets  (MuseScore HowTo)
How To create triplets and other tuplets across measures  (MuseScore HowTo)
Tuplet  at Wikipedia
The User Guide to Tuplets in MuseScore  [video]

Ripetizioni e salti

Ripetizioni semplici

Si può creare una ripetizione semplice mettendo una stanghetta di inizio ritornello e una di fine ritornello all'inizio e
alla fine di un passaggio. Queste possono essere applicate dalle tavolozze Stanghette oppure Salti e Ripetizioni.

Nota: Se l'inizio di una ripetizione coincide con l’inizio di un brano o di una sezione, la stanghetta di inizio ripetizione può
essere omessa, se lo si desidera. Allo stesso modo, una stanghetta di fine ripetizione può essere omessa alla fine di una
partitura o sezione.

Finali 1° e 2°

Dapprima creare una ripetizione semplice (come mostrato sopra), poi applicare i finali di prima e seconda volta - vedere
Volta.

Riproduzione sonora

Attivare/disattivare la riproduzione ripetuta

Attivare il pulsante/icona "Riproduci le ripetizioni"  nella barra degli strumenti.

Regolare la riproduzione sonora di sezioni ripetute

Ripetizioni semplici, come quelle illustrate sopra, o sezioni "1, 2" volta, di solito vengono riprodotte correttamente al primo
tentativo. Ripetizioni più complesse possono richiedere ulteriori regolazioni come segue:

1. Assicurarsi che le stanghette di inizio e fine siano posizionate correttamente. Per una sezione di volta, assicurarsi
che ogni volta, tranne l'ultima, termini con una stanghetta di ripetizione finale.

2. Nel caso di una ripetizione semplice, per la quale è necessaria più di una ripetizione, cliccare con il tasto destro
del mouse sulla battuta che contiene la stanghetta di fine ripetizione e selezionare Proprietà battuta. Regolare
Conteggio ripetizione così che sia uguale al numero di volte che si desidera la ripetizione sonora della sezione.

3. Nel caso sezioni di volta complesse, come la seguente:

Assicurarsi che "Elenco ripetizioni" in sezione Volta dell’Ispettore sia corretto - vedere Proprietà di Volta. Cliccare
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con il tasto destro del mouse sulla battuta che contiene la stanghetta di ripetizione finale e selezionare Proprietà
della battuta. Regolare Conteggio ripetizione in modo che sia maggiore di una volta rispetto al numero di battute
elencate nell’ “Elenco ripetizioni” di Volta. In questo caso, poiché sono elencate 5 misure, il "Conteggio ripetizione"
deve essere impostato a 6.

Simboli di ripetizione e testo

I testi e simboli relativi alle ripetizioni si trovano nella tavolozza "Salti e Ripetizioni" (nelle aree di lavoro Essenziale e
Avanzata). Questa tavolozza contiene:

Simboli per ripetizione di battuta, Segno, Variazione Segno (Serpente), Coda e Variazione Coda (Codetta)
Test: D.S., D.C., al Coda, al Fine, To Coda, e Fine
Stanghette di ripetizione

Per aggiungere un simbolo di ripetizione allo spartito usare uno dei seguenti modi:

Selezionare una battuta, quindi cliccare sul simbolo di ripetizione desiderato nella relativa tavolozza (doppio clic
nelle versioni precedenti la 3.4).
Trascinare e rilasciare un simbolo di ripetizione dalla tavolozza sulla battuta desiderata (non sopra!) (in modo che la
misura cambi colore).

Salti

I Salti sono simboli nella partitura che indicano al musicista di saltare a un marcatore nominato (vedere avanti). I Salti
includono i vari tipi di testo D.C. (Da Capo) e D.S. (Dal Segno).

Per impostare la corretta riproduzione sonora dei salti:

Assicurarsi che il pulsante/icona "Riproduci le ripetizioni"  nella barra degli strumenti sia selezionato. È di tipo
“interruttore” e quindi, cliccando lo stesso pulsante, la riproduzione sonora può essere interrotta.

Dopo il salto, e seguendo le convenzioni stabilite, viene riprodotto solo l’ultimo ciclo di qualsiasi sezione di
ripetizione semplice. Se si vuole che la riproduzione sonora riprenda queste ripetizioni per intero:

1. Selezionare il simbolo di salto applicabile;
2. Nella sezione "Salta" dell’Ispettore, spuntare "Riproduci le ripetizioni".

Nota: I salti vengono eseguiti solo dopo che tutte le ripetizioni semplici della sezione sono state suonate.

Se si clicca su un salto, nella sezione Salta dell’Ispettore vengono visualizzate alcune caselle di testo e di spunta. Hanno i
seguenti effetti sulla riproduzione sonora:

Vai a: La riproduzione sonora salta al marcatore la cui "Etichetta" è uguale a quella qui indicata.
Suona fino a: La riproduzione sonora continua fino al raggiungimento del marcatore la cui "Etichetta" è uguale a
quella qui indicata.
Continua a: La riproduzione sonora salta al successivo marcatore la cui "Etichetta" è uguale a quella qui indicata.

Riproduci le ripetizioni: Spuntando questa casella si dice a MuseScore di suonare le ripetizioni dopo i salti D.C.
(Da Capo) o D.S. (Dal Segno). Se questa casella non è spuntata le Ripetizioni semplici non vengono riprese dopo i
salti e la riproduzione si comporta come se fosse l'ultima ripetizione.

Nota: I tag (indicatori) start e end, che si riferiscono a inizio e fine partitura o sezione, sono impliciti e non hanno
bisogno di essere aggiunti dall'utente.

Marcatori

I Marcatori sono le posizioni stabilite in partitura a cui fanno riferimento i salti. Segue un elenco di marcatori (in aggiunta
agli impliciti "start" e "end"):
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: Segno (tag: segno)

: Segno Variazione (tag: varsegno)

: Coda (tag: codab)

: Coda Variazione (tag: varcoda)
Fine: (tag: fine)
To Coda: (tag: coda)

Cliccando su un marcatore, nella sezione Marcatore dell’Ispettore appaiono le seguenti proprietà:

Tipo di marcatore: Questo può essere cambiato dall'elenco a discesa, se necessario.
Etichetta: Questo è il tag (identificatore) associato al marcatore. Vedere anche, Salti (sopra esposto).

Esempi di salti

Da Capo (D.C.): Al segno "D.C.", la riproduzione sonora “salta” all’inizio (cioè all’implicito tag start) ripetendo l’intera
partitura o sezione (cioè fino al successivo implicito tag end).
Da Capo (D.C.) al Fine: Al segno "D.C. al Fine", la riproduzione sonora salta all’inizio (cioè all’implicito tag start) e
suona la partitura fino a Fine (cioè al tag fine).
Dal Segno (D.S.) al Fine: Al segno "D.S. al Fine", la riproduzione sonora salta al simbolo Segno (cioè al tag segno)
e suona fino a Fine (cioè al tag fine)
Dal Segno (D.S.) al Coda: Al segno "D.S. al Coda", la riproduzione sonora salta al simbolo Segno (cioè al tag
segno) e suona fino a To Coda (cioè al tag coda); continua poi fino al simbolo Coda (cioè al tag codab).

Nota: Le proprietà (cioè i nomi di tag) dei salti e dei marcatori possono essere impostate tramite Ispettore.

È necessario modificarli se si usano più salti e marcatori.

Vedere anche

Stanghette
Volta

Collegamenti esterni

MuseScore in Minutes: Repeats and Endings, part 2  (video tutorial)
How to separate a coda from the rest of the score  (MuseScore HowTo)
How to create a 2-measure repeat sign with playback  (MuseScore HowTo)
How to use Jumps and Repeats  (MuseScore HowTo)

Volta

Le parentesi di Volta, o quelle di finale primo e secondo, sono linee utilizzate per contrassegnare finali diversi per una
ripetizione semplice. La riproduzione sonora della partitura segue automaticamente le indicazioni di ripetizione.

Aggiungere una Volta alla partitura

Usare uno dei seguenti metodi:

Selezionare una battuta, o un intervallo di battute e cliccare una icona di Volta nella Tavolozza Linee (doppio clic
nelle versioni precedenti la 3.4).
Trascinare una linea di volta dalla tavolozza Linee, quindi regolarne la lunghezza come richiesto (vedere sotto).
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Cambiare il numero di battute comprese in una linea di Volta

1. Andare sulla Volta in modalità modifica. La maniglia finale viene selezionata automaticamente.
2. Premere Maiusc+→ per spostare la maniglia finale avanti di una battuta. Premere Maiusc+← per spostare la maniglia

indietro di una battuta. Ripetere se necessario.

Nota: Quando si seleziona un inizio o un fine maniglia, appare una linea tratteggiata che la collega a un punto di
ancoraggio sul pentagramma (vedere diagramma sotto riportato). Questo ancoraggio indica la posizione dei punti di
inizio/fine della riproduzione sonora nella Volta. I comandi Maiusc sopra descritti cambiano il punto di ancoraggio in modo
che la riproduzione sonora rimanga sempre in sincronia con i punti visivi di inizio/fine. Per effettuare regolazioni fini a
questi punti visivi di inizio/fine, senza influire sulla riproduzione sonora, usare altri comandi da tastiera, oppure trascinare
le maniglie con il mouse.

Proprietà di Volta

Per apportare modifiche al testo di Volta:

Selezionare la linea di volta, e modificare le proprietà nella sezione Dettagli linea di testo dell’ Ispettore.

Per specificare l’ordine delle ripetizioni:

Selezionare la linea di volta, e in "Elenco ripetizioni" (sezione Volta dell’Ispettore) digitare un numero, o una
sequenza di numeri separati da virgole, per indicare la/le ripetizione/i in cui la Volta sarà riprodotta.

Per esempio, un finale primo mostra il numero "1"; un finale secondo, il numero "2" e così via. Sono possibili anche
ripetizioni più complesse: per esempio, un "Elenco ripetizioni" che mostra "1, 2, 4, 5, 7" indica che la Volta deve essere
suonata durante le ripetizioni 1, 2, 4, 5, e 7, e così via.

Nota: Ogni sezione di Volta, eccettuata quella finale, deve terminare con una stanghetta di ripetizione finale.

Riproduzione sonora

A volte una ripetizione suona più di due volte. Se si vuole cambiare il numero di volte che MuseScore suona una
ripetizione, andare alla battuta che contiene la stanghetta di ripetizione finale e cambiare il campo "Conteggio ripetizione".
Vedere Operazioni sulle battute: Altre proprietà e il capitolo sulla riproduzione sonora per Volta in Ripetizioni e salti.

Conteggio ripetizione
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Il valore del numero in conteggio ripetizione di cui alla battuta con la stanghetta di ripetizione finale deve essere maggiore
di uno rispetto al numero di volte che la battuta deve essere suonata (di solito è uguale al numero di valori presenti
nell’Elenco ripetizioni della sezione Volta + 1).

Analizzando la seguente parte:

La battuta 4 dovrebbe avere “Conteggio ripetizione” = 4
La battuta 6 dovrebbe avere “Conteggio ripetizione” = 3

Collegamenti esterni

MuseScore in Minutes, Lesson 8: Repeats and Endings, Part 1
How to create ties leading into a 2nd ending  (MuseScore HowTo)

Trasposizione

La Trasposizione è l'atto di alzare o abbassare l'altezza di una selezione di note dello stesso intervallo. Si può scegliere
di trasporre note sia manualmente sia utilizzando la finestra di dialogo Trasporto.

Trasposizione manuale

1. Selezionare le note che si vogliono trasporre;
2. Usare una delle seguenti opzioni:

Per trasporre cromaticamente: Premere ↑ oppure ↓. Ripetere se necessario.
Per trasporre diatonicamente; Premere Alt+Maiusc+↑ oppure ↓. Ripetere se necessario.
Per trasporre di un’ottava: Premere Ctrl+↑ oppure ↓ (Mac: Cmd+↑ or ↓).

Trasposizione automatica

La finestra di dialogo Trasporto di MuseScore offre più opzioni per la trasposizione delle note.

Nota: Per impostazione predefinita questa finestra di dialogo si apre dal menù Attrezzi, ma è possibile scegliere di aprirla
assegnandole una scorciatoia da tastiera (vedere Preferenze).

Trasposizione Cromatica
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Alla tonalità

Per trasporre le note su o giù alla tonalità desiderata:

1. Selezionare le note che si vogliono trasporre; nessuna selezione equivale a "seleziona tutto".
2. Dalla barra dei menù selezionare Attrezzi → Trasporto.
3. Selezionare "Trasponi Cromaticamente" e "Alla tonalità".
4. Selezionare/deselezionare "Trasporta la tonalità" (N.d.T.: meglio “Aggiorna armatura di chiave”) e "Trasporta le sigle

accordali" se necessario.
5. Selezionare la "Tonalità più vicina", "Su" oppure "Giù" e scegliere la tonalità di destinazione dal menù a tendina.
6. Cliccare OK.

Per Intervallo

Per trasporre su o giù le note selezionate con incrementi di semitono:

1. Selezionare le note che si vogliono trasporre; nessuna selezione equivale a "seleziona tutto".
2. Dalla barra dei menù selezionare Attrezzi → Trasporto.
3. Selezionare "Trasponi Cromaticamente" e "Per intervallo".
4. Selezionare/deselezionare "Trasporta la tonalità" (N.d.T.: meglio “Aggiorna armatura di chiave”) e "Trasporta le sigle

accordali" se necessario.
5. Selezionare "Su" o "Giù” e scegliere un intervallo di trasposizione dal menù a tendina.
6. Cliccare OK.

Trasposizione Diatonica

Per trasporre su o giù le note selezionate di un intervallo diatonico:

1. Selezionare le note che si vogliono trasporre; nessuna selezione equivale a "seleziona tutto".
2. Dalla barra dei menù scegliere Attrezzi → Trasporto.
3. Selezionare "Trasponi diatonicamente".
4. Selezionare/deselezionare "Mantieni grado alterazioni" e "Trasponi le sigle accordali" se necessario.
5. Selezionare "Su" o "Giù" e selezionare un intervallo di trasposizione dal menù a tendina.
6. Cliccare OK.

Opzioni

Nell’area delle Opzioni sono disponibili due scelte utilizzabili per entrambe le modalità di trasposizione cromatica e
diatonica:

Trasponi le sigle accordali, se necessario,
e la scelta Usa doppi ♯ e ♭ oppure Solo ♯ e ♭ singoli

Strumenti traspositori

Gli strumenti traspositori, come la tromba in SI bemolle o il sax alto in MI bemolle, suonano note più basse o più alte
rispetto a quelle scritte sulle loro parti. MuseScore dispone di diverse caratteristiche volte a facilitare la redazione di
partiture per questi strumenti.

Tonalità “da concerto”

La modalità di visualizzazione predefinita di MuseScore mostra la notazione musicale in tonalità scritta (N.d.T.:
Trasposta o “da concerto”); è però possibile visualizzare la parte in tonalità reale (Partitura in DO). In quest’ultimo modo,
la notazione musicale di tutti gli strumenti corrisponderà con le altezze reali che si sentono in riproduzione.

Per fissare la visualizzazione in tonalità reale: Premere il pulsante Partitura in Do per metterlo in risalto.

Prima di stampare la partitura principale o qualsiasi parte, assicurarsi che il pulsante “Partitura in Do” sia OFF.

Cambiare la trasposizione di un pentagramma

Le trasposizioni degli strumenti sono già impostate in MuseScore. Comunque, in presenza di uno strumento raro o di una
trasposizione non disponibile in MuseScore, potrebbe sorgere l’esigenza di modificare manualmente la trasposizione
dello strumento.

1. Cliccare con il tasto destro del mouse su una parte vuota del pentagramma dello strumento e selezionare Proprietà
Pentagramma/Parte.

2. Nella parte inferiore della finestra, selezionare l'intervallo di trasposizione, eventuali spostamenti di ottava, e se
l'intervallo è "Su" (suona più alto di quanto scritto) o "Giù" (suona più basso di quanto scritto).

È inoltre possibile utilizzare il pulsante Cambia strumento… nella finestra “Proprietà Pentagramma/Parte” per adeguare
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automaticamente la trasposizione a quella di un diverso strumento standard.

Collegamenti esterni

How to transpose  (MuseScore How-To)
Concert pitch or not?  (forum discussion)
How to change enharmonic key signatures for transposing instruments  (MuseScore How-To)

Intavolature

La musica per strumenti tastati a corde viene comunemente scritta utilizzando un'intavolatura, nota anche come tab la
quale fornisce una rappresentazione visuale delle corde e delle cifre di tasto:

L'Intavolatura può essere anche combinata con la notazione rotonda tradizionale:

Creare un nuovo rigo d'Intavolatura

Se desiderate creare un'intavolatura come parte di una nuova partitura, utilizzate la Procedura guidata nuova partitura. Se
volete aggiungere un'intavolatura ad una partitura esistente, utilizzate la finestra Strumenti dialog. Oppure, in altrenativa,
potete convertire un rigo standard esistente. Si veda sotto per dettagli.

Con la procedura guidata nuova partitura

Per creare un'intavolatura in una nuova partitura (per l'accollatura combinata rigo/intavolatura vedi → sotto):

1. Aprire la Procedura guidata nuova partitura.
2. Immettere i dettagli della partitura. Click Successivo.
3. Nella pagina Seleziona file modello , click su Scegli strumenti sotto "Comuni".
4. Nella pagina Strumenti, scegliere l'intavolatura voluta nella categoria "Strumenti a pizzico", nella colonna di sinistra.

Quindi click su Aggiungi alla partitura .
5. Completare il resto della Procedura guidata nuova partitura.

Nota: se l'intavolatura voluta non fosse disponibile nella lista Scegli strumenti, aggiungere comunque un rigo
d'intavolatura di cui al punto 4 sopra. Quindi modificare l'Intavolatura come necessario utilizzando la finestra Proprietà
Rigo/Parte.

Con la finestra Strumenti

Per aggiungere un singolo rigo d'intavolatura ad una partitura esistente (per l'accollatura combinata rigo/intavolatura vedi
→ sotto):

1. Aprire la finestra Strumenti (premereI; o dalla barra dei menù, scegliere Modifica → Strumenti…).
2. Fare clic sul rigo cui si vuole aggiungerne un altro (collegato o meno)
3. Aggiungere il rigo di intavolatura come descritto in Aggiungi strumenti ("Crea nuova partitura").

Cambiando tipo di rigo

Per convertire un rigo standard esistente in un'intavolatura, oppure un'intavolatura in un rigo standard:

1. Click-destro sul rigo e scegliere Proprietà Rigo/Parte…. Se "Strumento" è già impostato nel tipo per strumenti a pizzico,
allora andare al punto 3.

2. Se "Strumento" non è del tipo a pizzico, click su Cambiare strumento e scegliere lo strumento appropriato da "Strumenti
a pizzico".
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3. Click sul bottone Stile, proprietà avanzate, scegliere le opportune opzioni dell'intavolatura da "Modelli", quindi premere <
Ripristino a modello. Si può raffinare l'aspetto se necessario utilizzando le schede "Capotasti" and "Valori della nota".

4. Click OK due volte per uscire.

Modificare i dati delle corde

Cambiare l'accordatura

Nota: Volendo solamente vedere (anziché cambiare) l'accordatura dello strumento, seguire solamente i punti 1 e 2.

1. Click destro sul rigo e scegliere Proprietà Rigo/Parte….

2. Premere il pulsante Modifica dati corda… in basso nel riquadro di dialogo. Si aprirà la finestra Modifica dati corda:

3. Click sull'altezza della corda e scegliere Modifica Corda…. O, in alternativa, semplicemente doppio-click sull'altezza
della corda.

4. Scegliere la nuova altezza nel riquadro Seleziona Nota e click su OK. O, in alternativa, semplicemente doppio-click
sulla nuova altezza.

5. Click OK per chiudere la finestra "Dati corda". Quindi click OK per chiudere la finestra "Proprietà Rigo/Parte".
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Note: (1) Cambiando l'accordatura quando l'intavolatura per quello strumento contiene già delle note, le cifre di tasto
verranno adeguate automaticamente (se possibile); (2) Qualsiasi cambio di accordatura di un dato strumento ha effetto
solamente per la partitura in elaborazione, e non cambierà nessuna impostazione predefinita del programma.

Aggiungere una corda

1. Click destro sul rigo, scegliere Proprietà Rigo/Parte…, quindi premere Modifica dati corda.
2. Click sull'altezza della corda e scegliere Nuova corda....
3. Scegliere la nuova altezza e premere OK—o, in alternativa, basterà fare doppio click nuova altezza. La nuova corda

verrà inserita sotto la corda selezionata.

Nota: Dopo aver aggiunto una corda dell'intavolatura si dovrà modificare il numero di linee nella finestra Proprietà
Rigo/Parte.

Cancellare una corda

1. Click destro sul rigo, scegliere Proprietà Rigo/Parte…, quindi premere Modifica dati corda.
2. Click sull'altezza della corda e scegliere Cancella corda.

Note: Dopo aver cancellato una corda dell'intavolatura si dovrà modificare il numero di linee nella finestra Proprietà
Rigo/Parte.

Marcare una corda libera come "vuota"

Questa funzionalità è utilizzata per definire una corda (bassa) come vuota (p.es. come le corde dell'arpa, suonate
solamente a corda vuota): come nel Liuto barocco o nella Tiorba ecc. Ciò vuol dire che verranno accettati come cifre di
tasto solo "0" (zero) opp. "a": ogni altra cifra di tasto verrà convertita in 0/a.

1. Click destro sul rigo, scegliere Proprietà Rigo/Parte…, quindi premere Modifica dati corda.
2. Spuntare una o più caselle della colonna "Vuota".

Cambiare il numero di tasti dello strumento

Questa proprietà definisce la cifra massima di tasto che può essere scritta su un dato rigo d'intavolatura.

1. Click destro sul rigo, scegliere Proprietà Rigo/Parte…, quindi premere Modifica dati corda.
2. Scegliere o inserire un nuovo numero nella casella di selezione "Numero di tasti".

Cambiare l'aspetto di un'intavolatura

Da Proprietà Rigo/Parte…

Per accedere a tutta la gamma di opzioni per l'aspetto di un'intavolatura utilizzare la finestra Proprietà Rigo/Parte:

1. Click-destro sul rigo e scegliere Proprietà Rigo/Parte….
2. Click sul bottone Stile, proprietà avanzate….

Dalla finestra Strumenti

Alcune delle fondamentali opzioni di aspetto sono accessibili dalla finestra di dialogo: Strumenti

1. Premere la scorciatoia da tastiera I; o dalla barra dei menù, scegliereModifica → Strumenti….
2. Scegliere un tipo intavolatura dalla lista a discesa "Tipo di rigo" nel pannello di destra:

Semplice: Mostra solo i tasti. Indicata per un'accollatura rigo/intavolatura.
Comune: Mostra tasti, gambi e travature.
Completa: Mostra tasti, gambi, travature e pause.
Intav. 6 corde. Italiana/Francese: opzioni per l'intavolatura storica per Liuto.

Le medesime opzioni sono disponibili nella pagina Scegli strumenti della Procedura guidata nuova partitura.

Combinare il rigo pentagramma con l'intavolatura

Gli strumenti a corde pizzicate — come la chitarra — sono comunemente notati usando sia un rigo pentagramma che
un'intavolatura (TAB) simultaneamente. MuseScore offre la possibilità di avere i due righi musicali sia non collegati che
collegati:

1. Righi non collegati: Il vantaggio di usare questa opzione è che ogni rigo può essere modificato indipendentemente.
Per trasferire la notazione musicale da un rigo all'altro, l'intervallo desiderato, selezionare la regione desiderata e
quindi fare copia e icolla sull'altro.

2. Righi collegati: I righi si "aggiornano reciprocamente": vale a dire che qualsiasi modifica apportata alla notazione in
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un rigo viene immediatamente applicata anche all'altro.

Note con cifra di tasto in conflitto: Quando in due voci diverse è inserita la stessa nota, MuseScore cerca di assicurarsi
che le cifre dei tasti non si sovrappongano sulla stessa corda. Eventuali sovrapposizioni che si dovessero verificare
saranno contrassegnate da quadrati rossi: questi appariranno solo nella finestra del documento e non su alcuna copia a
stampa. In quasi tutti i casi (p. es. i tasti da 0 a 4 sulla sesta corda), la sovrapposizione è il risultato desiderato e non sono
necessarie ulteriori aggiustamenti. I segni di cifre rossi si possono nascondere selezionando " Visualizza" e togliendo il
segno di spunta a " Mostra elementi non stampabili"

Creare una nuova coppia rigo pentagramma/intavolatura con la Procedura guidata nuova partitura

1. Aprire la Procedura guidata nuova partitura.
2. Inserire i dettagli della partitura (opzionale). Click Successivo.
3. Nella pagina Seleziona file modello , click su Scegli Strumenti sotto "Generale".
4. Selezionare un rigo musicale (non intavolato) nella sezione "Strumenti a pizzico" della colonna di sinistra. Quindi

click su Aggiungi alla partitura .
5. Nella colonna di destra, click sulla riga con etichetta "Rigo 1", appena creata. Questo attiva le opzioni "Aggiungi

rigo/Aggiungi rigo collegato" :
Click su Aggiungi rigo per creare una coppia rigo pentagramma/ intavolatura non collegati.
Click su Aggiungi rigo collegato  per creare una coppia rigo pentagramma/ intavolatura collegati.

6. Nella colonna Tipo di rigo, click sulla lista a discesa del rigo appena creato e scegliere un'intavolatura fra le possibili
(questa scelta potrà essere modificati successivamente, se necessario, nella pagina della partitura —vedi Proprietà
Rigo/Parte).

7. Se necessario, cambiare l'ordine dei righi utilizzando il pulsante ↑.
8. Completare il resto della Procedura guidata nuova partitura, o click su Fine.

Note: Per creare righi non collegati con canali mixer distinti mixer, invece del passo "5" (sopra), scegliere un Rigo
intavolato nella colonna di sinistra, poi click su Aggiungi alla partitura . Quindi continuare coi passi 6 e 7.

Creare una nuova coppia rigo pentagramma/intavolatura in una partitura esistente

1. Aprire l'editor Strumenti (premere I, o dalla barara dei menu, scegliereModifica → Strumenti…).
2. Quindi seguire i passi 4–8 sopra.

Creare una nuova coppia rigo pentagramma/intavolatura da un rigo esistente

Per aggiungere un'intavolatura a un rigo per strumento a pizzico in partitura (o viceversa):

1. Aprire l'editor Strumenti (premere I, o dalla barara dei menu, scegliereModifica → Strumenti…).
2. Nella colonna di destra, scegliere il rigo da cui si voglia creare la coppia rigo pentagramma/intavolatura, quindi

seguire una delle possibilità di cui al passo 5 sopra.
3. Continuare con i passi 6-8 qui sopra.

Inserire note nell'intavolatura

Con la tastiera del computer

1. In Modalità normale, selezionare una battuta o una nota esistente da cui iniziare l'inserimento note.
2. Passare alla modalità Inserimento note (N): un corto 'rettangolo blu' appare attorno ad una corda dell'intavolatura:

questa è la corda corrente.
3. Scegliere la durata della nota o pausa che volete inserire (vedi sotto).
4. Premere i tasti freccia su/giu per spostare il cursore sulla corda voluta. Utilizzare i tasti freccia sinistra/destra per

navigare nella partitura.

5. Premere da 0 a 9 per inserire una cifra di tasto fra 0 e 9 sulla corda corrente; per inserire cifre di tasto numeriche a
più cifre premere ciascuna cifra numerica in sequenza. Possono inoltre essere utilizzati i tasti da A a K (eccetto I):
sono convenienti quando si lavora con l'intavolatura francese. Per L , M, N, utilizzare la tastiera alfanumerica e
digitare rispettivamente 10, 11, 12... (Nota: non è possibile inserire una cifra di tasto di valore maggiore di "Numero di
tasti" quale impostato nella finestra Modifica dati corda).

Premere ; (punto e virgola) per inserire una pausa della durata selezionata.

6. Si possono inserire note nelle diverse voci se necessario— esattamente come si farebbe per un rigo standard.

Vedi anche, Modificare le note (sotto).

Intavolature storiche

È supportata la notazione d'epoca per corde basse (liuti e sim.):

Intavolatura francese: lettere con premesse barrette di taglio tipo slash proprio sotto il corpo dell'intavolatura: p.es.
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7a corda: "a", 8a corda: "/a", 9a corda: "//a" e così via, tutte in prima posizione sotto il corpo dell'intavolatura.

Intavolatura italiana: numeri con tagli 'addizionali' come segmenti di corda sopra il corpo dell'intavolatura: p.es. 7a
corda: "0" una posizione sopra il corpo dell'intavolatura con un taglio 'addizionale'; 8a corda: "0" due posizioni sopra
il corpo dell'intavolatura con due tagli 'addizionali e così via.

L'inserimento delle cifre di tasto si fa solo con la tastiera del computer, spostando il cursore di inserimento-nota sotto
(francese), o sopra (italiano), al corpo della intavolatura; le barrette o i tagli 'addizionali' indicheranno la corda di
destinazione a cui verrà applicata la cifra; premendo la cifra del tasto, verrà inserita (e disposta) la nota su quella corda.

Con il mouse

Per inserire note nell'intavolatura col mouse:

Entrare nella modalità inserimento note e scegliere la durata della nota o pausa (vedi sotto).
Click su una corda per creare lì una nota. Le note sono inizialmente create sul tasto 0 (opp. a per l'intavolatura
francese): per correggerlo digitare la cifra giusta sulla tastiera.
Si può aumentare o diminuire la cifra di tasto con Alt+Maiusc+↑ or Alt+Maiusc+↓.
Si possono immettere note nelle diverse voci  se necessario— esattamente come si farebbe per un rigo standard.

Vedi anche, Modificare le note (Sotto).

Scegliere la durata della nota

In modalità Inserimento note, per impostare nell'intavolatura un valore di durata si può utilizzare uno qualsiasi dei
seguenti metodi:

Premere daMaiusc+1 a Maiusc+9: Imposta le durate dal 128° alla Breve (la disponibilità di queste scorciatoie può
dipendere dalla piattaforma e/o dal layout della tastiera);
Premere da NumPad1 a NumPad9: Imposta le durate dal 128° alla Breve (se c'è il tastierino numerico e BlocNum e
attivato);
Click sull'icona di una durata sulla Barra inserimento note in alto nella finestra del documento;
Premere Q per diminuire una durata selezionata e W per aumentarla.

Modificare le note

Cambiare cifra di tasto

In Modalità Inserimento note:

Posizionare il cursore sopra la cifra del tasto e digitare nuovamente il numero/lettera desiderato.
Incrementare o decrementare la cifra del tasto utilizzando Alt+Maiusc+↑ o Alt+Maiusc+↓ (La cifra del tasto cambia corda
automaticamente, se necessario, per raggiungere la posizione di tasto più bassa possibile).

In Modalità normale:

1. Selezionare una o più cifre di tasto.
2. Utilizzare uno dei seguenti comandi:

Per incrementare o decrementare, senza cambiare corda: Premere ↑ / ↓.
Per incrementare o decrementare, cambiando corda per minimizzare, quando possibile, la cifra di tasto:
Premere Alt+Maiusc+↑ / ↓

Nota: Il valore della cifra di tasto non può essere maggiore di "Numero di tasti" quale fissato nella finestra Modifica dati
corda dialog.

Cambiare il numero di corda

Per spostare la cifra di tasto su una corda adiacente senza cambiare l'altezza (se la corda è libera e può produrre quella
nota):

In modalità Inserimento note:

Posizionare il cursore su una cifra di tasto , e premere Ctrl+↑ / ↓ (Mac: Cmd+↑ / ↓).

In Modalità normale:

Selezionare uno o più cifre di tasto e premere Ctrl+↑ / ↓ (Mac: Cmd+↑ / ↓).
Trascinare una cifre di tasto in alto o in basso su una corda adiacente.

Note stoppate

Per cambiare una cifra di tasto in una nota stoppata:
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1. Selezionare uno o più cifre di tasto (In modalità non inserimento note).
2. Premere Maiusc+X per ciclare fra nota stoppata si/no.

Riepilogo dei comandi da tastiera

Modalità inserimento note

Digitare: per avere:
↑ Seleziona la corda superiore come corrente.
↓ Seleziona la corda inferiore come corrente.
da Maiusc+1 a Maiusc+9 Seleziona una durata (dal 128° alla Breve).
da NumPad 1 a NumPad 9 Seleziona una durata (dal 128° alla Breve).
Q Riduce la durata corrente .
W Aumenta la durata corrente.
da 0 a 9 Inserisce una cifra/lettera di tasto.

da A a K Inserisce una cifra/lettera di tasto
(eccettuatoI).

Alt+Maiusc+↑ Aumenta la cifra di tasto corrente.
Alt+Maiusc+↓ Diminuisce la cifra di tasto corrente.
; (punto e virgola) Inserisce una pausa.

Modalità normale

DIGITARE: PER AVERE:
da 0 a 9 Cambia la durata della nota o pausa selezionata (dal 128° alla Breve)
Alt+Maiusc+↑ Aumenta l'altezza della nota selezionata (MuseScore sceglierà la corda).
↑ Aumenta l'altezza senza cambiare la corda.

Alt+Maiusc+↓
Diminuisce l'altezza della nota selezionata (MuseScore sceglierà la
corda).

↓ Diminuisce l'altezza senza cambiare la corda.
Ctrl+↑ (Mac: Cmd+↑) Muove la nota alla corda superiore, mantenedone l'altezza.
Ctrl+↓ (Mac: Cmd+↓) Muove la nota alla corda inferiore, mantenedone l'altezza.
Maiusc+X Ciclicamente testa di nota stoppata Si/No.

Collegamenti esterni

Video tutorial: MuseScore in Minutes: Lesson 7 - Tablature and Drum Notation

Notazione percussioni

Inserire la notazione delle percussioni è un po' diverso dall'inserire la notazione degli strumenti a corda (come il pianoforte
o il violino).

Tipi di rigo per percussioni

Quando si crea un rigo di percussioni usando Creazione nuova partitura o la finestra dialogo Strumenti, MuseScore
sceglie automaticamente il tipo di rigo più appropriato (1, 3, o 5 linee) per lo strumento: questo può essere cambiato, se
necessario, tramite la colonna “Tipo di rigo" nella pagina Scelta strumenti / Strumenti, modificando il menù a discesa insito
nel relativo campo. Qualsiasi ulteriore cambiamento (per esempio un rigo a 2 linee) può essere fatto dalla partitura stessa
(vedere Stile, proprietà avanzate).

Su un rigo di 5 linee per percussioni, ad ogni strumento viene assegnata una posizione verticale del rigo stesso (linea o
spazio) e una forma di testa di nota. Per un drumset, si possono usare una o due voci. In quest'ultimo caso, la voce 1 (la
voce superiore) di solito contiene note (con gambi verso l’alto) suonate dalle mani mentre la voce 2 (la voce inferiore) di
solito contiene note (con gambi verso il basso) suonate dai piedi (vedi immagine sotto).

Metodi di inserimento note

È possibile aggiungere note a un rigo di percussioni da uno qualsiasi dei seguenti elementi:
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Tastiera MIDI esterna;
Tastiera Pianoforte (virtuale);
Tastiera del computer;
Mouse.

Questi metodi possono essere utilizzati in qualsiasi combinazione desiderata:

Tastiera MIDI

Per aggiungere note a un rigo per percussioni da una tastiera MIDI:

1. Assicurarsi che la tastiera MIDI sia collegata e funzioni correttamente.

Nota: Se si clicca sul rigo delle percussioni senza entrare nella modalità di inserimento note, si ottiene una demo
(dimostrazione) degli strumenti a percussione dalla tastiera MIDI.

2. Cliccare sulla nota o sulla pausa da cui si vuole iniziare.

3. Entrare in modalità inserimento note.
4. Selezionare la voce corretta. Per esempio, rullanti, sidestick (bacchette?) e tutti i piatti sono normalmente aggiunti

alla voce 1; la grancassa alla voce 2.
5. Fissare la durata della nota.
6. Premere un tasto dello strumento per aggiungere una nota alla partitura. Per aggiungere un'altra nota nella stessa

posizione, tenere premuto il primo tasto mentre si preme il secondo.

Note: Per i dettagli sulla corrispondenza fra tasti della tastiera MIDI e relativi strumenti a percussione correlati, fare
riferimento alla GM2 drum map (mappa percussioni GM2). Alcune tastiere (per esempio, Casio) mostrano i simboli delle
percussioni accanto ai tasti come aiuto per l'utente.

Tastiera Pianoforte (virtuale)

Per aggiungere note a un rigo di percussioni dalla tastiera di pianoforte virtuale:

1. Assicurarsi che sia visualizzata la tastiera del pianoforte. Premere P (o selezionarlo dal menù, Visualizza → Tastiera
pianoforte).

Nota: Se si clicca sul rigo delle percussioni senza entrare nella modalità di inserimento note, si ottiene una demo
(dimostrazione) degli strumenti a percussione dalla tastiera del pianoforte virtuale.

2. Cliccare sulla nota o sulla pausa da cui si vuole iniziare.

3. Entrare in modalità inserimento note.
4. Selezionare la voce corretta. Per esempio, rullanti, sidestick (bacchette?) e tutti i piatti sono normalmente aggiunti

alla voce 1; la grancassa alla voce 2.
5. Fissare la durata della nota.
6. Cliccare su un tasto (del pianoforte virtuale) per aggiungere una nota alla partitura.
7. Per aggiungere un’altra nota ad una già esistente, premere Maiusc e tenerlo premuto mentre si preme la nuova nota

(nelle versioni precedenti la 2.1, usare Ctrl (Mac: Cmd)).

Note: Per i dettagli sulla corrispondenza fra tasti del pianoforte virtuale e relativi strumenti a percussione correlati, fare
riferimento alla GM2 drum map (mappa percussioni GM2).

Per impostazione predefinita, la tastiera del pianoforte virtuale è agganciata nella parte inferiore dello schermo, a sinistra
della tavolozza inserimento note percussioni. Tuttavia è possibile sganciarla trascinandola, quindi riagganciare il pannello
in diversi modi:

Trascinare il pannello verso il basso al centro e si sovrapporrà alla tavolozza di inserimento note percussioni, per
tutta la sua lunghezza. Entrambi i pannelli sono quindi accessibili tramite relative schede.
Trascinate il pannello verso il basso a destra/sinistra e si aggancerà a destra/sinistra della tavolozza di inserimento
note percussioni.

Tastiera del computer

Per inserire le note su un rigo di percussioni usando la tastiera del computer:

1. Cliccare sulla nota o sulla pausa da cui si vuole iniziare.
2. Entrare in modalità inserimento note. La tavolozza inserimento note percussioni appare ora nella parte inferiore dello

schermo (vedere sotto).
3. Selezionare la durata della nota desiderata.
4. Premere the il tasto di scelta rapida (A-G) per lo strumento che si desidera inserire – fare riferimento alla finestra

della tavolozza di inserimento note percussioni.
5. Se si vuole aggiungere un'altra nota a una già esistente in quella voce, premere Maiusc+[A–G].
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Nota: L'assegnazione della voce è determinata dal colore della nota nella tavolozza di inserimento note percussioni: blu
per la voce 1, verde per la voce 2.

Mouse

Per aggiungere una nota a un rigo di percussioni

Usare il seguente metodo per aggiungere una nuova nota o per sostituire un accordo esistente.

1. Selezionare la nota o la pausa da cui si vuole iniziare. Si può anche selezionare una battuta.
2. Premere N per accedere poi note input mode. La tavolozza inserimento note percussioni ora appare in fondo allo

schermo (vedere sotto).
3. Fissare la durata della nota.
4. Scegliere una delle seguenti opzioni:

Doppio clic su una note nella tavolozza inserimento note percussioni.
Selezionare una nota (per esempio grancassa o rullante) nella tavolozza inserimento note percussioni, poi
cliccare su una nota o su una pausa nella partitura.

Per aggiungere una nota a un accordo esistente nel rigo delle percussioni

1. Assicurarsi di essere in note input mode.

2. Selezionare una durata di nota uguale a quella a cui si sta effettuando l’aggiunta.

3. Cliccare sulla nuova nota nella tavolozza inserimento note percussioni.

4. Cliccare sopra o sotto la nota esistente nel rigo delle percussioni.

Nota: L'assegnazione della voce è determinata dal colore della nota nella tavolozza inserimento note percussioni: blu per
la voce 1, verde per la voce 2.

Tavolozza inserimento note percussioni

Quando un rigo di percussioni è selezionato e la modalità di inserimento note è attiva, si apre una finestra in fondo allo
schermo chiamata Tavolozza inserimento note percussioni. Questa finestra è essenziale per l’inserimento tramite
mouse input, mostra le scorciatoie per l’inserimento da tastiera del computer, ma può essere ignorata se si usa una
Tastiera MIDI o la Tastiera Pianoforte (virtuale).

Ogni nota nella tavolozza rappresenta uno strumento a percussione: passando il puntatore del mouse sopra la nota si
visualizza il nome dello strumento.

Le lettere da A a G (mostrate sopra alcune note nella tavolozza) sono designate come scorciatoie per inserire strumenti
particolari (grancassa, rullante, hi-hat chiuso ecc.), piuttosto che riferirsi alle altezze delle note stesse. Possono essere
cambiate o riassegnate a piacere nella finestra Modifica set percussioni.

Quando la Tavolozza inserimento note percussioni è aperta, facendo doppio clic su una nota nella tavolozza o
inserendo una lettera di scelta rapida, si aggiunge quella nota dello strumento al rigo delle percussioni. Il colore della nota
nella tavolozza mostra la voce assegnata a quella nota: blu per la voce 1, verde per la voce 2. Questo può essere
cambiato nella finestra-dialogo Modifica set percussioni se necessario.

Questa assegnazione di voci si applica solo con l'immissione di note tramite tastiera e mouse: l'immissione tramite una
tastiera MIDI o la tastiera virtuale del pianoforte permette di utilizzare qualsiasi voce.

Modifica set percussioni

Per aprire la finestra modifica set percussioni, usare una delle seguenti opzioni:

Cliccare sul pulsante Modifica set percussioni alla sinistra della Tavolozza inserimento note percussioni.
Cliccare con il tasto destro del mouse su un rigo di percussioni e selezionare "Modifica set percussioni...".
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La finestra di dialogo Modifica set percussioni mostra gli strumenti a percussione disponibili e le note/numeri MIDI a cui
sono assegnati. Determina anche come ogni strumento viene visualizzato sul rigo - il suo nome, la posizione, il tipo di
testa e la direzione del gambo della nota. Qualsiasi cambiamento fatto qui viene automaticamente salvato nel file di
MuseScore di riferimento.

Cliccando su una riga nella colonna di sinistra è possibile modificare le proprietà di visualizzazione per la nota selezionata
come segue:

Nome: Il nome che si vuole venga visualizzato nella tavolozza di inserimento note percussioni quando si passa con il
mouse sulla nota. Lasciare vuoto per rimuovere questa nota dalla tavolozza di inserimento note percussioni.
Gruppo testa delle note: Scegliere una testa-nota per lo strumento da un elenco a discesa di opzioni (Nota: la scelta
"Personalizzato" attiva "Modifica testa delle note" (sotto).
Modifica teste delle note: Permette di personalizzare ulteriormente la visualizzazione specificando le teste delle note per
particolari durate delle note stesse.
Voce predefinita: Assegnare a una delle quattro voci. Questo non influisce sull'inserimento note da una tastiera MIDI o
dalla tastiera del pianoforte virtuale.
Linea rigo: Questo numero indica la linea/spazio del rigo su cui viene visualizzata la nota. "0" significa che la nota viene
visualizzata sulla linea superiore del rigo a 5 linee. Numeri negativi spostano la nota verso l'alto passo dopo passo,
mentre numeri positivi la spostano verso il basso nello stesso modo.
Scorciatoia: Assegna una scorciatoia da tastiera per inserire quella note.
Direzione gambo: Automatica, Su o Giù.

Il set percussioni personalizzato può essere salvato come file .drm premendo Salve come.... È inoltre possibile importare un
set percussioni personalizzato usando il pulsante Carica....

Sticking (diteggiatura)

Per inserire simboli sticking (R, L):

1. Selezionare una nota di partenza;
2. Dal menù, selezionare Aggiungi→Testo→Diteggiatura (Sticking). In alternativa, impostare in Preferenze una scorciatoia da

tastiera per fare la stessa cosa;
3. Inserire il simbolo proprio come si farebbe con un testo normale. Per spostarsi avanti alla nota successiva o indietro

a quella precedente, usare le stesse scorciatoie da tastiera come per le Sigle accordali.
4. Per uscire, premere Esc, o cliccare su una sezione vuota dello spartito.

Aggiungere un rullo di tamburo

Per creare un rullo di tamburo, usare un Tremolo.

Collegamenti esterni

How to create jazz drum notation  [MuseScore How-To]
Video tutorial: MuseScore in Minutes: Lesson 7 - Tablature and Drum Notation
Drum Parts  [video]
Editing the Drum Palette in MuseScore 1.1  [video]
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Saving Drumset Changes in MuseScore 1.1  [video]
Guide to Drum and Percussion Notation

Sound and playback
MuseScore has "Sound and playback" capabilities built-in. This chapter covers the playback controls and ways to extend
the instrument sounds.

External links

How to restore sound if playback stops working

Cambio strumento lungo il rigo

Quando a un musicista è richiesto di suonare con uno strumento diverso una sezione di un pezzo, l'istruzione relativa al
cambio strumento è generalmente posta sopra il rigo all'inizio di quella sezione. Un ritorno allo strumento principale è
gestito nello stesso modo.

Per questo scopo MuseScore permette di inserire una specifica classe di testo chiamata Cambio strumento. Questa
classe di testo è diversa sia dal testo di Rigo che da quello di Accollatura in quanto collega le indicazioni contenute alla
riproduzione sonora e cambia il suono in corso con quello del nuovo strumento.

Effetto del cambio di strumento

Quando viene effettuato un cambio di strumento:

Il suono riprodotto sarà sostituito con quello del nuovo strumento da quel punto in poi, ma il display del mixer rimane
invariato.
Le note successive sono regolate automaticamente per indicare la corretta altezza scritta per il nuovo strumento
(ma la nuova armatura di chiave dovrà essere ancora aggiunta manualmente - vedere sotto).
Il nuovo nome dello strumento sarà visualizzato davanti alle accollature successive.

Aggiungere un cambio di strumento

1. Selezionare il punto di inizio della modifica cliccando su una nota o una pausa;
2. Se non già presente, aprire la tavolozza principale digitando F9 (oppure dal menù Visualizza), e cliccare su Testo

per aprire la relativa tavolozza:

3. Un clic sul testo Cambia Strum. nella tavolozza apre la finestra di dialogo (doppio clic nelle versioni precedenti la
3.4), La casella superiore mostra lo strumento corrente, quella inferiore l'elenco degli strumenti selezionabili:
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;
4. Scegliere lo strumento, quindi cliccare OK. Quando selezionato uno strumento si preme il pulsante OK comparirà

nella partitura il testo che indica quale strumento l'esecutore utilizzerà .
5. Se necessario, al cambio Inserire una nuova armatura di chiave per il rigo in questione.

Nota: I cambi di strumento nel corso del rigo sono limitati allo stesso tipo di rigo. Per esempio, non si può cambiare tra un
rigo di percussioni e uno di strumenti a corda o viceversa.

Vedere anche

Cambio strumento
Cambiamento di suono lungo il rigo (pizz., con sordino, ecc.)

Collegamenti esterni

Come cambiare il suono dello strumento (es. pizz., con sordino) a metà della partitura  (MuseScore Come fare)

Mixer

Il Mixer permette di cambiare i suoni degli strumenti, regolare volume e panoramica stereo, e fare altre regolazioni alla
riproduzione sonora per ogni rigo.

Aprire il Mixer

Per visualizzare/nascondere il mixer, usare uno dei seguenti modi:

Premere F10 (Mac: Fn+F10).
Dal menù principale, selezionare Visualizza→Mixer.

Il Mixer è diviso in un’Area Dettagli in alto e un’Area Tracce in basso.
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Area Tracce

L'area delle tracce è in basso e mostra il Guadagno generale, seguito da una “riga di tracce” (N.d.T. corrispondente agli
strumenti presenti in partitura). I pannelli dell'Area Traccia permettono di regolare il volume di ogni strumento utilizzato nei
vari righi. Cliccando su uno dei pannelli lo si seleziona e, nell’Area Dettagli, si possono modificare anche altri parametri
dello strumento, come la scelta dello strumento, il nome, il bilanciamento, il coro, il riverbero, ecc.

MuseScore crea una "traccia-parte" per ogni rigo della partitura. Queste tracce parte possono essere ulteriormente
suddivise in "tracce-canale" corrispondenti ai diversi suoni usati all'interno del rigo. Mentre molti righi hanno bisogno di
una sola traccia di canale, altri richiedono più canali in modo che lo strumento possa suonare più di un suono (per
esempio un violino che può suonare in voci arco, tremolo o pizzicato); o a causa di un Cambio strumento lungo il rigo.
Queste tracce di canali extra possono essere visualizzate o nascoste cliccando il pulsante freccia in cima al controllo della
traccia.

Traccia-parte espansa, che visualizza le tracce “figlie” in colore rosa

Guadagno generale
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Il Guadagno generale controlla il volume di uscita complessivo. Per regolarlo, cliccare e trascinare il cursore o inserire un
valore nella casella sottostante.

Freccia di visualizzazione del canale

Ogni traccia di parte ha un pulsante in alto con una freccia, abilitato quando quello strumento ha più canali, come ad
esempio il violino (per arco, pizzicato, tremolo), disabilitato negli altri casi. Quando viene cliccato, questo alterna la
visualizzazione delle tracce dei canali del rigo accanto ad esso. Le tracce di canale non hanno un pulsante freccia; viene
invece visualizzato il nome della traccia di cui fanno parte.

Muto e Solo

In cima a ogni traccia c'è un pulsante verde per il Solo e un pulsante rosso per il Muto: ognuno può essere attivato o
disattivato. Se un qualsiasi pulsante Solo è spuntato, allora solo le tracce che hanno l'assolo acceso suoneranno. Se
nessun assolo è acceso, tutte le parti possono potenzialmente suonare. Muto fa l'opposto: ogni traccia che ha Muto
acceso non suonerà. Usando una combinazione di pulsanti Muto e Solo, è possibile controllare quali strumenti vengono
ascoltati durante la riproduzione sonora.

Bilanciamento

Il quadrante sotto il pulsante mute controlla il Bilanciamento a sinistra e a destra. È possibile cliccare e trascinare sul
quadrante per cambiarne il valore. Nota: MuseScore non supporta ancora i valori di bilanciamento per la traccia-parte,
per cui la traccia-parte mostra lo stesso valore di bilanciamento del primo canale. Impostando il valore di bilanciamento
della traccia-parte, tutte le tracce dipendenti saranno automaticamente impostate allo stesso valore.

Volume

Il cursore al centro della traccia controlla il volume di riproduzione. Nota: MuseScore non supporta ancora i valori di
volume per la traccia-parte, per cui la traccia-parte mostra lo stesso valore di volume del primo canale. Impostando il
valore di volume della traccia-parte, tutte le tracce dipendenti saranno automaticamente impostate allo stesso valore.

Nome traccia

La casella di testo in fondo alla traccia contiene il nome corrente della parte o del canale di traccia (qualora presente).

Area dettagli

L'area dei dettagli visualizza e fornisce un controllo più fine della traccia attualmente selezionata.

Nome

Il nome della parte a cui questa traccia è associata. Sia le tracce di parte che quelle di canale mostrano il nome della
parte. Nota: Il nome della parte è modificabile, anche se questo ha effetto solo per il Mixer. Il nome del canale non è
modificabile.

Canale

Se è selezionata una traccia di canale, qui viene visualizzato il nome del canale.

Batteria

Indica se questa parte rappresenta uno strumento melodico o uno strumento a percussione (suono indeterminato). Per gli
strumenti melodici regolari, ogni passo nella stessa frase musicale di solito ha lo stesso timbro, mentre le frasi musicali di
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percussioni (a suono indeterminato) di solito hanno timbri diversi per ogni altezza.

Suono

Per cambiare il suono in una traccia:

1. Cliccare sulla traccia desiderata così che i dettagli compaiano nella relativa Area dettagli .
2. Cliccare sull’elenco a discesa di "Suono" e selezionare un altro strumento.

Il menu a discesa di "Suono" elenca ogni strumento supportato dal vostro Librerie Suoni corrente. Se sono state caricate
nel Sintetizzatore più Librerie di Suoni, tutti gli strumenti da tutte le Librerie (e/o files SFZ) appariranno nell’ordine
impostato nel Sintetizzatore.

Suggerimento: Per trovare più facilmente uno strumento, cliccare sulla lista "Suono" e digitare la prima lettera del nome
dello strumento. Ripetere fino a quando necessario.

Volume

Il volume complessivo con cui viene riprodotto il suono.

Bilanciamento

Il bilanciamento applicato alla parte.

Colore della traccia

Per cambiare il colore dell'area della traccia:

Cliccare sul rettangolo colorato per entrare nella tavolozza dei colori e apportare le modifiche desiderate.

L'impostazione del colore di una traccia parziale cambierà automaticamente anche i colori di tutte le sue tracce
dipendenti.

Controlli MIDI

Porta e Canale

La porta MIDI di uscita e il canale su cui viene suonata la parte.

Riverbero / Coro

Il valore di riverbero/coro inviato all'uscita MIDI. Questa è un'informazione inviata ai dispositivi MIDI e non influenzerà la
riproduzione audio incorporata di MuseScore

Silenzia voce

Permette di silenziare singole voci all'interno di ogni rigo. Ogni riga rappresenta un diverso rigo all'interno di una parte.
Così, premendo “2” sulla riga superiore si metterà in “muto” la seconda voce sul primo rigo della parte.

Pulsante Nascondi dettagli

In fondo all'area dettagli è situato un pulsante largo con sopra un piccolo triangolo. Cliccando questo pulsante si
nasconderà l'area dettagli per avere più spazio. Cliccando di nuovo su di esso si ripristina l'area dettagli.

Nota: Da Preferenze/Partitura è possibile mettere la spunta alla casella Mostra controlli MIDI nel Mixer per preimpostarla
espansa all'apertura del Mixer

Cambiamento di suono lungo il rigo (pizz., con sordino, ecc.)

Alcuni strumenti sono dotati di canali multipli nel Mixer utilizzabili per cambiare i suoni lungo il rigo. Per esempio, un rigo
per uno strumento a corda (violino, viola, violoncello, ecc.) ha tre canali: uno per "arco" (o "normale"), un altro per
"pizzicato" e un altro per "tremolo". Un rigo per tromba avrà un canale per "normale" e un altro riservato alla "sordina", e
così via.

Le seguenti istruzioni usano gli archi pizzicati come esempio; lo stesso principio può essere applicato a qualsiasi altro rigo
di strumento che permetta cambiamenti di suono.

1. Selezionare la prima nota della sezione che si vuol eseguire “pizzicata”;
2. Dal menù principale, scegliere Aggiungi→Testo→Testo di rigo oppure usare la scorciatoia Ctrl+T;
3. Digitare "pizz." Questo testo è solo per riferimento visivo e non influisce sulla riproduzione audio;
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4. Cliccare con il tasto destro del mouse sul testo di rigo applicato e selezionare Proprietà testo rigo ;
5. Nella scheda "Cambio Canale" della finestra di dialogo "Proprietà testo rigo", selezionare una o più voci sulla

sinistra;

6. Dal menu a discesa selezionare pizzicato;

7. Cliccare OK per tornare alla parte.
Ogni nota dopo il testo del rigo aggiunto ora suona pizzicato. Per tornare successivamente a un normale suono di
archi, seguire le stesse linee guida di cui sopra, tranne che per digitare "arco" al passo 3 e selezionare arco al passo
6.

La maggior parte delle volte è molto più facile applicare semplicemente il testo corrispondente (pizz., tremolo, arco,
sordino, aperta, ecc.) dalla Tavolozza Testo.

Vedere anche

Librerie Suoni
Sintetizzatore
Cambio strumento

Collegamenti esterni

How to change instrument sound (e.g. pizz., con sordino) midway through score  (MuseScore HowTo)

Piano Roll Editor

The Piano Roll Editor allows you edit individual notes and tweak aspects of their playback.

Opening the Piano Roll Editor

To open the Piano Roll Editor (PRE), right-click on a measure in the score and choose the Piano Roll Editor option from
the context menu. The Piano Roll Editor will open showing the staff and measure where you clicked. If the Piano Roll
Editor is already open, it will be updated to show the new staff and measure you clicked on.
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Overview

The Piano Roll Editor is divided into several sections. At the very top is a row of buttons and controls that affect playback
and can modify notes. The name of the part being edited is at the top right.

The central portion contains the Note Display Area which allows you to view and edit notes. Each note is displayed as a
block, with yellow blocks representing selected notes, and darker green blocks representing unselected notes (these
colors can be changes in the Preferences). Given sufficient space, each block will display its pitch on the left and the voice
it is assigned to on the right. Changing the size of the note blocks is covered in the navigation section.

To the left of the Note Display Area is the Keyboard. By clicking on a key in the Keyboard, you can hear a sample of that
note playing. As you move the mouse in either the Node Display Area or the Keyboard, a key on the keyboard will light,
corresponding to the pitch you are over. You can also hover your mouse over a particular key to get more information
about that pitch. If you are using a Drumkit, the keys of the keyboard will show the name of the drum assigned to that
particular pitch. For instruments that are not concert C, the keyboard will be adjusted so that the C of the keyboard
matches the C of the instrument.
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Along the top of the Note Display Area is the Measure Ruler which displays the current position of the playback head, as
well as the current looping range if it set.

The bottom of the editor contains the Levels Display Area. It is a bar graph showing extra data values assigned to each
note, such as its velocity or cutoff time. To the left of the Levels Display Area is a dropdown menu allowing you to select
the type of data you wish to see displayed or edited.

Navigation

There are several ways to move about in the Piano Roll Editor. First of all, you can click and drag on the scroll bars on the
edges of the Note Display Area.

The mouse wheel can also be used to pan and zoom as follows:

Scroll vertically: Mouse wheel.
Scroll horizontally: Shift + mouse wheel.
Zoom vertically: Ctrl + mouse wheel.
Zoom horizontally: Ctrl+Shift + mouse wheel.

To jump to a particular measure, switch back to score view and find the measure you wish to see. Then right-click on the
measure and select Piano Roll Editor. The Piano Roll Editor will scroll to center on the measure you clicked.

Selecting Notes

In the Note Display Area, you can click on single notes or click and drag to select a group of notes. Holding down the
modifier keys will affect how your selection changes:

Shift: Invert existing selection: i.e. notes that were previously selected are deselected, and notes which were not
selected are selected. Useful for toggling a note between selected and not selected.
Ctrl: Add notes to selection.
Ctrl+Shift: Subtract notes from selection.

Editing Notes

To change the pitch of a selection of notes: Drag a selected note up or down to a new pitch; or press the ↑ or ↓ arrows.
Note: Dragging the note horizontally to change the start time is not supported at the moment.

To delete a selection of notes: Press the Del key.

To move a note selection to another voice: Click the desired voice number button at the top of the editor.

To add notes:

Notes can be inserted by clicking in the Piano Note Area with the modifier keys held. These edit operations will use the
beat or subbeat line to the left of the spot where you click as the point where a note is altered:

Ctrl: A note of the current insert note duration will be added at the subbeat and pitch where you clicked. The note
insert length is the same as the one you use to add notes in note entry mode in the score. If you wish to change the
duration, you will need to select this in the Score View as the Piano Roll Editor does not currently have these
buttons. If notes already exist in this location, a chunk will be cut out of them to make room for the note you are
inserting, unless they happen to have the same start time and duration of the note you're adding, in which case the
new note will simply be appended to the existing chord. Tuplets are currently not supported, and so will be ignored.
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Shift: Looks for a chord that already spans this subbeat line. If it finds one, appends a new pitch to the existing chord.
Otherwise, this is a rest and the rest will be replaced with a note of equal start time and duration to the existing rest.

Ctrl+Shift: Looks for a chord or rest that spans this subbeat. This chord will be cut in two at this subbeat line. Tuplets
are currently not supported, and so will be ignored.

To edit note event data:

Note event data can be changed in the Levels Display Area. To edit event data such as velocity or cutoff time, first select
the notes you wish to edit in the note area. Then click in the Levels Display Area on the corresponding bar; the value of
the level will changed to correspond to the point where you clicked. You can also click and drag in this area to change the
levels of several notes with a single gesture. If you want the levels to all be set to the same value, hold Shift while
dragging. Only selected notes will have their value changed - this is to prevent you from accidentally changing the values
of other notes.

The Levels area can display the same data in multiple ways. For example, velocity data can be displayed both as
absolute (i.e., relative to the output midi volume) and relative (i.e., as an offset to the dynamics value). You can switch
between these display modes as you see fit.

Controls

From left to right the controls have these functions;

First Row

Undo
Undoes the last action

Redo
Redoes the last action

MIDI Toggle
Toggles MIDI input

Rewind
Rewind to start of score.

Play
Starts/stops playback.

Loop Playback
Sets the range of and toggles looping playback.

Play Repeats
Toggles whether repeats are played.

Pan Roll During Playback
If set, the window will automatically scroll to center on the playback head during playback.

Metronome
Toggle metronome.

Wave
Currently does nothing.

Voice Numbers
Moves selected notes to chosen voice.

Part
Name of part currently being viewed/edited.

Second Row
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Cursor
Provides feedback on the current measure and pitch of the position of the mouse within the Note Display Area.

Subdiv

Subdivides the beat by adding extra divisions to the Note Display Area. The value indicated the number of time the
beat will be subdivided. So for 4/4 time, a division of 2 will draw grid lines at every eighth note; a division of 3 at
every sixteenth note, and so on. Setting the subdivision is necessary for some editing operations if you wish to place
notes off the beat.

For larger numbers of subdivisions, you may need to be zoomed in to see the extra grid lines since grid lines are not
drawn below a certain density. Combines with the tuplet control which also affects grid line placement.

Tuplet

Adds additional grid lines, subdividing the beat to show the rhythmic placement of tuplets. For example, setting
tuplets to 3 will show the beat subdivided into three parts. Combines with the subdiv control to show subdivisions of
the tuplet. For example, setting tuplets to 3 and subdiv to 2 will draw grid lines showing the tuplet beats subdivided
into two parts - i.e., the beat will be subdivided into 6.

Selecting a tuplet mode other than 1 will disable some of the note insertion tools for the Piano Roll Editor. For larger
numbers of subdivisions, you may need to be zoomed in to see the extra grid lines since grid lines are not drawn
below a certain density.

Stripe pattern
Changes the pattern of stripes shown behind the notes in the Note Display Area. By default the pitches of C major
are highlighted, but you can change this to highlight the pitches of a different key, or even scales such as the
diminished or whole tone.

Velocity

Shows the velocity of the currently selected note (only one note may be selected). Indicates the loudness of the
note. This can be expressed as 'Offset' or 'User':

Offset: Value is treated as a multiplier for the velocity already set by the dynamics.
User: This is the raw value being sent to MIDI and overrides the dynamics value. Values are between 0 and
127, where 64 is "middle, neither loud nor soft".

When you switch from User to Offset or vice versa, the value will be recalculated to best match the value in the
other system. This way you could, for example, switch to User mode to set the value as you would like it to sound in
MIDI output and then switch to Offset so that this value respects the dynamic marking instead of overriding it. At the
moment you switch back, the offset value will be recalculated to match the User value in loudness but will no longer
act as an override so you may later change the dynamic.

Pitch
Shows the pitch and octave of the selected note in text format (i.e. f#4).
The pitch will change if the note is dragged Up or down to a new pitch. Currently cannot be edited.

OnTime
Shifts the start of the note in time, which can be used to modify the playing style. Negative values will make the note
sound earlier, positive will make it sound later. The duration of the note corresponds to a value of 1000 (e.g. setting
the value to 250 will make the note sound 1/4 of its duration later).

Length
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Set the time that the note is sounding, which may be used to modify the degree of "legato". Lower values will make
the note sound more staccato, higher values will make it sound more legato. The duration of the note corresponds to
a length of 1000, but the value can be set higher. 950 is usually considered "non-legato".

Keyboard

Some keys are hooked up to perform special actions:

↑: Move selected notes up one semitone
↓: Move selected notes down one semitone
Del: Delete selected notes
Space: Start/stop playback

Customization

The Piano Roll Editor will display in both normal mode and dark mode. If you wish to change the colors the Piano Roll
Editor uses to display in these modes, they can be adjusted in the Preferences under the Advanced tab. All the Piano Roll
Editor related properties begin with ui/pianoroll/light for light mode and ui/pianoroll/dark for dark mode.

Librerie di suoni e file SFZ

La riproduzione audio è fornita dal sintetizzatore integrato di MuseScore, che ospita una grande selezione di strumenti
virtuali (o software), comprese percussioni ed effetti sonori.

MuseScore supporta strumenti virtuali in due formati:

SoundFont (.sf2/.sf3) (librerie di suoni): Un singolo file contenente uno o più strumenti virtuali.
SFZ (.sfz): Un insieme di file audio e di definizione contenenti uno o più strumenti virtuali.

SoundFonts (Librerie di suoni)

MuseScore viene fornito con il proprio GM (General MIDI ) SoundFont, MuseScore_General.sf3, contenente oltre 128
strumenti, effetti sonori e vari kit di batteria/percussioni.

GM (General MIDI) è un formato universale, quindi una volta che una partitura è impostata per la riproduzione corretta
usando il Soundfont nativo di MuseScore, si dovrebbe essere in grado di esportarla in un formato di propria scelta farla
riprodurre sul computer di qualsiasi altro utente.

Su Internet sono disponibili molti Soundfonts differenti, alcuni gratuiti, altri commerciali. Per una lista di soundfonts gratuiti,
vedere sotto.

Installare un SoundFont

Dopo aver trovato e decompresso un SoundFont (vedere →sotto), fare doppio clic per aprirlo. Nella maggior parte dei
casi il tipo di file SoundFont sarà già associato a MuseScore, e MuseScore si avvierà con una finestra di dialogo che
chiederà se si vuole installare il SoundFont. Occasionalmente, applicazioni diverse da MuseScore potrebbero essere
associate al tipo di file SoundFont; in questo caso, cliccare con il tasto destro del mouse o Ctrl-click sul file, in modo da
visualizzare un menu dal quale si potrà scegliere di aprire il file in MuseScore. In entrambi i casi, quando appare la
finestra di dialogo che chiede se si vuole installare il SoundFont, cliccare "Sì" per mettere una copia del file SoundFont
nella directory SoundFonts di MuseScore. Questa directory può essere visualizzata o cambiata nelle Preferenze di
MuseScore, ma la posizione predefinita è:

Windows: %HOMEPATH%\Documents\MuseScore3\Soundfonts

macOS e Linux: ~/Documents/MuseScore3/Soundfonts

Diversamente dai SoundFont aggiunti dall'utente, il SoundFont di default iniziale installato con MuseScore si trova in una
directory di sistema, destinata solo a questo scopo, che non dovrebbe essere modificata. Questa directory e il suo file
SoundFont di default è:

Windows x86 (32-bit) / MuseScore x86: %ProgramFiles%\MuseScore 3\sound\MuseScore_General.sf3
Windows x64 (64-bit) / MuseScore x86: %ProgramFiles(x86)%\MuseScore 3\sound\MuseScore_General.sf3

Windows x64 (64-bit) / MuseScore x86_64: %ProgramFiles%\MuseScore 3\sound\MuseScore_General.sf3

macOS: /Applications/MuseScore 3.app/Contents/Resources/sound/MuseScore_General.sf3

Linux (Ubuntu): /usr/share/mscore-xxx/sounds/MuseScore_General.sf3 (con xxx che è la versione di MuseScore)

Disinstallare

Per disinstallare un SoundFont, basta aprire la cartella dove è installato il suo file e cancellarlo.
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SFZ

Un SFZ è una collezione di file e directory, un file SFZ e un gruppo di file sonori reali in formato WAV o FLAC, con il file
SFZ che è un file di testo che fondamentalmente descrive quale è file sonoro da usare per quale strumento, gamma di
tonalità e dove si trova.

Installare un SFZ

Dopo aver scaricato un SFZ (vedere →sotto), si devono estrarre manualmente tutti i file che appartengono alla SFZ (il/i
file SFZ e tutte le sottodirectory e altri file) nella directory elencata sopra. Lasciare le sottodirectory e il loro contenuto
come sono. Notare, comunque, che a volte, un file SFZ nella sua cartella può cercare i file sonori WAV effettivi all'interno
della sotto-directory SFZ stessa, di solito in una cartella etichettata "Libs". Se il file zip SFZ scaricato ha una cartella Libs
al suo interno, spostarla nella sotto-directory SFZ principale.

Disinstallare un SFZ

Per disinstallare una SFZ, basta aprire la cartella dove sono installati i suoi file (vedere sopra) e cancellarli tutti.

Sintetizzatore

Una volta che un SoundFont è stato installato sul sistema, deve anche essere caricato nel Sintetizzatore. Vedere Caricare
una Libreria di suoni.

Mixer

Il Mixer ti permette di cambiare facilmente i suoni per ogni rigo (anche mentre lo spartito è in riproduzione audio). Per
ulteriori dettagli, vedere Mixer.

Elenco dei SoundFont scaricabili

GM SoundFont

Le seguenti librerie di suoni sono conformi allo standard General MIDI (GM2). Questa specifica fornisce un set di suoni di
128 strumenti virtuali, più i kit di percussioni.

GeneralUser GS  (29,8 MB non compresso)
Per gentile concessione di S. Christian Collins
Magic Sound Font, versione 2.0  (67,8 MB non compresso)
Arachno SoundFont, versione 1.0  (148 MB non compresso)
Per gentile concessione di Maxime Abbey
MuseScore 1 è fornito con TimGM6mb  (5,7 MB non compresso)
Licenza: GNU GPL, versione 2
Per gentile concessione di Tim Brechbill
MuseScore 2 (fino alla versione 2.1) è fornito con FluidR3Mono_GM.sf3  (13,8 MB).
MuseScore 2 (dalla versione 2.2) e 3 sono forniti con MuseScore_General.sf3  (35.9 MB) (versione SF2  (208 MB)) e
vengono aggiornati di volta in volta (vedere il Changelog ).
Licenza: rilasciata sotto il MIT license
Per gentile concessione di S. Christian Collins
MuseScore 3 offre una versione HQ di quel soundfont come estensione
Timbres of Heaven, versione 3.2  (369 MB non compresso)
Per gentile concessione di Don Allen
Soundfonts4U  (da 12 MB fino a 1 GB, a seconda del pacchetto scelto)
Collezione di chitarre acustiche dal bel suono, così come pianoforti, bassi, violini, arpe e molti altri.

SoundFont orchestrali

Sonatina Symphonic Orchestra (503 MB non compresso)
Scaricabile come: SoundFont  | formato SFZ
Licenza: Creative Commons Sampling Plus 1.0
Aegean Symphonic Orchestra
Per gentile concessione di Ziya Mete Demircan  (352 MB non compresso)

SoundFont per Piano

SF2 Piano

Yamaha C5 Grand - A beautiful sounding 6 velocity-layer-sampled Yamaha Salamander C5 Grand
Acoustic grand piano, release 2016-08-04
Descrizione: Yamaha Disklavier Pro Grand Piano, formato sf2, 36 MB compresso, 113 MB non compresso, 121
esempi, 5 livelli di intensità
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Maggiori informazioni: http://freepats.zenvoid.org/  inclusi altri SoundFont.
Licenza: Creative Commons Attribution 3.0
Per gentile concessione di Roberto Gordo Saez
Salamander C5 Light
Per gentile concessione di Ziya Mete Demircan  (24,5 MB non compresso)

SFZ Piano

Salamander Grand Piano
Scaricabile come: versione 2  | versione 3
Descrizione: Yamaha C5, 48 kHz, 24 bit, 16 livelli intensità, tra 80 MB e 1,9 GB non compresso
Licenza: Creative Commons Attribution 3.0
Per gentile concessione di Alexander Holm
Detuned Piano  (244 MB non compresso)
Licenza: Creative Commons Attribution-ShareAlike 3.0
Plucked Piano Strings
Descrizione: 44.1 kHz, 16 bit, stereo, 168 MB non compresso
Licenza: Creative Commons Attribution-ShareAlike 3.0
The City Piano
Descrizione: Baldwin Baby Grand, 4 livelli di intensità, 696 MB non compresso
Licenza: Public domain
Per gentile concessione di Big Cat Instruments
Kawai Upright Piano, release 2017-01-28
Descrizione: 68 esempi, 44KHz, 24bit, stereo, 2 livelli di intensità, 58 MB non compresso
Licenza: GNU General Public License version 3 or later, with a special exception
Per gentile concessione di Gonzalo and Roberto

Decomprimere i soundfont scaricati

Poiché i soundfonts occupano molto spazio, sono spesso zippati (compressi) in una varietà di formati, inclusi.zip, .sfArk,
and .tar.gz. È necessario decomprimere questi file prima di poterli utilizzare.

ZIP è un formato di compressione standard supportato dalla maggior parte dei sistemi operativi.

sfArk è un formato di compressione progettato appositamente per comprimere i file SoundFont. Per decomprimere,
usare Polyphone  (software multipiattaforma); oppure questo servizio online: https://cloudconvert.com/sfark-to-
sf2

.tar.gz è un popolare formato di compressione per Linux. Gli utenti Windows possono usare 7-Zip ; gli utenti Mac
possono usare The Unarchiver , oppure l'utilità di archiviazione integrata in macOS. Notare che l’uso di 7-Zip
comporta dover applicare la decompressione due volte - una volta per GZip e una volta per TAR.

Risoluzione dei problemi

Se il pannello di riproduzione della barra degli strumenti è in grigio o non è visibile, seguire le istruzioni qui sotto per far
funzionare di nuovo la riproduzione audio:

1. Cliccare con il tasto destro del mouse sulla barra dei menu e assicurarsi che ci sia un segno di spunta accanto alla
voce di menu Controlli riproduzione. Se questo passo non risolve il problema, andare al passo 2.

2. Se il pannello di riproduzione scompare dopo aver cambiato il SoundFont, andare sulla scheda Modifica → Preferenze...
→ I/O e suoni e cliccare OK senza effettuare modifiche. Dopo aver riavviato MuseScore, il pannello di riproduzione
dovrebbe riapparire.

Se si sta impostando un SoundFont per la prima volta, usare uno dei SoundFont raccomandati elencati sopra.

Se la riproduzione “balbetta”, il computer potrebbe non essere in grado di gestire il SoundFont utilizzato. I seguenti
consigli possono essere utili:

Ridurre la quantità di RAM (memoria) usata da MuseScore usando un SoundFont più piccolo. Vedere la lista sopra
per i suggerimenti.
Aumentare la quantità di RAM disponibile per MuseScore chiudendo tutte le applicazioni tranne MuseScore stesso.
Se i problemi persistono e si ha la necessità di disporre di un SoundFont grande, prendere in considerazione
l’incremento della RAM per il computer.

Vedere anche

Sintetizzatore
Mixer

Collegamenti esterni
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How to change the SoundFont or add another  (MuseScore HowTo)
The SFZ Format  (per dettagli sulle specifiche sfz)

Metronomo (Indicazioni di Tempo)

(N.d.T.: la definizione Metronomo comprende solo una delle due modalità di indicare il tempo di esecuzione di un brano
musicale; esiste infatti l’Indicazione metronometrica, caratterizzata da “nota+valore numerico” e l’Indicazione di
andamento (es: Grave , Largo, ecc.). Per semplificare MuseScore ha adottato il solo termine Metronomo).
Le Indicazioni di tempo si trovano nella tavolozza Metronomo nelle aree di lavoro Base e Avanzata. Sono disponibili
nelle due forme “metronometrica” e “di andamento”, ma possono essere successivamente modificate e integrate per
mostrare qualsiasi espressione di tempo desiderata. Il tempo di riproduzione può essere variato in tutta la partitura
usando più segni metronometrici, visibili o invisibili.

Aggiungere una indicazione di Metronomo

Utilizzare uno dei seguenti metodi:

Selezionare una nota o una pausa e premere la scorciatoia da tastiera Alt+Maiusc+T.
Selezionare una nota o una pausa, e dalla barra del menu scegliere Aggiungi→Testo→Metronomo.
Selezionare una nota o una pausa and cliccare su un appropriato simbolo di Metronomo nella relativa tavolozza
(doppio clic nelle versioni precedenti alla 3.4);
Trascinare e rilasciare una indicazione di tempo dalla palette Metronomo direttamente su una nota o una pausa.

Nota: Se una indicazione di Metronomo viene applicata dal menù o tramite una scorciatoia da tastiera, il “battito” si
adegua automaticamente all'indicazione. Il vantaggio dell'applicazione da una tavolozza è che si può scegliere quale
valore della nota di battuta usare.

Modificare il Metronomo

Per cambiare il tempo di un segno di metronomo esistente nella partitura:

1. Andare in Modalità modifica sul segno di Metronomo in questione;
2. Modificare il numero di metronomo e/o la nota di battuta come richiesto;
3. Uscire da modalità modifica.

Si può anche sovrascrivere il tempo di un segno di metronomo esistente dall'Ispettore:

1. Selezionare il simbolo;
2. Deselezionare "Segui testo" nella sezione Testo Tempo dell’Ispettore;

3. Impostare il tempo di riproduzione voluto nel campo "Tempo" (sotto collocato).

Nota: La riproduzione può essere più veloce o più lenta se l'impostazione del Metronomo nel pannello Controlli di
riproduzione indica una percentuale diversa da 100%.

Modificare il testo del Metronomo

Gli indicatori di Metronomo possono essere modificati e formattati come qualsiasi altro oggetto di testo. Per impostare
proprietà e stile del testo, vedere Stili di testo e proprietà.

Il tempo indicato da un segno di Metronomo di solito persiste anche se sovrascritto da un'espressione come Andante,
Moderato ecc. Si può anche aggiungere altro testo a un semplice segno di metronomo, per esempio:

Sovrascrivere l’indicazione di Metronomo

È possibile bypassare temporaneamente l’indicazione di Metronomo, e riprodurre la partitura a qualsiasi velocità si voglia
utilizzando il pannello Controlli riproduzione:

1. Visualizzare il pannello: Visualizza→Controlli riproduzione oppure F11 (Mac: Fn+F11):
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2. Spostare il cursore del Metronomo verso l'alto o verso il basso come si desidera. Il valore di Metronomo viene
mostrato sia come valore assoluto che come percentuale rispetto a quello in vigore. Fare doppio clic sul cursore del
tempo per resettarlo.

Nota: I BPM (Battiti Per Minuto) sono sempre misurati e visualizzati (N.d.T.: tradotti) in semiminime al minuto,
indipendentemente dal denominatore dell’Indicazione Metrica in vigore.

Riproduzione di Ritardando e Accelerando

È possibile simulare la riproduzione di ritardando ("rit.") e accelerando ("accel.") aggiungendo indicazioni
metronometriche nascoste nella partitura. L’indicazione stampata per l’esecutore dovrebbe essere aggiunta come testo di
pentagramma/accollatura.

Nell’esempio sotto illustrato il tempo di Metronomo era originariamente di 110 BPM (battiti al minuto). Al ritardando, il
tempo diminuisce di 10 BPM sulla prima nota di ogni battuta. Ogni cambio di Indicazione metronometrica è reso invisibile
deselezionando la casella di controllo Visibile nell’Ispettore, così che sulla partitura stampata appaia solo l’indicazione
ritardando :

Un plugin è stato appositamente sviluppato per automatizzare questo processo: TempoChanges

Corona

La Corona (o punto coronato), disponibile nella tavolozza Articolazioni, dispone della proprietà Aumenta tempo che può
essere impostata tramite Ispettore. Per default, questa proprietà è fissata a 1.00. Per far riprodurre a MuseScore una
corona di durata doppia rispetto a quella normale cliccare sul relativo simbolo e impostare "Aumenta tempo" a 2.00.
Questo naturalmente non ha effetto sulle corone applicate a stanghette di battuta, dato che queste non hanno una durata
da modificare.

Vedere anche

Modalità riproduzione
Indicazione metrica

Collegamenti esterni

How to create a visual swing marking  (MuseScore HowTo)
Metrico: a font to create metronome marks, metric modulations and swing indications for music notation.
Le misure (battute) e i tempi musicali

Modalità riproduzione sonora

Barra degli strumenti di controllo riproduzione

Le funzioni di riproduzione di base sono accessibili dalla barra degli strumenti Controlli riproduzione situata sopra la
finestra del documento:

Da sinistra a destra, le icone sono:

Attiva/Disattiva 'Ingresso Midi':
Riavvolgi alla posizione iniziale: La riproduzione ritorna all'inizio della partitura, o all'inizio del ciclo (se ne è
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impostato uno).
Inizia o ferma la riproduzione: Vedere Avviare/interrompere riproduzione.
Attiva/Disattiva riproduzione ciclica: Vedere Riproduzione ciclica.
Riproduci le ripetizioni: Disattivare se si desidera che la riproduzione ignori le ripetizioni.
Segui la partitura automaticamente: Disattivare se si desidera che la partitura non segua la riproduzione sonora.
Attiva metronomo durante la riproduzione: Attiva e disattiva il metronomo.

Comandi Riproduzione

Avviare/interrompere riproduzione

Per avviare la riproduzione:

1. Cliccare su una nota, una pausa o la parte vuota di una battuta per stabilire il punto di partenza. Nota: Se non viene
fatta alcuna selezione, la riproduzione ritorna al punto in cui è stata lasciata; o, se non c'è una riproduzione
precedente, all'inizio della partitura.

2. Premere il pulsante Inizia/Ferma la riproduzione; oppure premere Spazio.

Durante la riproduzione è possibile saltare a una nota specifica o a una pausa nella partitura semplicemente cliccando su
di essa.

Per fermare la riproduzione:

Premere il pulsante Inizia/Ferma la riproduzione; oppure premere Spazio.

Durante la riproduzione

Una volta iniziata la riproduzione, sono disponibili i seguenti comandi:

Tornare all’accordo precedente: ←
Avanzare all’accordo successivo: →
Tornare all’inizio della battuta precedente: Ctrl+← (Mac: Cmd+←)
Avanzare all’inizio della battuta successiva: Ctrl+→ (Mac: Cmd+→)
Riavvolgimento all'inizio della partitura: Inizio (Mac: Cmd+Inizio); oppure premere il pulsante Riavvolgi alla posizione
iniziale (barra strumenti riproduzione).

Durante la riproduzione sonora è ancora possibile utilizzare le opportune scorciatoie da tastiera per aprire e chiudere
pannelli come Controlli riproduzione, Sintetizzatore, Mixer, ecc.

Riproduzione ciclica

La riproduzione sonora dovrebbe essere off (non in corso), e il pulsante "Attiva/Disattiva riproduzione ciclica" on
(attivato).
Selezionare la regione desiderata della partitura per la riproduzione ciclica.
Premere il pulsante “Inizia/Ferma riproduzione”.

La riproduzione si svolgerà ora in modo ciclico all'interno della regione compresa tra le bandiere blu.

Usare il pulsante "Attiva/Disattiva riproduzione ciclica" per alternare riproduzione ciclo / parte completa durante la
riproduzione sonora.

Vedere anche: Pannello Controlli riproduzione (sotto).

Pannello Controlli riproduzione

Per aprire il Pannello Controlli riproduzione usare una delle seguenti opzioni:

Premere F11 (Mac: Fn+F11).
Dalla barra dei menù, selezionare Visualizza → Controlli riproduzione.
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Il pannello “Controlli riproduzione” permette di apportare modifiche temporanee al tempo (Metronomo) e al volume, di
mettere in ciclo la riproduzione tra punti specificati, ecc.

Riavvolgi alla posizione iniziale, Inizia/Ferma la riproduzione: controlli di riproduzione sonora.
Riproduzione ciclica: Selezionare una nota iniziale e cliccare sul pulsante Imposta posizione inizio ciclo;
selezionare la nota finale e cliccare sul pulsante Imposta posizione fine ciclo. Premere Inizia/Ferma la
riproduzione per ascoltare il ciclo. I controlli funzionano anche durante la riproduzione sonora.
Battiti “a vuoto”: (icona del “Direttore d’orchestra”) Aggiunge i battiti “a vuoto” di una battuta (es. se Indicaz.
metrica = 3/4 vengono aggiunti 3 battiti) quando si avvia la riproduzione all'inizio di una battuta. Nel caso si parta da
un punto intermedio della battuta, un appropriato numero di battiti extra viene ulteriormente aggiunto. Clic sull’icona
attiva/disattiva l’opzione. (N.d.T.: è una modalità in uso dai direttori d'orchestra o di coro per indicare a tutti i
musicisti - prima della partenza - il tempo esatto con cui dovrà essere eseguito il brano).
Metronomo (volume): Attiva / Disattiva il battito del metronomo (il cursore sopra l’icona regola il volume del battito).
Metronomo (tempo): Apporta una modifica temporanea alla indicazione metrica in vigore. Viene visualizzata sia in
valore percentuale che in bpm (battiti al minuto). Fare doppio clic per resettare. (Nota: modifiche permanenti al
tempo (indicazione metrica) dovrebbero essere apportate tramite il testo di Metronomo).
Volume generale: Effettua una modifica temporanea al volume (si ripristina quando il programma viene riaperto).
Nota: per modificare il volume di riproduzione della partitura preimpostato, vedere Sintetizzatore.

Riproduzione sonora: Sigle accordali / Sistema numerico Nashville

A partire dalla versione 3.5 di MuseScore, sia le Sigle accordali che il Sistema numerazione Nashville (ma non l'Analisi in
Numeri Romani) suonano automaticamente in corso di riproduzione sonora della partitura.
A partire da MuseScore 3.5.1 questa funzionalità è possibile solo per le partiture create inizialmente con MuseScore 3.5 o
successivo; per le partiture più vecchie dovrà essere abilitata, usando i metodi descritti di seguito.

Attivare/disattivare la riproduzione

Nota : Le impostazioni fissate di seguito influenzano anche l’ esportazione di file Audio e MIDI.

Per tutte le partiture (a partire dalla versione 3.5.1)

Per abilitare o disabilitare la riproduzione sonora delle Sigle accordali per tutte le partiture:

Selezionare Modifica (Mac: MuseScore)→Preferenze→Avanzata); quindi adottare le seguenti opzioni, se necessario:
Per disabilitare/abilitare la riproduzione di partiture precedenti la versione 3.5: Spuntare/Deselezionare
score/harmony/play/disableCompatibility (per default è spuntata, riproduzione = NO)
disabilitare/abilitare la riproduzione di partiture di versione 3.5 o successive: Spuntare/Deselezionare
score/harmony/play/disableNew (per default è deselezionata, riproduzione = SI)

Per le partiture correnti

A partire dalla versione 3.5.1

Per attivare/disattivare la riproduzione di TUTTE le Sigle accordali :

Spuntare/Deselezionare Formato→Stile→Sigle accordali→Riproduci.

A partire dalla versione 3.5

Per attivare/disattivare la riproduzione di TUTTE le Sigle accordali:
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1. Selezionare una Sigla accordale o un numero Nashville
2. Nella sezione " Sigla accordale" dell’ Ispettore spuntare/deselezionare la casella "Riproduci".
3. Cliccare sul tasto S "Imposta come stile" associato (a destra di quella casella, potrebbe essere necessario scorrere

un po’).

In alternativa, è possibile silenziare la traccia o le tracce in riproduzione nel mixer - vedere sotto. Questo potrebbe essere
necessario, per esempio, quando sono presenti Sigle accordali su più di un rigo e si vuol avere la riproduzione solo per
uno di essi. Le parti della partitura devono essere regolate separatamente.

Per attivare/disattivare la riproduzione di una SELEZIONE di Sigle accordali :

1. Selezionare un intervallo di sigle.
2. Cliccare con il tasto destro del mouse su una Sigla accordale o su un numero Nashville.
3. Cliccare su Seleziona→Seleziona tutti gli elementi simili nell’intervallo scelto , OK.
4. Nella sezione " Sigla accordale" dell’ Ispettore spuntare/deselezionare la casella "Riproduci".

oppure

1. Cliccare sulla prima Sigla accordale o sul numero Nashville in quell'intervallo.
2. Maiusc+clic sull'ultima Sigla accordale o numero Nashville in quell’intervallo.
3. Nella sezione " Sigla accordale" dell’ Ispettore spuntare/deselezionare la casella "Riproduci".

Nota: Questo non modifica le parti che devono essere trattate separatamente.

Cambiare il suono della riproduzione

Il suono predefinito per le Sigle accordali è "Gran Piano". A partire dalla versione 3.5.1, le partiture create da modelli per
assolo di chitarra, usano invece "Chitarra con corde in nylon".

Per cambiare il suono di riproduzione delle Sigle accordali:

1. Aprire il Mixer (scorciatoia: F10, Mac: Fn+F10)
2. Nell’Area tracce individuare la traccia per la parte in questione.
3. Cliccare sulla freccia "Mostra canali" per visualizzare tutte le tracce dipendenti di quella parte.
4. Cliccare sulla traccia il cui nome contiene le parole "armonia" o "Simb. acc." (può essere troncata, dovrebbe essere

il più a destra).
5. Selezionare un nuovo "Suono" nell’elenco a discesa Suono.

Questa impostazione è condivisa tra partitura e parti.

Cambiare il volume di riproduzione / Traccia muta

1. Aprire il Mixer (scorciatoia: F10, Mac: Fn+F10)
2. Nell’Area Tracce individuare la traccia per la parte in questione.
3. Cliccare sulla freccia "Mostra canali" per visualizzare tutte le tracce dipendenti di quella parte.
4. Cliccare sulla traccia il cui nome contiene le parole "armonia" o "Simb. acc." (può essere troncata, dovrebbe essere

il più a destra).
5. Regolare il cursore del volume; o premere il pulsante "M" per silenziare la traccia.

La procedura dovrebbe essere eseguita per la partitura e/o le parti, separatamente.

Attivare/disattivare il suono della sigla durante la modifica

Per attivare/disattivare il suono delle Sigle accordali durante l'editing:
1. Dal menù, selezionare Modifica (Mac: MuseScore)→Preferenze→Inserimento note.
2. Spuntare/Deselezionare l’opzione "Riproduci sigle accordali durante la modifica".

Interpretazione e Realizzazione delle Sigle accordali

(N.d.T.: Realizzazione o Voicing da Wikipedia: “Con il termine voicing si indica la strumentazione, la disposizione
verticale e l'ordine delle note che compongono un accordo. La nota che si trova nella parte più bassa determina il rivolto”).

Se lo si desidera, è possibile regolare le proprietà di riproduzione delle Sigle accordali selezionate come segue:

1. Selezionare una o più le Sigle accordali.
2. Nell’Ispettore effettuare le modifiche come segue:

Interpretazione. Le opzioni sono:
Letterale;
Jazz. Aggiunge toni di colore (per esempio la nona maggiore) ma può anche omettere alcune note; la
scelta dipende sia dall'accordo stesso che dal contesto (l'accordo successivo in particolare).

Realizzazione. Le opzioni sono:
Automatico
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Solo fondamentale = suona solo la nota fondamentale dell'accordo;
Parti strette = dispone le note entro un'ottava;
Drop due = abbassa di un'ottava la seconda nota più acuta dell'accordo;
Sei Note;
Quattro Note = intervalli di terza, quinta, settima e nona;
Tre Note.
Nota: Tutte le realizzazioni includono una nota di basso 2 ottave sotto la fondamentale dell'accordo.

Durata: Le opzioni sono:
Fino al prossimo simbolo di accordo
Fino alla fine della battuta
Durata accordo/pausa.

La seguente figura mostra come le opzioni Interpretazione e Realizzazione influenzano la riproduzione di un accordo di
settima di Do maggiore (Cmaj7 o CM7).

Nota: Per questo particolare accordo le opzioni Realizzazione "Parti strette" e "Automatico" sono le stesse, ma questo
caso non necessariamente si verifica per ogni accordo. Quindi, se si vuole specificamente l’opzione "Parti strette", è
meglio renderla esplicita.

Vedere anche

Attrezzi – Realizza sigle accordali

Collegamenti esterni

Voicing  (Wikipedia)

Sintetizzatore

Panoramica

Per visualizzare il Sintetizzatore: dal menù, selezionare Visualizza→Sintetizzatore.

Il Sintetizzatore controlla l'uscita sonora di MuseScore e permette di:

Caricare e organizzare diverse librerie di suoni campionati per riprodurre la musica.
Applicare effetti quali riverbero e compressione.
Regolare l’intonazione generale (frequenza del La4).
Modificare il volume di uscita.
Selezionare i Midi Continuous Controllers da usare con le Dinamiche Nota Singola (versione 3.1 e successive).

La finestra del Sintetizzatore è divisa nelle seguenti sezioni/schede:

Fluid: Un software di sintetizzatore che riproduce librerie di suoni-campione (SoundFont) SF2/SF3.
Zerberus: Un software di sintetizzatore che riproduce librerie di suoni-campione formato SFZ.
Effetti generali: Usato per applicare effetti multipli alla partitura.
Accordatura: Utilizzato per regolare l’intonazione generale della riproduzione sonora.
Dinamiche (versione 3.1 e successive): Usato per configurare i controlli Midi per le Dinamiche Nota Singola.

Salvare/Caricare le impostazioni del Sintetizzatore

I pulsanti nella parte inferiore della finestra del sintetizzatore hanno le seguenti funzioni:

Pulsante Funzione
Ripristina come
predefinite

Salva tutte le impostazioni correnti del Sintetizzatore come impostazioni predefinite. Queste vengono poi
applicate automaticamente al Sintetizzatore quando si apre MuseScore.

Carica
predefinito

Carica le ultime impostazioni predefinite salvate nel Sintetizzatore.

Salva nella
partitura

Salva tutte le impostazioni correnti del Sintetizzatore solo nella partitura corrente.
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Carica da
partitura

Carica le impostazioni dalla partitura corrente sul Sintetizzatore.Pulsante Funzione

Note: (1) Le "impostazioni del sintetizzatore" includono l'ordine dei SoundFonts (Librerie di suoni) e dei file SFZ,
l'impostazione degli effetti, la sintonizzazione master e il volume (2) Può essere attivo un solo un set di impostazioni del
sintetizzatore alla volta - cioè se più partiture sono aperte contemporaneamente, non è possibile fare modifiche al
sintetizzatore in una partitura e lasciare intatte le impostazioni delle altre partiture. (3) Le modifiche alle impostazioni del
sintetizzatore non potranno essere sentite nei file audio esportati a meno che non siano state prima salvate nella partitura
(vedere tabella, sopra). Vedere anche Accordatura (sotto).

Fluid

Cliccare sulla scheda Fluid per accedere al pannello di controllo per le librerie suoni-campione (SoundFont) SF2/SF3. Per
impostazione predefinita, la libreria SoundFont MuseScore_General.sf3 dovrebbe essere già caricata.

È possibile caricare, riorganizzare e cancellare i SoundFonts come richiesto. La riproduzione sonora può essere condivisa
tra qualsiasi combinazione di diversi SoundFonts (e/o file SFZ). L'ordine dei SoundFonts in Fluid si riflette nell'ordine
predefinito degli strumenti nel mixer.

Per caricare una libreria suoni (SoundFont)

1. Cliccare sul pulsante Aggiungi
2. Cliccare su un SoundFont nella lista.

Per poter caricare il SoundFont, è necessario che prima sia stato installato nella propria cartella SoundFonts. Questo
farà sì che appaia nella lista al passo 2 (sopra).

Per riordinare i SoundFont

1. Cliccare su un SoundFont.
2. Usare le frecce su/giù (a destra) per regolare l'ordine.
3. Ripetere con altri SoundFonts nella lista se necessario.
4. Oppure usare la doppia freccia su (in alto a destra) per spostare qualsiasi SoundFont in cima alla lista.

L'ordine dei set di strumenti virtuali nel Sintetizzatore si riflette nell'ordine degli strumenti elencati nel Mixer. Quindi, se la
riproduzione di una partitura dipende da un insieme di set di strumenti, è consigliabile salvare la configurazione del
Sintetizzatore nella partitura in questione premendo il tasto Salva nella partitura. La prossima volta che si vorrà riprodurre la
partitura, premere il tasto Carica da partitura per caricare la stessa configurazione. Ricordare comunque, che questo modo di
operare imposta solo l'ordine degli strumenti - non gli strumenti stessi, che dovrebbero essere al loro posto sul computer.

Per rimuovere un SoundFont

1. Cliccare sul nome del SoundFont
2. Cliccare sul pulsante Cancella.

Questa operatività rimuove il SoundFont dal sintetizzatore ma non lo disinstalla dalla cartella SoundFonts: rimane ancora
disponibile se si desidera ricaricarlo in seguito.
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Zerberus

Cliccare sulla scheda Zerberus per accedere al pannello di controllo delle librerie di suoni-campione formato SFZ. È
possibile aggiungere, cancellare o riordinare file in modo simile alla scheda Fluid. Notare che, come per Fluid, prima di
essere caricati nel Sintetizzatore, i file SFZ devono essere installati nella cartella SoundFonts del computer.

Volume

Il cursore a destra del Sintetizzatore controlla il volume di riproduzione: qualsiasi modifica fatta qui dura solo fino alla fine
della sessione, a meno che non venga salvata nella partitura o impostata come nuovo default.

Effetti

La scheda Effetti generali del Sintetizzatore permette di aggiungere riverbero e compressione alla partitura.

Effetti generali con Riverbero Zita1 e Compressore SC4.

Per attivare o disattivare un effetto:

Selezionare un’opzione dall’elenco a discesa accanto a Effetto A o Effetto B (gli effetti sono applicati in serie, A →
B).

Per memorizzare e caricare le configurazioni degli effetti, usare i pulsanti situati nella parte inferiore della finestra del
Sintetizzatore Vedere Impostazioni del Sintetizzatore (sopra) per i dettagli.

Riverbero Zita 1

Il modulo di riverbero stereo Zita 1 permette di simulare l'atmosfera di qualsiasi ambiente, da una piccola stanza a una
grande sala. Il pre-ritardo, il tempo di riverbero e il tono del riverbero possono essere regolati finemente utilizzando i
controlli forniti:

Delay: (Ritardo) Imposta un pre-ritardo per il riverbero da 20 a 100 ms.
Low RT60 (Tempo di riverbero a bassa frequenza): Usare il controllo grigio per regolare la frequenza centrale (50-
1000 Hz) della banda di bassa frequenza che si vuole influenzare: il controllo verde regola il tempo di riverbero (1-8
secondi) di questa banda di frequenza.
Mid RT60 (Tempo di riverbero medio): Regola il tempo di riverbero (1-8 secondi) della banda di frequenza media.
HF Damping: Regola la componente ad alta frequenza del riverbero. Aumentando questo valore aumenta la
frequenza del punto di taglio rendendo il riverbero più luminoso e lungo.
EQ1: Permette di tagliare o aumentare (da -15 a +15) una banda di frequenza (centro = 40 Hz - 2 KHz) nella parte
bassa dello spettro.
EQ2: Permette di tagliare o aumentare (da -15 a +15) una banda di frequenza (centro = 160 Hz - 10 KHz) nella
parte alta dello spettro.
Output: Controlla la quantità di effetto applicato. "Dry" è nessun effetto. "Wet" indica il 100% di riverbero. "Mix" è un
bilanciamento 50/50 del segnale wet/dry.

Nota: EQ1 e EQ2 influenzano solo il tono del riverbero, non il segnale dry (non processato).
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Per impostare rapidamente una patch di effetti, impostare "Output" su "Mix" e regolare il controllo "Mid RT60" sul tempo di
riverbero desiderato. Poi mettere a punto l'effetto come spiegato sopra.

Compressore SC4

Il compressore stereo SC4 fornisce un fine controllo sulla gamma dinamica della riproduzione, riducendo la variazione di
volume tra suoni forti e morbidi. Offre i seguenti controlli:

RMS: Regola il bilanciamento tra compressione RMS (0) e Picco (1). Nel primo caso, il compressore risponde ai
livelli medi del segnale; in modalità Picco, il compressore risponde ai livelli di picco.
Attacco: (1,5-400 ms) Il tempo che impiega la compressione a inserirsi completamente dopo che il segnale supera il
livello di soglia.
Rilascia: (2-800 ms) Il tempo necessario alla compressione per tornare a zero dopo che il segnale scende sotto il
livello di soglia.
Soglia: (in dB) Il livello di segnale oltre il quale la compressione inizia ad avere effetto. Abbassando la soglia
aumenta la quantità di segnale che viene compresso.
Rapporto: La quantità di compressione applicata al segnale sopra la soglia. Più alto è il rapporto, maggiore è la
compressione. Varia tra 1:1 e 20:1.
Curva: Permette di selezionare una gamma tra "curva morbida" e "curva dura". Più morbida è la “curva”, più
graduale è la transizione tra il segnale non compresso e quello compresso.
Guadagno: La compressione tende ad abbassare il volume, quindi usare questo controllo per aumentare il segnale
come desiderato.

Per impostare rapidamente, provare con i valori RMS = 1, Soglia = -20 db, Rapporto = 6. Aumentare il Guadagno per
ripristinare il volume perso. Poi mettere a punto come spiegato sopra.

Accordatura

Nella scheda Accordatura è possibile regolare l'accordatura generale del programma. Per gli strumenti traspositori, A4 =
440 Hz di default.

Per cambiare l’accordatura generale:

Inserire in nuovo valore nel campo Accordatura e premere il pulsante Cambia accordatura.

Note: (1) Questa accordatura si applica solo a tutte le partiture nella sessione corrente. Per renderla predefinita del
programma o per memorizzarla in una partitura particolare, vedere Salvare/Caricare le impostazioni del Sintetizzatore. (2)
Per applicare la nuova accordatura ai file audio esportati (WAV, MP3, OGG), premere Salva nella partitura prima di esportare.

Dinamiche (versione 3.1 e superiori)

Cliccare sulla scheda Dinamiche per accedere al pannello di controllo per le Dinamiche Nota Singola:
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Metodo della dinamica: È possibile scegliere tra 1) Predefinito (dinamica e intensità della singola nota), 2) Solo
intensità (nessuna dinamica di una singola nota), 3) Solo eventi CC (intensità costante).
CC da utilizzare: A seconda del SoundFont in uso, potrebbe sorgere l’esigenza di dover scegliere quale
Continuous Controller utilizzare, 1) CC 1, 2) CC 2 (predefinito), 3) CC 4, 4) CC 11.

Nel riquadro Impostazioni avanzate, è possibile scegliere di abilitare o disabilitare il controllo di espressione per il suono
degli strumenti:

Cambia tutti i suoni: Selezionare 1) A Espressivo (per attivare controllo espressione per tutti i suoni degli
strumenti), 2) A non-Espressivo (per disattivare controllo espressione per tutti i suoni degli strumenti), 3) Ripristina
tutto (Ripristina tutti i suoni degli strumenti alle impostazioni predefinite).

Vedere anche

SoundFont
Mixer

Collegamenti esterni

How To: Using Single Note Dynamics (SND)  (MuseScore HowTo)

Swing

La funzione swing di MuseScore permette di cambiare la riproduzione sonora della partitura da un ritmo “Preciso” a uno
con swing. Lo swing può essere applicato globalmente o solo a una sezione della partitura, ed è completamente variabile.

Applicare lo swing a una sezione della partitura

Per applicare lo swing a tutti i righi in una accollatura:

1. Cliccare sulla nota dove si vuole che inizi lo swing;

2. Cliccare Swing nella tavolozza Testo (doppio clic nelle versioni precedenti a 3.4);
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3. Modificare il testo Swing se necessario;

4. Se vi è necessità di variare lo swing rispetto la sua impostazione predefinita, cliccare con il tasto destro del mouse
sul testo Swing e selezionare Proprietà testo di accollatura...  Cliccare sulla scheda "Impostazioni Swing", scegliere la
durata della nota (Croma/Semicroma) e regolare il "Rapporto di swing".

Per applicare lo swing solo a specifici righi in una accollatura:

1. Cliccare sulla nota dalla quale si vuole che inizi lo swing;
2. Aggiungere Testo di rigo;
3. Modificare l'aspetto del testo come richiesto;
4. Cliccare con il tasto destro sul testo, selezionare Proprietà testo di rigo…, e cliccare sulla scheda "Impostazioni swing".

Modificare come richiesto;
5. Ripetere i passaggi da 1 a 4 per altri righi se necessario.

Il testo Swing può essere modificato e formattato come qualsiasi altro oggetto di testo.

Terzina nella marcatura del tempo

Spesso questa notazione è usata per indicare lo swing:
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MuseScore non ha un modo per includere una terzina nel testo come indicazione di tempo; esiste comunque una
semplice soluzione alternativa:

1. Aggiungere il testo Swing come descritto sopra e renderlo invisibile (scorciatoia V, o deselezionare "Visibile"
nell’Ispettore);

2. Aggiungere alla partitura una Immagine appropriata della indicazione di tempo richiesta. Queste immagini possono
essere scaricate da fine pagina "Come fare", argomento: How to create a visual swing marking .

3. Ridimensionare e riposizionare l'immagine come richiesto.

Ritorno al ritmo normale (Preciso)

Se si vuole che la riproduzione sonora ritorni al ritmo preciso dopo una sezione di swing, usare una delle seguenti opzioni:

Usare e modificare un testo Swing. (prima della versione 3.4).

1. Aggiungere testo Swing alla prima nota o pausa della sezione “Preciso" (vedere sopra).
2. Modificare il testo per indicare il ritorno al tempo senza swing: es. "Ritmo preciso".
3. Cliccare con il tasto destro del mouse sul testo e selezionare Proprietà testo di accollatura… . Cliccare sulla scheda

"Impostazioni swing" e impostare "Swing” su "Spento".

Usare il testo “Preciso” come per la versione 3.4.

Aggiungere il testo Preciso dalla Tavolozza principale - Testo alla prima nota o pausa della sezione "precisa"
(vedere sopra).

Applicare lo swing globalmente

Se si vuole applicare lo swing a tutta la partitura, è possibile potete farlo dal menù:

1. Selezionare Formato → Stile → Partitura.

2. Nella sezione "Impostazioni Swing ", selezionare il valore di nota desiderato e il relativo "rapporto di swing".
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Collegamenti esterni

How to create a visual swing marking  (MuseScore HowTo)
Swing (jazz performance style)  (Wikipedia)

Dinamiche

Le Dinamiche sono simboli che indicano il volume relativo di una nota o di una frase musicale. Si possono trovare nella
tavolozza Dinamiche sia nell’area di lavoro Essenziale che nell’Avanzata.

Ulteriori simboli di dinamiche sono disponibili nella Tavolozza generale (Maiusc+F9).

Nota: Nel caso in cui si voglia regolare il volume generale di riproduzione della partitura, utilizzare il cursore del volume
nel pannello Controlli riproduzione, o nel Sintetizzatore.

Aggiungere una dinamica

Per applicare una dinamica alla partitura, utilizzare uno dei seguenti metodi:

Selezionare una nota e cliccare su un simbolo di dinamica nella tavolozza (doppio clic nelle versioni precedenti alla
3.4).
Trascinare un simbolo di dinamica dalla tavolozza su una nota.

Per creare un crescendo o un decrescendo, vedere Forcelle.

Regolare le proprietà di una dinamica

La dinamica di default della partitura è mf (mezzoforte) impostata a Intensità pari a 80 (su 127). A seconda della dinamica
che governa una particolare sezione della partitura, l’intensità (e il volume risultante) può essere sia inferiore che
superiore a questo valore.

Modificare l’intensità di una dinamica
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Selezionare la dinamica e, nella sezione Dinamica dell’Ispettore modificare il valore Velocity, più alto per più forte,
più basso per più tenue.

Modificare l’ambito di applicazione (“Gamma” nell’Ispettore)

Nota: Gamma = i pentagrammi dell’accollatura interessati dalla dinamica.

Selezionare la dinamica, e nella sezione Dinamica dell’ Ispettore, scegliere una opzione in "Gamma dinamica". Il
valore preimpostato è "Parte", che significa che sono interessati tutti i pentagrammi di un particolare strumento.
"Pentagramma" limita l’effetto al pentagramma cui la dinamica è collegata. "Accollatura" significa che tutti i
pentagrammi dell’accollatura saranno interessati dalla dinamica.

Cambiare il posizionamento (sopra o sotto il pentagramma)

Per un singolo indicatore di dinamica: selezionarlo e digitare X per capovolgerne la posizione oppure usare
l’Ispettore (vedere sotto).
Per tutti i simboli di dinamica nel pentagramma:

1. Cliccare con il tasto destro del mouse su una dinamica, poi scegliere Seleziona > Tutti gli elementi simili nel
pentagramma;

2. Nella sezione Dinamica dell’Ispettore scegliere l’opzione richiesta Sopra o Sotto nel menù a discesa di
"Posizione".

Per tutti i segni di dinamica nella partitura:
Vedere sopra, poi usare il pulsante S "Imposta come stile" nell’Ispettore.

Personalizzare una dinamica

Le Dinamiche possono essere modificate come qualsiasi altro oggetto di testo. Speciali combinazioni di caratteri possono
essere utilizzate per aggiungere i seguenti simboli:

Ctrl+Maiusc+P (Mac: Cmd+Maiusc+P): Piano p.
Ctrl+Maiusc+F (Mac: Cmd+Maiusc+F): Forte f.
Ctrl+Maiusc+M (Mac: Cmd+Maiusc+M): Mezzo m.
Ctrl+Maiusc+R (Mac: Cmd+Maiusc+R): Rinforzando r.
Ctrl+Maiusc+S: Sforzando s.
Ctrl+Maiusc+N (Mac: Cmd+Maiusc+N): Niente n.
Ctrl+Maiusc+Z (Mac: Cmd+Maiusc+Z): Z z.

È inoltre possibile modificarne Intensità, Gamma dinamica, etc. (vedere sopra). Se lo si desidera, è possibile salvare il
risultato per utilizzi successivi in una tavolozza personalizzata.

Dinamiche Singola Nota (SND)

A partire dalla versione 3.1, MuseScore supporta le dinamiche per singola nota. Oltre che modificare l’intensità,
nell’Ispettore è possibile anche regolare il “Cambio di intensità”. Inserendo un numero in questo campo l’intensità della
nota cambierà approssimativamente di quel valore dopo che l’intensità iniziale è stata riprodotta. Un numero negativo può
essere inserito abbassare il volume dopo quello iniziale della nota mentre un numero positivo aumenterà il volume della
nota dopo quello riprodotto inizialmente. Vedere i collegamenti (sotto) per maggiori dettagli.

Collegamenti esterni

Video tutorial: Lezione 10 - Articolazioni, Dinamiche e Testo
Using Single Note Dynamics (SND)  (MuseScore HowTo)
How to restore correct playback of dynamics and hairpins in an imported MIDI file  (MuseScore HowTo)
Dynamics  (Wikipedia)

Riproduzione (sonora) del Capotasto mobile

MuseScore permette di trasporre la riproduzione di un rigo, senza influenzare la notazione musicale. Questo simula
l'effetto di un capotasto mobile  (Wikipedia) sullo strumento.

Aggiungere un capotasto a un singolo rigo

1. Aggiungere testo di rigo alla nota/pausa da cui si vuole che inizi la riproduzione del capotasto;
2. Cliccare su "Proprietà" nella sezione "Testo di rigo" dell’Ispettore, o cliccare con il tasto destro del mouse sul testo di

rigo e selezionare Proprietà testo di rigo...; poi cliccare sulla scheda Impostazioni Capotasto;
3. Spuntare la casella "Impostazioni Capotasto", e impostare Tasti capotasto al numero di tasto al quale si vuole

applicarlo (ogni tasto aumenta la tonalità di un semitono);
4. Cliccare Ok per rendere effettive le modifiche;
5. Modificare la formulazione del testo come desiderato.
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Aggiungere il capotasto al rigo/intavolatura collegati

Stesso metodo come sopra, ma nel passo 1, aggiungere il testo di rigo solo al rigo musicale.

Aggiungere il capotasto al rigo/intavolatura non collegati

Stesso metodo di cui sopra, ma applicare il testo di rigo sia al rigo che all'intavolatura.

Nota: La riproduzione del capotasto sarà applicata dalla nota a cui il testo di rigo è attaccato, fino al prossimo testo di rigo
con "Impostazioni capotasto" abilitata, o fino alla fine della partitura.

Rimuovere il capotasto

Per rimuovere la riproduzione sonora del capotasto da un rigo, riportando lo strumento alla sua normale accordatura:

Aggiungere un testo di rigo con impostazione "Capotasto" uguale a "Nessun capotasto".

Testo
Vi sono molti tipi diversi di oggetti di testo in MuseScore (vedi tabelle sotto); il testo può anche essere trovato incorporato
nelle linee. Questo capitolo mostra come creare, formattare e modificare gli oggetti di testo, includendo anche
informazioni sui seguenti tipi di testo:

Tipo di testo Usi

Testo di rigo Testo di uso generale attaccato a un singolo pentagramma: appare solo nella parte dello strumento a
cui il rigo corrisponde.

Testo di
accollatura

Testo di uso generale attaccato a un unico pentagramma: appare in tutte le parti strumentali
dell’accollatura.

Simboli di
accordi Visualizza gli accordi associati a una melodia: di solito sopra il pentagramma.

Diteggiatura Numeri o lettere, collegati alle note, che mostrano quali dita usare.
Testo cantato Creare testi collegati a una melodia.
Numeri di
chiamata Facilitare le prove, dividere la partitura in sezioni, segnare i passaggi ecc.

Per altri tipi di testo disponibili in MuseScore, seguire i link qui sotto:

Tipo di testo Usi
Dinamiche Indica il volume di una nota o di una frase.
Basso figurato Notazione del periodo per tastieristi.
Testo di cornice Dettagli su titolo/compositore/paroliere all'inizio di una partitura; testi di canzoni, ecc.
Intestazione/Piè di pagina Numeri di pagina, informazioni di copyright, ecc. in intestazione/piè di pagina.
Testo Cambio strumento Applicare cambiamenti di strumenti nel corso della parte.
Ripetizioni e salti Da Capo, Dal segno, Fine etc.
Analisi dei numeri Romani (RNA) Un sistema di analisi degli accordi.

Sticking Lettere (L e R) collegate a note (per tamburo) che indicano quale mano o piede
usare.

Testo di Swing Passare dal tempo normale a quello di swing e viceversa.
Metronomo (indicazioni di
tempo) Applicare il metronomo e/o i segni di espressione.

Linee di testo Volta, ottava, linee di pedale, linee di barré per chitarra, ecc.

Modifica del testo

La modalità modifica testo permette di aggiungere o cancellare testo e di applicare la formattazione (ad esempio
grassetto, corsivo, sottolineato, ecc.) ai singoli caratteri.

Entrare/uscire dalla modalità di modifica del testo
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Per entrare in modalità modifica testo usare uno dei seguenti metodi:

Fare doppio clic su un oggetto di testo.
Cliccare su un oggetto di testo già selezionato.
Cliccare con il tasto destro del mouse su un oggetto di testo e selezionare Modifica elemento.
Cliccare su un oggetto di testo e premere Alt+Maiusc+E.

Nota: La creazione di un nuovo oggetto testo (vedere Testo, nozioni di base) mette automaticamente il programma in
modalità di modifica del testo.

È possibile accedere alle varie funzioni di formattazione dalla barra degli strumenti Testo, che appare sotto la finestra
del documento:

Per uscire dalla modalità di modifica del testo usare uno dei seguenti modi:

Premere Esc.
Cliccare su un’area della partitura fuori dalla finestra di modifica.

Scorciatoie da tastiera

In modalità modifica testo, sono disponibili le seguenti scorciatoie da testiera:

Ctrl+B (Mac: Cmd+B) alterna carattere grassetto.
Ctrl+I (Mac: Cmd+I) alterna carattere corsivo.
Ctrl+U (Mac: Cmd+U) alterna sottolineato.
Inizio Fine ← → ↑ ↓ muove il cursore.
Backspace (Mac: Delete) rimuove il carattere a sinistra del cursore.
Canc (Mac: → Delete o Fn+Canc) rimuove il carattere a destra del cursore.
↵ inizia una nuova linea.
F2 (Mac: Fn+F2) Inserisce caratteri speciali (vedere sotto).

Simboli e caratteri speciali

È possibile usare la finestra Caratteri speciali per inserire nel testo note, frazioni e molti altri tipi di simboli o caratteri
speciali. Alcuni simboli sono accessibili anche tramite scorciatoie (vedere sotto).

Per accedere alla tavolozza Caratteri speciali, usare uno dei seguenti metodi:
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Cliccare sull’icona  nella barra strumenti di testo (in basso nella finestra della partitura).
Press F2 (Mac: Fn+F2).

Note: (1) Questo funziona solo in modalità modifica testo; (2) La finestra di dialogo Caratteri speciali non deve essere
confusa con la voce di menu con lo stesso nome nella versione macOS di MuseScore.

La finestra di dialogo è divisa in 3 schede: Simboli comuni, simboli musicali e simboli unicode. Le schede musicali e
unicode sono ulteriormente suddivise in categorie in ordine alfabetico.

Cliccando su un elemento nella finestra di dialogo dei caratteri speciali lo si aggiunge immediatamente al testo dove è
posizionato il cursore. Si possono applicare più elementi senza chiudere la finestra di dialogo, e l'utente può anche
continuare a digitare normalmente, cancellare caratteri, inserire codici di caratteri numerici ecc.

Scorciatoie con caratteri speciali

In modalità modifica testo per poter accedere ad alcuni caratteri speciali, sono disponibili le seguenti scorciatoie da
tastiera:

Ctrl+Maiusc+# (Mac: Cmd+Maiusc+#): Diesis ♯. (Nota: Questo potrebbe non funzionare su ogni tipo di tastiera)
Ctrl+Maiusc+B (Mac: Cmd+Maiusc+B): Bemolle ♭.
Ctrl+Maiusc+H (Mac: Cmd+Maiusc+H): Bequadro ♮.
Ctrl+Maiusc+P (Mac: Cmd+Maiusc+P): Piano p.
Ctrl+Maiusc+F (Mac: Cmd+Maiusc+F): Forte f.
Ctrl+Maiusc+M (Mac: Cmd+Maiusc+M): Mezzo m.
Ctrl+Maiusc+R (Mac: Cmd+Maiusc+R): Rinforzando r.
Ctrl+Maiusc+S (Mac: Cmd+Maiusc+S): Sforzando s.
Ctrl+Maiusc+N (Mac: Cmd+Maiusc+N): Niente n.
Ctrl+Maiusc+Z (Mac: Cmd+Maiusc+Z): Z z.
Ctrl+Alt+- (Mac: Cmd+Alt+-): Elisione ‿.

Vedere anche

Simboli di accordi
Testo cantato
Cornici
Modalità modifica

Testo, nozioni di base

Aggiungere testo

Per aggiungere un elemento di testo allo spartito, usate uno dei seguenti metodi generali:

Scorciatoie da tastiera: Per esempio, premere Ctrl+T per inserire Testo di rigo, Ctrl+L per inserire Testi cantati, e così
via.
Menù comandi: Aggiungi→Testo permette di scegliere fra una serie di elementi di testo.
Area di lavoro: Selezionare una nota e cliccare una icona in una delle tavolozze con elementi di testo (doppio clic
nelle versioni precedenti la 3.4); oppure, in alternativa, trascinare il simbolo dalla tavolozza al pentagramma.
Esempio: Testo di Swing, Metronomo, ecc.

Note: (1) Il metodo corretto dipende dal tipo di testo che si sta aggiungendo (vedere Testo). (2) Per le caselle di testo di
uso generale collegate ai pentagrammi, vedere Testo di rigo e di accollatura.

Formattazione del testo

Quando in MuseScore viene creato un oggetto di testo, questo assume il corrispondente Stile di Testo: tutto il testo di
pentagramma, per esempio, ha un unico Stile di Testo, così come le indicazioni metronomometriche, le dinamiche, i
simboli di accordo, ecc. Ogni Stile di Testo consiste di un numero di proprietà caratteristiche (tipo di carattere,
dimensione, stile, ecc.), che possono essere visualizzate, principalmente, nella finestra di dialogo Stile del testo
(Formato→Stile→Stile del testo).

Un oggetto di testo appena creato assume proprietà di testo identiche a quelle stabilite in Stile di testo. Queste possono
essere visualizzate nell'Ispettore:
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Tuttavia, queste proprietà del testo non sono limitate a quelle dello Stile di testo in vigore: se necessario, è possibile
modificarle nell'Ispettore in modo indipendente.

Infine, se si vuole applicare la formattazione a caratteri specifici in un oggetto di testo (tipo di carattere, grandezza,
Grassetto, Italico, Sottolineato, apice, pedice), è possibile farlo in modalità modifica testo.

Regolare la posizione degli oggetti di testo

Per posizionare un oggetto di testo, usare uno dei seguenti metodi:

Trascinare l’oggetto.
Selezionare l’oggetto e regolare i valori di offset X o Y nell’Ispettore.
Selezionare l’oggetto e applicare una delle seguenti scorciatoie da tastiera:

←: Sposta il testo a sinistra 0.1 spazi di pentagramma (s.p. da qui in avanti).
→: Sposta il testo a destra 0.1 s. p.
↑: Sposta il testo in alto 0.1 s. p.
↓: Sposta il testo in basso 0.1 s. p.
Ctrl+← (Mac: Cmd+←): Sposta il testo a sinistra uno s. p.
Ctrl+→ (Mac: Cmd+→): Sposta il testo a destra uno s. p.
Ctrl+↑ (Mac: Cmd+↑): Sposta il testo in alto uno s. p.
Ctrl+↓ (Mac: Cmd+↓): Sposta il testo in basso uno s. p.

Ancoraggi di testo

Quando si applica un elemento di testo alla partitura, la sua posizione di ancoraggio dipenderà dal tipo di testo:

Titolo, Sottotitolo, Compositore, Paroliere: Ancorati a cornice.
Diteggiatura: Ancorata alle teste-nota.
Testo cantato: Ancorato a “Battito di pentagramma”.
Simbolo di accordo: Ancorato a “Battito di pentagramma”.
Testo di pentagramma: Ancorato a “Battito di pentagramma”.
Testo di accollatura: Ancorato a “Battito di pentagramma”.
Sticking: Ancorato a “Battito di pentagramma”.

Stili del testo e proprietà

Stili del testo

Quando si crea un oggetto di testo, inizialmente questo assume le proprietà dello Stile di Testo applicabile alla sua
classe. Gli oggetti testo di pentagramma, per esempio, hanno il loro proprio stile, così come le indicazioni di tempo, i testi
cantati, i simboli di accordo, e così via.

Per visualizzare e modificare qualsiasi Stile di testo: selezionare Formato→Stile→Stile del testo. Questo dà accesso alle
seguenti proprietà:
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Nome: Cambiare il tipo di stile in uso se necessario.
Carattere / Dimensione: Nome del carattere (esempio Times New Roman, Arial etc.) e la sua dimensione in punti.
Spaziatura della linea: Modifica l’interlinea.
Segui le dimensioni del rigo: Se la dimensione del testo cambia in proporzione alla scalatura della partitura.
Stile: Stile del carattere in uso, esempio Corsivo, Grassetto o Sottolineato.
Allineamento: Orizzontale (sinistra, centro, destra) e Verticale.
Colore: Colore del testo.
Offset X/Y: Offset orizzontale e verticale in unità di spazio pentagramma.
Cornice: Possibilità di scelta fra cornice circolare o rettangolare intorno al testo.
Bordo: Colore del bordo della cornice.
Evidenzia: Colore dello sfondo all’interno della cornice.
Spessore: Spessore della linea di etichetta in unità di spazio.
Margine: Margine della cornice interna in unità di spazio.

Raggio dell’angolo: Per cornice rettangolare, raggio dell’angolo arrotondato.

Note: L’opacità è impostata dal parametro "Canale alfa" nella finestra-dialogo "Seleziona il colore": valore compreso
fra 0, trasparente, e 255, opaco.

In alternativa, è possibile modificare le proprietà di uno Stile di Testo selezionando nella partitura un oggetto con il
desiderato stile, regolandone le proprietà nell’ Ispettore, e cliccando il pulsante Imposta come stile mentre si procede.
Questo aggiornerà automaticamente lo Stile di testo e tutti gli oggetti di testo pertinenti nella partitura.

Oggetti di testo

Se si vuol formattare un particolare oggetto di testo nella partitura in modo diverso rispetto al suo tipico Stile di Testo,
selezionarlo e regolarne le proprietà nell' Ispettore:

157



Nel caso che siano state apportate modifiche a una particolare proprietà del testo nell'Ispettore, ma si voglia riportare
quella proprietà al predefinito Stile di testo, premere il pulsante Rimuovi formattazione personalizzata .

Salvare e caricare stili di testo

Gli stili di testo (come tutti gli altri stili in un documento) possono essere salvati come file di stile e caricati in altri file
MuseScore. Vedere Salvare e caricare stile.

Vedere anche

Modifica del testo
Intestazione/Piè di pagina
Comportamento del testo e delle linee applicate

Testo di rigo e testo di accollatura

Il Testo di accollatura e il Testo di rigo sono testi fondamentali di uso generale. Per applicarli allo spartito, usare uno dei
seguenti metodi:

Selezionare una nota o una pausa; quindi per Testo di rigo, premere Ctrl+T; oppure per Testo di accollatura,
premere Maiusc+Ctrl+T.
Selezionare una nota o una pausa; quindi scegliere l’opzione desiderata da Aggiungi→Testo.
Selezionare una nota o una pausa, quindi cliccare il tipo di testo desiderato dalla tavolozza “Testo” (doppio clic nelle
versioni precedenti la 3.4).
Trascinare il tipo di testo desiderato dalla tavolozza su una nota o una pausa.

Questo creerà un riquadro di delimitazione vuoto, pronto per l’inserimento del testo. Per uscire premere Esc o cliccare su
uno spazio vuoto fuori dal riquadro.

Oltre al loro uso indicativo, i testi di rigo e di accollatura hanno anche proprietà di riproduzione sonora opzionali: vedere
sotto.

Sommario delle differenze:

Stile Testo Si applica a? Riproduzione sonora (se
applicabile)

Appare nelle parti
strumentali?

Testo di Rigo Solo al rigo Solo al rigo Solo allo strumento di cui al rigo
Testo di
Accollatura

Tutti i righi
dell’accollatura Tutti i righi dell’accollatura Tutti gli strumenti

Testo di rigo

Il Testo di Rigo è applicato a un rigo (o al doppio rigo per pianoforte, arpa) nella partitura, ed è indicativo solo per il quel
rigo; ogni effetto di riproduzione sonora associato a questo testo è limitato allo stesso modo. Il testo apparirà nella
corrispondente parte strumentale.

Se si sceglie di nascondere i righi vuoti, qualsiasi testo di rigo appartenente a un rigo vuoto sarà anch'esso nascosto.

Proprietà del testo di rigo

Le normali proprietà del testo, come il carattere, la dimensione, il corsivo ecc., possono essere visualizzate e aggiornate
direttamente nell'Ispettore, ma il testo di rigo può contenere anche proprietà relative alla riproduzione sonora.

Il testo di rigo può, per esempio, essere usato per applicare indicazioni come Solo o Pizzicato a un rigo della partitura. A
seconda di quale sia l'istruzione del testo di rigo, la riproduzione sonora di quel rigo nella posizione del testo può talvolta
essere alterata per corrispondere alle variazioni imposte dall'istruzione stessa. Le proprietà di riproduzione sonora di un
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testo di rigo sono accessibili in due modi:

Selezionare il testo di rigo, e cliccare su "Proprietà" nella sezione "Testo di rigo" nell’Ispettore.
Cliccare con il tasto destro del mouse sul testo e scegliere "Proprietà testo rigo", poi cliccare sulla relativa scheda.

La finestra di dialogo che si apre contiene schede per le seguenti proprietà di riproduzione sonora:

Cambia canale.
Questa proprietà può essere usata per cambiare il suono di uno strumento, come passare dal suono aperto a quello
silenziato per una tromba, o tra “arco” e “pizzicato” per un violino. Tale modalità però funziona solo per gli strumenti
che sono definiti per avere più di un canale. Questa caratteristica può essere verificata selezionando la scheda
"Cambia canale" e cliccando su uno dei campi di opzione nella colonna "Channel:". Se è presente solo l’opzione
"normale", questo strumento ha un solo canale. Vedere Cambio suono nel corso del rigo per maggiori informazioni.

Impostazioni Swing.
Per scambiare la riproduzione sonora da normale a modalità "swing" solo per quel rigo/strumento. È possibile anche
applicare lo swing a tutti i righi della partitura o all'intera partitura dall'inizio alla fine. Vedere Swing per maggiori
informazioni.

Impostazioni Capotasto.
Per gli strumenti a corda è possibile applicare un diverso "capo tasto", trasponendo verso l’alto la riproduzione
sonora di un certo numero di tasti / semitoni. Vedere Riproduzione (sonora) del Capotasto mobile per maggiori
informazioni.

Azione MIDI
Questa scheda al momento non è attiva e può essere ignorata.

Quando il testo di rigo è copiato e incollato in altre posizioni della partitura, o viene aggiunto a una tavolozza
personalizzata, vengono copiate anche le relative proprietà di riproduzione sonora.

Testo di accollatura

Il testo di accollatura è applicato a un rigo della partitura, ma è indicativo per ogni rigo compreso nell’accollatura.
Qualsiasi proprietà di riproduzione sonora associata viene applicata all'intero sistema. Il testo apparirà in tutte le parti
strumentali dell’accollatura.

Il testo di accollatura non viene mai nascosto dalla funzione Nascondere i righi vuoti….

Proprietà del testo di accollatura

Per aggiungere o modificare lo Swing:

Cliccare con il tasto destro sul testo e scegliere Proprietà testo di accollatura, poi cliccare sulla scheda
Impostazioni Swing.

Vedere anche

Cambio suono nel corso del rigo

Collegamenti esterni

How to change instrument sound (e.g. pizz., con sordino) midway through score  (MuseScore HowTo)

Sigle accordali

Le Sigle accordali sono un modo abbreviato di rappresentare accordi musicali (vedere Chord names and symbols
(Wikipedia) per maggiori dettagli). Per esempio:

Nota: Per riempire battute con simboli “slash”, vedere Riempire con slashes oppure Attivare notazione ritmica slash.

Oltre alla notazione convenzionale delle Sigle accordali, dalla versione 3.3 MuseScore supporta anche Sistema Numerico
Nashville (NNS), e Analisi Numerali Romani (ANR).

Inserire una Sigla accordale

1. Selezionare una nota iniziale o uno “slash”;
2. Premere Ctrl+K (Mac: Cmd+K);
3. Il cursore è ora posizionato sopra il pentagramma pronto per l’inserimento. Inserire la Sigla accordale come un

normale testo, come segue:
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Nota fondamentale: A, B, C, D, E, F, G.
Diesis: # (simbolo 'cancelletto' #, AltGr+à sulla tastiera ITA).
Bemolle: b (lettera "b" minuscola).
Doppio diesis: x (lettera "x" minuscola) oppure ## (due simboli #).
Doppio bemolle: bb (doppia lettera "b" minuscola).
Bequadro: natural. Nota : Non ci dovrebbe essere alcun spazio prima della parola "natural"; al contrario
qualsiasi suffisso di accordo che la segue dovrebbe essere separato da spazio inserito con il comando
Ctrl+Spazio. Così, per scrivere B♮m: digitare "Bnatural", poi premere Ctrl+Spazio, quindi digitare "m". Si può usare
anche Ctrl+Maiusc+H. Notare che nessuno di questi inserimenti traspone o riproduce (oltre alla nota principale), o
esporta correttamente in MusicXML.
Per altre sigle, vedere Sintassi delle Sigle accordali (più avanti).

4. Muovere il cursore in avanti o indietro per continuare a inserire o modificare le Sigle accordali (vedere Comandi da
tastiera qui sotto);

5. Uscire dalla modalità inserimento sigle premendo Esc.

Quando si esce dall'inserimento di una Sigle accordale, i caratteri inseriti assumeranno automaticamente il formato
corretto: per default la nota fondamentale digitata con carattere minuscolo diventerà maiuscola (per opzioni alternative,
vedere Maiuscolo Automatico); un "#", "b" o "natural" si trasformeranno in corretti diesis (♯), bemolle (♭) o bequadro (♮) e
così via. Non tentare di utilizzare gli effettivi caratteri di bemolle, diesis e naturale, perché MuseScore non li
interpreterebbe correttamente.

Comandi da tastiera

Durante l'inserimento delle Sigle accordali sono disponibili i seguenti comandi:

Spazio sposta il cursore alla nota, alla pausa o al tempo successivo
Maiusc+Spazio sposta il cursore alla nota, alla pausa o al tempo precedenti
Ctrl+Spazio (Mac: Alt+Spazio) aggiunge uno spazio al nome dell’accordo
; sposta il cursore al tempo successivo
: sposta il cursore al tempo precedente
Tab sposta il cursore alla battuta successiva
Maiusc+Tab sposta il cursore alla battuta precedente
Ctrl (Mac: Cmd) più numero (1 - 9) sposta il cursore di un intervallo pari alla durata del numero corrispondente
(esempio; una minima – o metà – per 6)
Esc uscita.

Sintassi delle Sigle accordali

MuseScore interpreta correttamente la maggior parte delle abbreviazioni usate nelle Sigle accordali:

Maggiore: M, Ma, Maj, ma, maj, Δ (digitare t o ̂  per il triangolo)
Minore: m, mi, min, -
Diminuito: dim, ° (inserito con lettera minuscola o, visualizzata come ° se usata in stile Jazz, altrimenti come “o”)
Semi-diminuito: ø (digitare 0, zero). In alternativa, è possibile, naturalmente, scegliere abbreviazioni come mi7b5
ecc.
Aumentato: aug, +
Sono valide anche le seguenti abbreviazioni: estensioni e alterazioni come b9 o #5, sus, alt, e no3; inversioni e
accordi slash, come C7/E; virgole; parentesi, che possono contenere parte, o anche tutto, di una Sigle accordale.

Modificare una Sigla accordale

Una Sigla accordale esistente può essere modificata in modo simile al testo ordinario: Vedere Modifica del testo.

Trasposizione di una Sigla accordale

Le Sigle accordali vengono trasposte automaticamente per impostazione predefinita se si applica il comando Trasporto
alle battute che li contengono. Se questo non fosse necessario, si può deselezionare l’opzione "Trasponi le sigle
accordali" nella stessa finestra di dialogo.

Testo delle Sigle accordali

Per regolare l’aspetto di tutti i testi delle Sigle accordali, usare una delle seguenti opzioni:

Dal menù principale, scegliere Formato → Stile → Stile del testo → Sigle accordali. Modificare quindi le proprietà di testo
come necessario.
Selezionare una Sigla accordale ed effettuare le modifiche nell’ Ispettore, premendo il pulsante the "Imposta come
stile" mentre si procede.

Stile delle Sigle accordali

Per accedere alle opzioni di formattazione per le Sigle accordali:
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Dal menù, selezionare Formato→Stile→Sigle accordali. Le proprietà regolabili sono elencate sotto le seguenti voci:

Aspetto

Sono possibili tre opzioni: Standard, Jazz e Personalizzato. Puoi scegliere tra queste usando i pulsanti opzione.

Nello stile Standard le sigle sono visualizzate in modo semplice, con il carattere determinato dallo stile del Testo
delle Sigle accordali in vigore.

Nello stile Jazz viene usato il carattere MuseJazz allo scopo di ottenere l’effetto “scrittura a mano”, con apici distintivi
e altre caratteristiche di formattazione. Lo stile Jazz è selezionato di default utilizzando uno qualsiasi dei modelli
Jazz.

L’opzione stile Personalizzato permette di personalizzare l'aspetto delle Sigle accordali (e assicura anche la
compatibilità con le vecchie partiture). Selezionare un file Stile Sigle accordali personalizzato nel campo di
seguito: questo tipo di file può essere creato copiando e modificando uno dei file preesistenti nella cartella "Stili". La
documentazione si trova nella stessa cartella. Notare, comunque, che questa funzionalità è destinata ad utenti
avanzati, e non c'è garanzia che questi file saranno supportati in futuro.

Ortografia delle note

Per default MuseScore impiega la notazione anglosassone standard per le Sigle accordali. Per gli utenti di
nazionalità/regioni dove sono usati altri sistemi di denominazione delle note, MuseScore fornisce i seguenti controlli:

Standard: A, B♭, B, C, C♯,...
Tedesco: A, B♭, H, C, C♯,...
Puro Tedesco: A, B, H, C, Cis,...
Solfeggio: Do, Do♯, Re♭, Re,...
Francese: Do, Do♯, Ré♭, Ré,...

Maiuscolo Automatico

Per default, MuseScore trasforma automaticamente in lettere maiuscole tutti i nomi delle note all'uscita,
indipendentemente dal fatto che siano stati inseriti in maiuscolo o minuscolo. È comunque possibile scegliere anche altre
opzioni di maiuscolo automatico:

Accordi minori in minuscolo: c, cm, cm7,...
Basso di rivolto in minuscolo: C/e,...
Nomi delle note in maiuscolo: DO, RE, MI,...

È inoltre possibile disattivare completamente il maiuscolo automatico; in questo caso i nomi delle note sono
semplicemente resi nel modo in cui vengono digitati.

Posizionamento

Distanza dal diagramma per chitarra: Se è presente un diagramma per chitarra, questo valore rappresenta
l'altezza alla quale il simbolo dell'accordo è situato sopra il diagramma (si possono usare valori negativi).
Distanza minima accordo: Lo spazio da lasciare tra i simboli degli accordi.
Distanza massima stanghetta: Cambia la dimensione dello spazio tra l'ultimo simbolo dell'accordo nella battuta e
la stanghetta che segue. La regolazione di questo valore è necessaria solo se c'è un problema persistente nella
partitura con la sovrapposizione tra l'ultimo simbolo in una battuta e il primo simbolo nella successiva.

Nota: Oltre alle impostazioni qui descritte, la posizione predefinita dei simboli degli accordi applicati è determinata anche
dalle impostazioni nella finestra di dialogo Stile del testo e proprietà. L'effetto è cumulativo.

Posizione capotasto

Inserire il numero di posizione del capotasto su cui si vogliono visualizzare gli accordi sostitutivi, tra parentesi, dopo tutti i
simboli di accordo nella partitura.
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Sistema Numerico Nashville

Il Sistema Numerico Nashville (NNS), disponibile in MuseScore a partire dalla versione 3.3, è un modo sintetico di
rappresentare gli accordi basato sui gradi della scala anziché sulle lettere degli accordi. Questo permette di suonare un
accompagnamento in qualsiasi tonalità dallo stesso spartito di accordi.

Per inserire la notazione Nashville:

1. Selezionare una nota di partenza;
2. Dal menù, selezionare Aggiungi→Testo→Numero Nashville.

Proprio come con i simboli standard degli accordi, la notazione Nashville può essere normalmente digitata e MuseScore
farà del suo meglio per riconoscere e formattare i simboli in modo appropriato. Le stesse scorciatoie usate per la
navigazione quando si inseriscono i simboli degli accordi standard (per esempio Spazio, vedere sopra) sono disponibili
anche per la notazione Nashville.

Analisi in Numeri Romani

A partire da MuseScore 3.3, è in grado di analizzare e interpretare l' Analisi in Numeri Romani, un tipo di notazione
musicale in cui gli accordi sono rappresentati da numeri romani maiuscoli e minuscoli (I, ii, III, iv ecc.), apici, pedici e altri
simboli di modifica. È usato per annotare e analizzare l'armonia di una composizione indipendentemente dalla sua tonalità
di impianto (vedere Collegamenti esterni per maggiori dettagli).

Nota: A differenza delle Sigle accordali standard e della notazione Nashville, che MuseScore formatta usando i propri
algoritmi, l' ANR per formattare le sigle utilizza il font gratuito e open source Campania font . Questo consente a
MuseScore di formattare le sigle in fase di digitazione, piuttosto che applicare la formattazione solo a fine digitazione.
Inoltre, installando il font Campania nel sistema, questo potrà essere normalmente utilizzato anche in altri programmi,
beneficiando così della medesima formattazione.

Inserire l'ANR

1. Selezionare una nota di partenza;
2. Dal menù, selezionare Aggiungi→Testo→Analisi numeri romani. In alternativa, impostare in Preferenze una scorciatoia da

tastiera per eseguire automaticamente gli stessi comandi;
3. Inserire le sigle degli accordi in ANR come un testo normale, come segue;

Accordo maggiore: numerale romano maiuscolo
Accordo minore: numerale romano minuscolo
Accordo diminuito: o (carattere minuscolo)
Accordo semi-diminuito: 0 (zero)
Accordo aumentato: +
Inversioni di accordi: Inserire fino a 3 numeri a una cifra, prima la nota superiore
Accidenti: # (diesis), b (bemolle)
Per altri simboli, vedere le immagini sotto, "Esempi di ANR".

4. Muovere il cursore in avanti o indietro per continuare a inserire o modificare i simboli di altri accordi;
5. Quando una sigla in ANR è completato, uscire premendo Esc, o cliccando su una sezione vuota dello spartito.

Proprio come con i simboli standard degli accordi, si può digitare la simbologia in numeri romani normalmente e
MuseScore farà del suo meglio per riconoscere e formattare i simboli in modo appropriato. Le stesse scorciatoie usate
per la navigazione quando si inseriscono i simboli standard degli accordi sono disponibili anche per l'Analisi in Numeri
Romani (vedere Comandi da tastiera (sopra)).

Esempi di ANR

Digitare questo:

Per ottenere questo:
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Riproduzione (a partire dalla versione 3.5)

Vedere Riproduzione sonora: Simboli di accordo / Numerazione Nashville.

Collegamenti esterni

Nashville Number System  (Wikipedia)
Roman Numeral Analysis  (Wikipedia)
Campania font
Chord Symbol Voicings for Playback

Diteggiatura

I simboli di diteggiatura per vari strumenti si trovano nella tavolozza “Diteggiatura” nell’area di lavoro Avanzata.

La musica per tastiera impiega i numeri da 1 a 5 per rappresentare le dita delle mani sinistra e destra. È stato inoltre
sviluppato il plugin posizionatore di diteggiatura  allo scopo di ottimizzare la disposizione delle diteggiature del
pianoforte o della tastiera.

La musica per chitarra impiega i numeri da 0 a 4 per rappresentare la diteggiatura della mano sinistra (la lettera “T”
è occasionalmente usata per il pollice). La diteggiatura della mano destra è indicata dalle lettere p, i, m, a, c. I
numeri cerchiati rappresentano le corde dello strumento.

Gli ultimi cinque simboli nella tavolozza sono utilizzati per la diteggiatura del liuto nella musica antica.

Nota : Per abilitare la visualizzazione della diteggiatura nell'intavolatura, cliccare con il tasto destro del mouse sulla
TAB (tablatura) e selezionare Proprietà Pentagramma/Parte→Stile, proprietà avanzate…; quindi selezionare la casella etichettata
"Mostra diteggiature nell’intavolatura".

Aggiungere diteggiatura a una singola nota

Utilizzare uno dei seguenti metodi:

Selezionare una nota e cliccare su uno dei simboli di diteggiatura nella relativa Tavolozza (doppio clic nelle versioni
precedenti la 3.4).
Trascinare e rilasciare un simbolo di diteggiatura dalla relativa tavolozza su una nota.

Quando la diteggiatura viene aggiunta a una nota, il focus si sposta immediatamente sul simbolo, in modo da poterlo
regolare subito.

Aggiungere la diteggiatura a più note

1. Selezionare le note desiderate;
2. Fare clic su un simbolo di diteggiatura nella tavolozza (doppio clic nelle versioni precedenti la 3.4).

Modalità di inserimento della diteggiatura facilitato (versione 3.1 e superiori)

Questa caratteristica speciale permette di aggiungere rapidamente e facilmente la diteggiatura alle note successive.

1. Scegliere una delle seguenti opzioni:
Aggiungere il primo simbolo di diteggiatura usando uno dei metodi mostrati sopra: può trattarsi di inserimento
di "diteggiatura mano sinistra per chitarra", "diteggiatura" o "numero di corda";
Solo per "diteggiatura", selezionare una nota e premere la scorciatoia da tastiera per "Aggiungere
diteggiatura" (definita in Preferenze: Scorciatoie da tastiera); quindi digitare il numero desiderato;

2. Scegliere una delle seguenti opzioni:
Per spostare il cursore alla nota successiva: Premere Spazio, oppure Alt+→;
Per spostare il cursore alla nota precedente: Maiusc+Spazio, oppure Alt + ←;

3. Digitare il numero desiderato;
4. Ripetere i passi 2 e 3 se necessario;
5. Per uscire premere Esc, o cliccare su uno spazio vuoto nella finestra del documento.
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Regolare la posizione della diteggiatura

Diteggiatura singola

Per cambiare la posizione di un simbolo, usare uno dei seguenti metodi:

Per regolazioni fini (0.1 spazi di pentagramma) (s.p. per brevità) usare i tasti direzionali; Per regolazioni più ampie (1
s.p.) usare Ctrl+← → ↑ ↓ .
Cambiare gli spiazzamenti X e Y nell’Ispettore .
Trascinare il simbolo con il mouse.

Diteggiatura multipla

Per cambiare la posizione di più simboli:

1. Selezionare i simboli di diteggiatura desiderati;
2. Regolare utilizzando gli spiazzamenti X e Y nell’Ispettore .

Nota: È possibile utilizzare il plugin posizionatore di diteggiatura menzionato sopra per ottimizzare la disposizione delle
diteggiature del pianoforte.

Per ripristinare un simbolo nella sua posizione predefinita selezionarlo e premere Ctrl+R.

Modifica testo diteggiatura

I simboli di diteggiatura sono oggetti di testo e possono essere modificati con le usuali analoghe modalità. Le proprietà del
testo e lo stile generale possono essere regolati nell’Ispettore.

Testo cantato

Inserire una linea di testo cantato

Prima riga

1. Inserire le note della linea melodica;
2. Selezionare la nota dalla quale si vuol cominciare ad inserire i testi
3. Per entrare nella modalità testo, digitare Ctrl+L (Mac: Cmd+L); oppure selezionare dal menù principale

Aggiungi→Testo→Testo cantato;
4. Scrivere una sillaba;
5. Usare le seguenti opzioni per continuare a inserire i testi:

Andare alla sillaba successiva: Premere Spazio (oppure Ctrl+→) (Mac: Alt+→) subito dopo la sillaba appena
scritta.
Trattino (per collegare le sillabe di una parola): Premere - subito dopo la sillaba appena scritta.
Andare alla sillaba precedente: Premere Maiusc+Spazio (oppure Ctrl+←) (Mac: Alt+→).
Spostarsi verso sinistra: Premere ← (freccia sinistra). Se il cursore si trova all'inizio di una sillaba, salterà a
quella precedente.
Spostarsi verso destra: Premere → (freccia destra). Se il cursore si trova alla fine di una sillaba, salterà a
quella successiva..
Passa alla sillaba sottostante: Premere ↓ (freccia giù).
Passare alla sillaba superiore: Premere ↑ (freccia su).
Iniziare una nuova linea di testo (strofa): Premere ↵ (Return) alla fine di una sillaba del testo esistente
(Nota: non usare il tasto Enter del tastierino numerico!).

6. Per uscire dalla modalità testo, premere Esc o cliccare fuori dalla casella di testo.

Linee (strofe) successive

Se si vuol aggiungere un'altra linea di testo ad una esistente (per esempio una seconda o terza strofa, ecc.):

1. Scegliere una delle seguenti opzioni:
Selezionare la nota dalla quale si vuole che inizi la nuova linea del testo. Entrare in modalità testo come
mostrato nel passo 3 (sopra). Il cursore si sposta su una nuova linea (vuota).
Entrare in modalità modifica testo da una sillaba esistente, portarsi alla fine della sillaba stessa e premere ↵
(Return). Il cursore si sposta alla riga successiva.

2. Continuare con l’inserimento del testo come da precedente passo 4 (sopra).

Esempio:
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Caratteri speciali

Nella maggior parte dei casi i testi possono essere modificati come un testo normale. Tuttavia, per inserire i seguenti
caratteri, sono necessarie speciali scorciatoie da tastiera:

carattere “Spazio”: Ctrl+Spazio (Mac: Alt+Spazio).

- (trattino): Ctrl+- (Mac: Alt+-) oppure AltGr+-.

Avanzamento di linea: Ctrl+↵ (Mac: Alt+Return) oppure Enter (dal tastierino numerico).

Numerazione strofe

Per numerare le strofe (o versi), digitare semplicemente il numero (es. 1.) e uno spazio prima della prima sillaba.
MuseScore allineerà automaticamente i numeri e la prima sillaba correttamente.

Melisma

Un melisma è una sillaba o una parola che si estende su due o più note. È indicato da una sottolineatura che si estende
dalla base di una sillaba all'ultima nota del melisma. La sottolineatura si ottiene posizionando il cursore alla fine di una
sillaba e premendo Maiusc+_: una volta per ogni nota del melisma. Vedere l'immagine sottostante:

Il testo di cui sopra è stato creato nel modo seguente:

1. Digitare le lettere, soul,.
2. Alla fine della parola, premere Maiusc+___.
3. Digitare le lettere To, quindi premere Esc.

Per estendere sillabe intermedie (non ultime) su più note basta usare trattini aggiuntivi -, normalmente solo uno di loro
verrà mostrato (più di uno solo se la distanza tra le sillabe raggiunge un’ampiezza che lo richiede), e la sillaba si allineerà
a destra della prima nota, in modo simile alle ultime sillabe che sono state annotate con il melisma dell’esempio sopra.

Legatura di elisione (o di Testo) / Sinalèfe

Due sillabe sotto una stessa nota possono essere unite con una legatura di elisione, conosciuta anche come "legatura di
testo" o "sinalèfe". Ad esempio:

Per creare il testo lirico di esempio, (partendo dalla sillaba "te"):

1. Digitare te;
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2. Cliccare sull’icona “Inserisci caratteri speciale”  in basso a sinistra dello schermo, oppure premere F2 per aprire
la tavolozza Caratteri speciali;

3. Utilizzare una delle seguenti opzioni:

Cliccare su una delle tre legature di elisione nella scheda "Simboli comuni": "Elisione stretta", "Elisione", o
"Elisione ampia" (si trovano fra la “chiave di Do” "e la lettera "p" delle dinamiche; vedere immagine di seguito):

Cliccare sulla legatura di elisione situata dopo la frazione 7/8 nella tabella "Simboli comuni" (tabella sopra). A
seconda del font di caratteri in uso, aggiungere uno o più spazi prima/dopo la legatura utilizzando Ctrl+Spazio
(Mac: Alt+Spazio).

Nota: Non tutti i font includono il carattere "undertie" (U+203F ‿ "undertie", presente in "Caratteri speciali"
principalmente per la compatibilità con le partiture scritte con MuseScore 1.x). Per scoprire quali dei font installati sul
computer lo supportano, vedere "fontlist " (individuare qualsiasi font che tra le sillabe "te" e "A" visualizzi la
legatura invece di un rettangolo vuoto).

4. Digitare A (e quindi proseguire con la sillaba successiva).

A partire dalla versione 3.6 l’inserimento della legatura è facilmente ottenibile con la scorciatoia: Ctrl+Alt+- (Mac: Cmd+Alt+-).

Modificare testi cantati

1. Entrare in modalità modifica testo su una sillaba esistente;
2. Usare i comandi standard di modifica testo per apportare le modifiche necessarie;
3. Continuare a inserire i testi (vedere sopra); o uscire dalla modalità testi premendo Esc.

Regolare le proprietà dei testi cantati

Per operare aggiustamenti globali alle proprietà di tutti i testi della partitura:

1. Dal menù selezionare Formato→Stile→Testo cantato;
2. Modificare le proprietà di posizionamento, spessore linea, margini, trattino e melisma come richiesto.

Regolare la posizione delle singole linee di testo

Per regolare la posizione di una particolare linea di testo:

1. Selezionare the la linea di testo da modificare: cioè cliccare con il tasto destro del mouse su una parola della riga e,
dal menù che compare, scegliere Seleziona→Di più... ; poi controllare le opzioni pertinenti, che dovrebbero includere
"Stesso sottotipo";

2. Regolare gli offset X e Y nell’Ispettore.

Copiare testi cantati negli appunti
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Per copiare tutti i testi cantati negli appunti:

Dalla barra del menù selezionare Attrezzi→Copia il testo cantato negli appunti .

Incollare testi cantati dagli appunti

Per copiare e incollare i testi cantati da un file di testo (per esempio) in una partitura:

1. Inserire nello spartito le note a cui sarà attaccato il testo.
2. Impostare i testi (in un file di testo) con gli appropriati spazi, trattini, interruzioni di riga, ecc.
3. Copiare il testo dal file agli appunti.
4. Selezionare in MuseScore la nota iniziale e premere Ctrl+L (Mac: Cmd+L) (passo 3 sotto Inserire testi cantati in una

partitura).
5. Applicando ripetutamente incolla si inserisce il testo cantato successivo. Potrebbe essere necessario inserire

melismi e fare altre correzioni man mano che si procede.

Vedere anche

Testo
Simboli degli accordi

Link esterni

How to insert Lyrics  (MuseScore HowTo)
How to move lyrics  (MuseScore HowTo)
How to add a block of text to a score  (MuseScore HowTo)
How to copy lyrics, or lyrics with rhythm  (MuseScore HowTo)
How to add lyrics in columns  (MuseScore HowTo)
Video tutorial: MuseScore in Minutes: Lesson 6 - Text, Lyrics and Chords

Numeri/lettere di chiamata

I numeri/lettere di chiamata (N.d.T. detti anche segni di prova) possono essere usati in diversi modi:

Identificare punti specifici in una partitura per facilitare le prove.
Come segnalibri nello spartito raggiungibili istantaneamente usando il comando Trova/Vai a.
Per contrassegnare le varie sezioni dello spartito.

Tipicamente, i segni di prova (numeri/lettere di chiamata) consistono appunto di una o più lettere e/o numeri, e
appaiono in sequenza nella partitura – per esempio A, B, C…, oppure 1, 2, 3… ecc. In alternativa, possono mostrare i
numeri di battuta (di solito più grandi dei numeri di misura standard, in grassetto e/o racchiusi in cornici). Le battute
d’aspetto sono automaticamente interrotte prima e dopo i segni di prova.

I segni di prova possono essere aggiunti alla partitura (i) automaticamente - il che assicura che siano nominati in
sequenza - o (ii) manualmente, permettendo di nominarli come si vuole.

Aggiungere un segno di prova

Posizionamento manuale

Creare manualmente un segno di prova:

1. Cliccare su una nota (o pausa) nella posizione desiderata;
2. Selezionare una delle seguenti opzioni:

Premere Ctrl+M (Mac: Cmd+M);
Dal menù, scegliere Aggiungi → Testo → Numero di chiamata;

3. Inserire il testo desiderato.

Posizionamento automatico

Aggiungere un segno di prova alfanumerico

Utilizzare una delle seguenti opzioni:

Cliccare su una nota (o pausa) nella posizione desiderata, quindi cliccare l’icona [B1] nella tavolozza “Testo” (doppio
clic nelle versioni precedenti la 3.4).
Trascinare e rilasciare il segno di prova dalla tavolozza "Testo" sulla partitura.

Note: (1) Per default, i segni sono aggiunti nella sequenza A, B, C ecc. (2) Per cambiare il formato dei segni aggiunti
successivamente (in lettere minuscole, o numeri), modificare con le nuove caratteristiche il segno di prova precedente. (3)
I segni aggiunti tra i segni di prova esistenti aggiungono un numero o una lettera al segno precedente: è buona prassi
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applicare successivamente il comando Risequenzia (vedere sotto).

Aggiungere segni di prova coincidenti ai numero-battuta

1. Aggiungere il primo segno di prova nella serie come alfabetico; poi modificarlo attribuendogli lo stesso numero della
battuta a cui è attaccato;

2. Aggiungere i segni successivi come mostrato sopra. Essi adotteranno automaticamente il formato “numero-battuta”.

Risequenziazione automatica dei segni di prova

MuseScore permette di riordinare automaticamente una serie di segni di prova nel caso siano andati fuori sequenza per
qualsiasi motivo. Usare il seguente metodo:

1. Prima di fare una selezione, si può, se lo si desidera, stabilire un nuovo formato per i segni di prova
(minuscolo/superiore, numero o numero di battuta) modificando manualmente – come desiderato – il primo segno
della serie.

2. Selezionare l’intervallo di battute alle quali si vuole applicare il comando Risequenzia… (in mancanza di selezione il
programma applica il processo di risequenziazione a tutte le battute).

3. Dal menù, selezionare Attrezzi → Risequenzia Numeri/lettere di chiamata .

MuseScore rileva automaticamente la sequenza in base al primo segno di prova nella selezione; tutti i successivi
selezionati sono poi modificati di conseguenza. Sono possibili le seguenti sequenze:

A, B, C etc.
a, b, c etc.
Numerica: 1, 2, 3 etc.
Numerica: coincidente al numero-battuta. Questa richiede che il numero del primo segno della serie sia uguale al
numero della battuta a cui è collegato.

Stile di testo

I segni di prova sono una varietà di testo di accollatura; appaiono sia sulla partitura che su ogni parte. Per impostazione
predefinita, vengono visualizzati con carattere grande e in grassetto, e racchiusi in cornici. Tutte le caratteristiche del loro
aspetto possono essere modificate globalmente attraverso lo stile di testo “Numero di chiamata”.

Ricerca per un numero/lettera di chiamata

Vedere Trova/Vai a (Visualizzazione e navigazione).

Vedere anche

Stili del testo; proprietà

Collegamenti esterni

Lettera di chiamata  (WikipediA)

Formattazione

Impaginazione e formattazione

Le opzioni di layout e formattazione della partitura sono accessibili dal menù Formato.

Modi per influenzare l'impaginazione

I principali comandi e le finestre di dialogo che influenzano l’impaginazione della partitura sono elencati immediatamente
sotto. Altre opzioni di formattazione sono contemplate più in basso nella pagina (per il testo, vedere Stile del testo e
proprietà).

Impostazioni di pagina: Regola le dimensioni generali dello spartito come grandezza della pagina, margini e scala.

Aumentare/Diminuire larghezza impaginazione: Regola la spaziatura della partitura allargando o stringendo le
battute selezionate.

Partitura: Imposta i dettagli generali dello spartito, come il carattere tipografico della musica, la visualizzazione delle
battute d’aspetto e se nascondere i righi vuoti.

Pagina: Regola la spaziatura di righi e accollature, margini della partitura e del testo cantato, ecc.

Stile delle battute: Imposta la spaziatura delle battute, influenzando quindi il numero di battute per linea.
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Dimensioni: Imposta la dimensione predefinita di note piccole e note di abbellimento, righi e chiavi piccole.

Altri comandi:

Aggiungere/Rimuovere interruzioni di accollatura: Imposta il numero di battute per accollatura.

Interruzioni e distanziatori: Applica interruzioni di accollatura, di pagina o di sezione. È inoltre possibile aggiungere
spazio extra tra particolari accollature o righi dove necessario.

Stile

Stile

Il sottomenù Stile contiene finestre di dialogo che permettono di regolare la formattazione globale di molti elementi della
partitura. Per aprire Stile usare una delle seguenti opzioni:

Dal menù, selezionare Formato→Stile
Fare clic con il tasto destro del mouse su uno spazio nella finestra del documento e selezionare Stile.
Usare una scorciatoia da tastiera (vedere Scorciatoie da tastiera).

Le finestre di dialogo dello Stile sono le seguenti:

Partitura

Per aprire la finestra dialogo Partitura, selezionare Formato→Stile→Partitura.

Questa finestra di dialogo permette di impostare proprietà globali, come il carattere tipografico musicale, la
visualizzazione delle battute d’aspetto, se nascondere o meno i righi vuoti, la riproduzione swing, ecc.

Caratteri simboli musicali: Scelta di visualizzazione con carattere Leland, Bravura, Emmentaler, Gonville,
MuseJazz o Petaluma. Spuntare la casella per confermare "Carica automaticamente le impostazioni dello stile in
base al font."

Caratteri testo musica: Scelta di visualizzazione con carattere Leland Text, Bravura Text, Emmentaler Text,
Gonville Text, MuseJazz Text o Petaluma Text.

Mostra note reali (strumenti traspositori disattivati): Spuntare questa opzione per visualizzare la partitura a note
reali (non trasposte). Se l’opzione non viene spuntata la partitura sarà visualizzata nella tonalità (Armatura di chiave)
tipica dello strumento traspositore (vedere: Partitura in DO).

Crea battute d’aspetto: Spuntare per visualizzare le battute d’aspetto.

Numero minimo di battute vuote: Il valore preimpostato è 2.
Larghezza minima di una battuta: Il valore preimpostato è 4 sp.

Posizione verticale del numero: Il valore preimpostato è -1,50 sp.

Attivare l’indentazione sulla prima accollatura: Spuntare per attivare il rientro (tipografico) della prima
accollatura.

Indentazione sulla prima accollatura: Il valore preimpostato è 5 sp.

Nascondere i righi vuoti all’interno delle accollature: Questa opzione risparmia spazio nascondendo quei righi in
un’accollatura che consistono solo di battute vuote. Si usa per le partiture condensate.

Non nascondere i righi vuoti nella prima accollatura: Visualizza sempre i righi nella prima accollatura anche se
sono composti da battute vuote.

Mostra sempre le graffe che si estendono al singolo rigo: Nel caso siano presenti nell’accollatura righi vuoti
relativi a “Famiglie” raggruppate da specifiche parentesi (voci, sottogruppi di strumenti omogenei), se la casella-
opzione viene spuntata, la relativa parentesi di raggruppamento viene visualizzata anche in caso di presenza di un
solo rigo non vuoto per Famiglia.

Mostra i valori delle note ignorando la stanghetta della battuta: Una caratteristica utile per annotare la musica
antica. Vedere Notazione libera (senza battute).

Nascondi il nome dello strumento se ce n’è solo uno: Di solito, in questo caso, non è necessario visualizzare il
nome dello strumento.

Impostazioni Swing permette di controllare il grado di Swing per tutto lo spartito.

Swing: Scelta tra Spento (default) / Croma / Semicroma.
Seleziona rapporto di swing: Il valore di default è 60%.
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Se si preferisce impostare lo swing nella pagina della partitura, vedere Swing.

Pagina

Per aprire la finestra di dialogo Pagina, selezionare Formato→Stile→Pagina.

Questa finestra di dialogo permette di regolare l’impaginazione generale della partitura cambiando la spaziatura di
margini, accollature, righi, linee di testo e cornici. È inoltre possibile controllare la visualizzazione delle armature di chiave,
dell’indicazione metrica e delle chiavi.

Il diagramma seguente è una guida ad alcuni parametri sotto il controllo di questa finestra di dialogo:

Margine superiore musica: Distanza tra la linea superiore del primo rigo di pagina e il margine superiore di pagina.

Margine inferiore musica: Distanza tra la linea inferiore dell'ultimo rigo della pagina e il margine inferiore di pagina .

Distanza tra righi: Spazio tra righi non facenti parte di doppio rigo (vedere sotto).

Distanza doppio rigo: Spazio tra i righi che condividono lo stesso strumento, come il pianoforte, l'organo o la
chitarra in caso di presenza di rigo e intavolatura.

Nota: Per modificare lo spazio sopra un particolare rigo vedere Distanza extra sopra un rigo (Proprietà dei righi).

Distanza minima tra le accollature: Distanza minima consentita tra un’accollatura e la successiva.
Massima distanza tra le accollature: Distanza massima consentita tra un’accollatura e la successiva.

(Altri parametri:)

Margine superiore cornice verticale: Altezza predefinita del margine sopra una cornice verticale.

Margine inferiore cornice verticale: Altezza predefinita del margine sotto una cornice verticale.

Soglia riempimento ultima accollatura: Se l'ultima accollatura è più lunga di questo valore percentuale di
larghezza della pagina, viene ulteriormente espansa fino al riempimento di quella larghezza.

Le seguenti caselle di controllo permettono di regolare la visualizzazione di chiavi, indicazioni metriche e armature di
chiave, comprese quelle di cortesia.

Crea chiave per tutte le accollature / Crea armatura di chiave per tutte le accollature / Crea chiave di cortesia / Crea
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indicazione metrica di cortesia / Crea armatura di chiave di cortesia.

Ulteriori possibilità introdotte con la versione 3.6

Nella figura sotto riportata il quadrato in colore rosso contiene i campi di regolazione dei parametri relativi alla funzionalità
Abilita la giustificazione verticale dei righi:

Per la spiegazione della funzionalità si rimanda a Nuove funzionalità di MuseScore 3.6, dove l’argomento è ampiamente
trattato.

Dimensioni

Per aprire la finestra di dialogo Dimensioni, selezionare Formato→Stile→Dimensioni.

Imposta la dimensione proporzionale delle note "piccole" e delle note di abbellimento, così come dei righi e delle chiavi
piccole. Cambiare queste impostazioni sarebbe insolito.

Intestazione, Piè di pagina

Per aprire la finestra di dialogo Intestazione, piè di pagina, selezionare Formato→Stile→Intestazione, piè di pagina.

Questo permette di aggiungere intestazioni e piè di pagina usando “metadati” (vedere Proprietà della partitura) - come
numeri di pagina, intestazioni di pagina, informazioni sul copyright, ecc. Per esempio, possono essere create intestazioni
e piè di pagina diverse per le pagine pari e dispari, come si possono mettere i numeri di pagina a destra per le pagine
dispari e a sinistra per quelle pari.

Se si passa con il mouse sopra la regione di testo “Intestazione” o “Piè di pagina”, apparirà una lista di macro con il loro
significato, così come i metadati esistenti e il loro contenuto.

Per creare un'intestazione o un piè di pagina per una parte individuale, quella parte deve essere la scheda attiva. Per
creare un'intestazione o un piè di pagina per una partitura con parti collegate, assicurarsi che la partitura principale sia
nella scheda attiva.

Numeri delle battute

Per aprire la finestra dialogo Numeri delle battute, selezionare Formato→Stile→Numeri delle battute.

Questo permette di specificare se i numeri di battuta appariranno nella partitura e, se sì, a quali intervalli.

Numeri delle battute: Spuntare per attivare la numerazione automatica delle battute.
Mostra il primo: Spuntare se si vuole che la prima battuta visualizzi un numero.
Tutti i righi: Spuntare per visualizzare i numeri su tutti i righi di una accollatura. Deselezionare se si vuole che il
numero appaia solo sul rigo superiore della accollatura.
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Ogni accollatura: Selezionare questa opzione per mettere i numeri di battuta all'inizio di ogni accollatura.
Intervallo: Per specificare che i numeri di battuta devono apparire a un intervallo di battute indicato dal numero. Per
esempio, un intervallo di 1 numero: ogni battuta; un intervallo di 5: numeri ogni cinque battute.
Posizionamento verticale: Selezionare dal menù a discesa se il numero di battuta deve apparire Sopra o Sotto il
rigo.
Posizionamento orizzontale: Selezionare dal menù a discesa la posizione orizzontale in cui si desidera che appaia
il numero della battuta; a Sinistra, in centro (Centra) o a Destra.
Posizione sopra: Permette di spostare la posizione standard del numero di battuta, tramite regolazione
spostamenti x/y, quando il numero di battuta si trova sopra il rigo.

Posizione in basso: Permette di spostare la posizione standard del numero di battuta, tramite regolazione
spostamenti x/y, quando il numero di battuta si trova sotto il rigo.

Mostra l’intervallo di numeri di battuta delle battute d’aspetto: Spuntare per attivare; sotto la battuta d’aspetto
comparirà fra parentesi l’intervallo numerico delle battute raggruppate (per esempio: [3-8] se le battute vuote
raggruppate sono quelle tra la 3 e la 8 del rigo).

Tipo di parentesi: Dal menù a tendina scegliere: Nessuna nel caso non si vogliano parentesi; Quadre se l’intervallo
deve essere racchiuso fra parentesi quadre; Tonde se l’intervallo deve essere racchiuso fra parentesi tonde. Il
valore di default è Quadre.
Posizionamento verticale / orizzontale: come per la sezione Numeri delle battute (sopra).
Posizione sopra / in basso: idem.

Accollatura

Per aprire la finestra dialogo Accollatura, selezionare Formato→Stile→Accollatura.

Questa finestra di dialogo permette di regolare alcune proprietà di tutte le accollature.

Parentesi di accollatura:

Spessore parentesi quadra: Imposta la larghezza delle parentesi quadre.
Spessore parentesi graffa: Imposta la larghezza delle parentesi graffe.
Distanza parentesi quadra: Imposta la distanza tra le parentesi quadre e le stanghette di inizio accollatura.
Distanza parentesi graffa: Imposta la distanza tra le parentesi graffe e le stanghette di inizio accollatura.

Vedere anche Parentesi (Raggruppamento righi).

Separatore di accollatura:

Destra / Sinistra: Specificare se mostrare i divisori di sistema, quali tipi, e applicare i valori di offset di
posizionamento globale.

Chiavi

Per aprire la finestra dialogo Chiavi, selezionare Formato→Stile→Chiavi.

Scegliere lo stile della chiave di intavolatura di default: Standard o Serif.

Alterazioni

Per aprire la finestra dialogo Alterazioni, selezionare Formato→Stile→Alterazioni.

Permette di specificare come visualizzare in partitura le alterazioni in caso di cambio armatura di chiave. Vedere
Bequadro sui cambi di armatura di chiave.

Battuta

Per aprire la finestra dialogo Battuta, selezionare Formato→Stile→Battuta.

Per dettagli, vedere Battuta.

Stanghette

Per aprire la finestra dialogo Stanghette, selezionare Formato→Stile→Stanghette.

Mostra suggerimenti per le stanghette (nei ritornelli con le “ali”):
Stanghetta all’inizio di un singolo rigo: Spuntare per mostrare la stanghetta all'inizio di un rigo.
Stanghetta all’inizio di righi multipli: Spuntare per mostrare la stanghetta all'inizio di più righi.
Scala le stanghette alle dimensioni del rigo: Influisce solo sui righi "piccoli".

Altre proprietà permettono di impostare lo spessore delle stanghette "sottili", "spesse" e doppie, la distanza tra le
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stanghette doppie e la distanza tra le stanghette di ripetizione e rispettivi punti.

Note

Per aprire la finestra dialogo Note, selezionare Formato→Stile→Note. La finestra di dialogo può anche essere aperta
direttamente dalla partitura cliccando con il tasto destro su qualsiasi nota e selezionando "Stile".

Qui è possibile regolare la distanza e lo spessore degli oggetti relativi alle note (gambi, tagli addizionali, punti, alterazioni).
Cambiare questi valori sarebbe insolito.

Gruppi di note (travature)

Per aprire la finestra dialogo Gruppi di note, selezionare Formato→Stile→Gruppi di note.

Questo permette di impostare le proprietà generali delle travature di note nella partitura:

Spessore travature
Distanza tra travature: Distanza verticale tra le travature.
Lunghezza minima codetta spezzata: Interessa le travature secondarie che non si estendono completamente da
una nota all'altra.

Spuntando l’opzione Appiattisci tutte le travature significa che tutte le travature delle note saranno solo orizzontali e non
inclinate.

Gruppi irregolari

Per aprire la finestra dialogo Gruppi irregolari, selezionare Formato→Stile→Gruppi irregolari.

Proprietà:

Direzione / Tipo di numero / Tipo di parentesi

Parentesi quadre:

Spessore parentesi quadra:
Altezza cediglia della parentesi; Imposta la lunghezza predefinita delle cediglie verticali alle estremità delle
parentesi dei gruppi irregolari.

Distanza verticale dalle note:

Pendenza massima: Limita la pendenza delle parentesi dei gruppi irregolari.
Distanza verticale dal gambo: Si riferisce al “Tipo di numero” e alla relativa parentesi (se presente).
Distanza verticale dalla testa delle note: Si riferisce al “Tipo di numero” e alla relativa parentesi (se presente).

Distanza orizzontale dalle note:

Distanza prima del gambo della prima nota: Imposta la posizione predefinita dell'inizio della parentesi del gruppo
irregolare quando si trova sopra/sotto i gambi delle note.
Distanza prima della testa della prima nota: Imposta la posizione predefinita dell'inizio della parentesi del gruppo
irregolare quando è sopra/sotto le teste delle note.
Distanza dopo il gambo dell’ultima nota: Imposta la posizione predefinita della fine della parentesi del gruppo
irregolare quando si trova sopra/sotto i gambi delle note.
Distanza dopo la testa dell’ultima nota: Imposta la posizione predefinita della fine della parentesi del gruppo
irregolare quando è sopra/sotto le teste delle note.

Arpeggi

Per aprire la finestra dialogo Arpeggi, selezionare Formato→Stile→Arpeggi.

Qui è possibile cambiare la distanza dalla nota, lo spessore della linea e la lunghezza della cediglia dei seguenti simboli di
arpeggio e “strum” (strimpellare?):

Legature (“di portamento” e “di valore”)

Per aprire la finestra dialogo Legature, selezionare Formato→Stile→Legature.

Spessore fondo linea
Spessore centro linea
Spessore linea tratteggiata
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Lunghezza minima legatura di valore
Posizionamento automatico min. distanza

Forcelle

Per aprire la finestra dialogo Hairpins, selezionare Formato→Stile→Forcelle.

Qui si possono impostare le proprietà predefinite delle forcelle (linee di crescendo e decrescendo):

Posizione: Posizionare sopra o sotto il rigo.
Posizione sopra/in basso: Impostare un valore numerico in unità sp.
Altezza: Larghezza della “bocca” della forcella.
Altezza continua: Ampiezza della forcella alla fine di una accollatura, prima che continui sulla accollatura
successiva.
Posizionamento automatico distanza dalla dinamica
Spessore linea

Volta

Per aprire la finestra dialogo Volta, selezionare Formato→Stile→Volta.

Qui si possono impostare le proprietà predefinite di volta:

Posizione: Impostare gli spiazzamenti in X e Y.
Altezza cediglia: La lunghezza delle linee discendenti alle estremità delle linee di volta.
Spessore linea
Stile linea: Una linea continua è l'opzione predefinita, ma ci sono in alternativa altre possibilità (tratteggiata,
punteggiata, tratto-punto e tratto-punto-punteggiato).

Ottava

Per aprire la finestra dialogo Ottava, selezionare Formato→Stile→Ottava.

Qui si possono impostare le proprietà predefinite di ottava (linee di ottava):

Solo numeri: Se non spuntato, l'ottava visualizza anche "va" o "vb" dopo il numero.
Posizione sopra / in basso: Impostare gli spiazzamenti X e Y per l'ottava.
Altezza della cediglia in alto / in basso: La lunghezza della linea ascendente / discendente alla fine dell'ottava.
Spessore linea
Stile linea: Una linea tratteggiata è l'opzione predefinita, ma ci sono in alternativa altre possibilità (continua,
punteggiata, tratto-punto e tratto-punto-punteggiato).

Pedale

Per aprire la finestra dialogo Pedale, selezionare Formato→Stile→Pedale.

Qui è possibile impostare le proprietà predefinite del pedale linee:

Posizione: Sotto o sopra il rigo.
Posizione sopra / in basso: Impostare l'esatta posizione predefinita utilizzando i valori di offset.
Spessore linea:
Stile linea: Una linea continua è l'opzione predefinita, ma ci sono in alternativa altre possibilità (tratteggiata,
punteggiata, tratto-punto e tratto-punto-punteggiato).

Trillo

Per aprire la finestra dialogo Trillo, selezionare Formato→Stile→Trillo.

Qui è possibile impostare il posizionamento predefinito della linea di Trillo:

Posizione: Sopra o sotto il rigo.
Posizione sopra / in basso: Imposta l'esatta posizione predefinita utilizzando i valori di offset.

Vibrato

Per aprire la finestra dialogo Vibrato, selezionare Formato→Stile→Vibrato.

Qui è possibile impostare il posizionamento predefinito della linea di Vibrato linee:

Posizione: Sopra o sotto il rigo.
__ Posizione sopra / in basso__: Imposta l'esatta posizione predefinita utilizzando i valori di offset.
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Bend

Per aprire la finestra dialogo Bend, selezionare Formato→Stile→Bend.

Qui si possono impostare le proprietà di visualizzazione di Bends. Questo include lo spessore della linea e la larghezza
della freccia.

Linea del testo

Per aprire la finestra dialogo Linea del testo, selezionare Formato→Stile→Linea del testo.

Qui è possibile impostare il posizionamento predefinito di linee del testo:

Posizione: Sotto o sopra il rigo.
Posizione sopra / in basso: Impostare l'esatta posizione predefinita utilizzando i valori di offset X e Y.

Linea testo di accollatura

Per aprire la finestra dialogo Linea del testo, selezionare Formato→Stile→Linea testo di accollatura .

Qui è possibile impostare il posizionamento predefinito di testo di accollatura:

Posizione: Sotto o sopra il rigo.
Posizione sopra / in basso: Impostare l'esatta posizione predefinita utilizzando i valori di offset X e Y.

Articolazioni e abbellimenti

Per aprire la finestra dialogo Articolazioni, Abbellimenti, selezionare Formato→Stile→ Articolazioni, Abbellimenti .

Questa finestra di dialogo permette di impostare le distanze di posizionamento predefinite e le dimensioni (in percentuale)
di articolazioni e abbellimenti.

Corona

Per aprire la finestra dialogo Corona, selezionare Formato→Stile→Corona.

Questa finestra di dialogo permette di impostare il posizionamento predefinito della corona.

Testo di rigo

Per aprire la finestra dialogo Testo di rigo, selezionare Formato→Stile→Testo di rigo.

Questa finestra di dialogo permette di impostare il posizionamento predefinito e le proprietà di auto-posizionamento del
testo di rigo.

Testo Tempo

Per aprire la finestra dialogo Testo Tempo, selezionare Formato→Stile→Testo Tempo.

Questa finestra di dialogo permette di impostare il posizionamento predefinito e le proprietà di auto-posizionamento del
testo indicazioni di tempo.

Testo cantato

Per aprire la finestra Testo cantato , scegliere Formato→Stile→Testo cantato.
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Testo cantato

Posizione: Posizione di default delle linee di testo cantato rispetto al rigo; Sopra o Sotto.
Posizione sopra / Posizione in basso: Spiazzamenti X e Y dalla "Posizione".
Interlinea: Distanza predefinita tra le linee del testo.
Min. margine superiore: Minima distanza fra linee di testo cantato e il profilo del rigo di appartenenza.
Min. margine inferiore: Minima distanza fra linee di testo cantato e il profilo del rigo successivo.
Min. distanza: Distanza minima fra le sillabe di una strofa.
Allinea il numero di verso: Allinea i numeri di strofa (se presenti più strofe numerate).

Trattino testo cantato

Lunghezza minima trattino: Lunghezza minima dei trattini intersillabici.
Massima lunghezza dei trattini: Lunghezza massima dei trattini intersillabici.
Distanza massima dal trattino: Distanza massima consentita tra i trattini. La riduzione di questo valore permette di
generare più trattini tra le sillabe, dove possibile, e viceversa.
Spessore trattino: Spessore (verticale) del trattino.
Distanza trattino: Distanza del trattino dalla sillaba.
Rapporto di posizione Y del trattino: Influenza il posizionamento verticale del trattino.
Forza sempre trattino: Spuntare per fare in modo che un trattino sia sempre visibile tra le sillabe.

Melisma testo cantato

Spessore melisma: Spessore (verticale) del melisma.
Distanza melisma: Distanza linea del melisma dalla sillaba.
Allineamento: passando con il mouse su ogni icona si può scegliere come allineare il testo cantato selezionato.

Vedere anche, Melisma.

Dinamiche

Per aprire la finestra dialogo Dinamiche, selezionare Formato→Stile→Dinamiche.

Questa finestra di dialogo permette di impostare il posizionamento predefinito e le proprietà di auto-posizionamento delle
dinamiche.

Numero di chiamata

Per aprire la finestra dialogo Numeri di chiamata, selezionare Formato→Stile→Numeri di chiamata.

Questa finestra di dialogo permette di impostare il posizionamento di default e le proprietà di auto-posizionamento dei
numeri/lettere di chiamata.

Basso continuo

Per aprire la finestra dialogo Basso continuo, selezionare Formato→Stile→Basso Continuo.

Questo permette di impostare il carattere predefinito, lo stile, l'allineamento e la posizione del basso continuo.
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Sigle accordali

Per aprire la finestra dialogo Sigle accordali, selezionare Formato→Stile→Sigle accordali.

Questa sezione permette di regolare il formato e il posizionamento delle Sigle accordali:

Aspetto:

Scegliere uno stile predefinito – Standard, Jazz o Personalizzato.

Ortografia:

Scegliere la convenzione ortografica per i simboli degli accordi e se usare lettere maiuscole o minuscole.

Posizionamento:

Distanza dal diagramma chitarra: Distanza (in unità sp.) da una sigla accordale a un diagramma di tastiera
quando entrambi sono applicati alla stessa posizione su un rigo musicale. Questo valore sovrascrive la precedente
impostazione "Posizione verticale predefinita". L'utente può scegliere di posizionare una sigla accordale sotto un
diagramma di tastiera inserendo un valore negativo.
Distanza minima accordo: Spazio minimo da lasciare tra le sigle accordali.
Distanza massima stanghetta: Aumenta la distanza tra il simbolo dell'accordo finale in una battuta e la linea di
battuta seguente. Potrebbe essere necessario regolare questo valore in caso di problemi ricorrenti nella partitura
con la sovrapposizione tra la sigla accordale finale in una battuta e quella successiva.

Massimo spostamento in alto / in basso: Variazioni verticali rispetto alla posizione standard.

Riproduci: Spuntare per attivare la riproduzione sonora di tutte le sigle accordali.

Interpretazione , Disposizione , Durata: vedere Interpretazione e Realizzazione delle Sigle accordali.

Posizione capotasto:

Posizione capotasto: Inserire un numero di posizione capotasto alla quale si vogliono visualizzare gli accordi
sostitutivi, tra parentesi, per tutte le sigle accordali nella partitura.

Diagrammi chitarra

Per aprire la finestra dialogo Diagrammi chitarra, selezionare Formato→Stile→Diagrammi chitarra.

Questa sezione permette di regolare il formato e il posizionamento dei Diagrammi per chitarra.

Posizione verticale predefinita: Distanza in unità sp. da un diagramma di tastiera appena applicato a un rigo. Si
può usare un valore negativo.
Scala: Aumentare o diminuire la dimensione del diagramma della tastiera nello spartito.
Posizione numero del tasto: Visualizza il numero di tasto a sinistra o a destra del diagramma della tastiera.
Dimensione del carattere del numero di tasto: Aumentare o diminuire le dimensioni del numero di tasto
visualizzato accanto a un diagramma.
Spessore linea barré: Rende le linee del barré nei diagrammi della tastiera più spesse o più sottili.
Dimensione relativa del punto: Controlla la dimensione dei punti su tutti i diagrammi, rispetto alla dimensione della
griglia in scala.
Spaziatura delle corde: Controlla la spaziatura tra le corde, e quindi la larghezza totale di tutti i diagrammi.
Spaziatura dei capotasti: Controlla la spaziatura tra i tasti, e quindi l'altezza totale di tutti i diagrammi rispetto al
numero di tasti che mostrano.
Massimo spostamento in alto / in basso: Variazioni verticali rispetto alla posizione standard.

Stile del testo

Per aprire la finestra dialogo Stile del testo, selezionare Formato→Stile→Stile del testo.

Questa finestra di dialogo permette di impostare la formattazione di tutti gli stili di testo. I singoli stili di testo possono
anche essere impostati dall' Ispettore.

Tasti OK / Annulla / Applica a tutte le parti

Tutte le modifiche apportate nella finestra di dialogo dello Stile sono immediatamente applicate alla partitura, ma possono
essere annullate in qualsiasi momento premendo Canc, il che fa anche uscire dalla finestra di dialogo. Premere OK per
salvare le modifiche alla partitura e chiudere la finestra.

Se si stanno facendo regolazioni di formattazione in una parte di strumento, usare il pulsante Applica a tutte le parti per
applicare tutte le modifiche a tutte le parti della partitura.

Impostazioni pagina
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Vedere Impostazioni pagina.

Aggiungi/Rimuovi interruzioni di accollatura

Questo comando aggiunge o rimuove le Interruzioni di accollatura su un intervallo selezionato o su tutta la partitura:

1. Selezionare un intervallo di misure. In assenza di una selezione il comando è applicato all'intera partitura.
2. Scegliendo Formato→Aggiungi/Rimuovi interruzioni di accollatura… appare la seguente finestra di dialogo:

3. Scegliere una delle seguenti opzioni:
Interrompere ogni X (numero scelto) misure;
Aggiungere un'interruzione ogni fine accollatura attualmente in partitura;
Rimuovere le interruzioni di accollatura impostate;

4. Premere OK.

Larghezza

Usato per aumentare, diminuire o ripristinare la spaziatura orizzontale delle figure musicali entro la regione di misure
selezionata.

Aumenta/Diminuisci larghezza impaginazione

1. Selezionare un intervallo di misure o utilizzare Ctrl+A per selezionare l'intera partitura.
2. Scegliere una delle due opzioni:

Per aumentare la larghezza impaginazione:
Utilizzare la scorciatoia } (parentesi graffa chiusa) (Tastiera italiana PC: Ctrl+Alt+Maiusc+[. Mac: Alt+Maiusc+[).
O dalla barra dei menù, scegliere Formato→Larghezza→Aumenta larghezza impaginazione.

Per diminuire la larghezza impaginazione:
Utilizzare la scorciatoia { (parentesi graffa aperta) (Tastiera italiana PC: Ctrl+Alt+Maiusc+[. Mac: Alt+Maiusc+[).
O dalla barra dei menù, scegliere Formato→Larghezza→Diminuisci larghezza impaginazione.

Ripristino larghezza

Per ripristinare la spaziatura orizzontale delle figure musicali al valore di 1:

1. Selezionare un intervallo di misure o utilizzare Ctrl+A per selezionare l'intera partitura.
2. Da menù, scegliereFormato→Larghezza→Ripristina larghezza impaginazione.

Vedere anche Proprietà delle battute: Larghezza battuta. Questo permette di impostare la larghezza in modo più preciso.

Ripristina stile del testo (sovrascrivi)

Per riportare tutti gli stili di testo alle impostazioni predefinite:

Dal menù, selezionare Formato→Ripristina stile del testo sovrascrivi.

Ripristina gambi (travature)

Per ripristinare le travature (raggruppamenti di note) al modo definito nelle locali indicazioni metriche:

1. Selezionare la sezione della partitura che si vuole resettare. In assenza di selezione, l'operazione verrà applicata a
tutta la partitura;

2. Selezionare Formato→Ripristina gambi.

Vedere anche Code.

Ripristina forme e posizioni
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Il comando Ripristina forme e posizioni ripristina le posizioni predefinite, le direzioni dei gambii delle note e le forme
(legature di valore e di portamento, ecc.) per gli elementi della partitura selezionati. Per applicarlo:

1. Selezionare gli elementi o l’intervallo di partitura che si vuol resettare. Oppure usare Ctrl+A per selezionare l'intera
partitura.

2. Premere Ctrl+R; oppure, dal menù, selezionare Formato→Ripristina forme e posizioni.

Carica/Salva stile

È facile trasferire un set completo di stili (tutte le impostazioni di Stile Generale, tutti gli stili del testo e proprietà, e le
impostazioni pagina) da una partitura all’altra usando la funzionalità Carica/Salva Stile.

Per caricare uno stile personalizzato:

1. Scegliere Formato→Carica Stile....
2. Navigare e selezionare il file Stile (.mss) quindi cliccare su Apri (oppure doppio click sul file).

Tutti gli stili presenti nella partitura dovrebbero aggiornarsi automaticamente.

Per salvare uno stile personalizzato:

1. Scegliere Formato→Salva Stile....
2. Assegnare un nome e salvare il file di stile (la cartella predefinita è impostata nelle proprie Preferenze). Gli stili sono

memorizzati come file *.mss.

Nota: È possibile definire uno stile preferito per partiture e parti anche nella sezione Partitura delle Preferenze di
MuseScore.

Vedere anche

Modificare spaziatura fra note
Upgrading from MuseScore 1.x, local relayout

Collegamenti esterni

Creating Modified Stave Notation in MuseScore  (MuseScore Tutorial)
MuseScore in 10 Easy Steps: Part 10A Layout and Formatting (a video tutorial)
MuseScore in 10 Easy Steps: Part 10B Layout and Formatting (a video tutorial) .BZI_T4).

Battute

Per aprire la finestra dialogo Battute, selezionare Formato→Stile→Battute.

Questo permette di regolare la distanza tra i vari elementi all'interno delle battute.

Introduzione

Se si modifica una proprietà dello stile di battuta, MuseScore regola automaticamente la partitura per mantenere la
corretta spaziatura tra le note e le pause secondo la migliore pratica di scrittura musicale. Riposizionerà anche
correttamente qualsiasi elemento collegato alle note o alle pause, come diteggiature, dinamiche, linee ecc.

Tutte le impostazioni relative alla larghezza delle battute e alla spaziatura delle note sono valori minimi. Le battute sono
automaticamente allungate, se necessario, per mantenere i margini di pagina esistenti.

Tutte le proprietà elencate di seguito usano lo spazio di pentagramma (abbreviato in "sp") come unità di misura di base.
Vedere Impostazioni pagina: Ridimensionamento per maggiori dettagli.

Opzioni

Larghezza minima battuta: Imposta la lunghezza orizzontale minima delle battute. Nelle battute che contengono
pochissimo contenuto (ad esempio, una singola nota intera o una pausa di misura intera), la larghezza si ridurrà
solo fino a questo minimo.

Spaziatura (1=stretta): Condensa o espande lo spazio dopo le note o le pause. Questa impostazione influisce
quindi non solo sullo spazio tra le note ma anche tra l'ultima nota e la stanghetta finale. Per lo spazio tra l'inizio della
battuta e la prima nota o pausa, vedi Nota margine sinistro (sotto).

Distanza minima note: Specifica la più piccola quantità di spazio che MuseScore lascerà dopo ogni nota (a
seconda di altri fattori, può essere permesso più spazio).

Margine sinistro nota: Fissa la distanza tra la stanghetta iniziale e la prima nota.
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Distanza note dalla stanghetta: Imposta la distanza dall'ultima nota alla seguente stanghetta.

Distanza stanghetta dall’abbellimento: Imposta la distanza tra stanghetta e nota di abbellimento che si presenti
prima della prima nota effettiva in una battuta (indipendentemente dall'impostazione "Margine sinistro nota").

Distanza stanghetta dall’alterazione: Imposta la distanza tra stanghetta e alterazione posta prima della prima nota
in una battuta (indipendentemente dall'impostazione "Margine sinistro nota").

Margine sinistro chiave: Imposta la distanza tra l'inizio di ogni riga e la chiave. (È una opzione necessaria
raramente).

Distanza chiave dalla stanghetta: Imposta la distanza tra una stanghetta e un cambio di chiave che la precede.

Margine destro chiave: Imposta la distanza tra una chiave aggiunta in corso di rigo o da una armatura di chiave e
la nota o la pausa seguente.

Distanza chiave - armatura: Imposta la distanza dalla chiave all’armatura di chiave che la segue.

Distanza chiave da indicazione metrica: Imposta la distanza tra la chiave e l'indicazione metrica che la segue (se
non c'è un'armatura di chiave in mezzo).

Margine sinistro armatura di chiave: Imposta la distanza tra l’inizio della battuta e l’armatura di chiave.

Distanza armatura di chiave da stanghetta: da aggiungere...

Distanza armatura da indicazione metrica: Imposta la distanza tra un’armatura di chiave e la seguente
indicazione metrica.

Margine sinistro indicazione metrica: Imposta la distanza tra l'inizio della battuta e un'indicazione metrica (se non
c'è un'armatura di chiave in mezzo).

Distanza indicazione metrica (unità di tempo) da stanghetta: da aggiungere...

Distanza intestazione accollatura: Imposta la distanza tra chiave o armatura di chiave a inizio accollatura e la
prima nota o pausa.

Distanza intestazione accollatura con indicazione metrica: Imposta la distanza da una indicazione di tempo
all'inizio di una accollatura e la prima nota o la prima pausa.

Margini battuta d’aspetto: Imposta la distanza tra una battuta d’aspetto e la stanghetta su entrambi i lati.

Spessore linea rigo: Imposta lo spessore delle linee del rigo musicale, il che permette di rendere il rigo più spesso
e più scuro, se serve avere maggiore visibilità sulle stampe.

Nota: I cambiamenti di allungamento di una battuta individuale (usando Formato→Larghezza → Aumenta/Diminuisci
larghezza impaginazione) sono calcolati dopo e proporzionalmente all'impostazione globale della spaziatura.

Impostazioni pagina

Impostazioni pagina permette di controllare globalmente le dimensioni della partitura quali dimensione pagina, margini di
pagina, e ridimensionamento. Questo è uno degli strumenti più importanti in MuseScore—insieme alle opzioni disponibili
nel menu Formato→Stile…

Per aprire la finestra Impostazioni pagina: dal menu, scegliere Formato → Impostazioni pagina....
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Dimensione pagina

Qui si può selezionare il formato della carta, sia in base al nome standard (ad esempio, Letter o A4), sia specificando
l'altezza e la larghezza in mm o pollici (usa i pulsanti di opzione per scegliere quale unità di misura usare). Il formato
pagina predefinito dipende dalla localizzazione: in Italia, il formato standard è l'A4.

Si può scegliere di formattale la musica in orientamento orizzontale o verticale usando i pulsanti di opzione.
Facoltativamente si può scegliere il formato Fronte-retro (p.es., il formato libro, coi margini sinistri e destri speculari per le
pagine pari e dispari - vedi sotto).

Margini pagine dispari/pari

Le impostazioni di Margini pagine pari e Margini pagine dispari permettono di definire l’area stampabile delle pagine.
Oltre a cambiare i margini intorno alla musica sulla pagina, altre impostazioni, come le posizioni di intestazioni e piè di
pagina, sono calcolate rispetto ai margini qui definiti.

Se la casella di controllo "Fronte-retro" sotto "Dimensione Pagina" è selezionata, è possibile fissare diversamente i
margini in modo da ottenere aspetto speculare tra pagine dispari e pari. Altrimenti solo un set di margini può essere
modificato, ma sarà applicato a tutte le pagine.
Per visualizzare i margini di pagina dello spartito sullo schermo (ma non in stampa), andare a Visualizza→Mostra margini
pagina.

Ridimensionamento

La proprietà Ridimensionamento consente di aumentare o diminuire le proporzioni della partitura.

In MuseScore, le dimensioni degli elementi in partitura, quali teste e gambi delle note, alterazioni, chiavi ecc., sono definiti
in termini di un'unità detta Spazio di pentagramma - abbreviato in sp (vedi Glossario) . Cambiando l'impostazione dello
"Spazio di pentagramma", tutti gli elementi verranno adeguati mantenendo così le corrette proporzioni. Fanno eccezione
gli oggetti di Testo a cui si può attribuire una dimensione assoluta, indipendente dal "Ridimensionamento"

Nota: Cambiare il "Ridimensionamento" non sempre modifica il numero di accollature per pagina, poiché la distanza fra le
accollature può variare entro i limiti fissati fra "Distanza minima tra accollature" e "Distanza massima tra accollature" (vedi
Formato→Stile→Pagina).

Unità (di misura)

Qui è possibile scegliere di visualizzare i valori in pollici o in millimetri.

Numero prima pagina
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Imposta il numero della prima pagina di una particolare partitura. I numeri di pagina inferiori a 1 non verranno stampati -
ad esempio, impostando il numero della prima pagina a -1 la prima e la seconda pagina non mostreranno alcun numero di
pagina, e il numero di pagina 1 apparirà sulla terza pagina.

Applica a tutte le parti

Il pulsante Applica a tutte le parti è disponibile quando si modifica una parte, anziché la partitura principale (vedere Estrazione
delle parti). Se si cambiano le impostazioni di pagina di una parte e si vuole che il resto delle parti abbia le stesse
impostazioni, questo pulsante applicherà il cambiamento a tutte le parti in una volta sola.

Interruzioni e Distanziatori

La tavolozza Interruzioni e Distanziatori contiene i seguenti simboli non stampabili:

I primi tre simboli sono chiamati interruzioni; le linee verticali sono conosciute come distanziatori.

Interruzioni

Una interruzione può essere applicata sia a una battuta che a una cornice. Ve ne sono tre tipi:

Interruzione di accollatura: Forza la parte restante dello spartito ad iniziare in una nuova accollatura.
Interruzione di pagina: Forza la parte restante dello spartito ad iniziare in una nuova pagina.
Interruzione di sezione: Forza la parte restante dello spartito ad iniziare in una nuova accollatura fissando inoltre
l’inizio di una nuova sezione (vedere sotto). Può essere combinata con una interruzione di pagina se necessario.

Note: (1) I simboli di interruzione sono visibili sullo schermo, ma non appaiono sulle stampe. (2) Per aggiungere (o
rimuovere) interruzioni di accollatura su tutta o parte della partitura, vedere Aggiungere/Rimuovere interruzioni di
accollatura. (3) Per dividere una battuta, vedere Operazioni sulle battute: dividere e unire.

Aggiungere una interruzione a una battuta

Le interruzioni possono essere aggiunte usando (1) una scorciatoia da tastiera; o (2) un simbolo di interruzione dalla
tavolozza.

Usare una scorciatoia da tastiera

Solo per aggiungere una Interruzione di accollatura o una Interruzione di pagina:

1. Selezionare una delle seguenti opzioni:
Stanghetta;
Battuta;
Testa della nota;
Elemento di testo associato a un rigo (per esempio sillaba di testo cantato, sigla accordale, testo di rigo, ecc;);
Intervallo di battute (scegliendo questa opzione, le interruzioni saranno applicate una prima e una dopo la
selezione);

2. Scegliere una delle seguenti opzioni:
Interruzione di accollatura: Premere↵ (aggiunge/toglie).
Interruzione di pagina: Premere Ctrl+↵ (Mac: Cmd+↵) (aggiunge/toglie).

Usare un simbolo di interruzione dalla tavolozza

Qualsiasi interruzione può essere aggiunta da tavolozza:

1. Selezionare una delle seguenti opzioni:
Stanghetta;
Battuta;
Testa della nota;
Elemento di testo associato a un rigo (per esempio sillaba di testo cantato, sigla accordale, testo di rigo, ecc;);
Intervallo di battute (scegliendo questa opzione, le interruzioni saranno applicate una prima e una dopo la
selezione);

2. Cliccare un simbolo di interruzione nella tavolozza (doppio clic per le versioni precedenti la 3.4). Ripetere per
disattivare.

In alternativa, trascinare qualsiasi simbolo di interruzione dalla tavolozza su una battuta.

Aggiungere una interruzione a una cornice
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Per aggiungere un’interruzione a una cornice, usare una delle seguenti opzioni:

Trascinare l’interruzione dalla tavolozza su una cornice.
Selezionare una cornice poi cliccare su un simbolo di interruzione della tavolozza (doppio clic per le versioni
precedenti la 3.4).

Cancellare interruzioni

Usare una delle seguenti opzioni:

Selezionare una o più interruzioni e premere Canc.

Vedere anche: Aggiungere/Rimuovere interruzioni di accollatura.

Spostare una interruzione

Anche se le interruzioni non sono visibili sull'output stampato, possono essere riposizionate, se necessario, entrando in
modalità modifica su una di esse e usando i tasti freccia della tastiera (vedere Regolare la posizione degli oggetti di testo).

Interruzione di sezione

Una interruzione di sezione, come suggerisce il nome, è usata per creare sezioni separate all'interno di una partitura.
Come una interruzione di accollatura, forza la battuta o la cornice successiva ad iniziare una nuova accollatura, e può
anche essere usata in associazione con una interruzione di pagina, se necessario. Un'interruzione di sezione potrebbe
essere usata, per esempio, per dividere un pezzo in movimenti separati.

Ogni sezione può avere la propria numerazione delle battute indipendentemente dal resto della partitura. Per default, la
prima battuta di una sezione è numerata "1" (vedere immagine sotto), anche se, come la prima battuta della partitura
stessa, il numero non viene visualizzato a meno che non sia configurato nel dialogo proprietà della battuta. La stessa
finestra di dialogo può essere usata per cambiare la numerazione secondo le proprie preferenze.

Nel caso si cambino l’indicazione metrica o l’armatura di chiave all’inizio della nuova sezione, alla fine della sezione
precedente non comparirà alcuna indicazione “di cortesia”. Vedere l’esempio seguente:

Quando si riproduce la partitura, il programma aggiunge una breve pausa tra ogni sezione. Inoltre, la prima stanghetta di
fine ripetizione in una sezione manda sempre il cursore di riproduzione all'inizio della stessa sezione; una eventuale
stanghetta di inizio ripetizione è quindi opzionale.

Dopo aver selezionato l’interruzione di sezione, nell’Ispettore possono essere modificate le seguenti proprietà:

Sospendi: Lunghezza della pausa alla fine della sezione.
Inizia una nuova sezione con nomi strumento estesi (casella di spunta).
Inizia una nuova sezione con la battuta numero uno: (casella di spunta).
Inizia una nuova sezione con l’indentazione sulla prima accollatura: (casella di spunta).

Per le versioni precedenti la 3.4, le stesse proprietà sono accessibili cliccando con il tasto destro del mouse
sull'interruzione e selezionando Proprietà interruzione di sezione.

Distanziatori

Vi sono tre tipi di distanziatori:

Distanziatore righi su: Una freccia rivolta verso l'alto. Per aggiungere spazio sopra un rigo.
Distanziatore righi giù: Una freccia che punta verso il basso. Per aggiungere spazio sotto un rigo.
Distanziatore rigo fisso in basso: Simile a una "I" maiuscola. Per fissare la distanza tra due righi (utile per
sovrascrivere le impostazioni di stile o auto-posizionamento in un solo punto). Sono possibili valori negativi.

Nota: i distanziatori non possono essere applicati a cornici.

Aggiungere un distanziatore

Sono disponibili le seguenti opzioni:
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Selezionare una battuta, quindi cliccare su un simbolo di distanziatore nella tavolozza (doppio clic per le versioni
precedenti la 3.4).
Trascinare il simbolo di distanziatore dalla tavolozza alla battuta.

I simboli dei distanziatori sono visibili sullo schermo, ma non appaiono in stampa.

Note: i distanziatori sono progettati solo per regolazioni locali. Se si vuole regolare lo spazio tra i righi nell'intera partitura,
usare invece le impostazioni in Formato → Stile → Pagina.

Regolare un distanziatore

Per regolare l’altezza di un distanziatore, scegliere una di queste opzioni:

Cliccare sul distanziatore e trascinare la maniglia blu finale verso l’alto o verso il basso (doppio clic per le versioni
precedenti la 3.4).
Cliccare sul distanziatore e usare i tasti ↑↓ e/o Ctrl+↑↓ per spostare la maniglia blu finale verso l’alto o verso il basso
(doppio clic per le versioni precedenti la 3.4).
Cliccare sul distanziatore e regolare l’altezza nell’Ispettore.

Cancellare un distanziatore

Cliccare sul distanziatore e premere il tasto Canc.

Vedere anche

Aggiungere/Rimuovere interruzioni di accollatura

Cornici

Una Cornice è un contenitore rettangolare per aggiungere uno spazio vuoto, testo o immagini nella partitura. Può essere
di tre tipi:

Orizzontale: Si usa per creare un interruzione in una certa accollatura. Può contenere uno o più oggetti di testo e/o
immagini.
Verticale: Inserita sopra un'accollatura o aggiunta dopo l'ultima. Può contenere uno o più oggetti di testo e/o
immagini.
Di testo: Inserita sopra un'accollatura o aggiunta dopo l'ultima. Può contenere un solo oggetto di testo.

Cornice orizzontale

Una cornice orizzontale si usa per creare un interruzione in una certa accollatura. Per esempio, si può:

Creare una Coda con una interspazio modificabile dal resto della partitura (vedi esempio sotto).

Creare un rientro ad inizio della partitura, in assenza dei nomi dei righi a produrre lo stesso risultato.
Creare un margine destro modificabile a fine accollatura.
Creare spazio per testi o immagini.
Creare uno spazio fra "Incipit storico" e inizio dell'edizione moderna.

Inserire/aggiungere una Cornice orizzontale

Vedi Creare una Cornice (sotto).

Regolare la larghezza di una Cornice orizzontale

Utilizzare uno dei seguenti metodi:

Click (doppio-click versioni precedenti la 3.4) sulla cornice e trascinare la maniglia a destra o sinistra.
Selezionare la cornice e regolare la "Larghezza" nell' Ispettore.

Aggiungere testo o un'immagine a una Cornice orizzontale

Per aggiungere del testo: Click-destro sulla cornice e selezionare Aggiungi → Testo.
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Per aggiungere un'immagine: Click-destro sulla cornice e selezionare Aggiungi → Immagine.

Cornice verticale

Una Cornice verticale può essere inserita sopra un’accollatura o aggiunta all'ultima accollatura. Può contenere uno o più
oggetti di testo e/o immagini. L'altezza è regolabile e la larghezza è uguale a quella delle accollature.

Può essere usata, per esempio, per:

Creare uno spazio di intestazione per Titolo/Sottotitolo/Compositore/Paroliere ecc. (vedi sotto).
Creare una pagina di Frontespizio (vedi sotto).
Aggiungere una o più strofe di testo cantato (a fine partitura).
Creare sottotitoli o altre annotazioni fra le accollature.

Inserire/aggiungere una Cornice Verticale

Vedi Creare una Cornice (sotto).

Regolare l'altezza di una Cornice verticale

Utilizzare uno dei seguenti metodi:

Click (doppio-click versioni precedenti la 3.4) sulla cornice e trascinare la maniglia verso l'alto o verso il basso.
Selezionare la cornice e regolare il valore di "Altezza" nell' Ispettore.

Modificare le proprietà di una Cornice verticale

La selezione della Cornice consente di regolare nell'Ispettore i vari parametri:

Spazio vuoto superiore: Regola la distanza fra Cornice ed elemento sopra.
Spazio vuoto inferiore: Regola la distanza fra Cornice ed elemento sotto.
Altezza: Regola l'altezza della Cornice.
Margine sinistro: Muove verso destra gli oggetti di testo allineati a sinistra.
Margine destro: Muove verso sinistra gli oggetti di testo allineati a destra.
Margine superiore: Muove verso il basso gli oggetti di testo allineati in alto (vedi anche Formato → Stile... → Pagina).
Margine superiore: Muove verso l'alto gli oggetti di testo allineati in basso (vedi anche Formato → Stile... → Pagina).
Abilita dimensionamento automatico: Abilita il ridimensionamento automatico della cornice in base alle dimensioni del
contenuto.

Aggiungere testo o immagini a una Cornice verticale

Aggiungere testo: Click destro sulla cornice e scegli Aggiungi, e scegli una delle opzioni per il testo.

Aggiungere un immagine: Click destro sulla cornice e scegli Aggiungi → Immagine.

Dentro una cornice si possono creare una quantità oggetti a piacimento. Le loro posizioni possono essere regolate
indipendentemente trascinandoli o, con più precisione, alterando i valori di offset nell'Ispettore. Per formattare gli oggetti di
testo, vedi Modifica del testo and Stili del testo e proprietà.

Inserire una Cornice orizzontale in una Cornice verticale

Click-destro sulla cornice verticale e scegliere Aggiungi → Inserisci Cornice orizzontale .

La Cornice orizzontale è allineata automaticamente a sinistra e riempie tutta la cornice verticale. Per allinearla a destra :
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1. Ridurre la Larghezza della cornice orizzontale.
2. Deseleziona la cornice quindi trascinala verso destra. Per ripristinare l'allineamento a sinistra trascina la cornice

verso sinistra.

Cornice "Titolo"

Compilando i campi di testo nella prima pagina della Procedura guidata nuova partitura viene creata automaticamente una
Cornice verticale all'inizio della partitura, questa mostra Titolo, Sottotitolo, Compositore, Paroliere ecc.

Se la partitura non ha una Cornice verticale all'inizio, si può creare come nel seguito:

1. Dal menu, scegli Aggiungi → Testo → Titolo/Sottotitolo/Compositore/Paroliere ;
2. Digitare il testo;
3. PremereEsc, o click su uno spazio vuoto per uscire.

Cornice di testo

Una Cornice di testo si presenta come una Cornice verticale, ma è specializzata per l'inserimento del testo: è consentito
un solo oggetto di testo per cornice. L'altezza si espande automaticamente per accoglierne il contenuto e non c'è maniglia
di regolazione dell'altezza.

Una Cornice di testo può essere usata, per esempio, per::

Creare strofe di testo cantato alla fine della partitura.
Creare sottotitoli o altre annotazioni fra le accollature.
Creare e inserire una pagina vuota [bianca] ovunque nella partitura, anche all'inizio.

Inserire/aggiungere una Cornice di testo

Vedi Creare una Cornice (sotto).

Modificare le proprietà di una Cornice di testo

La selezione della Cornice consente di regolare nell'Ispettore i vari parametri:

Spazio vuoto superiore: Regola la distanza fra Cornice ed elemento sopra.
Spazio vuoto inferiore: Regola la distanza fra Cornice ed elemento sotto.
Altezza: Regola l'altezza della Cornice.
Margine sinistro: Muove verso destra gli oggetti di testo allineati a sinistra.
Margine destro: Muove verso sinistra gli oggetti di testo allineati a destra.
Margine superiore: Muove verso il basso gli oggetti di testo allineati in alto (vedi anche Formato → Stile... → Pagina).
Margine superiore: Muove verso l'alto gli oggetti di testo allineati in basso (vedi anche Formato → Stile... → Pagina).

Creare una Cornice

Inserire una Cornice in partitura

Da menu:

1. Selezionare una misura;
2. Selezionare dal menu Aggiungi → Cornici → Inserisci cornice Orizzontale/Verticale/di testo.

Da una misura:

1. Click-destro su una misura;
2. Selezionare Aggiungi → Insert Cornice orizzontale/verticale/di testo.

Da una tavolozza:

Vedi Applicare simboli da una tavolozza.

Aggiungere una Cornice alla partitura

Scegliere dal menu Aggiungi → Cornici → Aggiungi cornice orizzontale/verticale/di testo.

Cancellare una Cornice

Utilizzare uno dei seguenti:

Selezionare il contorno della Cornice e premereCanc.
Selezionare il contorno della Cornice, quindi click-destro sulla cornice e scegliere Cancella.
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Applicare un'Interruzione

Alle Cornici possono essere applicate interruzioni di accollatura, pagina o sezioni così come alle misure. Utilizzare uno dei
metodi:

Selezionare una Cornice e poi click (doppio-click versioni precedenti la 3.4) su un simbolo di interruzione in una
tavolozza (per esempio, nella tavolozza Spaziature e Interruzioni).
Trascinare un simbolo di interruzione dalla tavolozza fin sulla Cornice.

Vedere anche

Proprietà del testo: per mettere un riquadro visibile (bordo) intorno a un testo.
Inserire misure: per inserire misure prima di una cornice.

Link esterni

How to add a block of text to a score  (MuseScore HowTo)
How to create a blank or title page at the beginning of a score
Page Formatting in MuseScore 1.1 - 1. Frames, Text & Line Breaks  [video]

Immagini

Per illustrare le partiture o per aggiungere simboli non disponibili nelle tavolozze standard, è possibile aggiungere
Immagini. MuseScore supporta i seguenti formati:

PNG (*.png)
JPEG (*.jpg and *.jpeg)
SVG (*.svg) (per SVG, MuseScore attualmente non supporta l'ombreggiatura, la sfocatura, il ritaglio o il
mascheramento).

Aggiungere immagini

Usare una delle seguenti opzioni:

Trascinare e rilasciare un file immagine (esterno a MuseScore) in una cornice verticale o orizzontale, o su una nota
o una pausa nella partitura.
Cliccare con il tasto destro del mouse su una cornice, selezionare Aggiungi→Immagine, quindi scegliere un'immagine
dal selettore di file.

Una volta importata in una partitura, un'immagine (proprio come altri elementi della partitura) può essere aggiunta a una
tavolozza se necessario.

Tagliare/copiare e incollare immagini

1. Cliccare su un’immagine nella partitura.
2. Applicare uno qualsiasi dei comandi standard di copia/taglio.
3. Cliccare su una nota, pausa o cornice.
4. Applicare uno qualsiasi dei comandi “incolla”.

Modificare immagini

Per modificare la larghezza/altezza di un'immagine, fare doppio clic su di essa e trascinare una delle maniglie. Se si
vogliono regolare la larghezza o l'altezza separatamente, prima deselezionare "Blocca le proporzioni" nell' Ispettore.

È possibile regolare la posizione di un'immagine semplicemente trascinandola.

Vedere anche

Cattura immagini
Personalizzare le tavolozze

Collegamenti esterni

How to create an ossia with image capture  (MuseScore HowTo)
How to create an ossia with another staff  (MuseScore HowTo)

Acquisizione immagini

La funzione di cattura immagini di MuseScore permette di salvare un'istantanea di qualsiasi parte della finestra della
partitura. Sono supportati i formati PNG, PDF e SVG.
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Salvare una istantanea

1. Cliccare sul pulsante Attiva/disattiva acquisizione immagine, .
2. Premere Maiusc + trascinamento (drag), per creare un nuovo rettangolo di selezione.
3. Regolare la posizione del rettangolo, se necessario, trascinandolo e/o cambiando i valori di "Posizione" nella

sezione "Acquisizione immagine" dell' Ispettore.
4. Regolare l'area del rettangolo, se necessario, trascinando le maniglie e/o cambiando i valori di "Dimensione"

nell'Ispettore.

5. Cliccare con il tasto destro del mouse sul rettangolo di selezione per aprire il menu Acquisizione immagine.
Selezionare l'opzione desiderata:

Salva come (modalità stampa). Salva un'immagine dell'area di selezione come apparirebbe se stampata, per
esempio

Salva come (modalità acquisizione immagine). Salva una selezione dello schermo attuale, inclusi i simboli
di interruzione di linea, gli elementi invisibili ecc.

È possibile salvare l'immagine in formato PNG (predefinito), SVG o PDF.

Menù cattura immagine

Cliccando con il tasto destro del mouse sul rettangolo di selezione si apre il menù Acquisizione immagine (Mac: Ctrl +
clic, o picchiettare con 2 dita):

Copia: Scegliere questo per copiare un'immagine prima di incollarla nello stesso o in un altro file MuseScore.
Copia con collegamento alla partitura: Scegliere questo per copiare un'immagine che include un link al file
MuseScore. Quando viene incollata in un programma che la supporta, è possibile cliccare sull'immagine per aprire il
file MuseScore.
Risoluzione (360 dpi)…: Imposta la risoluzione, e quindi la dimensione dell'immagine salvata o copiata. Provare
con 100 dpi per iniziare, se non si è sicuri.
Sfondo trasparente: Attiva o disattiva la trasparenza dell'immagine.
Ridimensionamento automatico alla pagina: Regola il rettangolo di selezione per adattarlo alla pagina.
Ridimensiona a A/B/C/D: Scegliere un rettangolo di selezione personalizzato (come impostato di seguito).
Imposta formato standard: Ridimensionare il rettangolo di selezione, poi scegliere " Imposta formato A/B/C/D" per
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memorizzarlo.

Vedere anche

Immagini

Collegamenti esterni

Creare un Ossia con la modalità acquisizione immagine  (MuseScore Come fare)
How to create an ossia with another staff  (MuseScore HowTo)

Allineamento degli elementi

Durante il trascinamento di un elemento:

Per vincolare il movimento solo in orizzontale: Cliccare e tenere premuto sull’elemento, premere Ctrl e poi trascinare
l'elemento a sinistra o a destra.
Per vincolare il movimento solo in verticale: Cliccare e tenere premuto sull’elemento, premere Maiusc e poi
trascinare l'elemento su o giù.

Aggancia alla griglia

Aggancia alla griglia è una caratteristica che permette di trascinare un elemento in passi precisi - utile per il
posizionamento esatto.

Per abilitare l’aggancio alla griglia, selezionare un elemento e cliccare uno o entrambi i pulsanti di aggancio (orizzontale
e/o verticale), situati a destra dei campi di offset X (orizzontale) e Y (verticale) nell'Ispettore. In tal modo è quindi possibile
trascinare l'elemento in passi uguali alla spaziatura della griglia. Il valore predefinito è 0,5 sp.

Per modificare la spaziatura della griglia:

1. Cliccare con il tasto destro del mouse su uno dei pulsanti di aggancio alla griglia nell'Ispettore e selezionare Configura
Griglia.

2. Impostare i valori per la spaziatura della griglia orizzontale e verticale come desiderato. Si noti che queste
impostazioni sono frazionarie.

Argomenti avanzati

Accessibility

Introduction

This document is written for blind and visually impaired users of MuseScore 3. It is not intended to provide a full
description of all of the features of MuseScore; you should read this in conjunction with the regular MuseScore
documentation.

MuseScore comes with support for the free and open source NVDA screen reader  for Windows. You can also install a
script  to enable support for JAWS , or install a script  for Orca  on Linux.

Eventually we hope to support other screen readers such as VoiceOver  and Narrator . Currently, unsupported screen
readers will usually read menus and dialogs, but reading the score note by note currently requires one of the supported
screen readers.

Beginning with MuseScore 3.3, most of the features of MuseScore are fully accessible, it is viable both as a score reader
and editor. Previous versions were more limited with respect to editing.

Initial setup

When you run MuseScore for the first time, you will be asked some questions on startup. We recommend you accept the
defaults, but answer "no" to the question about showing tours, since these unfortunately are not yet accessible.

When MuseScore starts, the first thing you normally see is the Start Center window. This shows you a list of recent scores
that you can access via Shift+Tab and then using the left and right cursor keys. You may find it easier to open scores
directly from the File menu, however so you can press Esc to close the Start Center if you prefer. In fact you may want to
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permanently disable it. After closing the Start Center, open the Edit menu (Alt+E), choose Preferences, and in the General
tab, uncheck Show Start Center, then close the Preferences window.

MuseScore includes keyboard shortcuts for many of its commands, and others that do not have shortcuts defined by
default can be customized later, in Edit, Preferences, Shortcuts.

Finding your way around

The user interface in MuseScore works much like other notation programs or other document-oriented programs in
general. It has a single main document window within which you can work with a score. MuseScore supports multiple
document tabs within this window. It also supports a split-screen view to let you work with two documents at once, and you
can have multiple tabs in each window.

In addition to the score window, MuseScore has a menu bar that you can access via the shortcuts for the individual
menus:

File: Alt+F
Edit: Alt+E
View: Alt+V
Add: Alt+A
Format: Alt+O
Tools: Alt+T
Plugins: Alt+P
Help: Alt+H

Hint: once you have opened a menu, it may take several presses of the Up or Down keys before everything is read
properly. Also, if at any point the screenreader stops responding, a useful trick to kickstart it again is to press Alt to move
focus to the menu bar, then Esc to return to the score. Sometimes switching to another application then back can help as
well.

In addition to the menu bar, there are also a number of toolbars, palettes, and sub-windows within MuseScore, and you
can cycle through the controls in these using Tab (or Shift+Tab to move backwards through this same cycle). When you first
start MuseScore, or load a score, focus should be in the main score window.

If nothing is selected (press Esc to clear any selection), pressing Tab takes you to a toolbar containing a series of buttons
for operations like New, Open, Play, and so forth. Tab will skip any buttons that aren't currently active. The names and
shortcuts (where applicable) for these buttons should be read by your screen reader.

Once you have cycled through the buttons on the toolbar, the next window Tab will visit is the Palettes. This is used to
add various elements to a score (dynamics, articulations, and so forth).

If an element is selected in the score, the first window visited by Tab is the Inspector, which is used for making various
manual adjustments in your score. Many of these features are based on the visual appearance of the score (although a
few relate to playback).

If you have opened one of the additional optional windows, such as the Selection Filter, the Tab key will also visit these.
You can close windows you do not need by going to the View menu and making sure none of the first set of checkboxes
is selected (the windows that appear before the Zoom settings). By default, only the Palettes and Inspector should be
selected. See Initial Setup for instructions for disabling the Start Center. F9 can be used to toggle the Palettes while F8 will
toggle the Inspector.

To return focus to the score window after visiting the toolbar, or a subwindow, press Esc. If something was selected
before visiting the other window, the selection is left intact, but pressing Esc once focus is in the score window clears the
selection. The selection is automatically restored when you commence navigation using the accessibility commands
described below.

The score window

When you first start MuseScore 3 an empty example score is loaded by default. If you wish to experiment with editing
features, this would be a good place to begin. Otherwise, you will probably want to start by loading a score. MuseScore
uses the standard shortcuts to access system commands like Ctrl+O (Mac: Cmd+O) to open a file, Ctrl+S (Mac: Cmd+S) to
save, Ctrl+W (Mac: Cmd+W) to close, etc.

If you press Ctrl+O (Mac: Cmd+O) to load a score, you are presented with a fairly standard file dialog. MuseScore can open
scores in its own format (MSCZ or MSCX) as well as import scores in the standard MusicXML format, in MIDI format, or
from a few other programs such as Guitar Pro, Capella, and Band-in-a-Box. Once you have loaded a score, it is displayed
in a new tab within the score window. You can move between the tabs in the score window using Ctrl+Tab (does not apply
for Mac). Hint: if the name of the score in the current tab is not read, ask your screen reader to read the title bar.

To read the score note by note, see below, but there are a few other interesting things you can do with a loaded score.
You can press Space to have MuseScore play the score for you. You can use File / Export to convert to another format,
including PDF, PNG, WAV, MP3, MIDI, MusicXML, etc. And of course, you can print it via File / Print or Ctrl+P (Mac:
Cmd+P).
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If a score contains multiple instruments, it may already have linked parts generated. Linked parts are presented as part
tabs within score tabs, but currently, there is no way to navigate these part tabs using the keyboard. The parts would not
normally contain information different from the score; they would just be displayed differently (each part on its own page).
If a score does not already have parts generated, you can do so through File / Parts, and that dialog is accessible. If you
wish to print the parts, you can work around the inability of accessing part tabs individually by using the File / Export Parts
dialog, which automatically exports PDF’s (or other formats) for all parts in one step.

Score reading

When you first load a score, the score window has the keyboard focus, but there will be nothing selected. The first step to
reading a score is to select something, and the most natural place to begin is with the first element of the score. After a
score is loaded, Alt+Right (Mac: Alt+Right) will select the literal first element, which is likely the title; Ctrl+Home (Mac:
Cmd+Home) will select the first "musical" element (usually a clef or an initial barline).

As you navigate between elements, your screen reader should give the name of the selected element. You will hear it
read the name of the element (for example, “Treble clef”) and also give position information (for example, “Measure 1;
Beat 1; Staff 1; Violin”). The amount of information read is optimized to not repeat information that has not changed.
Pressing Shift currently interrupts the reading, which might also be useful.

Most navigation in MuseScore is centered around notes and rests only—it will skip clefs, key signatures, time signatures,
barlines, and other elements. So if you just use the standard Right and Left keys to move through your score, you will only
hear about notes and rests (and the elements attached to them). However, there are two special accessibility commands
that you will find useful to gain a more complete summarization of the score:

Next element: Alt+Right (Mac: Alt+Right)
Previous element: Alt+Left (Mac: Alt+Left

These commands include clefs and other elements that the other navigation commands skip, and also navigate through
all voices within the current staff, whereas other navigation commands such as Right and Left only navigate through the
currently selected voice until you explicitly change voices. For instance, if you are on a quarter note on beat 1 of measure
1, and there are two voices in that measure, then pressing Right will move on to the next note of voice 1—which will be on
beat 2—whereas pressing Alt+Right (Mac: Alt+Right) will stay on beat 1 but move to the note on voice 2. Only once you have
moved through all notes on the current beat on the current staff will the shortcut move you on to the next beat. The intent
is that this shortcut should be useful for navigating through a score if you don’t already know what the contents are.

When you navigate to an element, your screen reader should read information about it. For notes and rests, it will also
read information about elements attached to them, such as lyrics, articulations, chord symbols, etc. The accessibility
commands will also navigate through those elements individually.

One important note: Up and Down by themselves, with Shift, or with Ctrl / Cmd are not useful shortcuts for navigation! Instead,
they change the pitch of the currently selected note or notes. Be careful not to inadvertently edit a score you are trying to
read. Up and Down should only be used with Alt if your intent is navigation only. See the list of navigation shortcuts below.

If you should lose track of your place in the score - or if you lose the selection completely - press Shift+L ("location") to get
the current location.

Moving forwards or backwards in time

The following shortcuts are useful for moving “horizontally” through a score:

Next element: Alt+Right
Previous element: Alt+Left
Next chord or rest: Right
Previous chord or rest: Left
Next measure: Ctrl+Right
Previous measure: Ctrl+Left
Go to measure: Ctrl+F
First element: Ctrl+Home
Last element: Ctrl+End

Moving between notes at a given point in time

The following shortcuts are useful for moving “vertically” through a score:

Next element: Alt+Right
Previous element: Alt+Left
Next higher note in voice, previous voice, or staff above: Alt+Up
Next lower note in voice, next voice, or staff below: Alt+Down
Top note in chord: Ctrl+Alt+Up
Bottom note in chord: Ctrl+Alt+Down

The Alt+Up and Alt+Down commands are similar to the Alt+Right and Alt+Left commands in that they are designed to help you
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discover the content of a score. You do not need to know how many notes are in a chord, how many voices are in a staff,
or how many staves are in a score in order to move vertically through the score using these commands.

Filtering score reading

Excluding certain elements like lyrics, or chord names while reading the score is possible by using the Selection filter (F6).
Uncheck those elements you don't want to read. However, this feature may not currently be implemented.

Score playback

The Space bar serves both to start and stop playback. Playback will start with the currently selected note if one is selected;
where playback was last stopped if no note is selected; or at the beginning of the score on first playback.

MuseScore supports looped playback so you can repeat a section of a piece for practice purposes. To set the “in” and
“out” points for the loop playback via the Play Panel (F11):

1. First select the note in the score window where the loop should start;
2. Go to the Play Panel and press the Set loop In position toggle button;
3. Back to the score window, navigate to the note where you want the loop to end;
4. Switch again to Play Panel, and press the Set loop Out position toggle button;
5. To enable or disable the loop, press the Loop Playback toggle button.

You can also control the loop playback and control other playback parameters, such as overriding the basic tempo of a
score, using the View / Play Panel (F11).

Score creation and editing

While some advanced score editing techniques require visual inspection of the score, and a small number of commands
may require the mouse, as of MuseScore 3.3 most score editing features are fully accessible.

You can enter music into the default empty score (a score with one staff, using a piano sound), or edit an existing score
that you have opened already, or you can create a new score with the set of instruments you want.

Creating a new score

To create a new score, use File, New or Ctrl+N. A wizard then walks you through the score creation process.

The first screen of the wizard has fields to enter the title, composer, and other information. The second allows you to
select a template (predefined scores for common ensembles like choral SATB or jazz big band) or to select instruments.
The third allows you to select an initial key signature and tempo. Sometimes this screen gets skipped, so if this happens,
press the Back button to go back. To select a key, use Up and Down. The key signature control does not work well with
some screenreaders, but if you give the "read current line" command (e.g., NVDA+L), it may read the currently-selected
key. The next and final screen of the wizard allows you to select an initial time signature, pickup (anacrusis), and the
number of measures to start with.

Once you have a score, you can begin editing it.

Note input

To enter notes, you need to be in note input mode. First, navigate to the measure in which you would like to enter notes,
then press N. Almost everything about note input is designed to be keyboard accessible, and the standard documentation
should be good to help you through the process. Bear in mind that MuseScore can either be in note input or normal mode,
and it won’t always be clear which mode of these you are in. When in doubt, press Esc. If you were in note input mode,
this will take you out. If you were in normal mode, you will stay there, although you will also lose your selection.

The basic process of note input is to first select a duration (for example, using shortcuts 4-5-6 for eighth, quarter, half),
then enter a note by typing its letter name. Once a duration is selected you can enter multiple notes of the same duration.
Press 0 to enter a rest.

The Up and Down keys raise or lower the pitch by a half step, adding or removing accidentals as necessary. To change
enharmonic spelling of a note, press J.

To enter a tie, select the duration of the tied note then press +. To create triplets, select the total duration for the triplet,
then press Ctrl+3 (similarly for quadruplets and other tuplets). To enter music in multiple voices on a single staff, pressing
Ctrl+Alt plus a number from 1 to 4 will switch to that voice (keep in mind, the first voice for each staff is always voice 1).

There is much more to note input in MuseScore. See for the section on Note Input in the Handbook .

Selection

MuseScore supports the usual keyboard shortcuts for selection. Navigating is the same as selecting for single elements.
To select a range of elements, navigate to the first, press and hold Shift, then navigate to the second. Ctrl+A will select the
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entire score.

Palettes

As mentioned previously, many symbols other than notes are entered from the palettes window. The basic use model is,
first select the element or elements in the score you want to apply the palette item to, then apply the palette element.
There are a few different ways to select the palette element.

The simplest method to use at first is to simply browse the palettes window by keyboard. To reach the palettes window,
press Shift+Tab. The screenreader may not specifically tell you that you are in the palettes window, but you will discover
that you are as you navigate. Depending on whether you have used the palettes before, focus may be where you left off,
or at the top. Press Tab a few times to get to the first palette within the window (Clefs). You can browse the list of palettes
using the Up and Down cursor keys. The Right cursor key opens a palette, and then all four cursor keys can be used to
navigate through the elements (they are arranged in a table). You can also use Tab to navigate the palette names and
contents.

Once you have found a palette item you want to apply, press Enter to apply it to the currently-selected score elements and
return focus to the score. The next time you press Shift+Tab to return to the palettes, the last-used palette item will still be
selected, so Enter will apply it again. The screenreader may stop responding after applying a palette item, even though
focus has returned to the score, but the trick of pressing Alt followed by Esc should get it working again.

You can also use the palette search facility to quickly find a palette item. The search box is one of the first elements at the
top of the palette, so you can navigate to it, or you can define a shortcut (Edit, Preferences, Shortcuts) for the "Palette
search" command, which will subsequently take you directly to the search box. Once you are in the box, type the first few
characters of a search term, and only palette items matching that search will shown. You can then navigate to the search
results and find the element you want. The Down cursor will take you directly to the first search result, then you can use
Right after that. However, on some systems MuseScore may crash when using the palette search function with a screen
reader enabled.

Another way to reach the palettes window is with the F9 shortcut, which toggles the palettes window on and off. By default,
the palettes window is open, so pressing F9 will close it, but then pressing it again opens the window and puts the cursor
in the search box.

There is one other useful technique for palette accessibility, and that is the "Apply current palette element" command (for
which you can define a shortcut). If you are in the score, this will apply the last-used palette element automatically (the
equivalent of Shift+Tab followed by Enter).

Menus and Shortcuts

Some elements can be added or edited via menu commands or keyboard shortcuts. The Edit menu has standard copy
and paste commands (and the usual shortcuts work too). The Add menu has commands to add notes, tuplets, measures,
frames, text, and some lines. The Format menu has commands relating mostly to the visual appearance of the score
(e.g., page and staff size, position and size of symbols, fonts used for text), which can be extremely useful in producing
large print a.k.a. "modified stave notation" scores (see below). The Tools menu has a number of other useful commands,
including ones to remove measures or other selected ranges, to transpose a selection, to join and split measures, and
more. any of these commands have shortcuts defined by default that should be read by a screenreader. You can define
custom shortcuts for most of the rest in Edit, Preferences, Shortcuts.

There are also shortcuts for a number of palette items, and the possibility to define others (although many palette items
currently do not support this). Some useful shortcuts to remember include:

Ctrl+T: staff text
Alt+Shift+T: tempo
Ctrl+L: lyrics
Ctrl+K: chord symbol
Ctrl+M: rehearsal mark

S: slur
Shift+S: staccato
Shift+V: accent
Shift+N: tenuto
Shift+O: marcato
slash: grace note
less than: crescendo
greater than: diminuendo

Customization

You can customize the keyboard shortcuts by opening the Edit menu, selecting Preferences, then navigating to the
Shortcuts tab. Once there, Tab will take you to the list of shortcuts, and you can navigate the list directly with the Up and
Down cursor keys, but it is a very long list. You can instead hit Tab a few more times to reach the Search box, then type
the first few characters of the command to filter the list, then navigate back to the list.
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Once you have found the command you wish to customize, press Enter. You can then press the key combination you
wish to be the shortcut. It can be a single key, a key with Shift, Ctrl, and/or other modifiers, or even a sequence or two or
more keys pressed in succession. After entering the shortcut you wish, press Tab to get to the Add or Replace button
(Tab is the only key that won't be interpreted as part of a shortcut sequence). If you reach Cancel without ever seeing Add
or Replace, it means the shortcut you choose conflicts with another. Navigate back to the where you typed the shortcut
and it will tell you the name of the command it conflicts with. Hit Tab to get to the Clear button to clear it, then try again
with a different shortcut.

At some point, we may provide a set of special accessibility-optimized shortcuts. There is already a facility in the shortcut
dialog to save and load shortcut definitions, so it is possible to share shortcut definitions with other users.

External links

MuseScore Accessibility Demo (YouTube)
Creating a New Score in MuseScore with NVDA  (MuseScore Tutorial)
Inputting notes in MuseScore with NVDA  (MuseScore Tutorial)
Creating Modified Stave Notation in MuseScore  (MuseScore Tutorial)

Albums

The Album feature has been disabled for 3.x. It will come back in 4.0.

The Album Manager allows you to prepare a list of multiple scores and save the list as an album file ("*.album"), print all
the scores as one long print job with consistent page numbers, or even join the scores into a single new MSCZ score.
This is ideal for preparing an exercise book or combining multiple movements of an orchestration.

To open the Album Manager, go to File → Album...

Create album

1. To create a new album, click the New button. Fill in a title in the "Album Name:" box at the top.
2. To add scores to the album, click Add Score. A file selection dialog will appear and let you choose one or multiple

scores from your file system. Click OK.
3. The scores you add will appear in a list in the Album Manager. You can rearrange their order by selecting a score

and clicking the Up or Down button.

Load album

If you have previously created an album, you can open it through the Album Manager by clicking the Load button. A file
selection dialog will appear to let you load the .album file from your file system.

Print album

To print an album as if it were a single document, click Print Album. The scores loaded into the Album Manager are printed
in the order they are listed in with the correct page numbers, ignoring the page number offset values in Layout → Page
Settings... → First page number for all but the first score. As the album is printed in one print job, double-sided printing (duplex
printing) also works as expected.

Join scores

To combine multiple scores into a single .mscz file, click Join Scores. The scores are combined in the selected order into
one single score. If not already present, line- and section breaks are added to the last measure or frame of each score in
the combined file.
All style settings are taken from the first score, different style settings from subsequent score are ignored.
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All the scores should have the same number of parts and staves for this to work correctly, ideally with the same
instruments in the same order. If the scores have the same total number of instruments but not the same ones, or not in
the same order, then the instrument names from the first score will overwrite ones from subsequent scores. If some of the
scores have fewer instruments than the first score, then empty staves will be created for those sections. Any part or staff
that is not present in the first score will be lost in the joined score.

Save album

Upon clicking the Close button, you will be prompted to save your album as a .album file. This file is not the same as a
joined score; it simply consists of the list of scores. Album files can be loaded into the Album Manager as described
above.

Attrezzi

Nel menù Attrezzi è raggruppato un buon numero di comandi utili.

Trasporto

Apre la finestra dialogo Trasposizione con varie opzioni per il trasporto di passaggi musicali.

Vedere Trasposizione automatica.

Esplodi

Il comando esplodi permette di selezionare un passaggio musicale in un unico rigo e di dividere (esplodere) gli accordi
nelle loro note o voci costituenti come segue:

Se il passaggio è tutto in voce 1, la nota superiore dell'accordo viene mantenuta sul rigo superiore, mentre le note
inferiori vengono spostate sui righi successivi.
Se il passaggio contiene più voci, le note della voce 1 vengono mantenute sul rigo superiore, mentre le altre voci
vengono spostate sui righi successivi. Tutte le voci “esplose” sono ora nella voce 1.

Per “esplodere” una sezione dello spartito:

1. Assicurarsi che ci siano abbastanza righi sotto il “rigo sorgente” per ricevere le note ridistribuite. Creare altri righi se
necessario usando la finestra di dialogo Strumenti.

2. Scegliere una delle due opzioni:
Selezionare un intervallo di battute nel “rigo sorgente”: ciò permette di “esplodere” tutte le note se ci sono
abbastanza righi disponibili.
Selezionare un intervallo di battute nel “rigo sorgente”; estendere quindi la selezione verso il basso per
includere uno o più righi di destinazione: questo limiterà il numero di note/voci ridistribuite al numero di righi
selezionati.

3. Scegliere Attrezzi→Esplodi.

Note: (1) Se la selezione è tutta in voce 1, MuseScore scarterà la nota o le note più basse di qualsiasi accordo che
contenga più note del numero di righi nella selezione. (2) Se la selezione è tutta in voce 1, e se un dato accordo ha meno
note del numero di righi di destinazione, allora le note saranno duplicate come necessario in modo che ogni rigo riceva
una nota. (3) Qualsiasi musica esistente nei righi di destinazione viene sovrascritta. (4) Se si seleziona una battuta
parziale, il comando “Esplodi” espanderà automaticamente la selezione a una battuta completa.

Implodi

Il comando Implodi funziona in modo opposto a "Esplodi":

Con un rigo selezionato, tutte le note delle voci 1-4 sono raggruppate nella voce 1.
Con più righi selezionati, le note del secondo rigo sono copiate nella prima voce disponibile nel rigo superiore, le
note del terzo rigo sono copiate nella successiva voce disponibile nel rigo superiore e così via.

Applicare implodi a un singolo rigo

1. Selezionare un intervallo di battute nel rigo desiderato.
2. Scegliere Attrezzi→Implodi.

Tutte le note selezionate nel rigo sono ora visualizzate nella voce 1.

Applicare implodi a più righi

1. Assicurarsi che ci sia una sola voce in ogni rigo.
2. Selezionare un intervallo di battute nel rigo di destinazione e estendere la selezione verso il basso per includere gli

altri righi da “implodere” Raggruppare.
3. Scegliere Attrezzi→Implodi.
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Realizza sigle accordali

Sviluppa sul rigo la sigla accordale trasformandola in note effettive secondo quanto definito nella sezione “Riproduci” di
Formato→Stile→Sigle accordali. Vedere: Interpretazione e Realizzazione delle Sigle accordali.

Per ottenere questa funzionalità:
1. Selezionare una o più sigle accordali;
2. Scegliere Attrezzi→Realizza sigle accordali .

MuseScore scriverà nel rigo tutte le note che compongono l’accordo nella forma prefissata in Formato→Stile→Sigle accordali
sovrascrivendo quanto presente nel rigo di origine per la voce a cui sono collegate le sigle accordali.

Nel caso si voglia mantenere la melodia utilizzare una delle due possibilità:
1. aggiungere una seconda voce composta di sole pause a cui collegare le sigle accordali da riscrivere;
2. aggiungere un nuovo rigo, copiare il contenuto del rigo originale e incollarlo sul nuovo rigo sul quale si potrà operare
senza perdere nessun elemento. il rigo con melodia e sigle accordali utilizzare una seconda voce.

Nel caso si vogliano variare solo localmente i parametri di un accordo per un diverso sviluppo:
1. Cliccare con il tasto destro del mouse sulla sigla accordale;
2. Nella finestra dialogo “Sigla accordale” che compare, scegliere “Realizza le sigle accordali”
3. Spuntare la casella “Sovrascrivi con opzioni personalizzate” e modificare i campi che si rendono disponibili per ottenere
il risultato voluto;
4. Premere Ok

Voci

Permette di scambiare le voci di note in un intervallo selezionato di battute. Vedere Scambio voci di note.

Battuta

Unire o dividere battute. Vedere Operazioni sulle battute: dividere e unire.

Rimuovi l’intervallo selezionato

Questo comando è utilizzato per rimuovere completamente un elemento, o un intervallo di elementi dalla partitura.

Per rimuovere battute (incluse battute parziali):

1. Selezionare un intervallo di note/pause, oppure un intervallo di battute;
2. Utilizzare uno dei seguenti metodi:

Premere Ctrl+Canc (Mac: Cmd+Canc).
Selezionare Attrezzi→Rimuovi l’intervallo selezionato .

Nota: Se l’intervallo selezionato include solo parte di una battuta, the risultato includerà una battuta di durata inferiore
rispetto alla Indicazione metrica in vigore. Questa eventualità è rappresentata da un piccolo segno - (meno) appena sopra
l’accollatura.

Per unire le battute:

1. Selezionare (cioè cliccare su) una stanghetta;
2. Usare uno dei seguenti metodi:

Premere Ctrl+Canc (Mac: Cmd+Canc).
Selezionare Attrezzi→Rimuovi l’intervallo selezionato .

La seguente tabella è un riassunto comparativo dei comandi Cancella e Rimuovi l’intervallo selezionato quando applicati a
singoli elementi:

Elemento Selezionato Applicare Cancella Applicare Rimuovi l’intervallo
selezionato

Nota Sostituisce con pausa Rimuove la sezione di partitura
Pausa (voce 1) Nessun effetto Rimuove la sezione di partitura
Pausa (voci 2-4) Cancella pausa Rimuove la sezione di partitura
Stanghetta Nessun effetto Cancella stanghetta e unisce battute

Battuta Sostituisce il contenuto con
pausa Rimuove la battuta

Nota: Per inserire note, vedere Inserire.

Riempi con barre ritmiche

Questo comando riempie la selezione con barre ritmiche, una per battito (movimento):
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1. Selezionare una o più battute;
2. Dal menù, selezionare Attrezzi→Riempi con barre ritmiche.

Se una battuta è vuota, le barre ritmiche sono aggiunte alla voce 1, a grandezza naturale e centrate sulla linea centrale
del rigo:

Note: (1) Se in una battuta nella selezione sono già presenti delle note, il comando metterà le barre ritmiche nella prima
voce vuota disponibile. (2) Le barre ritmiche della voce 2 sono a grandezza naturale e centrate sulla linea centrale del
rigo; le barre ritmiche della voce 3 appaiono piccole e sopra il rigo; le barre ritmiche della voce 4 sono piccole e sotto il
rigo. (3) Se una battuta contiene note in tutte le 4 voci, la voce 1 sarà sovrascritta. (4) Tutte le barre ritmiche sono
impostate per non trasposizione o riproduzione sonora.

Attiva/Disattiva notazione barre ritmiche

Questo comando alterna la visualizzazione delle note selezionate tra notazione normale e notazione con barre ritmiche:

1. Selezionare un intervallo di note o di battute (Nota: usare il filtro di selezione se si vogliono escludere alcune voci);
2. Dal menù, selezionare Attrezzi→Attiva/Disattiva notazione barre ritmiche.

Le teste di nota selezionate sono cambiate in teste ritmiche di nota che non saranno trasportate o riprodotte.

Le teste di nota barrate, nelle voci uno o due sono fissate alla linea centrale del rigo; quelle nelle voci tre o quattro sono
piccole (notazione "accentata") e fissate sopra o sotto il rigo:

Nei righi di percussione, le note nelle voci 3 e 4 non sono convertite in piccole barre ma in piccole note sopra o sotto il
rigo.

Sostituzione enarmonica delle alterazioni

Corregge le alterazioni per adattarle alla tonalità corrente. Vedere Alterazioni: ridefinire (enarmonicamente) le altezze .

Raggruppa ritmi

Questa opzione corregge le legature di valore, le durate e le travature (raggruppamenti) secondo la pratica standard della
notazione musicale. Per esempio:

Prima:

Dopo:

Tutte le note legate e che hanno la stessa lunghezza di una nota punteggiata saranno cambiate nella nota punteggiata
con due limitazioni. (i) Solo l'ultima nota di un gruppo di note legate avrà un singolo punto. Usando questa opzione le note
con più di un punto non vengono generate. (ii) Le note puntate non passeranno da un raggruppamento travatura) a un
altro a meno che la loro durata non sia la stessa di tutti i raggruppamenti che occupa. Qualsiasi nota con più di un punto
sarà raggruppata secondo le regole di cui sopra.
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Per applicare:

1. Selezionare la sezione della partitura che si vuol resettare. In assenza di selezione, l’operazione verrà applicata
all’intera partitura;

2. Selezionare Attrezzi→Raggruppa ritmi.

Note: Questa è una funzionalità sperimentale e vi sono bug conosciuti. Le articolazioni e gli abbellimenti vengono eliminati
e alcune altezze sono riscritte. Le legature di valore tra le stanghette possono essere perse su UNDO.

Risequenzia numeri/lettere di chiamata

Il comando Risequenzia numeri/lettere di chiamata permette di riordinare l’ordinamento numerico/letterale di
numeri/lettere di chiamata nella partitura se, per qualche ragione, fosse andato fuori sequenza. Per maggiori dettagli
vedere Risequenziazione automatica dei segni di prova.

Svolgi le ripetizioni (versione 3.1 e successive)

Questo comando crea una copia della partitura (in una nuova scheda), elimina le stanghette di ripetizione e annota invece
le sezioni ripetute per intero.

Copia il testo cantato negli appunti

Questo comando copia tutti i testi cantati della partitura negli appunti:

Dal menù, selezionare Attrezzi→Copia il testo cantato negli appunti .

Acquisizione immagine

Scatta un'istantanea di una parte selezionata della finestra del documento. Sono supportati i formati PNG, PDF e SVG.
Vedere Acquisizione immagini.

Rimuovi battute vuote finali

Questo rimuove automaticamente tutte le battute vuote alla fine della partitura.

Vedere anche

Interruzioni e distanziatori
Numeri/lettere di chiamata

Collegamenti esterni

How to merge/combine/implode two staves in one with two voices  (MuseScore HowTo)

Basso continuo

Aggiungere una nuova indicazione di Basso Continuo

1. Selezionare la nota a cui il B.C. si riferisce;
2. Premere la scorciatoia Basso continuo. Per default è Ctrl+G (Mac: Cmd+G): volendo questa può essere modificata

Preferenze: Scorciatoie;
3. Inserire il testo voluto nel "box blu" di modifica (vedi sotto);
4. Utilizzare una delle seguenti opzioni come serve:

DigitareSpazio per spostarsi alla prossima nota che deve ricevere le cifre del B. C. (o click fuori dal box di
modifica per uscire). Il box di modifica avanza alla prossima nota o pausa del rigo a cui state aggiungendo il
Basso continuo. (Per spostarsi in un punto intermedio, o per estendere la durata del gruppo di cifre ad un
valore di durata maggiore, vedere Durate (sotto).
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Maiusc+Spazio muove il box di modifica alla precedente nota o pausa del rigo.
Tab fa avanzare il box di modifica all'inizio della successiva misura.
Maiusc+Tab muove il box di modifica all'inizio della precedente misura.

Formato del testo

Cifre

Le cifre si inseriscono direttamente. Gruppi di più cifre impilate una sopra l'altra si inseriscono direttamente in un unico
testo, impilandole con Invio:

Accidenti

Gli accidenti possono essere immessi utilizzando i normali tasti:

Per inserire: digitare:
doppio bemolle bb
bemolle b
bequadro h
diesis #
doppio diesis ##

I caratteri verranno automaticamente convertiti nei relativi simboli lasciando il box di modifica. Gli accidenti possono
essere messi prima o dopo una cifra (e ovviamente al posto di una cifra nel caso di terza alterata), secondo lo stile voluto;
entrambi gli stili saranno allineati correttamente con l'accidente a destra o a sinistra.

Cifre alterate

Cifre col taglio o col simbolo + possono essere inserite aggiungendo uno \, / oppure il + dopo la cifra (intervalli alterati);
uscendo dal box di modifica verrà sostituita con la corretta modifica della sua grafia:

Il carattere incorporato può gestire la corrispondenza delle alterazioni, favorendo le combinazioni più usuali:

1+, 2+, 3+, 4+ result in  (or )

e 5\, 6\, 7\, 8\, 9\ restituranno  (or )

Si rammenti che / può essere combinata solo col 5; la barra applicata a qualsiasi altra cifra produrrà un ?.

+ può essere anche usato prima della cifra; in questo caso la cifra non sarà modificata ma il + verrà correttamente
allineato a sinistra.
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Parentesi

Prima e dopo alterazioni, cifre e linee di continuazione si posso mettere parentesi aperte e chiuse, sia tonde: '(', ')' e sia
quadre: '[', ']'; le parentesi aggiunte non altereranno il corretto allineamento del carattere principale.

Note: (1) L'editor non verifica il bilanciamento fra parentesi aperte e chiuse, tonde o quadre. (2) più parentesi allineate non
sono sintatticamente corrette e impediranno il corretto trattamento del testo inserito. (3) È consentita la parentesi fra la
cifra e il suffisso di abbreviazione ('+', '\', '/'), ma non consentirà la restituzione del simbolo composto.

Linee di continuazione

Le linee di continuazione si inseriscono aggiungendo un '_' (trattino basso) alla fine della linea. Ogni cifra del gruppo può
avere la sua linea di continuazione:

Le linee di continuazione vanno tracciate per l'intera durata del gruppo di Basso continuo.

Linee di continuazione 'Estese'

Talvolta, una linea di continuazione deve essere collegata con una linea del gruppo successivo, quando un grado
dell'accordo deve essere tenuto per entrambe le armonie. Esempi (entrambi da J. Boismortier, Pièces de viole, op. 31,
Paris 1730):

Nel primo caso, ciascun gruppo ha la propria linea di continuazione; nel secondo, la linea di continuazione del primo
continua 'nel' secondo gruppo.

Ciò si può fare immettendo più (due o più) trattini bassi "__" alla fine della linea di cifra del primo gruppo.

Durate

Ogni gruppo di Basso continuo ha una durata, indicata da un tratto grigio chiaro sovrastante (naturalmente, questa linea è
meramente a scopo informativo e non verrà stampata o esportata in PDF).

In prima istanza, un gruppo ha la medesima durata della nota a cui è collegato. Potrebbe essere necessaria una differente
durata per porre più gruppi sotto una singola nota o estendere un gruppo su più note.

A questo fine, ogni combinazione di tasti nella tabella qui sotto può essere utilizzata per (1) far avanzare il box di modifica
della relativa durata, e (2) impostare la durata di detto gruppo fino alla nuova posizione del box di modifica.

Digitandone varie in sequenza senza immettere alcuna cifra di B. C. estenderà detto gruppo.

Digitare: per avere:
Ctrl+1 1/64
Ctrl+2 1/32
Ctrl+3 1/16
Ctrl+4 1/8 (croma)
Ctrl+5 1/4 (semiminima)
Ctrl+6 metà (minima)
Ctrl+7 intero (semibreve)

Ctrl+8
doppio intero
(breve)

(le medesime cifre utilizzate per le durate delle note)

Impostare l'esatta durata di di un gruppo di cifre è obbligatorio solo in due casi:

1. Quando più gruppi sono distribuiti sulla stessa nota di pentagramma (non c'è altro modo).
2. Quando si utilizzano linee di continuazione, poiché la lunghezza della linea dipende dalla durata del gruppo.
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Comunque, è buona norma impostare sempre le durate al valore inteso nell'ottica di un utilizzo di plugin e del MusicXML.

Modifica di un Basso continuo esistente

Per modificare un'indicazione di Basso continuo già inserita utilizzare una delle seguenti opzioni:

Selezionarla, o selezionare la nota a cui essa appartiene e digitare la stessa scorciatoia per il Basso continuo
utilizzata per crearle di nuove.
farci Doppio-click.

Per una modifica più agevole si aprirà il consueto box di modifica col testo convertito in caratteri normali ('b', '#' and 'h' per
le alterazioni, i modificatori distinti, trattini bassi, ecc.).

Una volta fatto, premere Spazio per spostarsi alla nota successiva, oppure click fuori del box di modifica per uscirne, come
per una nuova immissione di Basso continuo.

Stile

Per configurare come apparirà il Basso continuo: da menu, selezionare Formato → Stile… → Basso continuo.

Carattere: La lista a discesa contiene tutti i tipi di carattere che sono stati configurate per il Basso Continuo.
Un'installazione standard conterrà esclusivamente il carattere, "MuseScore Figured Bass" che inlotre è quello
predefinito.
Dimensione: Scegliere una dimensione carattere in punti. Nota: Questo valore è inoltre modificato da qualsiasi
cambiamento fatto in Ridimensionamento (Formato → Impostazioni pagina…), o Scala ("Proprietà Pentagramma").
Posizione Verticale: La distanza (in spazi) dalla linea superiore del pentagramma al margine superiore del testo di
Basso continuo. Spostamenti verso l'alto con valori negativi (cifre sopra il pentagramma) e spostamenti verso il
basso con valori positivi (cifre sotto al pentagramma: per scendere oltre il pentagramma stesso servirà però un
valore maggiore di 4 spazi).

Interlinea: la distanza fra le linee di base delle cifre sovrapposte espressa in percentuale della dimensione
carattere.

L'immagine seguente mostra il significato dei vari parametri:

Allineamento: Sceglie l'allineamento verticale: con In alto, la linea superiore di ogni gruppo viene allineata come da
Posizione verticale e il gruppo cifrato vi 'pende' (ciò è utilizzato di consueto nella scrittura del Basso continuo ed è il
modo predefinito); con In basso, la linea inferiore di ogni gruppo viene allineata come da Posizione verticale e il
gruppo cifrato vi 'siede' (ciò talvolta è utilizzato in alcuni tipi di scrittura per l'analisi armonica):
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Stile: Sceglie fra "Moderno" o "Storico". La differenza fra i due è mostrata sotto:

Correttezza di sintassi

Affinché sostituzioni significative e combinazioni grafiche funzionino e al fine di un corretto allineamento, il 'motore' del
Basso continuo si aspetta che il testo immesso segua alcune regole (che in ogni caso sono le stesse regole di sintassi del
Basso continuo):

Ci può essere un solo accidente (prima o dopo), o una sola combinazione per cifra;
Non ci posso essere simultaneamente un accidente e una combinazione;
Ci può essere un accidente senza una cifra (terza alterata), ma non una combinazione senza la cifra.
Non è ammesso qualsiasi altro carattere che non sia nella Tabella dei comandi.

Se un testo immesso non segue queste regole non verrà processato: verrà memorizzato e mostrato così com'è, senza
nessun posizionamento.

Tabella dei comandi

Digitare: per avere:
Ctrl+G Aggiunge un nuovo gruppo di cifre alla nota selezionata.
Spazio Fa avanzare il box di modifica alla nota successiva.
Maiusc+Spazio Sposta il box di modifica alla nota precedente.
Tab Fa avanzare il box di modifica alla misura successiva.
Maiusc+Tab Sposta il box di modifica alla misura precedente.
Ctrl+1 Fa avanzare il box di modifica di 1/64, impostando tale durata per il precedente gruppo.
Ctrl+2 Fa avanzare il box di modifica di 1/32, impostando tale durata per il precedente gruppo.
Ctrl+3 Fa avanzare il box di modifica di 1/16, impostando tale durata per il precedente gruppo.
Ctrl+4 Fa avanzare il box di modifica di 1/8 (croma), impostando tale durata per il precedente gruppo.
Ctrl+5 Fa avanzare il box di modifica di 1/4 (semiminima), impostando tale durata per il precedente gruppo.
Ctrl+6 Fa avanzare il box di modifica di 1/2 (minima), impostando tale durata per il precedente gruppo.
Ctrl+7 Fa avanzare il box di modifica di un intero (semibreve), impostando tale durata per il precedente gruppo.

Ctrl+8
Fa avanzare il box di modifica di un doppio intero (breve), impostando tale durata per il precedente
gruppo.

Ctrl+Spazio Inserisce un effetivo spazio; utile quando la cifra appare "sulla seconda linea (p.es., 5 4 -> 3).
BB Inserisce un doppio bemolle.
B Inserisce un bemolle.
H Inserisce un bequadro.
# Inserisce un diesis.
## Inserisce un doppio diesis.
_ Inserisce una linea di continuazione.
__ Inserisce una linea di continuazione 'Estesa'.

Note: Nei comandi Mac Ctrl è rimpiazzato dal Cmd.

Cambio tipo di rigo

È possibile cambiare l'aspetto di un rigo nel corso della partitura aggiungendo ad una battuta un elemento Cambio tipo di
rigo e regolando le sue proprietà nell'Ispettore.

Aggiungere un Cambio tipo di rigo

1. Selezionare una battuta nella partitura e, nella tavolozza "Testo", click (doppio-click versioni prec. alla 3.4) sul
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simbolo "Cambio tipo di rigo" ; in alternativa, trascinare l'icona del "Cambio tipo di rigo" su una battuta;
2. Selezionare il simbolo e regolare le sue proprietà (vedi sotto) nell'Ispettore come richiesto.

Proprietà del Cambio tipo di rigo

Quando si modificheranno le proprietà del __Cambio tipo di rigo __ nell'Ispettore, i nuovi valori saranno prioritari rispetto a
quelli nella finestra globale Proprietà Rigo / Parte: tutti i righi. Solamente i valori che in "Proprietà Rigo / Parte: tutti i righi"
che non possono essere modificati nell'Ispettore del "Cambio tipo di rigo" saranno validi lungo tutta la partitura.

Le proprietà che possono essere alterate nell'Ispettore del __Cambio tipo di rigo__sono:

Offset
L'ammontare di quanto il rigo cambiato risulterà spostato verso l'alto o verso il basso: misurato in spazi (abbr.: sp) .

Rigo piccolo
Spuntare per il rigo di proporzioni ridotte.

Ridimensiona
Cambia in percentuale la dimensione del rigo e di tutti gli elementi associati.

Linee
Il numero di linee che costituiscono il rigo.

Distanza linee
La distanza fra due linee del rigo misutara in spazi (abbr.: sp).

Offset di grado
Offset in gradi (musicali) verso l'alto o verso il basso aggiunto alle note.

Mostra stanghette
Controlla se sul rigo verranno mostrate le stanghette.

Mostra tagli addizionali
Controlla se verranno mostrati i tagli aggiuntivi per note sopra/sotto al rigo.

Senza gambi
Controlla verrà mostrata la notazione standard o senza gambi.

Schema teste delle note
Consente la scelta di come verranno mostrate le teste delle note.

Genera chiavi
Controlla se verrà mostrata la chiave.

Genera indicazione metriche
Controlla se verrà mostrata l'indicazione/i metrica/e .

Genera armatura di chiave
Controlla se verrà mostrata l'Armatura di chiave.

Esempio

Per illustrare l'utilizzo del Cambio tipo di rigo, il rigo mostrato sotto è stato creato coi seguenti passi:

1. Aggiunto un Cambio tipo di rigo a battuta 2.
2. Impostata la dimesione a "Rigo piccolo".
3. Impostato "Linee" a 4.
4. Aggiunto un secondo Cambio tipo di rigo a battuta 3.

5. Impostato "Linee" a 7,

Dopodiché le proprietà globali del rigo vengono cambiate utilizzando le Proprietà Rigo:

1 Impostato "Linee" a 2.
2. Cambiato "Colore linee rigo".
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Come si può vedere, il cambio in "Linee" ha effetto solamente fino al primo Cambio tipo di rigo, mentre il cambio di
"Colore linee rigo" ha effetto lungo tutta la partitura.

Diagrammi degli accordi

Note: Questa pagina si applica solo a MuseScore vers. 3.1 e superiori. Gli utenti di versioni precedenti alla 3.1
dovrebbero andare su Diagrammi per tastiera (versioni precedenti la 3.1).

Panoramica dei diagrammi degli accordi

MuseScore permette l'uso e la creazione di diagrammi degli accordi (o accordi). Di solito appaiono sopra il rigo sugli
spartiti in linea melodica (lead sheet ) e sugli spartiti per pianoforte. Sono comunemente usati per accordi di chitarra, ma
MuseScore permette la creazione di diagrammi per qualsiasi strumento.

Sotto è riportato un semplice esempio di utilizzo dei diagrammi degli accordi.

(Nota: i diagrammi degli accordi sono un'alternativa alla Intavolatura, che è una forma di notazione specializzata preferita
da alcuni esecutori di strumenti a corda).

Il meccanismo del diagramma degli accordi può essere utilizzato in diversi modi.

1. Accordi Standard. Un set di 21 diagrammi di comuni accordi per chitarra si trova nella tavolozza “Diagrammi
chitarra” nell'area di lavoro Avanzata. Questi consistono in un singolo esempio di accordo maggiore, minore e di
settima per ogni tono della scala diatonica (CDEFGAB). Questi 21 accordi sono adatti per molte semplici partiture di
musica pop o folk. Vedere la panoramica di questa tavolozza qui sotto.

2. Accordi modificati. In molti casi, gli accordi standard della tavolozza “Diagrammi chitarra” sono usati come punto di
partenza per creare diagrammi di accordi modificati, tramite l’Ispettore. Questa tecnica permette di applicare ai 21
diagrammi standard estensioni, alterazioni, diverse disposizioni (voicing), diverse posizioni, ecc. Esistono
letteralmente migliaia di accordi per chitarra in uso generale, il che rende impraticabile una tavolozza o un dizionario
completo. Vedere How to use Fretboard Diagrams for custom/complex chords  per gli esempi.

3. Accordi "Freehand" (“A mano libera”). I chitarristi più esperti spesso preferiscono partire da una griglia di accordi
vuota, e poi disegnare gli accordi specifici desiderati. Vedere How to use Fretboard Diagrams for custom/complex
chords  per esempi.

Nota: Molti aspetti della notazione musicale seguono standard tipografici ben stabiliti. I diagrammi degli accordi per
chitarra sono un'eccezione. L'uso è variato molto di anno in anno, da editore a editore, da insegnante a insegnante e da
arrangiatore ad arrangiatore. Molte pratiche incoerenti persistono ancora oggi, e stili distinti di notazione degli accordi
sono preferiti in diversi generi musicali e regioni. Per questo motivo, l'interfaccia Diagrammi degli accordi di MuseScore
supporta diagrammi di vari tipi. Gli utenti sono liberi di scegliere i loro preferiti.

Panoramica della tavolozza di accordi standard per chitarra

La tavolozza “Diagrammi chitarra” nell’Area di lavoro Avanzata mette a disposizione 21 diagrammi, che comprendono un
singolo accordo maggiore, minore e di settima per ogni tono della scala diatonica (CDEFGAB). Il nome di ogni diagramma
appare quando il cursore passa sopra la voce.
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Nota: Questa gamma di diagrammi di accordi, o qualsiasi selezione di 21 accordi, non sarebbe tipicamente sufficiente per
scopi di pubblicazione. Gli arrangiatori devono considerare molte altre disposizioni (voicing), posizioni e qualità di accordi.
Questa tavolozza è anche un esempio dei diversi formati di diagramma per chitarra in uso, come discusso sopra. Inoltre
si dà il caso che questi 21 accordi incorporino indicatori di corde aperte/mute (i simboli X e O sopra i diagrammi). Anche
se questi simboli appaiono spesso nelle partiture pubblicate, il loro uso varia a seconda del contesto. Per esempio, gli
arrangiamenti jazz generalmente omettono gli indicatori delle corde mute, a meno che non siano importanti per il contesto,
e raramente usano le corde aperte.

In futuro saranno probabilmente disponibili altre tavolozze contenenti una gamma più ampia di accordi standard. Queste
cercheranno di rispondere alle esigenze di specifici generi e situazioni musicali.

Panoramica sulla creazione di accordi modificati o personalizzati

I Diagrammi degli accordi modificati sono creati aggiungendo e poi modificando un diagramma esistente dalla tavolozza.
Modificando gli accordi standard, è possibile creare Diagrammi degli accordi per qualsiasi accordo suonabile, e replicarne
la diteggiatura su qualsiasi strumento a corde occidentale, indipendentemente dall’accordatura, dal numero di corde, o dal
numero di tasti. La maggior parte del materiale che segue riguarda il processo di modifica dei diagrammi e la creazione di
nuovi.

I diagrammi personalizzati possono essere salvati in una tavolozza personalizzata, se lo si desidera, per utilizzi futuri. I
diagrammi modificati possono ovviamente essere copiati/incollati all'interno di uno spartito nei soliti modi.

Aggiungere un Diagramma degli accordi

Per aggiungere un Diagramma degli accordi alla partitura, usare uno dei seguenti metodi:

Selezionare una nota in voce 1 e fare doppio clic su un diagramma degli accordi dalla tavolozza Diagrammi chitarra.
Trascinare e rilasciare un diagramma degli accordi dalla tavolozza “Diagrammi degli accordi” alla posizione
desiderata nella partitura.

Quando il cursore passa sopra il diagramma scelto all'interno della tavolozza, il suo nome apparirà come un
suggerimento a comparsa (vedere l’esempio nella panoramica).

Sigle Accordali collegate a Diagrammi degli accordi

Quando si aggiunge un diagramma degli accordi a una partitura, viene creato automaticamente anche una sigla
accordale. La sigla accordale è normalmente posizionata sopra il diagramma e prende il nome dell'accordo dalla cella
della tavolozza dell'accordo. Il posizionamento automatico e la formattazione della sigla accordale di un diagramma è
controllato dalle impostazioni di stile (vedere impostazioni di stile, sotto).

Una sigla accordale generata da un diagramma degli accordi può essere selezionata, spostata e modificata come
qualsiasi altro elemento di testo. Si comporta generalmente come le normali sigle accordali che vengono aggiunte
usando Aggiungi→Testo→Sigle accordali o la scorciatoia Ctrl+K.
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Nota 1: Un campo nella pagina di stile delle Sigle accordali (sottomenu: Stile selezionare Formato→Stile→Sigle accordali) –
nonché nella pagina di stile dei Diagrammi chitarra – controlla la "Distanza della sigla accordale dal diagramma __".
Questo valore interagisce con il campo __Distanza minima nella sezione Elemento" dell’Ispettore, al fine di
controllare il posizionamento automatico della sigla accordale rispetto al diagramma. Notare anche che il "bordo
superiore" del diagramma degli accordi include lo spazio vuoto dove apparirebbero gli indicatori di corde aperte/mute,
anche se quell'area è vuota. Questo potrebbe lasciare uno spazio più grande di quello desiderato. Come al solito, il
posizionamento manuale può essere usato per annullare le impostazioni automatiche.

Nota 2 : Le sigle accordali automatiche generate per gli diagrammi degli accordi non sono completamente integrate con le
normali sigle accordali che possono essere direttamente associate alle note sul rigo. In particolare, l’evidenziazione
(focus?) non scorre dalla sigla accordale di un diagramma degli accordi alla sequenza di altri simboli nella pagina quando
si usa Spazio per muoversi attraverso le sigle accordali. Questo problema minore sarà affrontato in un futuro
aggiornamento.

Uso delle Sigle accordali con i Diagrammi degli accordi

Aggiungere automaticamente la Sigla accordale di un diagramma degli accordi semplicemente aggiungendo un
diagramma degli accordi come descritto sopra.
Cancellare la Sigla accordale di un diagramma degli accordi selezionando il simbolo e cancellandolo, come per
qualsiasi elemento di testo.
Aggiungere una nuova Sigla accordale a un diagramma che ne è privo selezionando il Diagramma degli
accordi e usando Aggiungi→Testo→Sigla accordale o la scorciatoia Ctrl+K.

Regolare le proprietà degli elementi di un diagramma degli accordi (posizione, colore, ordine di impilatura...)

La posizione di un Diagramma degli accordi può essere regolata usando i tasti freccia in Modalità modifica; o con gli
offset X- e Y- nella sezione "Elemento" in alto nell’Ispettore.

Visibilità, Colore e Ordine di impilatura possono anche essere regolati nella sezione "Elemento": vedere il diagramma
sotto modifica.

Regolare le proprietà globali/predefinite di stile un diagramma degli accordi (posizione, colore, ordine di
impilatura...)

Alcune proprietà predefinite e globali dei Diagrammi degli accordi (vedere immagine seguente) possono essere regolate
dal sottomenù Stile: selezionare Formato→Stile→Diagrammi chitarra. Alcune di queste proprietà possono essere modificate
tramite l’Ispettore; ma molte hanno effetto su tutti i Diagrammi degli accordi nella partitura.
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Posizione verticale predefinita specifica il posizionamento predefinito del diagramma rispetto al rigo. (Soggetto a
sovrascrittura tramite Ispettore).
Scala specifica la scala predefinita (cioè la dimensione del diagramma). (Soggetto a sovrascrittura tramite
Ispettore).
Dimensione del carattere del numero tasto e ...posizione controllare il posizionamento dei numeri di tasto su tutti
i diagrammi. (Globale).
Spessore linea barré controlla lo spessore della linea usata per rappresentare un barré su tutti i diagrammi. Per
default, è lo stesso spessore dei punti solidi. Una linea più sottile permetterà ai punti di essere visibili sotto il barré,
per situazioni in cui ciò è preferibile. (Globale).
Dimensione relativa del punto (Global). controlla la dimensione dei punti su tutti i diagrammi, rispetto alla
dimensione della griglia in scala. (Globale).
Spaziatura delle corde controlla la spaziatura tra le corde, e quindi la larghezza totale di tutti i diagrammi.
(Globale).
Spaziatura del tasto controlla la spaziatura tra i tasti, e quindi l'altezza totale di tutti i diagrammi rispetto al numero
di tasti visualizzati. (Globale).
Massimo spostamento in alto/basso rispetto alla posizione predefinita. (Globale).

Molte delle proprietà di Diagrammi chitarra esposte nell'Ispettore comprendono i pulsanti "ripristina lo stile predefinito" e
"imposta come stile predefinito". Questi valori non appaiono tipicamente nella pagina dello stile, ma sono regolabili tramite
l'Ispettore.

Modificare un diagramma degli accordi

Quando un diagramma degli accordi è selezionato, può essere modificato nell’Ispettore come segue:

L’Ispettore visualizza tre sezioni correlate al Diagramma degli accordi:

Una sezione Elemento che controlla la visibilità, il posizionamento, il colore e altri aspetti del Diagramma degli
accordi che sono usati in comune con altri elementi di MuseScore; vedere modificare le proprietà di un elemento e
l’Ispettore per dettagli.
Una sezione Diagramma chitarra, con campi di controllo e pulsanti che definiscono l’aspetto di questo diagramma.
Una versione ingrandita del Diagramma degli accordi, che mostra i suoi dettagli e permette la modifica.

Di seguito è riportato un esempio dell’Ispettore con un Diagramma degli accordi selezionato.
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Modificare le proprietà del Diagramma degli accordi

(Vedere le proprietà dell’Ispettore sopra, nell’esempio modifica).

Per regolare la scala (dimensione) del diagramma: Usare Scala.
Per regolare la posizione del diagramma rispetto al rigo: Usare Posizione.
Per regolare l’orientamento del diagramma rispetto al rigo: Usare Orientamento.
Per stabilire il numero di corde dello strumento: Usare Corde. Le corde vengono aggiunte/rimosse dal lato
sinistro del diagramma.
Per stabilire quanti tasti visualizzare (cioè l’altezza del diagramma): Usare Tasti. I tasti vengono aggiunti/rimossi
dalla parte inferiore del diagramma.
Per stabilire la posizione del primo tasto: Usare Numero del tasto. La cifra viene indicata accanto al primo tasto
visibile.
Per specificare l’ispessimento del capotasto (una linea pesante sopra il primo tasto): Usare Mostra capotasto.
Posizionare i punti di pressione delle dita (finger dots) come descritto di seguito.

Modifica dei punti di pressione delle dita (uso di base)

(Vedere le proprietà dell’Ispettore sopra, nell’esempio di modifica).

Per rimuovere tutti i punti correnti, usare il pulsante "Pulisci" sopra il diagramma. (Nota: si potrebbe salvare una
griglia vuota in una palette personalizzata, come punto di partenza per diagrammi personalizzati).
Per creare un punto di pressione, cliccare su un tasto nel diagramma in fondo all’Ispettore; cliccare nuovamente
per rimuovere il punto.
Per spostare un punto, cancellarlo dalla sua posizione attuale cliccando su di esso; creare quindi il nuovo punto
desiderato.
Per creare un barré o un barré parziale: Cliccare il pulsante "Barré" sopra il diagramma; cliccare quindi nella
posizione più a sinistra desiderata per il barré. Il barrè si estenderà fino al bordo destro della tastiera. Scorciatoria
da tastiera: Tenendo premuto il tasto Maiusc, cliccare sulla corda da cui si vuole che abbia inizio il barré.
Per terminare un barré prima della corda più a destra: Cliccare il pulsante "Barré" sopra il diagramma; cliccare
quindi nella posizione più a destra desiderata su un barré esistente. Il barré terminerà su quella corda. Scorciatoia
da tastiera: Tenendo premuto il tasto Maiusc, cliccare sulla corda su cui si vuole che il barré termini.
Per cancellare un barré: Cliccare il pulsante "Barré" sopra il diagramma; cliccare quindi sulla posizione più a
sinistra del barré. Questo verrà rimosso. Scorciatoia da tastiera: Tenendo premuto il tasto Maiusc, cliccare sulla
posizione più a sinistra del barré.
Per creare barré multipli: Seguire i passi precedenti per creare più di una barré, ad esempio per mostrare il terzo
dito che copre due corde.
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Per regolare lo spessore del barré: Usare le Opzioni di Stile (Formato->Stile->Diagrammi chitarra) per regolare lo
spessore della linea di barré in relazione ai punti. Questo permetterà ai punti di essere visibili sul barré, nei casi in
cui ciò sia preferibile.
Per Indicare corde aperte e mute (optionale). Cliccare appena sopra il diagramma per alternare una corda fra:

Aperta (o)
Muta/non suonata (x)
Nessuna indicazione

Modifica dei punti di pressione delle dita (uso avanzato)

Alcuni arrangiatori ed educatori usano una forma più avanzata di Diagramma degli accordi che a) incorpora più tipi di
"punti", e che b) permette più punti per corda.

Questa tecnica è associata in particolare ai molti libri e arrangiamenti pubblicati da Ted Greene e dai suoi successori.
(Nota: nessun altro software di notazione supporta attualmente questo stile di diagramma).

Stile di notazione a più punti. Con questo approccio, i punti rotondi sono suonati per primi. Poi, su battiti
successivi, le note rappresentate dagli altri punti vengono suonate in ordine. Questo permette a un diagramma
singolo di rappresentare più battiti di musica. (La sequenza usuale è: punto→X→quadrato→delta. L’uso varia
comunque). Ecco due esempi di diagrammi a più punti.

Stile di notazione “nota opzionale”. Un altro uso di punti multipli per corda permette ad altri simboli di mostrare
note opzionali, piuttosto che note ritardate. Di solito, viene mostrata una disposizione (voicing) dell'accordo
correlato, come un'estensione opzionale o una versione opzionale dell'accordo senza radici. Ecco un esempio di
un'estensione opzionale.

Diagrammi degli accordi di MuseScore permette di creare questi e altri tipi di diagrammi multi-simbolo. Un accordo viene
prima creato e modificato usando i passi base descritti sopra. Poi, i pulsanti di punti multipli sopra il diagramma sono
utilizzati per aggiungere note secondarie.

1. Per iniziare ad aggiungere punti multipli (cioè simboli) a un diagramma, cliccare su "Punti Multipli".
2. Per aggiungere un altro punto ad una corda, cliccare sopra o sotto un simbolo esistente. Il simbolo successivo in

sequenza sarà collocato in quella posizione, ad esempio se c'è già un punto, apparirà una X.
3. Per rimuovere qualsiasi simbolo da un diagramma, cliccarci sopra.
4. Per inserire un particolare simbolo fuori sequenza, cliccare sul pulsante con quel simbolo pima di aggiungere il
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punto; ad esempio, per inserire una X su una corda senza punti attuali – perché quella nota dovrebbe essere
suonata dopo il resto dell’accordo – cliccare sulla X e poi posizionarla come desiderato.

(Nota: Gli utenti esperti dei diagrammi in stile Ted Greene troveranno che diverse caratteristiche secondarie degli
diagrammi di Ted non sono ancora supportate in MuseScore. Questi includono: a. Visualizzazione del numero di tasto su
un tasto più alto del primo tasto visibile. b. Permettere ai simboli delle note di includere cifre, non solo i quattro stili di punti
attualmente supportati. c. Permettere la creazione di annotazioni su e tra gli diagrammi, come cerchiare una nota
particolare, o disegnare linee che collegano le note in diagrammi adiacenti. Tuttavia, MuseScore fornisce molti strumenti
per il disegno e l'annotazione che possono servire al posto di queste tecniche).

(Nota: Poiché i simboli multi-nota non sono standardizzati, anche all'interno della comunità Ted Greene, gli utenti devono
fare attenzione ad indicare come vengono utilizzati all'interno di una determinata partitura.)

Collegamenti esterni

How to use Fretboard Diagrams for custom/complex chords  (MuseScore HowTo)
Palette with fretboard diagrams for Mandolin  (Forum article)
Palette with fretboard diagrams for Ukulele  (Forum article)
Fretboard plugin

Fretboard diagrams (prior to version 3.1)

Note: This page applies to versions of MuseScore prior to 3.1 only. Users of MuseScore 3.1 and above should go to
Fretboard diagrams.

A range of fretboard (or chord) diagrams for the guitar are provided in the Fretboard Diagrams palette in the Advanced
Workspace.

You can create a chord diagram for any fretted, stringed instrument by editing an existing one. It can be saved to a custom
palette for future use if required.

Add a fretboard diagram

To add a fretboard diagram to the score, use one of the following methods:

Select a note in voice 1 and double-click a fretboard diagram from a palette.
Drag and drop a fretboard diagram from a palette to the desired position in the score.

As the cursor hovers over the chosen diagram within the palette, its name will appear as a pop-up hint.

Edit a fretboard diagram

When a fretboard diagram is selected, it can be edited in the Inspector as follows:

To adjust the number of instrument strings: Use Strings.
To adjust the fret position number: Use Offset.
To adjust how many frets to display (height-wise): Use Frets.
To place the finger dots: Click on a fret to establish a dot; click again to remove the dot.
To create a barre or partial barre: First make sure that the desired fret position is clear of black dots (click on a dot
to remove it). Then, holding the Shift key, click on the string where you want the barre to begin. (Note: Only one barre
can be applied per diagram; a partial barre must end on the first string).
To delete a barre: Click on the black dot where the barre begins.
To Indicate open and mute strings (if applicable): Click just above the diagram to toggle a string between:

Open (o)
Mute/unplayed (x)
No indication.

To adjust the size: Use the Scale property.

To adjust a diagram's element properties

The position of a Fretboard Diagram can be adjusted using the keyboard arrows in Edit mode; or with the X- and Y-
offsets in the "Element" section at the top of the Inspector.
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Visibility, Color and Stacking order can also be adjusted from the "Element" section.

To adjust a diagram's style properties

Certain default and global properties of Fretboard Diagrams (e.g. barre thickness, vertical position, scale, fret-number
font-size and position) can be adjusted from the Style submenu: select Format→Style…→Fretboard Diagrams. Some of these
properties are subject to override via the Inspector; but most affect all Fretboard Diagrams in the score.

File formats

MuseScore can import and export a wide variety of file formats, allowing you to share and publish scores in the format that
best meets your needs.

MuseScore native format

MuseScore saves files in the following native formats:

*.mscz: The default MuseScore file format. Being compressed it takes up relatively little disk space.
*.mscx: An uncompressed MuseScore file format, mainly used for debugging or storing in a versioning system
.*.mscz, / .*.mscx,: These are backup files. Notice the point (full stop) added before the file name, and the comma
added to the file extension.

A note about fonts: MuseScore does not embed text fonts in saved or exported native format files. If you want your
MuseScore file to be viewed by other MuseScore users, make sure you are using the built-in Edwin (since version 3.6),
FreeSerif, or FreeSans font families for your text, or a font that the other parties have installed too. If a system does not
have the fonts specified in your original file, MuseScore will use a fallback option, which may cause your score to appear
differently.

MuseScore format (*.mscz)

MSCZ is the standard MuseScore file format and recommended for most uses. A score saved in this format takes up very
little disk space, but preserves all the necessary information. The format is a ZIP-compressed version of .mscx files and
includes any images the score may contain and a thumbnail.

Uncompressed MuseScore format (*.mscx)

MSCX is the uncompressed version of the MuseScore file format. A score saved in this format will retain all information,
except images. It can be opened with a text editor, allowing the user access to the file's source code.

MuseScore backup file (.*.mscz,) or (.*.mscx,)

Backup files are created automatically and saved in the same folder as your normal MuseScore file. The backup copy
contains the previously saved version of the MuseScore file and can be important if your normal copy becomes corrupted,
or for looking at an older version of the score.

The backup file adds a period to the beginning of the file name (.) and a comma (,) to the end (e.g. if your normal file is
called "untitled.mscz", the backup copy will be ".untitled.mscz,"), and the period and comma need to be removed from the
name in order to open the backup file in MuseScore. As it is stored in the same folder as your normal MuseScore file, you
may also need to give it a unique name (e.g. changing ".untitled.mscz," to "untitled-backup1.mscz").

Note: In order to see the MuseScore backup files, you may need to change your system settings to "Show hidden files".
See also How to recover a backup copy of a score .

Graphic files (export only)

MuseScore can export a score as a graphic file in either PDF, PNG or SVG format.

PDF (*.pdf)

PDF (Portable Document Format) files are ideal for sharing your sheet music with others who do not need to edit the
content. This is a very widely-used format and most users will have a PDF viewer of some kind on their computers.

To set the resolution of exported PDFs:

1. From the menu bar, choose Edit→Preferences... (Mac: MuseScore→Preferences...), and select the "Export" tab;
2. Set the resolution in the "PDF" section.

PNG (*.png)

PNG (Portable Network Graphics) files are based on a bitmap image format, widely supported by software on Windows,
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Mac OS, and Linux, and very popular on the web. MuseScore creates PNG images as they would appear if printed, one
image per page.

To set the resolution of exported PNG images:

1. From the menu bar, choose Edit→Preferences... (Mac: MuseScore→Preferences...), and select the "Export" tab;
2. Set the resolution and transparency in the PNG/SVG section.

Note: If you want to create images that show only parts of the score (with or without screen-only items such as frame
boxes, invisible notes, and out-of-range note colors), use Image capture instead.

SVG (*.svg)

SVG  (Scalable Vector Graphics) files can be opened by most web browsers (except Internet Explorer before version 9)
and most vector graphics software. However, most SVG software does not support embedded fonts, so the appropriate
MuseScore fonts must be installed to view these files correctly. SVG is the current format for all scores saved on
MuseScore.com.

To set resolution and transparency of exported SVG files, see the instructions under PNG (above). Note that MuseScore
does not (yet) support gradients on export (although it does for images in a score).

Audio files (export only)

MuseScore can create normalized, stereo audio of the score in any of the following formats: WAV, MP3, OGG VORBIS,
FLAC. To export an audio file:

1. From the menu, select File → Export...;
2. Choose the desired format from the dropdown menu, then press Save.

You can adjust the sample rate of all audio formats as follows:

1. From the menu bar, select Edit→Preferences... (Mac: MuseScore→Preferences...), and click on the Export tab;
2. Set "Sample rate" in the "Audio" section.

WAV audio (*.wav)

WAV (Waveform Audio Format) is an uncompressed sound format. This was developed by Microsoft and IBM, and is
widely supported by software for Windows, OS X, and Linux. It is an ideal format for use when creating CDs, as full sound
quality is preserved. For sharing via email or the internet, use a compressed alternative such as MP3.

MP3 (*.mp3)

MP3 is a very widely-used compressed audio format. MP3 files are ideal for sharing and downloading over the internet
due to their relatively small size.

To set the MP3 bitrate:

1. From the menu bar, choose Edit→Preferences... (Mac: MuseScore→Preferences...), and select the "Export" tab;
2. Set the MP3 bitrate in the "Audio" section.

FLAC audio (*.flac)

Free Lossless Audio Codec  (FLAC) is compressed audio format. FLAC files are approximately half the size of
uncompressed audio and just as good quality. Windows and OS X do not have built-in support for FLAC, but software
such as the free and open source VLC media player  can play FLAC files on any operating system.

Ogg Vorbis (*.ogg)

Ogg Vorbis  is intended as a patent-free replacement for the popular MP3 audio format (which MuseScore also supports
—see above). Like MP3, Ogg Vorbis files are relatively small (often a tenth of uncompressed audio), but some sound
quality is lost. Windows and OS X do not have built-in support for Ogg Vorbis. However, software such as VLC media
player  and Firefox  can play Ogg files on any operating system.

Share with other music software

MuseScore can import and export MusicXML and MIDI files; it is also able to import a variety of native format files from
other music notation programs.

MusicXML (*.musicxml, *.xml)

MusicXML  is the universal standard for sheet music. It is the recommended format for sharing sheet music between
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different scorewriters, including MuseScore, Sibelius, Finale, and more than 100 others. MuseScore imports *.xml and
*.musicxml, exports *.musicxml, and the outdated *.xml(since version 3.5) because the program you want to import it needs
that, in previous MuseScore version you need to rename it yourself after the export.

Compressed MusicXML (*.mxl)

Compressed MusicXML creates smaller files than regular MusicXML. This is a newer standard and isn't as widely
supported by older scorewriters, but MuseScore has full import and export support.

MIDI (*.mid, *.midi, *.kar)

MIDI (Musical Instrument Digital Interface) is a format widely supported by sequencers and music notation software. For
details of the protocol see the MIDI Association  website.

MIDI files are very useful for playback purposes but contain little in the way of score layout information (formatting, pitch
spelling, voicing, ornaments, articulations, repeats, key signatures etc.). To share files between different music notation
software, MusicXML is recommended instead.

For details about how to import MIDI files see MIDI import.

MuseData (*.md) (import only)

MuseData  is a format developed by Walter B. Hewlett beginning in 1983 as an early means of sharing music notation
between software. It has since been eclipsed by MusicXML, but several thousand scores in this format are still available
online.

Capella (*.cap, *.capx) (import only)

CAP and CAPX files are created by the score writer, Capella . MuseScore imports version 2000 (3.0) or later fairly
accurately.

Bagpipe Music Writer ( *.bww) (import only)

BWW files are created by the niche score writer, Bagpipe Music Writer .

BB (*.mgu, *.sgu) (import only)

BB files are created by the music arranging software, Band-in-a-Box . MuseScore's support is currently experimental.

Overture (*.ove) (import only)

OVE files are created by the score writer Overture . This format is mainly popular in Chinese-language environments,
such as Mainland China, Hong Kong, and Taiwan. MuseScore's support is currently experimental and seems to support
Overture 3 and later only.

Guitar Pro (various—import only)

MuseScore can open Guitar Pro  files with the following extensions: *.gtp, *.gp3, *.gp4, *.gp5, *.gpx, and, as of version
3.5, *.gp.

Power Tab Editor ( *.ptb) (import only)

PTB files are created by Power Tab Editor . MuseScore's support is currently experimental.

See also

Open/Save/Export/Print
Recovered files

External links

How to recover a backup copy of a score  (MuseScore HowTo)

File ripristinati

Se MuseScore o il computer dovessero bloccarsi, o se viene a mancare la corrente, un messaggio pop-up al riavvio di
MuseScore chiederà se si desidera ripristinare la sessione precedente:
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Cliccare Yes, per avviare il tentativo di recupero dei file dalla sessione interrotta. Oppure cliccare No per ignorare il
messaggio.

Salvataggio dopo il recupero della sessione

Quando MuseScore recupera i file dopo un crash, li rinomina con il nome del percorso completo aggiunto davanti al nome
del file originale. Questo nome molto lungo apparirà nella scheda (o nelle schede) sopra la finestra della partitura attiva.

Per assicurarsi che il file sia salvato nella sua posizione originale. Salvare immediatamente il file ripristinato usando
l'opzione "Salva Come...": questa aprirà una finestra che permetterà di navigare nella cartella e nella directory corrette. Se
invece si usa il comando "Salva", il file verrà salvato nella sua posizione attuale, che difficilmente sarà quella originale.

Trovare i file recuperati

Nel caso in cui venga usato "Salva" al posto di "Salva Come..." con un file recuperato, si dovrà effettuare la ricerca dei file sul
computer. La posizione effettiva di quei file varierà a seconda del sistema operativo e in quale directory è installato
MuseScore.

Per Windows 7, con un'installazione predefinita di MuseScore nella directory dei file di programma, i file recuperati sono
salvati automaticamente in C:\Program Files\MuseScore 3\bin (in realtà %ProgramFiles%\MuseScore 3\bin).

Per Windows 10, guardare in C:\Users\[User Name]\AppData\Local\VirtualStore\Program Files\MuseScore 3\bin  (in
realtà%LOCALAPPDATA%\VirtualStore\%ProgramFiles:~3%\MuseScore 3\bin).

Potrebbe essere necessario eseguire una ricerca a livello di sistema per trovare i file salvati direttamente dopo il recupero
di una sessione. Usare le parole chiave del nome del file originale così come i caratteri jolly, e specificare la data di
modifica.

Vedere anche

Salva/Esporta/Stampa

Collegamenti esterni

How to recover a backup copy of a score  (MuseScore HowTo)

Funzionalità per la Musica Antica

MuseScore offre diverse funzioni specializzate per creare stampe di musica antica (in particolare medievale e
rinascimentale) simili alle edizioni commerciali dal XX secolo in poi.

Notazione non barrata (o non misurata)

In MuseScore, le note che hanno durata maggiore di quella della battuta sono normalmente rappresentate con legatura di
valore attraverso la stanghetta. Tuttavia MuseScore ha una caratteristica speciale che gli permette di visualizzare i valori
intatti delle note, senza dividerle e legarle in questo modo. Questo permette di trascrivere musica senza stanghette (cioè
non è divisa in battute), come quella del rinascimento:

1. Dalla barra menù, selezionare Formato→Stile→Partitura.
2. Contrassegnare la casella etichettata "Mostra il valore delle note ignorando la stanghetta della battuta".

3. Cliccare "OK" o "Applica". La partitura esistente si aggiorna immediatamente.

Esempio

1. L'esempio qui sotto mostra un estratto dalla partitura originale del "De Profundis Clamavi" per 4 voci di Nicolas
Champion:
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2. Lo stesso estratto visualizzato in MuseScore:

3. E dopo aver attivato "Mostra il valore delle note ignorando la stanghetta della battuta".

4. Per non visualizzare le stanghette, basta deselezionare la casella "Mostra stanghette" nella finestra di dialogo delle
proprietà Rigo / Parte. Vedere anche Mensurstrich (sotto).

Nota: La funzione è ancora in sviluppo e può contenere bug. Il valore di nota più lungo supportato è la longa (una longa
punteggiata è ancora spezzata e legata).

Mensurstrich

Poiché per i musicisti attuali una completa mancanza di linee di battuta potrebbe rendere l'esecuzione della musica più
difficile, molti editori moderni hanno optato per un compromesso chiamato Mensurstrich, con il quale le stanghette di
battuta sono disegnate tra i righi, ma non attraverso di essi.

Per posizionare le stanghette di battuta tra i righi:

1. Nel rigo più basso (di solito il rigo inferiore di una accollatura) dove si vuole applicare il Mensurstriche proposto,
deselezionare "Mostra stanghette" nella finestra di dialogo Proprietà Rigo /Parte;

2. Nel rigo sopra il punto in cui si vuole il Mensurstrich, cliccare su una stanghetta;
3. Nella sezione Stanghetta dell’Ispettore, spuntare l’opzione "Estendi al rigo successivo";
4. Nella sezione Stanghetta dell’Ispettore, regolare il valore "Estendi da" in modo che la parte superiore della

stanghetta incontri la linea inferiore del rigo (per esempio, impostare a 8);
5. Cliccare il tasto "Imposta come predefinita rigo".

Ambitus

Prima che venisse introdotto il concetto di altezza assoluta, gli esecutori dovevano spesso trasporre "al momento" la
musica vocale per ottenere estensioni cantabili dal loro ensemble. Per aiutarli, a volte veniva incluso un ambitus che
indicava l'intervallo di estensione vocale all'inizio del pezzo.

Per applicare un ambitus, usare uno dei seguenti metodi:

Trascinare il simbolo dell’ambitus (dalla tavolozza Linee dell’area di lavoro Avanzata) su una chiave.
Selezionare una o più chiavi, quindi cliccare (doppio clic per versioni precedenti la 3.4) il simbolo ambitus (nella
tavolozza Linee dell’area di lavoro Avanzata).

Quando viene applicato, l'ambitus visualizza automaticamente l'intervallo di note del rigo corrispondente: se c'è
un'interruzione di sezione, allora viene visualizzato solo l'intervallo di note della sezione. Oltre l'interruzione di sezione
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potrà essere applicato un nuovo ambitus.

L'intervallo di note dell'ambitus può essere regolato manualmente selezionandolo e cambiando i valori di "Nota apicale" e
"Nota inferiore" nell’Ispettore. Per la regolazione automatica cliccare sul pulsante Corrispondenza rigo nell’Ispettore.

Indicazioni metriche mensurali

ATTENZIONE - Questa parte è da aggiornare
Nel sistema di notazione mensurale, le indicazioni metriche non definivano la lunghezza di una battuta, ma la lunghezza
di brevi e semibrevi. MuseScore supporta i simboli di tempo mensurali come metodo di visualizzazione nella finestra
dialogo delle “proprietà indicazioni metriche” piuttosto che come simboli, ma in questo caso hanno proprio solo funzione di
“visualizzazione”, poiché la proporzione, per esempio, tra minima e semibreve non può essere modificata.

Un modo per fare uso di questi simboli è quello di trascrivere composizioni rinascimentali in cui sono simultaneamente
presenti più voci con diverse indicazioni metriche senza utilizzare gruppi irregolari. Modificare l'indicazione metrica in base
al singolo rigo, fino a far coincidere inizio e fine battuta in tutti i righi. Se questo risultasse impossibile prendere in
considerazione la possibilità di aumentare le dimensioni delle battute in base al minimo comune denominatore.

De Profundis Clamavi a 5 voci di Josquin Des Prez

Intavolature d’epoca

Una intavolatura d'epoca dall'aspetto autentico è possibile per strumenti come il liuto, la tiorba ecc. I vari stili storici sono
ben supportati da una scelta di capotasti e simboli di nota, intavolatura opzionale "capovolta", e simboli speciali per le
note della corda del basso. Vedere Intavolatura.

Vedere anche

Operazioni sulle battute: Dividere e unire

Gruppo di note tra righi

Negli spartiti per pianoforte è frequente l'utilizzo di tutti e due i righi (chiave di basso e chiave di violino) per scrivere frasi
musicali. Questo effetto può essere ottenuto in MuseScore come segue:

1. Per prima cosa inserire tutte le note della frase in un rigo. Esempio:

2. Selezionare una nota e premere Ctrl+Maiusc + ↓/↑ (Mac: Cmd+Maiusc + ↓/↑). Questo sposta tutte le note di quella voce
giù/su tra un rigo e l’altro. Esempio:

Nota: Nel caso si vogliano spostare solo alcune note in un accordo, è necessario assicurarsi che appartengano a
voci separate.

3. Per posizionare le code, un clic (doppio clic per le versioni precedenti la 3.4) sull’elemento per visualizzarne le
maniglie. Usare le frecce della tastiera oppure trascinare le maniglie per modificare l’angolo e l’altezza della coda:
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Vedere anche

Stanghette: Come estendere le stanghette di battuta tra righi multipli.
Code: Come modificare angolo e altezza.

Collegamenti esterni

Come estendere il gambo delle note tra due righi  (MuseScore Come fare)

Livello (sperimentale)

Questa caratteristica è ancora sperimentale e visibile solo se MuseScore viene avviato usando l'opzione '-e', vedi
Command line options

Per il progetto Open-Goldberg, era necessaria la capacità di creare diverse versioni della partitura. Una versione è
l'"Urtext", una partitura che è vicina alla versione originale di Bach. Una seconda versione potrebbe essere una variazione
di Czerny che, oltre all'Urtext, contiene le diteggiature.

La funzione dei livelli permette di creare diverse versioni da un file della partitura. Se vuoi aggiungere delle diteggiature,
devi creare un livello e contrassegnare gli elementi della diteggiatura con il nome del livello.

Per prima cosa, creare dei livelli:

Poi, creare una variante della partitura:
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Aggiungere il livello visibile alla variante della partitura poi selezionare tutte le diteggiature e contrassegnarle con il nome
della variante della partitura:

Livello predefinito:

Livello Czerny:
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Vedi anche

Command line options

MIDI import

MuseScore can import MIDI files (.mid/.midi/.kar) and convert them into music notation.

To import a MIDI file, use the standard Open command. This converts the MIDI file into a MuseScore file (.mscz)
and applies the default quantization settings.

The MIDI Import Panel appears at the bottom of the screen: you can expand this by dragging the interface with the
document window upwards. The panel shows all the tracks in the file (only those with note events are shown) and allows
you to adjust parameters affecting the conversion process. If there are multiple tracks, then one more track is added at
the top of the list to select all tracks at once.

To accept the default conversion: Simply press the "X" symbol on the top-left of the Import Panel to close it. The
panel can be re-opened at any time during the session by pressing "Show MIDI import panel" at the bottom of the
document window.

To reimport the file: Adjust the desired parameters in the Import Panel (see below) and press Apply. If you have
made changes to the Import Panel but wish to UNDO them, press Cancel. To close the Import Panel, press the "X"
symbol at the top-left of the panel.
If you reimport the file after making changes to the temporary generated result score, MuseScore will prompt you
what should happen with that modified score: Save it somewhere, Discard it or Cancel. The Save option will save the
modified score as a Musescore file in your \bin directory without modifying the original MIDI file. It will then reimport
the original MIDI file and apply the import panel settings. The import panel settings are NOT applied to the saved
file. The Discard option will UNDO your changes to the Musecore file, then reimport the original MIDI file and apply
the new settings. The Cancel option will reimport the original MIDI file in the first tab and apply any import panel
setting then create a new tab with your modified score but without applying any import panel settings. The second
tab is the same as hitting SAVE, then opening the saved file. Therefore, you cannot apply import panel settings to a
user modified score. You must first apply the import panel settings, make any changes to the score, then save the
score using the standard Save command.

Mouse wheel scrolling (MIDI Import Panel): Vertical scrolling is the default. For horizontal scrolling, press Shift or Ctrl
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while using the wheel.

Available operations

MuseScore instrument
Assign a MuseScore instrument (listed in instruments.xml or in specified custom xml file in Preferences) that defines
staff name, clef, transposition, articulations, etc.

Quantization

Quantize MIDI notes by some regular grid. The grid MAX resolution can be set via the drop-down menu:

Value from preferences (default) - quantization value is taken from the main Preferences dialog of MuseScore
(in the “Import” tab)
Quarter, Eighth, 16th, 32nd, 64th, 128th - user-defined values

However, the actual quantization grid size is adaptive and reduces when the note length is small, so for each note
the quantization value is different. But there is an upper limit for the quantization value, and that value can be set by
the user as "max. quantization".
For example, if some note is long - say, half note, and the max. quantization is set to 8th, then the note will be
quantized with the 8th-note grid, not the half- or quarter-note grid as it supposed to be by the algorithm.
Such quantization scheme allows to quantize all notes in the score (with different lengths!) adequately.

Max. voices
Sets maximum count of allowed musical voices.

Search tuplets
When enabled, this option attempts to detect tuplets and applies the corresponding quantization grid to the tuplet
chords.

Is human performance
If enabled, this option reduces the accuracy of MIDI-to-score conversion in favor of readability. It is useful for
unaligned MIDI files, when no regular quantization grid is provided. For such files the automatic beat tracking
algorithm is used which tries to detect the bar positions throughout the piece.

2x less measure count
The option is active for unaligned MIDI files (when "Is human performance" is checked by default). It halves measure
count obtained in the internal beat tracking operation. It may be convenient when the beat tracking gives 2x more
frequent bar subdivision than necessary.

Time signature
The option is active for unaligned MIDI files. The user can choose an appropriate time signature for the whole piece
if the default detected value is wrong. The option is useful because it handles imported tuplets correctly unlike the
direct time signature setting from the palette.

Split staff
This option is suited mainly for piano tracks - to assign notes to the left or right hand of the performer. It uses
constant pitch separation (the user may choose the pitch via sub-options) or floating pitch separation (depending on
the hand width - sort of a guess from the program point of view).
For drum tracks (“Percussion” sound in the track list) it splits the staff into multiple staves, each of which gets only
one drum pitch (i.e. drum sound). There is also a sub-option to allow/disallow the application of the square bracket
for the newly created set of drum tracks.

Clef changes
Small clefs can be inserted within a staff to keep chords closer to the 5 staff lines. Clef changes depend on the
average pitch of the chord. Tied groups of notes are not broken by the clef insertion (if it occurs, one can report a
bug for algorithm in importmidi_clef.cpp). This option is available for non-drum tracks only.

Simplify durations
Reduces number of rests to form more "simple" note durations. For drum tracks this option can remove rests and
lengthen notes as well.

Show staccato
Option to show/hide staccato markings in the score.

Dotted notes
Controls whether MuseScore will use dotted notes or ties.

Show tempo text
Shows/hides tempo text markings in the score.

Show chord names
Shows/hides chord names in the score, if any, for XF MIDI file format.

Recognize pickup measure
When enabled, this option doesn't change the time signature of the first bar that is shorter than the second bar. It is
also called anacrusis. This option is only available for all tracks at once.

Detect swing
MuseScore tries to detect swing, and automatically replace a pattern of 4th + 8th notes in triplets (for the most
common swing feel, 2:1), or a dotted 8th + 16th pattern (for shuffle, 3:1), with two straight 8ths and a “Swing” or
“Shuffle” text at the beginning.

Modalità inserimento note

MuseScore permette di scegliere tra diverse modalità di inserimento note. Un passo alla volta (vedere sotto) è la modalità
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predefinita, ma altre possono essere raggiunte cliccando la piccola freccia a discesa accanto al pulsante “Inserimento
note” nella barra degli strumenti inserimento note .

Un passo alla volta

Questo è il metodo predefinito di inserimento delle note e comporta l'inserimento delle note una alla volta: prima
selezionando una durata della nota con il mouse o la tastiera del computer, poi scegliendo un'altezza con il mouse, la
tastiera del computer, la tastiera MIDI o la tastiera virtuale pianoforte.

Per dettagli vedere Inserimento note: elementi basilari.

Modifica altezze

La modalità “Modifica altezze” permette di correggere le altezze di una sequenza di note lasciando le loro durate invariate
(da non confondere con Accidenti: Ridefinire le altezze).

1. Seleziona una nota come punto di partenza;
2. Selezionare l’opzione Modifica altezze dal menù a discesa di Inserire le note …; oppure usare la combinazione

tasti, Ctrl+Maiusc+I (Mac: Cmd+Maiusc+I).
3. Ora inserire le altezze usando la tastiera del computer, la tastiera MIDI o la tastiera virtuale pianoforte.

Potete anche usare la funzione “Modifica altezze” per creare un nuovo passaggio da uno già esistente caratterizzato dalla
stessa sequenza di durate - copiando e incollando quest'ultimo, poi applicando “Modifica altezze”.

Ritmo

La modalità “Ritmo” permette di inserire le durate con una singola pressione del tasto. Combinando le modalità “Ritmo” e
“Modifica altezze” si ottiene un metodo molto efficiente di inserimento delle note.

1. Selezionare il punto di partenza nello spartito ed entrare in modalità “Ritmo”.
2. Selezionare una durata dalla barra degli strumenti di inserimento delle note, o premere una scorciatoia di durata

(numeri 1-9) sulla tastiera del computer. Verrà aggiunta alla partitura una nota con la durata selezionata. In
contrasto con Inserimento note: elementi basilari, premendo il tasto . si alternerà la condizione di “nota puntata” e
“nota normale” per tutte le durate successive. Tutti i ritmi seguenti resteranno “puntati” fino a quando non sarà
nuovamente premuto il tasto .. A differenza di Inserimento note: elementi basilari, il punto deve essere premuto
prima di inserire il ritmo.

3. L'inserimento di pause è simile all'aggiunta di note puntate. Premere il tasto 0 per commutare in inserimento pause.
Tutti i ritmi inseriti saranno “pause” finchè il tasto 0 non sarà premuto nuovamente. Questa opzione può essere
usata contemporaneamente alle note puntate.

4. Continuare a premere i tasti di durata per inserire le note con le durate scelte.
5. Ora utilizzare la modalità Modifica altezze per impostare le altezze delle note appena aggiunte.

Tempo reale (automatico)

Le modalità “Tempo reale” fondamentalmente permettono di eseguire il pezzo su una tastiera MIDI (o sulla tastiera
virtuale pianoforte) e ottenere la notazione aggiunta. Tuttavia è necessario essere consapevoli delle seguenti limitazioni
che si applicano attualmente:

Non è possibile utilizzare la tastiera di un computer per l'inserimento in tempo reale
Non si possono inserire gruppi irregolari o note più brevi della durata selezionata
Non si possono inserire note in più di una voce alla volta

Tuttavia, queste restrizioni significano che MuseScore ha poche scelte quando analizza come dovrebbe essere annotato
l’inserimento, il che rende molto accurata la modalità di inserimento in tempo reale.

Nella versione automatica di inserimento con modalità “Tempo reale”, si suona a un tempo fisso indicato da un battito del
metronomo. Si può regolare il tempo cambiando il ritardo tra i battiti dal menù: Modifica → Preferenze... → Inserimento note
(Mac: MuseScore → Preferenze... → Inserimento note).
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1. Selezionare la posizione di partenza nello spartito ed entrare nella modalità “Tempo reale” (automatico).
2. Selezionare una durata dalla barra degli strumenti di inserimento delle note.
3. Tenere premuto un tasto MIDI o un tasto del piano virtuale (una nota verrà aggiunta alla partitura).
4. Ascoltare i battiti del metronomo. Ad ogni battito la nota cresce della durata selezionata.
5. Rilasciare il tasto quando la nota ha raggiunto la lunghezza (durata) desiderata.

La partitura smette di avanzare non appena si rilascia il tasto. Se si vuole che la partitura continui ad avanzare (ad
esempio per consentire l’inserimento di pause) si può usare la scorciatoia Avanzamento Tempo reale per avviare il
metronomo.

Tempo reale (manuale)

Nella versione manuale di inserimento in “Tempo reale”, il tempo di ingresso deve essere indicato toccando un tasto o un
pedale, ma si può suonare a qualsiasi velocità anche non costante. Il tasto predefinito per impostare il tempo (chiamato
"Avanzamento Tempo reale") è Enter sul tastierino numerico (Mac: Fn+Return), ma si raccomanda vivamente di cambiarlo
con un tasto o un pedale MIDI (vedere sotto).

1. Selezionare la posizione di partenza nello spartito ed entrare nella modalità “Tempo reale” (manuale).
2. Selezionare una durata dalla barra degli strumenti di inserimento delle note.
3. Tenere premuto un tasto MIDI o un tasto del piano virtuale (una nota verrà aggiunta alla partitura).
4. Premere il tasto “Avanzamento Tempo reale”. Ad ogni pressione la nota cresce della durata selezionata.
5. Rilasciare la nota quando ha raggiunto la lunghezza desiderata.

Scorciatoia Avanzamento Tempo reale

La scorciatoia “Avanzamento Tempo reale” è usata per scandire manualmente i battiti in modalità “Tempo reale –
(manuale)”, o per avviare i battiti del metronomo in modalità “Tempo reale – automatico”. È chiamata "Avanzamento
Tempo reale" perché fa sì che la posizione di inserimento si sposti in avanti – o “avanzi” – attraverso la partitura.

Il tasto predefinito per l’Avanzamento in Tempo reale è Enter sul tastierino numerico (Mac: Fn+Return), ma è fortemente
raccomandato di sostituirlo con un tasto o un pedale MIDI tramite il “Controllo remoto MIDI” di MuseScore. Detto controllo
è disponibile dal menù: Modifica → Preferenze... → Inserimento note (Mac: MuseScore → Preferenze... → Inserimento note).

In alternativa, se si dispone di un interruttore a pedale USB o un pedale per computer che può simulare i tasti della
tastiera, è possibile impostarli per simulare Enter sul tastierino numerico.

Quando le note sono inserite, vengono posizionate appena prima dell'elemento iniziale selezionato, che sarà evidenziato
con un marcatore quadrato blu. L'elemento iniziale e tutte le note o le pause successive all'interno della stessa battuta
saranno spostati in avanti. È possibile spostare avanti e indietro il punto di inserimento usando i tasti freccia → o ←, e il
nuovo punto di inserimento verrà evidenziato.

Inserire

La modalità Inserire (chiamata Timewise nelle versioni precedenti la 3.0.2) permette di inserire e cancellare note e pause
all’interno delle battute, spostando automaticamente avanti o indietro la musica successiva. La durata della battuta viene
automaticamente aggiornata mentre si procede.

1. Assicurarsi di essere in modalità inserimento note, e di aver selezionato l’elemento dal quale iniziare l’inserimento di
note e pause;

2. Cliccare sulla freccia accanto all’icona “Inserire le note …”, e selezionare Inserire (oppure, se “Inserire” è la corrente
scelta predefinita, premere semplicemente N);

3. Inserire una nota o una pausa come si farebbe in modalità Un passo alla volta. Ogni nota viene inserita prima della
posizione corrente del cursore;

4. Spostare il cursore avanti e indietro se necessario (usando i tasti freccia), per cambiare il punto di inserimento.

In alternativa, se vi è la necessità di inserire solo una o due note, è preferibile usare una scorciatoia:

Premere Ctrl+Maiusc (Mac: Cmd+Maiusc) mentre si aggiunge la nota con un clic del mouse-o con una scorciatoia da
tastiera (A-G).

Ogni qualvolta la durata totale delle note e delle pause all'interno della battuta non corrisponde all' indicazione metrica,
sopra la battuta stessa apparirà un piccolo segno + o -.

Vedere anche: Rimuovere un intervallo selezionato (Attrezzi).

Modalità normale
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Per uscire dalla modalità “Inserimento note”, cliccare sul pulsante dello strumento “Inserire le note …”, premere N, o Esc.
Questi passaggi portano in modalità Normale, nella quale è possibile cambiare le durate e cancellare note o pause come
segue:

Se si seleziona una nota e si preme Canc la nota sarà sostituita da una pausa della stessa durata.
Se si seleziona una nota o una pausa e si preme Ctrl+Canc la nota/pausa verrà cancellata, e le note successive
spostate indietro (vedere Rimuovere l’intervallo selezionato).
Se si riduce la durata di una nota o di una pausa, la durata rimanente sarà riempita di pause.
Se si aumenta la durata di una nota o di una pausa, essa sottrarrà la durata alle note/pause successive per
compensare la durata. Se questa operazione viene fatta sull'ultima nota/pausa della battuta, una nota o una pausa
con la durata richiesta sarà inserita all'inizio della battuta successiva, e le due saranno legate insieme.

Vedere anche

Inserimento note
Copia e incolla

Collegamenti esterni

Video: Semi-Realtime MIDI Demo Part 1: New note entry modes
Introduction to the new Repitch Mode  (YouTube)

Parti

Nota: ATTENZIONE. Questa sezione del manuale non è aggiornata alla versione 3.6 di MuseScore. In particolare – per
detta versione – i paragrafi relativi a Personalizzare le parti, Aggiungere strumenti a una parte, Rimuovere strumenti da
una parte, Selezionare i righi per uno strumento, Selezionare le voci per uno strumento possono essere applicati come
funzionalità solo in fase di creazione di nuova parte mentre non hanno valore per le modifiche, non più previste. Per
“modificare” una parte, crearla nuovamente con le caratteristiche aggiuntive e Cancellare la vecchia parte esistente.

MuseScore permette non solo di creare e stampare una partitura completa, ma anche di generare da essa le parti dei
singoli strumentisti.

Una parte può essere creata da un pentagramma specifico di uno strumento nella partitura principale o anche da una
voce all'interno di un rigo. Questo permette di visualizzare più parti (per esempio Flauto 1 e 2) su un unico rigo nella
partitura ma di estrarle come parti separate.

Riproduzione sonora della parte

Per la Parte che si sta visualizzando, durante la riproduzione sonora Musescore esegue un "assolo", cioè nessun’altra
Parte suona. Questo perché la casella-box “Riproduci solo la parte” del Mixer è selezionata di default.

Se si vogliono ascoltare tutte le tracce abilitate alla riproduzione sonora mentre si sta visualizzando una parte,
deselezionare semplicemente la casella-box “Riproduci solo la parte”. È inoltre possibile usare i pulsanti “Muto” e “Solo”
del Mixer per ottenere vari mix parziali di tutte le tracce disponibili. Questo può rivelarsi molto utile perché permette di
correggere, arrangiare e comporre all'interno di qualsiasi parte mentre si ascoltano le altre tracce per il contesto.

Creare tutte le parti

Il metodo più diretto è quello di creare tutte le parti in una volta sola. Le parti sono generate su una base uno-a-uno dagli
strumenti corrispondenti nella partitura:

1. Dal menù, selezionare File → Parti….
2. Cliccare Tutte le parti (MuseScore 3.2-3.3.4: Generate; versioni precedenti a MuseScore 3.2: New All) (le parti sono

nominate con il nome dello strumento, e un numero aggiunto per differenziare le parti che hanno la stessa etichetta
nella partitura principale).
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3. Cliccare OK.

Le parti sono ora accessibili cliccando sulle schede sopra la finestra del documento.

Creare parti specifiche

Questo metodo permette di generare parti specifiche solo per strumenti selezionati (anziché tutti insieme):

1. Nella finestra “Parti” cliccare su Singola parte (versioni MuseScore precedenti a 3.4 New) per creare una parte;
2. Nel pannello centrale, digitare il testo che si vuole usare per il "Titolo della parte" (questo serve anche per la parte

corrispondente del nome del file quando si esporta);
3. Dal pannello "Strumenti nella partitura" scegliere lo strumento (o gli strumenti) che si vogliono inserire nella parte in

creazione, e premere + per aggiungerlo/i al pannello "Strumenti nella parte".

Se si vogliono creare più parti, ripetere i passi da 1 a 3 (sopra) per ogni parte.

4. Cliccare OK per salvare le parti.

L’impostazione delle parti ora è terminata. Non vi è più necessità di farlo di nuovo, a meno che non si voglia aggiungere o
rimuovere uno strumento dalla partitura completa.

Personalizzare le parti

(vedere Nota iniziale)
Una volta generata una parte (o tutte le parti), si può selezionare qualsiasi parte in alto e usare i controlli in basso per
controllare non solo quale strumento è inserito nella parte, ma anche quali righi e voci all'interno dello strumento stesso
sono inclusi.
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Aggiungere strumenti a una parte

(vedere Nota iniziale)

Per aggiungere strumenti a una parte esistente:

1. Selezionare la parte nel pannello "Parti".
2. Selezionare lo strumento dal pannello "Strumenti nella partitura".
3. Premere + per aggiungerlo al pannello "Strumenti nella parte".

Rimuovere strumenti da una parte

(vedere Nota iniziale)

Per rimuovere strumenti da una parte esistente:

1. Selezionare la parte nel pannello "Parti".
2. Selezionare lo strumento dal pannello "Strumenti nella parte".
3. Premere - per rimuovere lo strumento.

Selezionare i righi per uno strumento

(vedere Nota iniziale)

Per selezionare i righi di uno strumento da includere nella parte:

1. Selezionare la parte nel pannello "Parti".
2. Cliccare sulla freccia accanto allo strumento in "Strumenti nella parte" per espandere l'elenco e mostrare tutti i righi

e le voci dello strumento.
3. Selezionare il rigo da rimuovere.
4. Premere - per rimuoverlo dallo strumento.

Selezionare le voci per uno strumento

(vedere Nota iniziale)

1. Selezionare la parte nel pannello "Parti".
2. Cliccare sulla freccia accanto allo strumento in "Strumenti nella parte" per espandere l'elenco e mostrare tutti i righi
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e le voci dello strumento.
3. Deselezionare le voci da rimuovere.

Nota: Se si seleziona solo la voce 1 per un dato rigo, solo il contenuto della voce 1 per quel rigo sarà incluso nella parte.
Quindi, per condividere il flauto 1 e 2 sullo stesso rigo, si dovranno inserire tutte le note su entrambe le voci, anche nei
passaggi in cui condividono il contenuto. Inoltre non si possono inserire le due parti come accordi nei passaggi in cui
condividono il ritmo.

Cancellare una parte

1. Aprire la finestra-dialogo “Parti” (File → Parti…);
2. Selezionate la parte pertinente nel pannello "Parti";
3. Premere Canc.

Esportare parti

Per essere in grado di esportare parti, queste devono essere state create prima, vedere sopra.

1. Dal menù, selezionare File → Esporta… Parti…;
2. Scegliere le parti nell’elenco a spunta e il formato del file (e relative opzioni) con cui dette parti si vogliono esportare

(PDF è il predefinito);
3. Per il nome del file inserire qualsiasi prefisso sia utile per tutte le parti, o lasciare il default (il nome del file della tua

partitura);
4. Cliccare OK.

Questo genererà file con i nomi "<titolo>" + "-" + "<nome parte>.<estensione>". In aggiunta, quando si esporta in PDF,
questo genererà anche "<titolo>" + "-Partitura_E_Parti.pdf".

Salvare parti

Le parti e la partitura sono "collegate", il che significa che qualsiasi cambiamento al contenuto di una influenzerà l'altra (ad
eccezione dei cambiamenti al layout). Quando si creano parti, queste vengono salvate insieme alla partitura (se si apre la
partitura si troveranno delle schede per la partitura e per ogni parte creata).

Tuttavia, se si vuol salvare una parte individualmente:

1. Assicurarsi che la parte sia "attiva". Selezionarla se non lo è;
2. Dal menù, selezionare File → Salva Come….

Stampare una parte

1. Assicurarsi che la parte sia "attiva". Se non lo è, selezionare la sua scheda;
2. Dal menù, selezionare File → Stampa… per aprire la finestra-dialogo di stampa.

Plugin

Cosa sono i Plugin?

I plugin sono piccoli pezzi di software ognuno dei quali aggiunge una particolare caratteristica a MuseScore. Abilitando un
plugin, una nuova opzione di menu viene aggiunta al menu Plugin: successivamente, quando questa opzione viene
selezionata, il plugin esegue un particolare compito nella partitura.

Alcuni plugin sono pre-installati con MuseScore – vedere Plugin installati di default (sotto). Si possono trovare molti altri
plugin nell’archivio plugin : alcuni funzionano con MuseScore 3, altri solo con le vecchie versioni di MuseScore, e altri
ancora con tutte le versioni. Per distinguere gli uni dagli altri: i file di codice dei plugin di MuseScore 3.x e 2.x hanno
estensione .qml; per le versioni più vecchie l’estensione è .js.

Attenzione. I plugin possono potenzialmente contenere codice dannoso o nocivo, che può compromettere o danneggiare
le partiture o il sistema. I plugin sono interamente non controllati (tranne quelli installed by default). È quindi necessario
fidarsi dell'autore oppure controllare personalmente il codice.

Installazione

Nota: Alcuni plugin per funzionare possono richiedere l'installazione di altri componenti (font, per esempio). Controllare la
documentazione del plugin per maggiori informazioni.

La maggior parte dei plugin sono forniti come archivi ZIP: scaricare il file .zip del plugin e decomprimetelo (unzip) in una
delle directory menzionate sotto (a seconda del proprio sistema operativo). Se il plugin è fornito direttamente come file
.qml non compresso, scaricarlo semplicemente e metterlo in una delle stesse directory.

Una volta che un plugin è installato, per poterlo utilizzare deve essere abilitato in Gestione plugin - vedere
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Abilitare/disabilitare i Plugin.

Windows

Su Windows, i nuovi plugin dovrebbero essere installati in %HOMEPATH%\Documents\MuseScore3\Plugins. In alternativa,
specificare una cartella diversa nel file Preferenze.

I Plugin installati di default si trovano in %ProgramFiles%\MuseScore 3\Plugins (o %ProgramFiles(x86)%\MuseScore 3\Plugins per la
versione a 32-bit) e in %LOCALAPPDATA%\MuseScore\MuseScore 3\plugins su Windows 7 e successivi. Queste cartelle non
dovrebbero essere modificate.

macOS

Su macOS, i nuovi plugin dovrebbero essere installati in ~/Documents/MuseScore3/Plugins. In alternativa, specificare una
cartella diversa nelle Preferenze di MuseScore.

I Plugin installati di default si trovano nel pacchetto MuseScore in /Applications/MuseScore 3.app/Contents/Resources/plugins (per
trovare i file nel pacchetto dell’applicazione, cliccare con il tasto destro del mouse su Preferenze in MuseScore 3.app e
scegliere "Show package contents"), e in ~/Library/Application Support/MuseScore/MuseScore 3/plugins. Queste cartelle non
dovrebbero essere modificate.

Linux

Su Linux, i nuovi plugin dovrebbero essere installati in ~/Documents/MuseScore3/Plugins. In alternativa, specificare una cartella
diversa nelle Preferenze di MuseScore.

I Plugin installati di default si trovano in /usr/share/mscore-3.x/plugins e in ~/.local/share/data/MuseScore/MuseScore3/plugins. Queste
cartelle non dovrebbero essere modificate.

I nomi delle directory potrebbero essere leggermente diversi, a seconda della lingua del proprio sistema operativo.

Abilitare/disabilitare i Plugin

Per poter accedere ai plugin installati dal menu Plugins, devono essere abilitati in Gestione Plugin:

Lo si fa semplicemente spuntando la casella appropriata. Questo aggiunge il nome del plugin alla lista nel file Menù
Plugin.

Creare/modificare/eseguire i plugin

È possibile creare nuovi plugin, modificarne di esistenti ed eseguirli tramite il Creatore plugin:
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La documentazione di tutti gli elementi disponibili può essere trovata anche qui.

Plugin installati di default

Alcuni plugin sono preinstallati con MuseScore, ma non sono abilitati di default. Vedere Abilitare/disabilitare i Plugin
(sopra) per abilitare i plugin.

(N.d.R.: alcuni dei plugin demo sono stati creati con precedenti versioni di MuseScore e non sono ancora stati aggiornati,
ragione per cui potrebbero non funzionare con la versione 3.6)

ABC Import

Questo plugin importa testo ABC  da un file o dagli appunti e lo converte in MusicXML. È richiesta la connessione a
Internet perché il plugin utilizza un servizio web esterno  per la conversione.

Notes → Color Notes

Questo plugin dimostrativo colora le note nella gamma selezionata (o nell'intera partitura), a seconda della loro altezza.
Colora la testa di tutte le note in tutti i pentagrammi e voci secondo la convenzione di Boomwhackers. Ogni tonalità ha un
colore diverso. C e C♯ hanno un colore diverso. C♯ e D♭ hanno lo stesso colore.
Per colorare tutte le note di nero, basta eseguire nuovamente il plugin (sulla stessa selezione). Si potrebbe altresì usare il
plugin 'Remove Notes Color' plugin .

Create Score

Questo plugin demo crea una nuova partitura. Crea una nuova partitura per pianoforte con note da 4 quarti: C, D, E, F. È
un buon inizio per imparare a realizzare una nuova partitura e aggiungere note da un plugin.

helloQml

Questo plugin dimostrativo illustra alcuni compiti di base.

Notes → Note Names

Questo plugin attribuisce il nome alle note in un intervallo selezionato o per l'intera partitura. Mostra i nomi delle note
(come testo di rigo) secondo le impostazioni linguaggio di MuseScore: voci 1 e 3 note sopra il rigo; voci 2 e 4 note sotto il
rigo; e note dell'accordo in un elenco separato da virgole, a partire dalla nota più alta.

Panel
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Questo plugin demo crea un pannello GUI.

random/random2

Creano una partitura random.

run

Questo plugin demo esegue un comando esterno. Probabilmente funzionerà solo su Linux.

scorelist

Questo plugin di test itera attraverso l'elenco delle partiture.

ScoreView

Plugin dimostrativo per dimostrare l'uso di una ScoreView

Walk

Questo plugin di test percorre tutti gli elementi in una partitura

Vedere anche

Attrezzi

Collegamenti esterni

Plugins for 3.x

Preferenze

È possibile personalizzare molti dei comportamenti predefiniti di MuseScore tramite il menù: Modifica→Preferenze... (Mac:
MuseScore→Preferenze...).

La finestra di dialogo delle preferenze ha più schede:

Ripristina tutte le preferenze al valore predefinito  ripristinerà tutte le preferenze a quelle che MuseScore aveva quando è stato
installato.
Ok salverà le impostazioni e chiuderà la finestra di dialogo.
Annulla chiuderà la finestra di dialogo senza applicare le modifiche.
Applica renderà effettive le modifiche senza chiudere la finestra di dialogo.

Generale
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Qui è possibile definire:

Avvio Programma: Specifica se iniziare la sessione vuota o visualizzando una partitura. Le opzioni sono una delle
seguenti: Avvia vuoto (nessuna partitura) / Continua l’ultima sessione / Avvia con una nuova partitura (cioè si apre
automaticamente la procedura guidata per nuova partitura) / Avvia con la partitura (quello predefinito del programma
o uno a scelta).
È anche possibile scegliere quali pannelli visualizzare. Può essere qualsiasi combinazione di: Schermata di
caricamento, Pannello controlli riproduzione, Navigatore, o Finestra di avvio. Selezionare anche se le Visite guidate
dovranno essere attive.
Cartelle: Specificare le cartelle predefinite per i file delle partiture, files di stile, modelli di partiture personalizzate,
plugins, Librerie di Suoni addizionali, immagini, e estensioni.
Lingua: Scegliere la lingua usata dal programma. Le traduzioni possono essere aggiornate anche da qui. Si noti che
gli aggiornamenti della traduzione delle lingue possono essere fatti anche tramite il menu: Aiuto→Gestione Risorse.
Telemetria: Spuntare/deselezionare per autorizzare o no MuseScore a raccogliere i dati di utilizzo. Il tipo di dati
raccolti è elencato, e aggiornato come necessario, in telemetria .
Aspetto: Si possono specificare un tema scuro o chiaro e la larghezza e l'altezza delle icone; impostare il tipo di
carattere e relative dimensioni ("Aspetto carattere" e "Dimensione carattere").
Salvataggio Automatico: Con quale frequenza il programma salva automaticamente.
Controllo remoto OSC

Area di visualizzazione
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Usare “Area di visualizzazione” per impostare le proprie preferenze di colori e sfondi per le rappresentazioni a schermo
della partitura e della carta. Lo "Sfondo" di default è blu scuro (RGB 20, 36, 51; Alpha 255) e la "Carta" di default è bianca.

Sfondo: Serve per impostare il colore o lo sfondo intorno alle pagine dello spartito. Selezionare il "Colore" quindi
cliccare sulla barra a destra e fare una scelta dal selezionatore di colori; oppure selezionare "Carta," cliccare
sull'icona del file e impostare un'immagine di sfondo.
Carta: Imposta il colore o lo sfondo delle pagine dello spartito. Controlli identici a quelli di "Sfondo" (sopra). È inoltre
possibile spuntare/deselezionare "Usa lo stesso colore nelle tavolozze".
Zoom: Definisce il livello di zoom predefinito e la precisione dello zoom da tastiera/mouse.
Scorri le pagine: Definisce il modo in cui le pagine sono disposte nella partitura. Scegliere "Orizzontalmente" per
una disposizione a righe, o "Verticalmente" per una disposizione a colonne. Per limitare lo scorrimento, spuntare
"Limita l’area di scorrimento ai bordi della pagina".
Miscellanea: "Usa funzione Anti-Aliasing" (opzione preimpostata) rende le linee diagonali e i bordi delle forme più
lisci. "Distanza tra elementi selezionati" controlla la distanza che il mouse può avere da un oggetto e ancora agire su
di esso. Numeri più piccoli richiedono più precisione, rendendo più difficile cliccare su oggetti piccoli. Numeri più
grandi sono meno precisi e rendono più difficile non cliccare involontariamente sugli oggetti vicini. Scegliere un
valore di lavoro comodo.

Inserimento note

In questa scheda ci sono le preferenze per inserimento note e controllo remoto MIDI. Qui si può impostare quanto segue:
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Inserimento note

Abilita ingresso MIDI: Lasciare il segno di spunta per permettere l'ingresso di note MIDI.
Colora le note fuori estensione: Per dettagli, vedere Colorazione delle note fuori estensione e Estensione note
utilizzabile (Proprietà del rigo: tutti i righi).
Ritardo automatico tra le note in modalità tempo reale: Vedere Tempo reale (automatico).
Riproduci le note durante la modifica: Quando è spuntato, MuseScore suona la nota quando viene inserita o
selezionata. Spuntare "Suona l’intero accordo durante la modifica", se si vogliono sentire tutte le note di un accordo
quando viene aggiunto. È anche possibile modificare la "Durata predefinita".

Controllo remoto MIDI

Il Controllo remoto MIDI permette di usare alcuni tasti della tastiera MIDI per inserire note e pause e per selezionare la
durata delle note, senza coinvolgere il mouse o la tastiera del computer. L'impostazione predefinita è off.

Per assegnare un comando a un tasto MIDI:

1. Assicurarsi che la casella "Controllo remoto MIDI " sia spuntata (la tastiera MIDI deve essere collegata prima di
aprire il programma).

2. Cliccare il pulsante rosso accanto all'opzione a cui si vuol assegnare un tasto MIDI: il pulsante rosso ora si accende.
3. Premere un tasto della tastiera MIDI. Il tasto rosso si spegne e al suo posto si accende il tasto verde. Il tasto MIDI è

stato ora assegnato all'opzione desiderata.
4. Ripetere i passaggi "2" e "3" per assegnare altri tasti.

Una volta definite le impostazioni dei tasti, si può usare la tastiera MIDI per controllare le operazioni di inserimento delle
note. Una volta definite le impostazioni dei tasti è possibile usare la tastiera MIDI per controllare le operazioni di input
delle note. Si possono verificare le impostazioni dei tasti osservando la Barra degli strumenti inserimento note di
MuseScore mentre si premono i tasti MIDI.

Per disattivare temporaneamente il Controllo Remoto Midi: deselezionare la relativa casella di spunta: tutti i pulsanti di
azione dei tasti di ingresso MIDI appariranno ora in grigio. Nota: Le assegnazioni di tasti personalizzate sono sempre
salvate tra le sessioni di MuseScore e non sono influenzate dalla disattivazione.

Note: (1) L'opzione "Pulisci" spegne tutti i pulsanti verdi per la sessione corrente di MuseScore; tutte le impostazioni dei
tasti MIDI registrate dall'utente vengono comunque mantenute e saranno ricaricate nella sessione successiva. (2)
Un'impostazione di tasto MIDI attivata non può essere successivamente disattivata, e il pulsante verde rimarrà sempre
acceso: tuttavia può essere sovrascritta con un tasto MIDI diverso usando nuovamente il pulsante rosso. (3) Se lo stesso
tasto MIDI è accidentalmente assegnato a più di un'opzione, allora tutti i tasti verdi associati rimangono accesi anche se
solo uno funzionerà. Per rimediare, vedere "(2)".

Partitura

La scheda Preferenze partitura include:

File predefiniti
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Elenco strumenti 1: File elenco strumenti predefinito uno
Elenco strumenti 2: File elenco strumenti predefinito due
Ordine dell’elenco delle partiture 1: File ordinamento predefinito della partitura uno (usato per l'ordinamento degli
strumenti)
Ordine dell’elenco delle partiture 2: File ordinamento predefinito della partitura due
Stile: Stile predefinito per la partitura
Stile per le parti: Stile predefinito per le parti

Vedere anche Carica/Salva Stile

Vista

Mostra i controlli MIDI nel mixer: Abilitare questa opzione per mostrare i controlli MIDI di default nel mixer.

I/O e suoni

PortAudio (API / Dispositivo)

Questo permette di impostare l'interfaccia audio (API) e specificare il dispositivo da utilizzare per la riproduzione audio: ad
esempio, altoparlanti/cuffie integrati, cuffie USB, wireless, ecc.

Ingresso / Uscita / Latenza MIDI

Quando un dispositivo esterno di ingresso MIDI è collegato, il suo identificatore appare in Ingresso MIDI. Quando il
dispositivo è collegato per la prima volta, è necessario selezionare la corretta opzione Uscita MIDI per abilitare l'ingresso
delle note e la corretta riproduzione audio (ad esempio, in Windows, questo potrebbe essere "MMS<device name>"): poi
chiudere e riaprire il programma per confermare le modifiche.

Usa Jack Audio Server

Spuntate queste opzioni come richiesto se usate il kit di connessione audio JACK. Spuntare queste opzioni come
richiesto se si usa il Kit di Connessione Audio JACK .

Motore Audio

In caso di comunicazione persa tra il dispositivo audio o la tastiera MIDI e MuseScore (nessuna uscita sonora o azione
MIDI), cliccare su Riavvia i dispositivi Audio e MIDI  per ripristinarli.

Importazione
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Queste impostazioni determinano come vengono importati i file provenienti da altre origini:

Stile utilizzato per l’importazione: Usa lo stile costruito in MuseScore o uno stile di propria scelta (vedere
Carica/Salva stile)
Music XML: Imposte le opzioni di importazione di MusicXML
Set di caratteri utilizzato nell’importazione di file binari: Set di caratteri usato per file binari (Set di caratteri
Guitar Pro e Overture)
MIDI: Definisce la nota più breve quando si importano i file MIDI
Quando si aprono le partiture dalle vecchie versioni di MuserScore: Quando è abilitato, all’apertura di una
partitura creata con una versione precedente alla 3.6 verrà chiesto se si vogliono applicare le nuove impostazioni di
notazione e stile di default.

Esporta

Queste impostazioni determinano come i vari file vengono esportati da MuseScore:

PNG: Risoluzione dell'immagine PNG/SVG (in DPI) e se usare lo sfondo trasparente.
MIDI: Se espandere le ripetizioni nei file MIDI esportati.
PDF: Risoluzione PDF (in DPI).
Audio: Imposta la frequenza di campionamento audio, il Bitrate MP3 e se "normalizzare" l'audio esportato.
MusicXML: Se esportare il layout e come esportare le interruzioni di accollatura e di pagina in MusicXML.
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Scorciatoie da tastiera

Questa scheda elenca tutti i comandi in MuseScore e tutte le scorciatoie da tastiera (per brevità “scorciatoie”) associate
ad essi. Le scorciatoie elencate nelle preferenze appaiono anche accanto ai loro comandi associati nei menù.

Per cercare un comando particolare: Inserire il suo nome nella casella "Cerca" nella parte inferiore della finestra.

Per creare una nuova scorciatoia per un comando:

1. Seleziona una voce esistente nell'elenco.
2. Cliccare Imposta; o semplicemente fare doppio clic sulla voce.
3. Inserire la nuova scorciatoia utilizzando fino a quattro tasti. Premere Pulisci se si deve reinserire la scorciatoia.
4. Premere Sostituisci per cambiare la scorciatoia esistente; oppure Aggiungi, per mantenere la vecchia scorciatoia e

aggiungere quella nuova.
Nota: Alcune scorciatoie, comprese quelle predefinite, potrebbero non funzionare con alcune tastiere.

Per riportare una scorciatoia alle sue impostazioni predefinite di sistema: Selezionare un comando nell’elenco
e premere Ripristina scorciatoie predefinite.

Per salvare l’elenco delle scorciatoie: Premere Salva e salvare con un nome di file a propria scelta.

Per caricare un elenco di scorciatoie salvato: Premere Carica ecc.

Per cancellare tutte le scorciatoie per una voce: Selezionare la voce e premere Pulisci.

Per stampare l'elenco delle scorciatoie (incl. esportazione in pdf): Premere Stampa ecc.

Aggiorna
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Stabilisce se MuseScore controllerà gli aggiornamenti e le estensioni all'avvio.

Gli aggiornamenti possono essere controllati manualmente in Aiuto→Controlla aggiornamenti.

Avanzata

Permette di controllare le impostazioni specifiche per "applicazione, "esportazione", "i/o" e "interfaccia utente", così come
le impostazioni del colore.

Vedere anche

Scorciatoie da tastiera
Lingue,traduzioni ed estensioni
Controllo aggiornamenti

Posizionamento automatico

La funzione di posizionamento automatico (AP) di MuseScore assicura che, nella maggior parte dei casi, gli elementi
siano correttamente distanziati e non collidano o si sovrappongono tra loro.
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Nota: quando si crea un elemento, AP è automaticamente abilitato, ma può essere disattivato se necessario (vedere
Disabilita posizionamento automatico).

Posizione predefinita

Un elemento appena creato, come testo di rigo o diteggiatura, assume una posizione predefinita sul rigo specificata dalle
proprietà "di posizione" contenute nel menù Stile. Queste proprietà "di posizione" possono includere caratteristiche come:

Posizione: Se l'elemento appare sopra o sotto il rigo.
Offset: Per gli elementi senza proprietà "Posizione sopra/sotto", questo specifica la posizione predefinita. Vedere
Offset X/Y.
Distanza minima: Distanza minima da altri elementi quando il posizionamento automatico è abilitato.

Per i dettagli sulle impostazioni disponibili per ogni tipo di elemento, vedere Impaginazione e formattazione: Stile.

Cambiare il posizionamento predefinito di un elemento

Usare uno dei seguenti metodi:

Dal menù, selezionare Formato→Stile; scegliere un tipo di elemento e poi regolare le impostazioni di
posizionamento/posizione.
Selezionare un elemento attinente nella partitura e cambiare le impostazioni di posizionamento/posizione nell'
Ispettore; premere poi il pulsante Imposta come stile" (S) per aggiornare le impostazioni di Stile.

Regolazioni manuali

Regolare la posizione dell'elemento

Usare uno dei seguenti metodi:

Selezionare l’elemento e regolare gli spiazzamenti X e Y nell’Ispettore (vedere spiazzamenti X e Y).
Spostare l'elemento usando i tasti freccia. Passare prima alla modalità modifica, se necessario.
Trascinare e rilasciare l'elemento usando il mouse. Usare questo metodo in preferenza al precedente, se si
vuole spostare un elemento attraverso un altro (per esempio, diteggiatura attraverso una legatura). Una volta
posizionato dall'altra parte si possono usare gli spiazzamenti X/Y nell'Ispettore, o i tasti freccia della tastiera per
mettere precisamente a punto la posizione.

Posizionare l'elemento sopra/sotto il rigo

Gli elementi con proprietà di "Posizionamento" disponibile nell' Ispettore possono essere facilmente spostati da sopra a
sotto il rigo, e viceversa:

1. Selezionare uno o più elementi.
2. Usare uno dei seguenti metodi:

Cambiare l'impostazione "Posizionamento" nell'Ispettore.
Premere X per passare da sopra a sotto.

Note: Quando, per un elemento, è abilitato il posizionamento automatico, non è possibile riposizionarlo in modo da
causare collisioni con altri elementi.

Disabilitare posizionamento automatico

Selezionare l’elemento e deselezionare la casella "Posizionamento automatico" nell' Ispettore.

L'elemento ritorna alla sua posizione predefinita. Può essere riposizionato a piacere e non viene più “evitato” quando si
posizionano altri elementi (ovvero sono possibili eventuali collisioni).

Ordine di impilatura

Per cambiare il valore di Ordine di impilatura:

Selezionare l’elemento e modificare il valore "Ordine di impilatura" nell’ Ispettore.

Nei casi in cui gli elementi possono sovrapporsi, Ordine di impilatura controlla l'ordine in cui vengono messi uno sopra
l'altro. L'elemento con il valore più basso sarà posto dietro.

Proprietà Rigo / Parte

La finestra Proprietà Rigo/Parte vi permette di fare cambiamenti su come si presenta un Rigo, regolarne intonazione e
trasposizione, cambiare lo strumento ecc. Per aprirla:
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Click-destro su una parte vuota del rigo, o sul nome dello strumento, e selezionare Proprietà Rigo/Parte....

Finestra Proprietà Rigo/Parte, come da versione 3.6.

Tipi di rigo

Ai fini pratici, vi sono quattro diversi tipi di rigo:

1a. Rigo Standard I. Un rigo con altezze dei suoni utilizzato per la maggioranza degli strumenti eccettuati quelli tastati a
corde pizzicate.
1b. Rigo Standard II. Un rigo con altezze dei suoni per uno strumento a corde pizzicate tastato con possibilità di
impostare numero di corde e accordatura dello strumento.
2. Rigo di Intavolatura. Un rigo con altezze dei suoni per uno strumento a corde pizzicate tastato che presenta la musica
come una serie di cifre di tasto sulle corde. Con possibilità di impostare numero di corde e accordatura dello strumento.
3. Rigo per le Percussioni. Un rigo con altezze dei suoni per strumenti a percussione.

È possibile cambiare un tipo di rigo in un altro utilizzando la finestra Strumenti, purché in questa venga caricato lo
strumento giusto. Ad esempio, per cambiare un rigo standard in uno di intavolatura questa dovrà contenere uno
strumento a pizzico. Analogamente, per cambiare un rigo standard in uno per le percussioni su questa dovrà venir
caricato un appropriato strumento a percussione e così via.

Gran parte delle opzioni della finestra Proprietà Rigo / Parte sono comuni a tutti i righi, ma ciascun tipo ha una o due
esclusive specifiche opzioni.

Proprietà Rigo / Parte: tutti i righi

Le seguenti Proprietà del rigo sono comuni a tutti i righi:

Linee
Il numero di linee che costituiscono il rigo.

Distanza Linee
La distanza fra due linee del rigo misutara in spazi (abbr.: sp.). Nota: Non è consigliabile cambiare questo valore da quello
predefinito mostrato. Se ci fosse bisogno di un rigo più grande o più piccolo utilizzare invece la finestra Impostazioni
pagina.

Distanza extra sopra il rigo
Aumenta e diminuisce la distaza fra il rigo selezionato e quello superiore in tutte le accolalture. Nota: Questa
impostazione non ha effetto sul rigo superiore di un'accollatura, che è controllato dalla minima/massima distanza fra le
accollature (vedi Impaginazione e formattazione: Formato → Stile … → Pagina).
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Nota: per alterare il distanziamento superiore di un solo rigo in una particolare accollatura, vedi interruzioni e Distanziatori.

Ridimensiona
Cambia in percentuale la dimensione del rigo selezionato e di tutti gli elementi associati (per regolare la dimensione
globale della partitura utilizzare Ridimensionamento dal menu Formato→Impostazioni pagina… ).

Nascondi quando è vuoto
In base all'impostazione di "Nascondere i righi vuoti all'interno dei sistemi" in Formato → Stile ... → Partitura, determina se
un rigo vuoto verrà nascosto.

Valori possibili:

Automatico (predefinito): Il rigo verrà nascosto quando vuoto, e sia impostato "Nascondere i righi vuoti".
Sempre: Il rigo verrà nascosto quando vuoto, anche se non sia impostato "Nascondere i righi vuoti".
Mai: Il rigo vuoto non verrà nascosto.
Strumento: Per gli strumenti scritti su più righi, Il rigo verrà nascosto solamente se tutti i righi di quello strumento
sono vuoti.

Mostra chiave
Controlla se sul rigo verrà mostrata la chiave.

Mostra indicazione metrica
Controlla se sul rigo verrà mostrata o meno la/le indicazione metrica/e .

Mostra Stanghette
Controlla se sul rigo verranno mostrate le stanghette.

Nascondi la stanghetta di accollatura
Show/hide barline at left-hand edge of the staff.

Non nascondere se l'accollatura è vuota
Non nasconde mai, perfino se tutta l'accollatura è vuota. Questa è prioritaria su qualsiasi impostazione di "Nascondere i
righi vuoti" in Formato → Stile ... → Partitura.

Rigo piccolo
Crea un rigo di proporzioni ridotte. Si può impostare il fattore di scala predefinito in Formato → Stile ... → Dimensioni.

Linee invisibili
Rende invisibili le linee del rigo.

Colore linee rigo
Utilizzare il selettore di colore per cambiare il colore delle linee del rigo.

Rigo parziale
Utilizzato per creare un Rigo parziale in cui compaiono solo le misure contenenti note (p.es. ossia  (Wikipedia); o
partiture a righi parziali). Può essere utilizzato indipendentemente da "Nascondi quando è vuoto" o "Nascondi righi vuoti
all'interno dei sistemi".

Strumento
Lo Strumento caricato nella finestra Strumento (I) o Cambia strumento. Il suono associato a questo Strumento, volendo,
può essere cambiato nel Mixer.

Nota: Le proprietà sotto (p.es. Nome parte, Nome strumento esteso etc.) sono impostate ai valori predefiniti fissati nel file
di MuseScore instruments.xml .

Nome parte
Il nome della parte. Questo è inoltre mostrato nel Mixer e nella finestra Strumenti dialog (I). Ogni modifica effettuata sul
Nome parte ha effetto unicamente su quello specifico strumento.

Nota: Il Nome parte è definito dal valore dell'elemento trackName nel file instruments.xml . Se trackName non è stato
definito, verrà utilizzato al suo posto il valore di longName (cioè il "Nome strumento esteso"—vedi sotto).

Nome strumento esteso
Nome mostrato alla sinistra del rigo nella prima accollatura della partitura. Il Nome strumento esteso può essere inoltre
modificato direttamente come un oggetto di testo (vedi Modifica del testo).

Nome strumento abbreviato
Nome mostrato alla sinistra del rigo nelle successive accollature della partitura. Il Nome strumento abbreviato può essere
inoltre modificato direttamente come un oggetto di testo (vedi Modifica del testo). La modifica ha effetto su tutte le
ricorrenze nella partitura.

Estensione note utilizzabile

Amatoriale: Note al di fuori da questo intervallo verranno colorate in verde oliva/giallo scuro nella partitura.
Professionale: Note al di fuori da questo intervallo verranno colorate in rosso nella partitura.
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Per disabilitare la colorazione delle note fuori estensione: Da menu, scegliere Modifica→Preferenze... (Mac:
MuseScore→Preferenze...), click sulla scheda "Inserimento note", e togliere la spunta a "Colora le note fuori estensione".

Vedi anche, Colorazione delle note fuori estensione.

Trasposizione
Questa opzione assicura che i righi degli strumenti traspositori mostraranno la musica scritta con la corretta trasposizione.
Impostare la trasposizione in termini di intervallo musicale ascendente o discendente (più le ottave, se necessarie).

Usa la dinamica di una singola nota (a partire dalla versione 3.1)
Lasciare spuntato per consentire la riproduzione delle Dinamiche sulla nota quali sfz etc.) e forchette di diminuendo e
crescendo sulle note singole (o legate).

frecce di navigazione
Utilizzare i bottoni ↑ and ↓ , in basso a sinistra nella finestra Proprietà rigo, per spostarsi al rigo precedente o successivo.

Proprietà Rigo / Parte: solo corde pizzicate

I righi degli strumenti a pizzico tastati hanno alcune opzioni extra oltre a quelle elencate sopra,

Numero di corde
Mostra il numero di corde dello strumento.

Modifica dati corda…
Questo pulsante apre una finestra di dialogo che consente di fissare numero e intonazione delle corde. Si veda Cambiare
l'accordatura.

Stile, proprietà avanzate…

Facendo click su Stile, proprietà avanzate… si aprirà una finestra che consente l'accesso alle opzioni avanzate di
visualizzazione per quel rigo. Queste varieranno in relazione al Tipo di rigo scelto: si vedano le rispettive sezioni sotto per
i dettagli.

Modelli

In basso nella finestra di dialogo Stile, proprietà avanzate ci sono un certo nemero di bottoni che consentono
agevolmente di cambiare i seguenti:

Il numero di linee in un rigo per le percussioni.
Il tipo di rigo per uno stumento a corde pizzicate. Ad esempio, si potrà cambiare da rigo standard ad intavolatura e
viceversa, o scegliere fra un certo numero di possibili intavolature.

1. Fare una scelta dalla lista a discesa etichettata "Modelli";
2. Premere < Ripristino a Modello;
3. Premere OK per confermare le modifiche ed uscire dalla finestra (o Annulla per annullare l'operazione).

Opzioni per Rigo Standard e Rigo per le Percussioni

Mostra chiave / indicazione metrica / stanghette / armatura di chiave / tagli addizionali
Possibilità di impostare la visualizzazione ON opp. OFF.

Senza gambo
Se spuntata, le note del rigo non avranno gambi, codette o travature.

Schema della testa delle note
Vedi Schemi teste di nota.

Opzione per Rigo d'intavolatura

Capovolgi
Se non spuntata, la linea superiore dell'intavolatura si riferirà alla corda più acuta e quella inferiore alla più bassa (la scelta
più frequnte). Se spuntata, la linea superiore dell'intavolatura si riferirà alla corda più bassa e quella inferiore alla più acuta
(p.es. intavolatura italiana per Liuto). per esempio:

Intavolatura 'Capovolta'.
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Opzione per Rigo d'intavolatura: cifre di tasto

Cifre di tasto sono numeri o lettere utilizzati per indicare la posizione delle note sulla tastiera. Il seguente gruppo di
opzioni definisce l'aspetto delle cifre di tasto:

Carattere
Il carattere utilizzato per disegnare la cifra. Vengono forniti 8 tipi di carattere che supportano tutti i simboli nei differenti stili
(Moderno con grazie, Moderno senza grazie, Rinascimentale, Phalèse, Bonneuil-de Visée, Bonneuil-Gaultier, Dowland,
Apprendimento Liuto).

Dimensione
Dimensione del carattere in punti tipografici. I tipi di carattere incorporati solitamente offrono buoni risultati se di corpo 9 o
10pt.

Offset Verticale
MuseScore prova a porre i simboli in modo leggibile e di norma (post a 0) per i font incorporati. Se il font avesse i simboli
non allineati alla linea di base (o in qualsiasi altro modo che MuseScore non si dovesse aspettare), questa proprietà
consentirà di spostare le cifre di tasto verso l'alto (offset negativo) o verso il basso (offset positivo) per un miglio
posizionamento verticale. i valori sono espressi in sp.

Le cifre sono
La sceltà è fra cifre di tasto Numeri (‘1’, ‘2’...) o Lettere (‘a’, ‘b’...). Nel caso di lettere, ‘j’ sarà evitata e per il 9° tasto si
utilizzerà ‘k’.

Le cifre sono poste
La sceltà è fra Sulle linee or Sopra le linee. Per esempio:

Cifre di tasto letterali sopra le linee.

Le linee sono
La sceltà è Continue (le linee tagliano le cifre) or Spezzate (viene introdotto un piccolo spazio dove compare la cifra). Per
esempio:

Intavolatura con linee spezzate.

Mostra serie di cifre di tasto legate
Se non spuntata, verrà mostrata solo la prima di una sequenza di note legate. Se spuntata, saranno mostrate tutte le note
legate.

Mostra diteggiature nell'intavolatura
Spuntare per consentire la visualizzazione dei simboli di diteggiatura applicati da una tavolozza.

Opzioni rigo di intavolatura: Valori delle note

Questo gruppo di opzioni definisce l'aspetto dei simboli indicanti i valori (di durata) delle note.

Carattere
Il carattere utilizzato per scrivere i valori di durata dei simboli. Vengono forniti 5 tipi di carattere che supportano tutti i
simboli necessari nei 5 differenti stili (moderno, intavolatura italiana, intavolatura francese, francese barocca (senza
teste), francese barocca). Utilizzati esclusivamente con l'opzione Simboli delle note.

Dimensione
Dimensione del carattere in punti tipografici. I tipi di carattere incorporati solitamente offrono buoni risultati se di corpo 15
pt. Utilizzati esclusivamente con l'opzione Simboli note.

Offset Verticale
Ha effetto solo quando è selezionata l'opzione Simboli note (vedi sotto). Utilizzare valori negativi per spostare verso l'alto i
simboli di durata delle note, positivi per spostarli verso il basso.

Mostra come:
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Nessuna: Non verrà mostrato nessun valore di durata (come nell'esempio sopra)
Simboli note: verranno segnati simboli a forma di note sopra il rigo. Con quest'opzione selezionata i simboli vengono
segnati solamente ad ogni cambio di valore della nota, senza essere ripetuti (per default) per una sequenza di note
di ugual valore. P.es.

Gambi e travature: verranno segnati Gambi e travature (o codette). Le durate sono indicate per ogni nota, secondo
le norme ortografiche per dei righi ordinari; tutti i comandi della tavolozza Proprietà gruppo note potranno essere
applicati a queste travature. P.es.

Ripeti:

Se diverse note in sequenza hanno la medesima durata, si potrà specificare se e dove ripetere lo stesso simbolo di nota.
P.es.

Mai
Alla nuova accollatura
Alla nuova battuta
Sempre

Nota: Questa opzione è disponibile solo se è selezionata "Mostra come: Simboli note" (vedi sopra).

Stile gambi:

Accanto al rigo: I gambi sono disegnati come linee di altezza fissa sopra/sotto il rigo.
Attraverso il rigo: I gambi attraversano il rigo fino alla cifra di tasto.

Note: Questa opzione è disponibile solo se è selezionata "Mostra come: Gambi e travature" (vedi sopra).

Posizione gambi:

Sopra: Gambi e travature sono disegnati sopra il rigo.
Sotto: Gambi e travature sono disegnati sotto il rigo.

Nota: Questa opzione è disponibile solo se sono selezionate "Mostra come: Gambi e travature" e "Stile del gambo:
Accanto al rigo" (vedi sopra).

Minime:

Nessuna
Gambo corto
Gambo barrato

Questa opzione è disponibile solo se sono selezionate "Mostra come: Gambi e travature" e "Stile del gambo: Accanto al
rigo" (vedi sopra).

Mostra pause
Nel caso che i simboli delle note debbano essere utilizzati per indicare anche le pause; quando utilizzati per le pause, i
simboli sono disegnati in posizione leggermente più in basso. Utilizzata sono con l'opzione Simboli note.

Anteprima

Mostra una breve partitura intavolata con i parametri applicati.

Cambio strumento

In qualsiasi momento è possibile sostituire ogni strumento in partitura con un altro. Il seguente metodo aggiorna
contestualmente suono, trasposizione e nome del rigo.

1. Click destro su una parte vuota di qualsiasi misura O sul nome dello strumento e scegliere Proprietà rigo/parte...;
2. Click su Cambia strumento... (riquadro"Proprietà parte");
3. Scegliere il nuovo strumento e click su OK per tornare alla finestra Proprietà rigo/parte;
4. Click OK nuovamente per tornare alla partitura.
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Da non confondere con Cambio strumento lungo il rigo.

Collegamenti esterni

Come creare un ossia con un altro rigo  (per MuseScore 2, ancora funzionante con MuseScore 3, sebbene qui
l'opzione Rigo parziale potrebbe essere la scelta migliore).
Come creare un ossia utilizzandi la cattura immagine  (per MuseScore 2, ancora funzionante con MuseScore 3,
sebbene qui l'opzione Rigo parziale potrebbe essere la scelta migliore).

Proprietà partitura

Titolo: Proprietà partitura
La finestra di dialogo delle Proprietà partitura contiene meta-dati del documento come "Titolo", "Compositore",
"Copyright" ecc. Per visualizzarla:

1. Assicurarsi che la partitura o la parte di strumento applicabile sia la scheda attiva;
2. Dal menù, selezionare File → Proprietà partitura….

Diversi meta-dati sono generati automaticamente quando si crea una partitura usando la Procedura guidata nuova
partitura , e altri possono essere aggiunti in seguito. I meta-dati possono essere anche incorporati in intestazioni o piè di
pagina se necessario – vedere sotto.

Modifica dei meta-dati

1. Assicurarsi che la partitura o la parte di strumento applicabile sia la scheda attiva;
2. Dal menù, selezionare File → Proprietà partitura…;

3. Modificare il testo dei vari meta-dati come richiesto;
4. Per aggiungere un altro meta-dato, cliccare sul pulsante Singola. Compilare i campi "Nome" e "Valore" e premere OK;

Nota: i meta-dati aggiunti saranno collocati in ordine alfabetico tra quelli presenti e potranno sempre essere eliminati, se

necessario, tramite l’icona  che li contraddistingue.

Meta-dati preesistenti

Ogni partitura visualizza in Proprietà partitura i seguenti campi:

Percorso file: posizione del file della partitura sul computer.
Versione di MuseScore: versione di MuseScore con cui la partitura è stata salvata l'ultima volta.
Revisione: revisione di MuseScore con cui la partitura è stata salvata l'ultima volta.
Livello API: versione del formato del file.

243

https://musescore.org/it/node/46236
https://musescore.org/it/node/46226


arranger (arrangiatore): (vuoto)
composer (compositore): inizialmente impostato con lo stesso contenuto del campo "Compositore" sulla prima
pagina della Procedura guidata nuova partitura.
copyright: inizialmente impostato con lo stesso contenuto del campo "Copyright" sulla prima pagina della Procedura
guidata nuova partitura (se hai bisogno di un simbolo di copyright, copia/incolla questo: ©).
creationDate (data di creazione): data di creazione della partitura. Questo campo potrebbe essere vuoto, se la
partitura è stata salvata in modalità test (vedere Opzioni della linea di comando).
lyricist (paroliere): inizialmente impostato con lo stesso contenuto del campo "Paroliere" sulla prima pagina della
Procedura guidata nuova partitura.
movementNumber (numero movimento): (vuoto)
movementTitle (titolo movimento): (vuoto)
originalFormat (formato originale) / mscVersion (versione MuseScore) / ecc.: questo campo esiste solo se lo
spartito è importato (vedere Formati file) e assume valore dipendente dal formato di importazione.
platform (piattaforma): sistema operativo con cui è stata creata la partitura. Questo campo potrebbe essere vuoto,
se la partitura è stata salvata in modalità test.
poet (poeta): (vuoto)
source (sorgente): Può contenere un URL se la partitura è stata scaricata da o salvata su MuseScore.com.
translator (traduttore): (vuoto)
workNumber (numero lavoro): (vuoto)
workTitle (titolo lavoro): inizialmente impostato con lo stesso contenuto del campo "Titolo" sulla prima pagina della
Procedura guidata nuova partitura.

Inserimento meta-dati Lavoro / Movimento / Parte

workNumber è il numero del lavoro principale (ad esempio: 8 – per "Le Quattro Stagioni," Op. 8, di Vivaldi).
workTitle è il titolo del lavoro principale (esempio: "Le Quattro Stagioni").
movementNumber è un numero di movimento nell'opera principale (ad esempio: 3 per l'Autunno).
movementTitle è il titolo di un movimento nell’opera principale (esempio: “Autunno”).

È consuetudine, quando si usa la “Procedura guidata nuova partitura”, creare un lavoro con il movementTitle come titolo
(anche se poi finisce in workTitle) e, direttamente dopo aver creato la partitura, modificare questa informazione nel
dialogo “Proprietà partitura”.

Ogni parte ha inoltre il seguente meta-dato, generato e compilato alla creazione della parte:

partName (nome parte): il nome della parte assegnato all’atto della creazione della parte stessa (che è anche
usato per compilare il corrispondente testo del nome della parte nel riquadro verticale superiore – essere
consapevoli che le successive modifiche di uno non si riflettono nell'altro).

Intestazione / Piè di pagina

Per mostrare il contenuto di uno o più meta-dati in un'intestazione o in un piè di pagina per la partitura/parte:

1. Assicurarsi che la partitura o la parte di strumento corretta sia la scheda attiva;
2. Dal menù, selezionare Formato → Stile → Intestazione, piè di pagina:

Se si passa con il mouse sopra la regione di testo Intestazione o Piè di pagina, apparirà una lista di macro, con il
loro significato, così come i meta-dati esistenti e il loro contenuto.
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3. Aggiungere meta-dati (esempio: $:workTitle:) e macro (esempio: $M) alle caselle appropriate, come desiderato.
Immediatamente dopo la modifica, il meta-dato è visibile in partitura nella posizione stabilita. Effettuare le eventuali
correzioni, se necessario;

4. Se nella scheda attiva è presente solo una delle parti della composizione, cliccare su Applica a tutte le parti, nel caso si
vogliano applicare queste impostazioni all’intera partitura;

5. Cliccare OK per confermare intestazione e/o piè di pagina e uscire dal dialogo.

Vedere anche

Impaginazione e formattazione: Intestazione e piè di pagina
Command line options: Test mode

Schemi teste di nota

Per un rigo standard si può scegliere uno qualsiasi dei nove schemi di testa di nota. Per impostare uno schema di testa
di nota:

Cliccare con il tasto destro su un rigo e selezionare Proprietà Rigo/Parte…; cliccare su Stile, proprietà avanzate… e
scegliere dall’elenco a discesa "Schema della testa della nota".

Gli schemi sono i seguenti:

Normale: Questo è lo schema predefinito e che sarà utilizzato dalla maggior parte degli utenti: è anche l'unico
schema in MuseScore 1 e 2. Usa teste di nota normali che possono essere cambiate tramite la tavolozza “Teste
nota” o l'Ispettore.
Nomi toni: Le teste delle note cambiano automaticamente e dinamicamente per includere il nome inglese
dell'altezza nella testa della nota.

Nomi toni Tedeschi: Proprio come il precedente, ma B sarà sostituito da H, e Bb da B.
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Solfeggio Do Mobile (anche chiamato Tonic Solfa) : Le teste delle note includono la sillaba del solfeggio, a
seconda del grado della scala. Usa Ti e non Si.

Solfeggio Do Fisso : Le teste delle note includono la sillaba di solfeggio per il nome della nota. Come si usa in
Francia, Italia, Spagna, ecc. Si usa Si e non Ti.

4 Forme (Walker): Le teste delle note seguono il sistema a quattro forme usato in libri come Southern Harmony di
William Walker (1835).

7 Forme (Aikin): Le teste delle note seguono il sistema a sette forme usato in libri come The Christian Minstrel di
Jesse B. Aikin (1846), e nei libri della Ruebush & Kieffer Publishing Company. È il sistema a 7 forme più usato.

7 Forme (Funk): Le teste delle note seguono il sistema a sette forme usato in libri come Harmonia Sacra (1851) di
Joseph Funk.

7 Forme (Walker): Le teste delle note seguono il sistema a sette forme usato in libri come Christian Harmony di
William Walker (1867).

(Per maggiori informazioni sulle diverse varianti di teste di note, vedere SMuFL specification )

L'impostazione si applica a un dato rigo e la testa delle note assumerà la forma scelta durante l’inserimento e la modifica
delle note in quel rigo. Ecco un esempio.
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Teste delle note

Si può accedere a una gamma di teste di nota alternative tramite la tavolozza Testa Nota dell'area di lavoro Avanzata, o
l'Ispettore (vedi Cambio gruppo testa nota, sotto).

Nota: Il design della testa della nota può variare a seconda del carattere musicale selezionato (Leland, Emmentaler,
Gonville, Bravura, MuseJazz, Petaluma). Quelle nella tavolozza sono visualizzate come mezze note con carattere
Bravura.

Gruppi di teste nota

MuseScore supporta una serie di stili di note:

Normale: Testa di nota standard.
Testa trasversale (Ghost note): Usate nella notazione delle percussioni per rappresentare i piatti. Indica anche
effetti muti e/o percussivi in strumenti a corda come la chitarra.
Diamante: Usato per indicare le note armoniche in strumenti come la chitarra, il violino ecc.
Barrata (Slash): Usato per annotare i ritmi (per esempio, le pennate alternate o strum della chitarra).
Triangolo su/giù: Usato nella notazione delle percussioni.
Note “di forma”: Do, Re, Mi, Fa, Sol, La, Ti.
Croce cerchiata: Usato nella notazione delle percussioni.
Teste di nota cerchiate
Teste di nota barrate (slashed): Una testa di nota con una linea obliqua che la attraversa.
Teste a forma di "più" (+)
Alt. Breve: Usata in notazione musica antica.
Parentesi (tonde): Applicate intorno a nota (o alterazione) esistente.

Cambio gruppo testa nota

Per cambiare la forma di una o più teste di nota nella partitura, usare una delle seguenti possibilità:

Selezionare una o più note e cliccare su una testa di nota nella tavolozza (doppio clic nelle versioni precedenti alla
3.4).
Trascinare una testa di nota dalla tavolozza a una nota nella partitura.
Selezionare una o più note e cambiare il gruppo testa della nota nell’Ispettore, usando l’elenco a discesa sotto Nota
→ Gruppo testa della nota (non supportato per i righi di percussioni).

Cambio tipo testa della nota

Occasionalmente potrebbe sorgere la necessità di cambiare la durata apparente di una testa di nota - cioè il tipo di testa
di nota - senza alterarne la sua durata effettiva, sottostante:

1. Selezionare una o più note.
2. Scegliere una delle seguenti possibilità nell’Ispettore sotto Nota → Tipo di testa della nota:

Auto: Automatico, cioè durata apparente = durata reale.
Semibreve: Testa della nota semibreve (4/4), indipendentemente dalla durata effettiva.
Minima: Testa della nota minima (2/4), indipendentemente dalla durata effettiva.
Semiminima: Testa della nota semiminima (1/4), indipendentemente dalla durata effettiva.
Breve: Testa della nota breve (8/4), indipendentemente dalla durata effettiva.

Teste di note condivise

Quando due note in voci differenti, ma della stessa altezza scritta, cadono sul medesimo battito, può verificarsi una delle
due seguenti possibilità:

Le note possono condividere la stessa testa.
Le teste delle note possono essere spostate: cioè disposte una accanto all'altra.

MuseScore rispetta le seguenti regole:
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Le note con gambo nella stessa direzione non condividono le teste.
Le note puntate non condividono le teste con quelle non puntate.
Le note nere non condividono le teste con quelle bianche.
Le note semibrevi non condividono mai le teste delle note.

Nota: Se due note all'unisono si presentano nella stessa voce sono sempre spostate.

Cambiare teste di nota non condivise (spostate) in condivise

Per trasformare le teste nota spostate appartenenti a voci opposte in teste nota condivise:

Rendere invisibile la testa della nota di valore più piccolo selezionandola e usando la scorciatoia da tastiera V (o
deselezionando l'opzione "Visibile" nell’Ispettore).

In una piccola minoranza di casi (dove la nota di valore minore è puntata) questa soluzione non è applicabile, quindi usare
la seguente alternativa:

Selezionare il valore più piccolo di testa-nota e, nella sezione "Nota" dell’Ispettore, cambiare il "Tipo di testa della
nota" in modo che corrisponda a quello della nota di valore maggiore nella voce opposta.

Esempi di condivisione della testa della nota

1. Nel primo esempio qui sotto, le note delle voci 1 e 2 condividono le teste per impostazione predefinita, perché sono
tutte nere, non puntate:

2. Al contrario, nel prossimo esempio, le note bianche non possono condividere le teste delle note con quelle nere,
quindi sono spostate a destra:

Per creare una testa di nota condivisa, cambiare il tipo di testa della nota nera da un ottavo in modo che corrisponda
a quello della nota bianca o, per versioni precedenti la 3.5, renderla invisibile (come spiegato sopra):

Rimuovere capotasti duplicati

In alcuni casi, una testa di nota condivisa, quando incollata a un rigo di intavolatura, può risultare in due capotasti separati
su corde adiacenti. Per correggere, rendere invisibili tutte le note di intavolatura estranee selezionandole e usando la
scorciatoia da tastiera V (o deselezionando l'opzione "visibile" nell'Ispettore).

Collegamenti esterni

Shape notes  at Wikipedia.
Ghost notes  at Wikipedia.

Strumento di confronto partiture
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Lo Strumento di confronto partiture vi permette di confrontare due versioni di una partitura per trovare le differenze fra
loro.

Introduzione

Aprire lo Strumento di confronto partiture:

Da menu, selezionare Visualizza→Strumento di confronto partiture .

La finestra di dialogo si apre sotto la finestra di documento ed è composta di tre sezioni (da sinistra a destra):

Scegli le partiture da confrontare: Seleziona le partiture che si desidera confrontare.
Modalità Diff.: Seleziona come si vedrà il confronto.
Confronto: Viene mostrato per linee il confronto fra le partiture.

Scegliere le partiture

il primo passo è selezionare le partiture. Utilizzare l'elenco a discesa vicino a "Partitura 1" per scegliere fra le partiture
aperte al momento, o click sul pulsante Sfoglia per aprire l'Esplora risorse e scegliere una partitura dal disco. Quindi
utilizzare l'elenco a discesa più a destra per scegliere se la prima partitura debba essere la versione aperta o quella
dell'ultimo salvataggio. Partitura 2 è impostato sulla medesima partitura ma se ne può scegliere un'altra fra quelle aperte.

Una volta scelte partiture e versioni premere Confronta per fare il confronto.

Scegliere la visualizzazione

"Intelligente" è l'opzione predefinita nella _Modalità Diff.__: questa presenta le differenze fra le partiture in un formato
leggibile (p.es. "Battuta 1: Elemento inserito Pausa"). Cambiare la scelta di Modalità Diff. in "Grezzo" se si preferiscono i
risultati mostrati in codice XML.

Visualizzazione del confronto

Premendo Confronta verrà mostrata una lista di differenze sulla destra e la visualizzazione dei documenti cambierà in
"Documenti affiancati". Nel riquadro Confronto , doppio click su una differenza della lista ed entrambe le partiture si
disporranno automaticamente per mostarvi gli elementi cambiati, che saranno anche evidenziati.

Uscire dal confronto

Per uscire dallo Strumento di confronto partiture, disattivare le due opzioni "Strumento di confronto partiture" e
"Documenti affiancati" nel menu Visualizza.

Esempio

Qui sotto si possono vedere due piccole partiture con alcune differenze fra loro:.

L'ultimo salvataggio:

La verione corrente:

Il risultato del confronto apparirà come questo:
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Tavolozza generale

La Tavolozza generale è un “contenitore” di simboli usati per popolare le aree di lavoro (Essenziale, Avanzata, e
Personalizzata). Viene inoltre utilizzata per creare nuove Indicazioni metriche e Armature di chiave.

Per aprirla, usare una delle seguenti opzioni:

Premere Maiusc+F9 (Mac: fn+Maiusc+F9).
Dal menu, selezionare Visualizza → Tavolozza generale.

La Tavolozza generale è divisa in sezioni basate sul tipo di simbolo. Passando il mouse sopra un elemento, viene
mostrato un tool tip (una breve definizione in nero su sfondo giallo).

Per trasferire un elemento della Tavolozza generale a una tavolozza personalizzata :

Trascinare il simbolo dalla finestra della Tavolozza generale ad una tavolozza personalizzata.

Nota: Tranne che per la sezione Simboli (sotto), è insolito aggiungere elementi alla partitura direttamente dalla Tavolozza
generale: usare invece le tavolozze dell'area di lavoro. Tuttavia, se lo si desidera, gli elementi possono comunque essere
aggiunti direttamente usando (i) il drag-and-drop (trascina e rilascia) o (ii) selezionando una o più note/pause e facendo
doppio clic sull'elemento.

Simboli

La sezione Simboli della Tavolozza generale è un grande contenitore di centinaia di simboli musicali in aggiunta a quelli
che si trovano nelle aree di lavoro preimpostate. Può essere aperta dalla Tavolozza generale, oppure direttamente dalla
partitura tramite la scorciatoia Z.
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Trovare un simbolo

Le sottocategorie dei Simboli possono essere visualizzate cliccando su "Simboli". Usare il menu font caratteri in basso
a destra nel riquadro per scegliere tra i simboli specifici relativi ai caratteri Leland, Bravura, Emmentaler, Gonville,
MuseJazz o Petaluma. Si può cercare un particolare simbolo inserendo una parola chiave nella casella di ricerca.

Applicare un simbolo

Per aggiungere un elemento alla partitura dalla sezione Simboli, usare una delle seguenti opzioni:

Trascinare e rilasciare il simbolo sul pentagramma.
Selezionare una nota o una pausa e fare doppio clic su un simbolo.

La posizione del simbolo può essere regolata trascinando o cambiando gli spiazzamenti orizzontale / verticale nell’
Ispettore. Anche il colore e la visibilità possono essere regolati nell'Ispettore.

Nota: Gli elementi della sezione Simboli non seguono alcuna regola di posizionamento (in molti casi a differenza di
elementi identici di altre sezioni della Tavolozza generale), né influenzano la riproduzione della partitura.

Collegare simboli

Gli elementi della sezione Simboli possono essere collegati tra loro nella pagina dello spartito, in modo che possano
essere spostati come una sola unità:

1. Applicare il primo simbolo allo spartito. Regolare la posizione come richiesto.
2. Fare doppio clic, o trascinare un secondo elemento sul primo simbolo. Regolare la posizione come richiesto.

Trascinate il primo elemento e l'elemento collegato lo seguirà.

Vedere anche

Tavolozze e aree di lavoro
Simboli e caratteri speciali (aggiungere simboli musicali agli oggetti di testo)

Timeline

Introduction

The timeline was developed as part of the Google Summer of Code 2017, and is included for the first time in MuseScore
3.0.
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Overview

The timeline is a navigation tool that displays an abstraction of the score to the order of measure numbers and instrument
names. There are four parts to the timeline:

Meta labels

This is found in the top left corner of the timeline. These are the names of the meta rows.

Instrument labels

This is found in the bottom left corner of the timeline. These are the names of the rows in the main grid.

Meta rows

This is found in the top right corner of the timeline. These hold the meta values of the score.

Main grid

This is found in the bottom right corner of the timeline. This holds multiple 'cells' (a specific measure and staff in the score
represented as a square)

Meta

Meta are elements found on the score that are not notes, but are still important to the score (key signature, time
signature, tempo, rehearsal marks, bar lines, and jumps and markers).

Basic interaction

Select a measure

To select a measure in the timeline, press the mouse button on the cell. A blue box will appear around the selected cell
and the respective measure in the score will be selected. The score view will place the selected measure in view.

Select multiple measures

Drag selection

Holding Shift and holding the left mouse button and dragging the mouse over the main grid will create a selection box.
Upon releasing the mouse button, all the cells underneath the selection box will be selected, as well as all the measures in
the score.

[Shift] selection

If a cell is already selected, holding Shift and selecting another cell in the timeline will stretch the selection to that new cell,
similar to how the score does

[Ctrl] selection

If no cells are currently selected, holding Ctrl and selecting a cell will select the entire measure

Clearing selection

To clear selection, holding Ctrl and clicking anywhere on the grid or the meta rows will clear any current selection.

Meta values selection

Selecting the meta values on the timeline will attempt to select the respective meta values in the score.

Scrolling

Standard scrolling
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Scrolling the mouse wheel up or down will move the grid and instrument labels down or up respectively. The meta labels
and rows do not move.

[Shift] scrolling

Holding Shift and scrolling the mouse wheel up or down will move the grid and meta rows left or right respectively. The
meta labels and instrument labels do not move.

[Alt] scrolling

Holding Alt and scrolling the mouse wheel up or down will move the grid and meta rows left or right respectively, faster
than Shift scrolling. The meta labels and instrument labels do not move.

Dragging

To drag the contents of the timeline, hold the left mouse button and move it around.

Labels interaction

Rearranging meta labels

All meta labels besides the measures meta may be rearranged in any way. By moving the mouse cursor onto one of the
meta labels, small up and down arrows will appear. Click the left mouse button on the up arrow to swap the meta label
with the one above it. Click the left mouse button on the down arrow to swap the meta label with the one below it.

Collapsing the meta labels

In order to hide all the meta labels while keeping all the meta information on the timeline, there is an arrow that appears on
the measures meta when the mouse is over it. Click the left mouse button on the large up arrow to collapse all the
currently visible meta rows into one row, where the meta values are staggered in that row. Click the left mouse button on
the large down arrow to expand the meta rows again.

Hiding instruments

All instruments--hidden or not--will be displayed on the timeline. To start this interaction, the mouse cursor is moved over
an instrument label. A small eye will appear on the right side of the label that is open if the instrument is visible on the
score, and closed if the instrument is hidden. Click the left mouse button on the eye to toggle between the two options.

Zooming

To zoom in or out of the score, hold Ctrl and scroll the mouse wheel up or down respectively (Mac: Cmd + scroll).

Context menus

To bring up a context menu, right-click on the timeline. There are three context menus found in these locations: meta
labels, instrument labels, and meta rows.

Meta labels context menu

Upon clicking the right mouse button on the meta labels, a context menu appears that displays all possible meta labels as
well as two options: "Hide all" and "Show all." Next to each meta label in the menu, there is a check box that shows if the
meta label is currently being shown on the timeline. To show or hide one of the meta labels, select the box of the meta
label in the context menu. Selecting "Hide all" will hide all meta labels except for the measures meta. Selecting "Show all"
will display all meta labels.
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Meta rows context menu

Clicking the right mouse button on the meta rows will display the same context menu as the meta labels.

Instrument context menu

Clicking the right mouse button on the instrument labels will display a context menu with the option to "Edit Instruments."
Selecting this will bring you to the same dialog as Edit > Instruments... or pressing I for the shortcut.

Support
This chapter describes how to find help using MuseScore: the best places to look, the best way to ask a question on the
forums, and tips for reporting a bug.

Helping to improve translations

You can help translate the MuseScore software and documentation into your own language, as mentioned in
Development / Translating .

Software translation

1. Ask in the forum to improve translation
2. Connect to Transifex/MuseScore http://translate.musescore.org , which will redirect you to

https://www.transifex.com/projects/p/musescore
3. Select the language and then the section you want to help with (MuseScore, Instruments, Start Center or tours)
4. Click on the "translate" button (the button text will depend on your language...)
5. Search for "strings" (informational meaning) you want to translate (you could filter "already translated items")

Here is a technical explanation: Continuous translation for MuseScore 2.0

Website and handbook translation

See Translation instructions

See also

Language Settings and Update Translation, Update Translation

Ripristinare le impostazioni predefinite iniziali

MuseScore ha la possibilità di ritornare agli standard predefiniti incorporati o alle "impostazioni di fabbrica". Questo può
essere necessario se le proprie impostazioni sono corrotte. Attenzione: Ripristinare le impostazioni predefinite rimuove
qualsiasi cambiamento apportato alle preferenze, alle tavolozze o alle impostazioni delle finestre. Questa non è una
procedura comunemente necessaria; consultare prima i forum, poiché potrebbe esserci un modo per risolvere il problema
senza resettare tutto.

Via menu

Se MuseScore si avvia ancora, è possibile tornare indietro dall'interno del programma.
Andare su Aiuto→Ripristina impostazioni predefinite. Apparirà una finestra di dialogo di avvertimento:

Cliccando Si si resettano tutte le impostazioni di MuseScore come se il programma fosse stato installato per la prima
volta, e MuseScore si riavvierà immediatamente. No annullerà in modo sicuro il ripristino.

Via linea di comando

Se MuseScore non si avvia, si deve eseguire questo processo tramite linea di comando.
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Istruzioni per Windows

1. Se MuseScore è aperto, prima deve essere chiuso (File→Esci)
2. Digitare ⊞ Win+R per aprire la finestra di dialogo Esegui. In alternativa selezionare "Start" con il mouse e digitare

"esegui", poi cliccare sul programma "Esegui".
3. Cliccare Sfoglia
4. Cercare MuseScore3.exe sul computer. La posizione può variare a seconda della propria installazione, ma è

probabilmente qualcosa di simile a My Computer → Local Disk → Program Files → MuseScore 3 → bin →
MuseScore3.exe

5. Cliccare su Apri per lasciare il dialogo Sfoglia e ritornare al dialogo Esegui. Il seguente testo (o qualcosa di simile)
dovrebbe apparire nel dialogo Esegui:

C:\Program Files\MuseScore 3\bin\MuseScore3.exe (attualmente %ProgramFiles%\MuseScore 3\bin\MuseScore3.exe)

Per la versione a 32-bit di MuseScore in una versione a 64 bit di Windows, la posizione è:

C:\Program Files (x86)\MuseScore 3\bin\MuseScore3.exe (attualmente %ProgramFiles(x86)%\MuseScore 3\bin\MuseScore3.exe)

Per la versione Windows Store (Windows 10), è abbastanza ben nascosto, cercarlo tramite Windows Explorer.

6. Cliccare dopo le virgolette e aggiungere uno spazio seguito da un trattino e una F maiuscola: -F

7. Premere OK

Dopo alcuni secondi, MuseScore dovrebbe partire riportando tutte le impostazioni a quelle predefinite iniziali.

Per gli utenti più esperti, il file delle preferenze principali si trova all'indirizzo:

C:\Users\[USERNAME]\AppData\Roaming\MuseScore\MuseScore3.ini
(attualmente %APPDATA%\MuseScore\MuseScore3.ini)

Le altre preferenze (tavolozze, sessioni, scorciatoie, aree di lavoro...) sono in:

C:\Users\[USERNAME]\AppData\Local\MuseScore\MuseScore3\ (attualmente %LOCALAPPDATA%\MuseScore\MuseScore3\)

Per la versione Windows Store (Windows 10), questi sono abbastanza ben nascosti, cercarli tramite Windows
Explorer

Istruzioni per MacOS

1. Se MuseScore è aperto, prima è necessario uscire dall'applicazione (MuseScore→Quit)
2. Aprire il Terminale (in Applications/Utilities, oppure via ricerca Spotlight) e dovrebbe apparire una finestra di

sessione

3. Digitare (oppure copiare/incollare) il seguente comando nella linea del terminale (incluso il carattere '/' all’inizio):

/Applications/MuseScore\ 3.app/Contents/MacOS/mscore -F

Questo riporta tutte le preferenze di MuseScore alle impostazioni iniziali e lancia immediatamente l'applicazione
MuseScore. Notare che non è possibile uscire da Terminale senza uscire da MuseScore. È possibile uscire
tranquillamente da MuseScore, uscire da Terminal, e poi riaprire MuseScore in modo normale, pronto per continuare ad
usarlo.

Per utilizzatori esperti, il file principale delle preferenze di MuseScore si trova in
~/Library/Preferences/org.musescore.MuseScore3.plist.
Le altre preferenze (tavolozze, sessioni, scorciatoie, aree di lavorio...) sono in ~/Library/Application\
Support/MuseScore/MuseScore3/.

Istruzioni per Linux

Quanto segue è vero per Ubuntu, e molto probabilmente per tutte le altre distribuzioni Linux e sistemi operativi in stile
UNIX.

1. Se MuseScore è aperto, prima è necessario uscire dall'applicazione (File→Quit)
2. Dal menù principale Ubuntu, scegliere Mostra applicazioni→Utilità→Terminale oppure Ctrl+Alt+T. Apparirà il Terminale

3. Digitare, (oppure copiare/incollare) il seguente comando nel terminale (Ctrl+Maiusc+V per incollare nel Terminale):

mscore -F

Oppure, se si sta usando la versione AppImage, utilizzare prima il comando cd per cambiare la directory in cui è
stata salvata l’AppImage. Ad esempio, se salvata sul Desktop (e ce n’è uno solo):

cd ~/Desktop
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./MuseScore*.AppImage -F

Questo riporta tutte le preferenze di MuseScore alle impostazioni iniziali e lancia immediatamente l'applicazione
MuseScore. Ora è possibile uscire da Terminale e continuare ad usare MuseScore.

Per utenti esperti, il file principale delle preferenze di MuseScore si trova in ${XDG_CONFIG_HOME:-
~/.config}/MuseScore/MuseScore3.ini.
Le altre preferenze (tavolozze, sessioni, scorciatoie, aree di lavoro, …) sono in ${XDG_DATA_HOME:-
~/.local/share}/MuseScore/MuseScore3/.

Vedere anche

Opzioni linea di comando

Bug reports and Feature requests

Before filing bug reports or feature requests in the Issue Tracker  it is recommended first to post it in the relevant
Forum  so others may help establish a bug as genuine, or provide ideas and second opinions for new features.
Include a link to such discussion when creating the Issue.

Bug reports

Before posting in the issue tracker :

Try to reproduce the issue with the latest nightly . You may also view the version history  to check whether it has
been fixed/implemented already.

Please include as much of the following information as you know and limit each issue to one report:

Version/revision of MuseScore you are using (e.g. version 3.0, revision 871c8ce ). Check Help → About...
(Mac: MuseScore → About MuseScore...).
Operating system being used (e.g. Windows 10, macOS 10.15 or Ubuntu 20.04)
Describe the precise steps that lead to the problem (where do you click, what keys do you press, what do you
see, etc.).
If you are not able to reproduce the problem with the steps, it is probably not worth reporting it as the
developers will not be able to reproduce (and solve) it either. Remember that the goal of a bug report is not
only to show the problem, but to allow others to reproduce it easily.

Please remember:

Attach the score that shows the problem, at least a minimal example —use the "File attachments" option at the
bottom of the page, just above the Save and Preview buttons when you're typing your post.

Feature requests

When posting in the Issue Tracker :

Be brief, but describe the goal as precisely as you can
Describe the context in which the new feature is intended to work
Suggest a specific workflow, if you can

Cross linking issues

When you write a comment in a forum topic, you can refer to an issue in the issue tracker using the following notation:
´[#number]´
That way the link in the comment will include the issue title and reflect the current status of the issue. Furthermore, it'll
lead to the forum topic being listed in the issue itself.
Type [#153286] get #153286: Change instrument causes a crash

External links

How to write a good bug report: step-by-step instructions  (MuseScore HowTo)
How to attach a file  (MuseScore HowTo)
Compose tips

Appendix

Scorciatoie da tastiera

La maggior parte delle scorciatoie da tastiera può essere personalizzata tramite il menù: select
Modifica→Preferenze...→Scorciatoie (Mac: MuseScore→Preferenze...→Scorciatoie). Di seguito è riportata una lista di alcune delle
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impostazioni iniziali delle scorciatoie.

Navigazione

Inizio della partitura: Inizio (Mac: Fn+←)
Ultima pagina della partitura: Fine (Mac: Fn+→)
Trova/Vai a (numero di battuta, numero/lettera di chiamata, oppure pXX dove XX è un numero di pagina): Ctrl+F (Mac:
Cmd+F)

Partitura successiva: Ctrl+Tab
Partitura precedente: Maiusc+Ctrl+Tab

Aumentare Zoom: Ctrl++ (non funziona su alcuni sistemi) (Mac: Cmd++); oppure Ctrl (Mac: Cmd) + scorrimento verso l’alto
Diminuire Zoom: Ctrl+- (Mac: Cmd+-); oppure Ctrl (Mac: Cmd) + scorrimento verso il basso

Pagina successiva: Pg Giù; oppure Maiusc + scorrimento verso il basso (Mac: Fn+↓)
Pagina precedente: Pg Su; oppure Maiusc + scorrimento verso l’alto (Mac: Fn+↑)

Battuta successiva: Ctrl+→ (Mac: Cmd+→)
Battuta precedente: Ctrl+← (Mac: Cmd+←)

Nota successiva: →
Nota precedente: ←

Nota sotto (all'interno di un accordo o su un rigo inferiore): Alt+↓
Nota sopra (all'interno di un accordo oppure su un rigo superiore): Alt+↑

Nota superiore dell'accordo: Ctrl+Alt+↑ (Ubuntu usa invece questa scorciatoia per le aree di lavoro)
Nota inferiore dell'accordo: Ctrl+Alt+↓ (Ubuntu usa invece questa scorciatoia per le aree di lavoro)

Elemento successivo (accessibilità): Alt+→
Elemento precedente (accessibilità): Alt+←

Inserimento note

Iniziare la modalità di inserimento delle note: N
Lasciare la modalità di inserimento delle note: N oppure Esc

Durata nota/pausa

1 ... 9 seleziona una durata. Vedere anche Inserimento note.

Dimezzare la durata della nota precedente: Q
Raddoppiare la durata della nota precedente: W
Diminuire la durata di un punto: (a partire dalla versione 2.1) Maiusc+Q (es. una nota da un quarto puntata diventa una nota
da un quarto; una nota da un quarto diventa una nota da un ottavo puntata)
Aumentare la durata di un punto: (a partire dalla versione 2.1) Maiusc+W (es. una nota da un ottavo diventa un ottavo
puntato; un ottavo puntato diventa un quarto)

Voci

Per selezionare una voce in modalità inserimento note.

Voce 1: Ctrl+Alt+1 (Mac: Cmd+Alt+1)
Voce 2: Ctrl+Alt+2 (Mac: Cmd+Alt+2)
Voce 3: Ctrl+Alt+3 (Mac: Cmd+Alt+3)
Voce 4: Ctrl+Alt+4 (Mac: Cmd+Alt+4)

Altezza

Le altezze possono essere inserite tramite il loro nome in lettere (A-G), oppure tramite tastiera MIDI. Vedere Inserimento
note per tutti i dettagli.

Ripetere la nota precedente oppure l'accordo: R (la ripetizione può essere di un valore di nota diverso selezionando prima
la durata)

Ripetere la selezione: R (La selezione sarà ripetuta dalla prima posizione di nota dopo la fine della selezione)

Alzare l’intonazione di un’ottava: Ctrl+↑ (Mac: Cmd+↑)
Abbassare l’intonazione di un’ottava: Ctrl+↓ (Mac: Cmd+↓)

Alzare l’intonazione di un semitono (tramite visualizzazione diesis): ↑
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Abbassare l’intonazione di un semitono (tramite visualizzazione bemolle): ↓
Alzare l’intonazione diatonicamente: Alt+Maiusc+↑
Abbassare l’intonazione diatonicamente: Alt+Maiusc+↓

Sostituzione enarmonica delle alterazioni sia nella vista in modalità scritta che in quella da concerto: J
Sostituzione enarmonica delle alterazioni solo nella vista currente: Ctrl+J (Mac: Cmd+J)

Pausa: 0 (zero)

Intervallo

Aggiungere un intervallo sopra la nota corrente: Alt+[Numero]

Visualizzazione (layout)

Invertire la direzione (gambi, legature di portamento, legature di valore, parentesi gruppi irregolari, ecc.): X
Testa nota “speculare”: Maiusc+X
Aumentare la larghezza di battuta(e): }
Diminuire la larghezza di battuta(e): {
Interruzione di linea su una stanghetta selezionata: ↵
Interruzione di pagina su una stanghetta selezionata: Ctrl+↵ (Mac: Cmd+↵)

Articolazioni

Staccato: Maiusc+S
Tenuto: Maiusc+N
Sforzato (accento): Maiusc+V
Marcato: Maiusc+O
Note di abbellimento (acciaccatura): /
Crescendo: <
Decrescendo: >

Inserimento Testo

Testo di rigo: Ctrl+T (Mac:Cmd+T)
Testo di accollatura: Ctrl+Maiusc+T (Mac: Cmd+Maiusc+T)
Testo di metronomo: Alt+Maiusc+T
Testo di Sigle accordali: Ctrl+K (Mac: Cmd+K)
Numeri/lettere chiamata: Ctrl+M (Mac: Cmd+M)

Inserimento Testo cantato

Aggiungere testo cantato a una nota: Ctrl+L (Mac: Cmd+L)
Precedente sillaba di testo cantato: Maiusc+Spazio
Successiva sillaba di testo cantato: se le sillabe corrente e successiva sono separate da '-': -, altrimenti Spazio
Spostare sillaba di testo cantato a sinistra di 0.1sp: ←
Spostare sillaba di testo cantato a destra di 0.1sp: →
Spostare sillaba di testo cantato a sinistra di 1sp: Ctrl+← (Mac: Cmd+←)
Spostare sillaba di testo cantato a destra di 1sp: Ctrl+→ (Mac: Cmd+→)
Spostare sillaba di testo cantato a sinistra di 0.01sp: Alt+←
Spostare sillaba di testo cantato a destra di 0.01sp: Alt+→

Spostarsi alla strofa precedente: Ctrl+↑ (Mac: Cmd+↑)
Spostarsi alla strofa successiva: Ctrl+↓ (Mac: Cmd+↓)

Per ulteriori scorciatoie relative a testo cantato, vedere Testo cantato.

Visualizzazioni

Successione cronologica: F12 (Mac: Fn+F12)
Controlli riproduzione: F11 (Mac: Fn+F11)
Mixer: F10 (Mac: Fn+F10)
Tavolozza: F9 (Mac: Fn+F9)
Ispettore: F8 (Mac: Fn+F8)
Tastiera Pianoforte (virtuale): P
Filtro di selezione: F6
Visualizzazione a schermo intero: Ctrl+U (Mac: nessuna, usare invece Visualizzare→Schermo intero)

Miscellanea
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Alterna la visibilità degli elementi selezionati: V
Mostra la finestra di dialogo degli Strumenti: I
Attiva o disattiva le battute d’aspetto: M
Ripristina l'elemento alla posizione predefinita: Ctrl+R (Mac: Cmd+R)

Vedere anche

Preferenze: Scorciatoie

Command line options

MSCORE(1) — General Commands Manual Page

NAME

mscore, MuseScore3 — MuseScore 3 sheet music editor

SYNOPSIS

You can launch MuseScore from the command line by typing

mscore [options] [ filename …] (Mac and Linux/BSD/Unix)
musescore [options] [ filename …] (Linux/BSD/Unix)
MuseScore3.exe [options] [ filename …] (Windows)

[options] and [filename] are optional. For this to work the MuseScore executable must be in %PATH% (Windows) resp. $PATH
(Mac and Linux). If it is not, see Revert to factory settings for detailed instructions on how and where to find and execute
the MuseScore executable from the command line on the various supported platforms.

A more detailed synopsis follows:

mscore [-deFfhIiLmnOPRstvw]
[-a | --use-audio driver]
[-b | --bitrate bitrate]
[-c | --config-folder pathname]
[-D | --monitor-resolution DPI]
[-d | --debug]
[-E | --install-extension extension file]
[-e | --experimental]
[-F | --factory-settings]
[-f | --force]
[-h | -? | --help]
[-I | --dump-midi-in]
[-i | --load-icons]
[-j | --job file.json]
[-L | --layout-debug]
[-M | --midi-operations file]
[-m | --no-midi]
[-n | --new-score]
[-O | --dump-midi-out]
[-o | --export-to file]
[-P | --export-score-parts]
[-p | --plugin name]
[-R | --revert-settings]
[-r | --image-resolution DPI]
[-S | --style style]
[-s | --no-synthesizer]
[-T | --trim-image margin]
[-t | --test-mode]
[-v | --version]
[-w | --no-webview]
[-x | --gui-scaling factor]
[--diff]
[--long-version]
[--no-fallback-font]
[--raw-diff]
[--run-test-script]
[--score-media]
[--score-meta]
[--score-highlight-config]
[--score-mp3]
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[--score-parts]
[--score-parts-pdf]
[--score-transpose]
[--source-update]
[--template-mode]
[file ...]

DESCRIPTION

MuseScore is a Free and Open Source WYSIWYG cross-platform multi-lingual music composition and notation software,
released under the GNU General Public Licence (GPLv2).

Running mscore without any extra options launches the full graphical MuseScore program and opens any files specified
on the command line.

The options are as follows:

-a | --use-audio driver

Use audio driver: one of jack, alsa, portaudio, pulse

-b | --bitrate bitrate

Set MP3 output bitrate in kbit/s

-c | --config-folder pathname

Override configuration and settings directory

-D | --monitor-resolution DPI

Specify monitor resolution (override autodetection)

-d | --debug

Start MuseScore in debug mode

-E | --install-extension extension file

Install an extension file; soundfonts are loaded by default unless -e is also specified

-e | --experimental

Enable experimental features, such as layers

-F | --factory-settings

Use only the standard built-in presets (“factory settings”) and delete user preferences; compare with the -R option
(see also Revert to factory settings)

-f | --force

Ignore score corruption and version mismatch warnings in “converter mode”

-h | -? | --help

Display an overview of invocation instructions (doesn’t work on Windows)

-I | --dump-midi-in

Display all MIDI input on the console

-i | --load-icons

Load icons from the filesystem; useful if you want to edit the MuseScore icons and preview the changes

-j | --job file.json

Process a conversion job (see EXAMPLES below)

-L | --layout-debug

Start MuseScore in layout debug mode

-M | --midi-operations file
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Specify MIDI import operations file (see EXAMPLES below)

-m | --no-midi

Disable MIDI input

-n | --new-score

Start with the New Score wizard regardless whether it’s enabled or disabled in the user preferences

-O | --dump-midi-out

Display all MIDI output on the console

-o | --export-to file

Export the given (or currently opened) file to the specified output file. The file type depends on the extension of the
filename given. This option switches to “converter mode” and avoids the graphical user interface.

-P | --export-score-parts

When converting to PDF with the -o option, append each part’s pages to the created PDF file. If the score has no
parts, all default parts will temporarily be generated automatically.

-p | --plugin name

Execute the named plugin

-R | --revert-settings

Use only the standard built-in presets (“factory settings”) but do not delete user preferences; compare with the -F
option

-r | --image-resolution DPI

Set image resolution for conversion to PNG files. Default: 300 DPI (actually, the value of “Resolution” of the PNG
option group in the Export tab of the preferences)

-S | --style style

Load a style file first; useful for use with the -o option

-s | --no-synthesizer

Disable the integrated software synthesizer

-T | --trim-image margin

Trim exported PNG and SVG images to remove whitespace surrounding the score. The specified margin, in pixels,
will be retained (use 0 for a tightly cropped image). When exporting to SVG, this option only works with single-page
scores.

-t | --test-mode

Set test mode flag for all files, includes --template-mode

-v | --version

Display the name and version of the application without starting the graphical user interface (doesn’t work on
Windows)

-w | --no-webview

Disable the web view component in the Start Center

-x | --gui-scaling factor

Scale the score display and other GUI elements by the specified factor; intended for use with high-resolution
displays

--diff

Print a conditioned diff between the given scores

--long-version
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Display the full name, version and git revision of the application without starting the graphical user interface (doesn’t
work on Windows)

--no-fallback-font

Don’t use Bravura as fallback musical font

--raw-diff

Print a raw diff between the given scores

--run-test-script

Run script tests listed in the command line arguments

--score-media

Export all media (except MP3) for a given score as a single JSON document to stdout

--highlight-config

Set highlight to svg, generated from a given score

--score-meta

Export score metadata to JSON document and print it to stdout

--score-mp3

Generate an MP3 for the given score and export it as a single JSON document to stdout

--score-parts

Generate parts data for the given score and save them to separate mscz files

--score-parts-pdf

Generate parts data for the given score and export it as a single JSON document to stdout

--score-transpose

Transpose the given score and export the data to a single JSON file, print it to stdout

--source-update

Update the source in the given score

--template-mode

Save files in template mode (e.g. without page sizes)

MuseScore also supports the automatic Qt command line options .

Batch conversion job JSON format

The argument to the -j option must be the pathname of a file comprised of a valid JSON document honoring the following
specification:

The top-level element must be a JSONArray, which may be empty.

Each array element must be a JSONObject with the following keys:

in: Value is the name of the input file (score to convert), as JSONString.
plugin: Value is the filename of a plugin (with the .qml extension), which will be read from either the global or per-
user plugin path and executed before the conversion output happens, as JSONString. Optional, but at least
one of plugin and out must be given.
out: Value is the conversion output target, as defined below. Optional, but at least one of plugin and out must be
given.

The conversion output target may be a filename (with extension, which decided the format to convert to), as
JSONString.

The conversion output target may be a JSONArray of filenames as JSONString, as above, which will cause the
score to be written to multiple output files (in multiple output formats) sequentially, without being closed, re-opened
and re-processed in between.
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If the conversion output target is a JSONArray, one or more of its elements may also be, each, a JSONArray of two
JSONStrings (called first and second half in the following description). This will cause part extraction: for each such
two-tuple, all extant parts of the score will be saved individually, with filenames being composed by concatenating
the first half, the name (title) of the part, and the second half. The resulting string must be a valid filename (with
extension, determining the output format). If a score has no parts (excerpts) defined, this will be silently ignored
without error.

Valid file extensions for output are:

flac
Free Lossless Audio Codec (compressed audio)

metajson
various score metadata (JSON)

mid
standard MIDI file

midi
standard MIDI file

mlog
internal file sanity check log (JSON)

mp3
MPEG Layer III (lossy compressed audio)

mpos
measure positions (XML)

mscx
uncompressed MuseScore file

mscz
compressed MuseScore file

musicxml
uncompressed MusicXML file

mxl
compressed MusicXML file

ogg
OGG Vorbis (lossy compressed audio)

pdf
portable document file (print)

png
portable network graphics (image) — Individual files, one per score page, with a hyphen-minus followed by the
page number placed before the file extension, will be generated.

spos
segment positions (XML)

svg
scalable vector graphics (image)

wav
RIFF Waveform (uncompressed audio)

xml
uncompressed MusicXML file

See below for an example.

ENVIRONMENT

SKIP_LIBJACK
Set this (the value does not matter) to skip initialization of the JACK Audio Connection Kit library, in case it causes
trouble.

XDG_CONFIG_HOME
User configuration location; defaults to ~/.config if unset.

XDG_DATA_HOME
User data location; defaults to ~/.local/share if unset.

Note that MuseScore also supports the normal Qt environment variables such as QT_QPA_GENERIC_PLUGINS,
QT_QPA_PLATFORM, QT_QPA_PLATFORMTHEME, QT_QPA_PLATFORM_PLUGIN_PATH, QT_STYLE_OVERRIDE, DISPLAY, etc.

FILES

/usr/share/mscore-3.0/ contains the application support data (demos, instruments, localization, system-wide plugins,
soundfonts, styles, chords, templates and wallpapers). In the Debian packages, system-wide soundfonts are installed into
/usr/share/sounds/sf2/, /usr/share/sounds/sf3/ or /usr/share/sounds/sfz/, respectively, instead.

The per-user data (extensions, plugins, soundfonts, styles, templates) and files (images, scores) are normally installed
into subdirectories under ~/MuseScore3/ but may be changed in the configuration. Note that snapshot, alpha and beta
versions use MuseScore3Development instead of MuseScore3 in all of these paths.
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$XDG_CONFIG_HOME/MuseScore/MuseScore3.ini contains the user preferences, list of recently used files and their locations,
window sizes and positions, etc. See above for development version paths.

$XDG_DATA_HOME/data/MuseScore/MuseScore3/ contains updated localization files downloaded from within the program, plugin
information, cached scores, credentials for the musescore.com community site, session information, synthesizer settings,
custom key and time signatures and shortcuts. See above for development version paths.

EXAMPLES

Convert a score to PDF from the command line

mscore -o 'My Score.pdf' 'My Score.mscz'

Run a batch job converting multiple documents

mscore -j job.json

This requires the file job.json in the current working directory to have content similar to the following:

[
  {
    "in": "Reunion.mscz",
    "out": "Reunion-coloured.pdf",
    "plugin": "colornotes.qml"
  },
  {
    "in": "Reunion.mscz",
    "out": [
      "Reunion.pdf",
      [ "Reunion (part for ", ").pdf" ],
      "Reunion.musicxml",
      "Reunion.mid"
    ]
  },
  {
    "in": "Piece with excerpts.mscz",
    "out": [
      "Piece with excerpts (Partitura).pdf",
      [ "Piece with excerpts (part for ", ").pdf" ],
      "Piece with excerpts.mid"
    ]
  }
]

The last part of the job would, for example, cause files like “Piece with excerpts (part for Violin).pdf ” to be generated alongside the
conductor’s partitura and a MIDI file with the full orchestra sound, whereas the equivalent part of the Reunion conversion
will be silently ignored (because the Reunion piece (a MuseScore demo) has no excerpts defined).

MIDI import operations

The attached midi_import_options.xml  is a sample MIDI import operations file for the -M option.

DIAGNOSTICS

The mscore utility exits 0 on success, and >0 if an error occurs.

SEE ALSO

fluidsynth(1), midicsv(1), timidity(1), qtoptions(7)

https://musescore.org/handbook

Online Handbook, full user manual

https://musescore.org/forum

Support Forum

https://musescore.org/en/node/278582

Reverting to factory settings (troubleshooting)

https://musescore.org/project/issues

Project Issue Tracker — Please check first to if the bug you’re encountering has already been reported. If you just
need help with something, then please use the support forum  instead.
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http://doc.qt.io/qt-5/qguiapplication.html#supported-command-line-optio…

Documentation of automatic Qt command line options

STANDARDS

MuseScore attempts to implement the following standards:

MusicXML 3.1 (score interchange format)
SF2 (SoundFont 2.01)
SF3 (SoundFont with OGG Vorbis-compressed samples)
SFZ (Sforzato soundfont)
SMuFL (Standard Music Font Layout 1.20)

HISTORY

MuseScore was split off the MusE sequencer in 2002 and has since become the foremost Open Source notation software.

AUTHORS

MuseScore is developed by MuseScore BVBA and others.

This manual page was written by mirabilos <tg@debian.org >.

CAVEATS

The automatic Qt command line options are removed from the argument vector before the application has a chance at
option processing; this means that an invocation like mscore -S -reverse has no chance at working because the -reverse is
removed by Qt first.

BUGS

MuseScore does not honor /etc/papersize.

Probably some more; check the project’s bug tracker (cf. SEE ALSO).

MuseScore — January 12, 2021

Nuove funzionalità in MuseScore 3.6

Nuove caratteristiche di configurazione e impaginazione della partitura

MuseScore 3.6 introduce un nuovo font musicale, Leland, un nuovo font di testo predefinito, Edwin (una versione di New
Century Schoolbook), e molte nuove impostazioni predefinite. Introduce anche una serie di nuove caratteristiche che sono
disponibili di default in tutte le nuove partiture create, e che possono anche essere applicate automaticamente o
manualmente alle partiture esistenti.

Le tre caratteristiche principali, che sono collegate tra loro, sono:

Ordinamento automatico degli strumenti
Parentesi quadrate (brackets) e graffe (braces) automatiche
Giustificazione verticale dei pentagrammi

Le prime due caratteristiche si applicano al momento della creazione della partitura e sono disponibili nella “Procedura
guidata nuova partitura”, sebbene possano essere accessibili anche in seguito nel pannello Strumenti. In precedenza,
spettava all'utente organizzare gli strumenti e aggiungere le parentesi manualmente una volta creata la partitura. Lo scopo
di queste nuove caratteristiche è quello di risparmiare tempo e dare un miglior risultato di default nella maggior parte dei
casi, ma non è inteso a soddisfare ogni possibile configurazione della partitura. Per impaginazioni insolite i risultati
possono essere personalizzati dopo che la partitura è stata creata, le caratteristiche possono essere disattivate
completamente, o si può usare un modello.

Ordinamento automatico degli strumenti
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Quando si crea una nuova partitura tramite "Scegli strumenti", è presente ora un menù a tendina “Ordinamento” che
mostra il sistema attuale di ordinamento degli strumenti. "Orchestrale" è il predefinito. Man mano che gli strumenti
vengono aggiunti alla partitura, saranno collocati nella posizione corretta secondo l'ordine selezionato. (In precedenza,
ogni strumento appariva sotto a quello attualmente selezionato nella lista di destra). Questo rende anche facile, per
esempio, aggiungere una doppia sezione di fiati, selezionando Flauto, Oboe, Clarinetto e Fagotto nella lista di sinistra, e
cliccando due volte su “Aggiungi alla partitura”.

Ogni ordinamento definisce una posizione nella partitura per gli strumenti solisti. Per esempio, in un ordinamento
orchestrale, questi sono sopra gli archi. Con uno strumento selezionato nella lista di destra, il pulsante “Rendi solista” lo
sposterà in quella posizione. Si possono designare più solisti; all'interno della 'sezione' del solista verrà applicato l'ordine
generale. Gli strumenti solisti avranno "solo" aggiunto al loro nome per impostazione predefinita, e saranno numerati
separatamente dagli strumenti non solisti, dove necessario. Notare che la designazione del solista è solo una funzione di
impaginazione della partitura e non ha alcun impatto sulla riproduzione sonora.

Una stranezza è che, per ora, solo una singola posizione di solista è definita per ordinamento, quindi un'opera con un
coro più solisti sia vocali che strumentali metterà i solisti strumentali sopra il coro. Questi dovranno essere spostati
manualmente.

Come prima, gli strumenti possono essere spostati su e giù manualmente con i pulsanti che si trovano ora a destra della
lista. Se si operano spostamenti, nel menù a tendina del campo “Ordine” comparirà “(Personalizzato)” aggiunto al nome
già presente (ad esempio, in caso di aggiunta strumenti con “Ordine: Orchestrale”, spostando su o giù uno strumento
rispetto alla posizione assegnata, il campo “Ordine” del menù a tendina diventerà “Orchestrale (Personalizzato)”.
L'ordinamento personalizzato viene salvato con la partitura. È possibile ripristinare l'ordine selezionando l'ordine originale
(o uno diverso) dal menù a tendina.

Selezionando direttamente l’ordine “Personalizzato” questa funzionalità viene completamente disabilitata, analogamente
all’assegnazione automatica delle parentesi di raggruppamento pentagrammi/famiglie (capitolo successivo).

Parentesi quadrate e graffe

Gli ordinamenti predefiniti associano famiglie di strumenti (flauti, oboi, clarinetti, ecc.) e dispongono queste famiglie in
sezioni (fiati, ottoni, percussioni, ecc.). Le parentesi vengono aggiunte automaticamente secondo queste semplici regole:

Una “parentesi spessa” (heavy bracket = quadra grossa) è applicata a tutti gli strumenti adiacenti della stessa
sezione, supponendo che ve ne sia più di una
una “parentesi quadrata sottile” (thin square bracket) è applicata a tutti gli strumenti identici adiacenti (quattro corni,
per esempio)
una parentesi graffa (curly brace) è applicata a ogni singolo strumento che è annotato su più di un pentagramma
(pianoforte e arpa, più comunemente)

In aggiunta, mentre questo dovrebbe fornire ordinamenti predefiniti ragionevoli per la maggior parte delle partiture, non
darà risultati perfetti per ogni possibile stile o disposizione. Fortunatamente, è facile fare aggiustamenti una volta che lo
spartito è stato creato.

Giustificazione verticale dei pentagrammi
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È stato aggiunto un nuovo algoritmo per giustificare verticalmente i pentagrammi al fine di riempire correttamente la
pagina, attivato di default per le nuove partiture in MuseScore 3.6. Per disattivarlo, deselezionare Formato > Stile >
Pagina > Abilita la giustificazione verticale dei pentagrammi.

Il principio di base dell'algoritmo è quello di cercare di rendere uguale lo spazio tra i pentagrammi, soggetto a due
impostazioni (tutte in Formato > Stile > Pagina):

Lo spazio ai lati (superiore e inferiore: trattasi di allineamento verticale) di una accollatura può essere aumentato
proporzionalmente regolando l'impostazione "Fattore per la distanza sopra/sotto la parentesi quadra (bracket)" ad
un valore maggiore di 1. Per esempio, se questo è impostato a 1,5, l'algoritmo tenterà di rendere lo spazio ai lati di
una parentesi 1,5 lo spazio 'standard' usato altrove (space used elsewhere).
La stessa cosa può essere applicata alla graffa con l’impostazione del " Fattore per la distanza sopra/sotto la
parentesi graffa (brace)".

Lo spazio tra una parentesi graffa (brace) e una quadra (bracket) sarà determinato dal più grande di questi due valori.
L'impostazione " Massima distanza doppio pentagramma " è usata per limitare l’ammontare della distanza tra
pentagrammi uniti da una parentesi graffa (curly brace). Ciò è utile perché questi pentagrammi generalmente devono
essere letti in una sola volta con un solo sguardo del musicista.

La "Massima distanza tra accollature" e la "Massima distanza pentagrammi" dovrebbero avere valori ragionevolmente
grandi per permettere all'algoritmo di riempire anche pagine piuttosto scarse. A volte una pagina non avrà abbastanza
pentagrammi perché abbia senso giustificare. In questo caso, prima l’algoritmo equalizza lo spazio come sopra descritto,
poi aggiunge spazio extra fra i pentagrammi fino al massimo pari all’impostazione data in "Massima distanza di
riempimento della pagina" (moltiplicato per ogni impostazione di fattore applicabile). Se si trova che molte pagine non
sono completamente giustificate, ma si vorrebbe che lo fossero, provare a regolare questa impostazione. In generale, un
valore basso è probabilmente il migliore per una partitura con un piccolo numero di pentagrammi per accollatura, e uno
più grande per un numero maggiore di pentagrammi.

La giustificazione verticale è dinamica, e non è legata alle assegnazioni di sezione degli strumenti usate per determinare
l'ordine della partitura in fase di impostazione, quindi se si aggiungono o si rimuovono parentesi la spaziatura cambierà di
conseguenza. Allo stesso modo, se i pentagrammi vuoti sono nascosti in una data accollatura, la spaziatura sarà
determinata solo dalle parentesi che sono effettivamente presenti in quella accollatura.

Si spera che le impostazioni di default diano buoni risultati nella maggior parte dei casi, ma potrebbe essere necessaria
un po' di sperimentazione con le impostazioni a seconda della composizione di una partitura. Se si ha l’abitudine di usare i
distanziatori per ottenere risultati simili, è meglio cercare di trovare le impostazioni che danno un buon risultato per la
maggior parte della partitura, e usare i distanziatori solo dove sono necessari aggiustamenti locali. È previsto per le
versioni future di rendere questo più configurabile. Per esempio, lo spazio extra potrebbe essere soppresso per una
specifica parentesi, o il valore potrebbe essere aumentato o diminuito per una particolare pagina o accollatura.

Indentazione (rientro) della prima accollatura

Questa nuova opzione, che è attivata di default, si trova in Stile > Partitura > Abilita l’indentazione sulla prima accollatura.
Come suggerisce il nome, farà rientrare la prima accollatura di una sezione nel modo consueto per le partiture classiche.
(Il vecchio artificio di usare una cornice per questo scopo non è più necessario.) Se sono presenti etichette di strumenti, si
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applica il massimo tra il valore dato per questa impostazione e la lunghezza delle etichette.

Applicare nuove caratteristiche a spartiti esistenti

Quando si apre una vecchia partitura, una finestra di dialogo dà la possibilità di applicare o il nuovo font di notazione
Leland, o il nuovo font di testo Edwin, o entrambi. Ognuno di questi applica - oltre ai soli cambiamenti di font - un
sottoinsieme di nuove impostazioni di stile preimpostate per la 3.6, per esempio la larghezza delle linee e le dimensioni
del testo, ma non applica tutte le nuove impostazioni di default, allo scopo di minimizzare cambiamenti di impaginazione
dirompenti.

Per applicare tutte le nuove impostazioni predefinite, comprese queste modifiche ai caratteri di testo e di notazione, aprire
la finestra Formato > Stile e cliccare sul pulsante in basso "Ripristina tutti gli stili ai valori predefiniti". Questa era in
precedenza l'opzione di menu Formato > Ripristina Stile. Il pulsante si comporta allo stesso modo, eccetto che non resetta
più le opzioni di impaginazione che sono impostate nella finestra Formato > Impostazioni di pagina; quella finestra ora ha
il suo pulsante equivalente, che resetterà solo quelle impostazioni che contiene. Ciò significa che le nuove opzioni di stile
possono essere provate senza rovinare completamente l’impaginazione della partitura, anche se alcune impostazioni di
Partitura e Pagina della finestra Stile potrebbero dover essere reimpostate manualmente.

Se c'è l'opzione, cancellare qualsiasi interruzione di sistema e di pagina non essenziale, selezionare l'intero spartito poi
Formato > Larghezza > Ripristina larghezza impaginazione. Eliminare anche i distanziatori per vedere i risultati di default
del nuovo algoritmo di giustificazione verticale (vedi sotto).

Edwin ha dimensioni dei caratteri più ampie in generale rispetto a FreeSerif (anche se vengono usate dimensioni dei punti
di default leggermente più piccole) quindi è abbastanza probabile che l'opzione Edwin causerà cambiamenti di
impaginazione, in particolare nelle partiture con testi cantati. Leland influenzerà la spaziatura in modo meno radicale, ma
alcuni aggiustamenti potrebbero essere ancora necessari.

Gli elementi di testo che hanno locali sovrapposizioni di stile applicate, non subiranno alcuna rimozione per quelle
personalizzazioni, sia come parte del processo di migrazione della partitura, sia tramite le opzioni di Ripristino Stili.
Questo potrebbe portare al risultato di una partitura incoerente nella quale alcuni testi mantengono il loro vecchio
carattere o non ne variano la dimensione. La nuova opzione del menu Formato > Ripristina lo stile del testo sovrascrivi
rimuoverà queste personalizzazioni, ripristinando tutti gli elementi di testo in modo che corrispondano agli stili di testo
attualmente definiti. (Questo equivale a cliccare su “Ripristina lo stile predefinito” per ogni attributo nell'area Testo
dell'Ispettore). Notare che questo non rimuove la Formattazione personalizzata, operazione che deve essere fatta
manualmente se necessaria.

Applicazione nuovo automatismo di ordinamento strumenti e corretta applicazione parentesi
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Premere “I” per accedere al pannello Strumenti, oppure scegliere la voce di menù Modifica > Strumenti. Assumendo che
la partitura sia stata creata con versione precedente la 3.6, l'ordinamento selezionato sarà “Personalizzato”. Se si vuole
applicare un ordinamento standard, selezionane uno dal menu, per esempio “orchestra”. Gli strumenti nella partitura
saranno riordinati secondo quella definizione, e le parentesi quadre e graffe saranno applicate di conseguenza. Notare
che qualsiasi parentesi quadra e/o graffa esistente sarà cancellata.

Applicazione della giustificazione verticale dei pentagrammi

Se si vuole usare questa funzione ma erano stati collocati in precedenza nella partitura dei distanziatori per creare
distanze extra o fisse tra i pentagrammi, è meglio prima cancellarli tutti, poiché distorcerebbero il funzionamento del
nuovo algoritmo. Un modo veloce per farlo è cliccare con il tasto destro del mouse su qualsiasi distanziatore, scegliere
Seleziona > Tuti gli elementi simili e premere Canc.

Per attivare questa funzione selezionare Stile > Pagina > Abilita la giustificazione verticale dei pentagrammi.
Successivamente possono essere reintrodotti i distanziatori se ci sono posti specifici dove la spaziatura predefinita ha
bisogno di essere regolata.

Altre modifiche tipografiche in 3.6

Nel processo di investigazione delle impostazioni di stile, dei problemi di incisione e creazione di un nuovo font musicale,
sono stati scoperti molti problemi che dovevano essere corretti e che possono avere un piccolo impatto sull'aspetto degli
spartiti esistenti. In alcuni casi è possibile annullarli manualmente

Spaziatura travature (Beam spacing)

Un errore di vecchia data nell'interpretazione dell'impostazione spaziatura travature che è definita insieme ai font SMuFL
ha fatto sì che questo valore fosse spesso la metà di quello che dovrebbe essere in MuseScore, anche con Emmentaler e
Bravura. (MuseScore definisce la distanza tra le travature come una percentuale dello spessore di una travatura, ma per
SMuFL l'impostazione è una distanza assoluta in spazi di pentagramma. Lo spessore normale di una travatura è 0,5sp, e
la distanza standard tra le travature è anch'essa 0,25sp, che MuseScore interpreta come il 25% di 0,5sp, cioè 0,125sp).

La nuova interpretazione corretta di questo valore, 50%, sarà applicata anche alle partiture esistenti, a meno che questo
valore non sia stato esplicitamente sovrascritto. Lo spazio extra viene aggiunto verso l'interno, quindi la posizione delle
travature più esterne rimane la stessa. Se si vuole davvero la vecchia spaziatura molto stretta, impostare manualmente
Stile > Gruppi di note > Distanza tra travature al 25%.

Prima (distanza travature 25%):

Dopo (distanza travature 50%):

Lunghezza del taglio addizionale (Ledger line)

In modo simile, MuseScore interpretava questo valore SMuFL come l'estensione totale della linea di taglio addizionale
oltre la testa della nota (cioè x/2 ad ogni lato), quando il valore dovrebbe essere l'estensione ad ogni lato. Questo errore è
stato anche mascherato dall'uso di un “coperchio quadrato” (square cap) per la linea, piuttosto che un “coperchio dritto”
(straight cap), aggiungendo così anche la metà dello spessore della linea ad ogni estremità.

Come per la spaziatura delle travature, se questa impostazione non è stata esplicitamente sovrascritta nel file, verrà
applicato un nuovo default anche nelle vecchie partiture, ma questo darà risultati identici. Se questo valore è stato
regolato sarà conservato, ma produrrà tagli addizionali troppo lunghi. Si può convertire il valore manualmente con la
formula:
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nuovo valore = (x / 2) - (y / 2)

dove x è il precedente valore di “Lunghezza taglio addizionale” e y è il valore di “Spessore taglio addizionale”. Oppure,
usare semplicemente le impostazioni predefinite ora correttamente interpretate per ogni carattere:

Leland: 0.35sp
Bravura, Gonville, Petaluma: 0.40sp
Emmentaler: 0.38sp

“Attacchi” dei gambi e posizioni delle codette (Stem caps and flag positions)

“Round caps” (?) erano precedentemente disegnati sui gambi. Questo è stato sostituito da un “flat cap” (?). In parte
questo è per rendere la lunghezza del gambo più esatta, ma principalmente è così che il “round cap” non oscura il
disegno della punta dei simboli della codetta in ogni carattere. Le codette di Emmentaler, per esempio, sono disegnate
con una punta piatta; Bravura e Leland hanno punte arrotondate che non sono esattamente simmetriche.

Il posizionamento delle codette era anche in precedenza in contrasto con i font SMuFL: veniva fatto un calcolo di quanto
estendere il gambo per un dato numero di codette, e poi il simbolo della codetta veniva disegnato con la parte superiore o
inferiore del suo riquadro di delimitazione alla fine del gambo. Ora, la presenza di codette non influisce sulla lunghezza
del gambo (cioè un gambo di lunghezza normale è usato per una nota in funzione della sua posizione verticale e della
direzione del gambo stesso) e il simbolo della codetta è quindi posizionato con la sua y=0 alla fine del gambo. Qualsiasi
"estensione" del gambo è quindi determinata dalla misura in cui il simbolo della codetta si estende al di sopra o al di sotto
di y=0. Le codette in Emmentaler, come usate all'interno di MuseScore, sono state riposizionate per riflettere questo, e
per corrispondere ad altri font SMuFL.

Il risultato di ciò è che le codette possono apparire leggermente più basse o più alte di come apparivano in precedenza;
tuttavia, il loro posizionamento riflette ora le intenzioni dei designer di ciascuno dei font disponibili. Le note con travatura
non sono interessate.

Prima (Bravura, in 3.5):

Dopo (Bravura, in 3.6):

Parentesi di alterazioni

In precedenza MuseScore non aggiungeva alcuno spazio tra le caselle di delimitazione delle alterazioni e le parentesi
attorno ad esse. Ora viene aggiunta una piccola quantità di spazio, che può essere personalizzata tramite Stile >
Accidenti > Riempimento tra le parentesi.

Prima (Bravura, in 3.5):

Dopo (Bravura, in 3.6):
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Alterazioni in Emmentaler

Queste sono state sostituite con quelle prese da Parnassus. Per dettagli, vedere PR #6747 .

New features in MuseScore 3

MuseScore 3 includes a number of new and improved features. For a brief summary, see the Release notes for
MuseScore 3 . More details can be found in the summaries below and by referring to the relevant pages of the
handbook.

Automatic Placement

MuseScore initially places elements in the score according to (a) the properties specified in style defaults and (b) any
manual adjustments made. For elements that have automatic placement enabled, however, MuseScore will attempt to
avoid collisions by moving one or more of them as needed.

See Automatic placement.

Default position

The default position for most elements is controlled by settings in Format → Style. You can either change the default
there, or, in the Inspector, apply a manual adjustment (see below) and then use the "Set as style" control (the S to the
right of the value you wish to set).

The specific properties you can set vary by element type but include:

placement (whether the element appears above or below the staff by default)
position above/below (specific positions when placed above or below)
offset (same as position above/below, for which placement is the default)
autoplace min distance (minimum distance from other elements when autoplace is enabled)

See Automatic placement.

Manual adjustments

Many elements can be placed either above or below the staff. To flip an element from above to below or vice versa, use
the "Placement" setting in the Inspector, or press the shortcut "X".

Manual adjustments to position can be performed by dragging or by changing the offsets in the Inspector. Neither method
will allow you to position an element in a way that causes a collision, however. To take full control of the position of an
element, you can disable automatic placement for it.

See Automatic placement.

Disabling automatic placement

To disable automatic placement for an element, untick the "Automatic placement" box in the Inspector. The element will
revert to its default position, and it will no longer be considered when automatically placing other elements.

See Automatic placement.

Stacking order

The "Stacking order" setting in the Inspector controls which elements overlap which in the cases where they actually do
overlap and are not moved due to autoplacement.

See Automatic placement.

Text Formatting

Formatting of text is controlled by three factors:

The text style associated with the element sets the defaults for properties such as the font, alignment, and frame.
Changes to these text properties can be applied to selected elements via the Inspector.
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Custom formatting can be applied to specific characters within the text using the text toolbar.

See Text basics, Text styles and properties.

Text Styles

Each text element has a text style associated with it. The default style for an element is determined by the type of the
element itself - staff text defaults to the Staff text style, dynamics to the Dynamics text style, etc. This text style determines
the default font face, size, style (bold/italic/underline), alignment, and frame properties.

You can change the defaults for any of these text styles using Format → Style → Text Styles. For instance, you can make
rehearsal marks bigger, or change lyrics to be italicized. This will affect all existing elements using that style as well as
elements you add later. Some elements also contain a limited set of text style controls in their own sections of the Format
→ Style dialog (although this might not be the case in the final release). The settings are linked: you can change the font
size for measure numbers in either Format → Style → Measure Numbers, or in Format → Style → Text Styles: Measure
Number. The effect is the same: all measure numbers in the score will take on this size. You can also change the defaults
for a text style using the Inspector; see Text Properties below.

For most text elements that you create directly (like staff text, rehearsal marks, and lyrics), you can apply a different text
style using the Style control in the Inspector. This will cause them to display using that style instead of the "native" style for
the element. For example, you can select one or more staff text elements and give them the Tempo style to force them to
display as if they were tempo markings.

See Text basics, Text styles and properties.

Text Properties

The text style controls the default properties for elements using that style, but you can override any of these properties for
selected elements using the Inspector. For example, you can select a handful of staff text elements using Ctrl+click, then
use the Inspector to make them larger. The Reset to Default button next to each property control returns it to the default.
You can also click the Set as Style button to change the style to match. So another way to change the size of all
measures numbers is to select one, change its size in the Inspector, then click Set as Style.

See Text basics, Text styles and properties.

Custom Formatting

Custom formatting is applied to text using the toolbar at the bottom of the main window in the same manner as in previous
releases. Thus, you can embolden one word in a sentence while the rest is normal, or superscript a particular character
etc. You can also remove all custom formatting from select text elements using the "Remove Custom Formatting" button
in the Inspector. This returns the text to the settings currently shown in the Inspector.

See Text editing.

Staff Type Change

You can change various staff properties mid-score, including staff size, notehead scheme (e.g., for pitch name
noteheads), generation of time signatures, and others. The staff type change element is found on the Text palette
(currently, but see #278205: Move Staff Type Change to another palette (it is not text)  - it may move). Add it to the
measure where you want the change to occur, then use the Inspector to change properties of the staff type change
element.

See Staff Type Change

Temporary and Cutaway Staves

To create a temporary staff that appears on certain systems only: first add the staff normally (Edit / Instruments), then add
notes, then right-click the staff, click Staff Properties, and set "Hide when empty" to "Always". This will cause the staff to
show only where needed even without needing to turn on "Hide empty staves" for the whole score (in Format / Style). The
default for "Hide when empty" is "Auto", meaning the staff will be hidden when empty if "Hide empty staves" is enabled.
Additional values include "Never" (the staff will not be hidden when empty even if "Hide empty staves" is enabled) and
"Instrument" (for instruments containing multiple staves, the staff is hidden only if all staves for that instrument are empty).

To create a cutaway staff in which only the measures containing notes are visible (for ossia or cutaway scores, for
example), right-click the staff, click Staff Properties, and enable the "Cutaway" option. This can be used independently of
"Hide when empty" or "Hide empty staves".

System Dividers

System dividers are a set of short diagonal lines that are used to visually separate systems on a page. MuseScore can
add these to your score automatically. In Format → Style → System, you can enable dividers on the left, right, or both,
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and you can set their default position. You can also adjust the position of individual dividers in your score manually or
mark them invisible (this currently does not survive saving).

Staff Spacing

As part of the automatic placement in MuseScore, staves are now spaced automatically, so you can set a comfortable
minimum distance and depend on MuseScore to open up more space where needed. You can use staff spacers as in
MuseScore 2 to increase distance between staves, but MuseScore 3 now also provides a way to decrease it—the "fixed"
staff spacer, found on the Breaks & Spacers palette. Just add the spacer and adjust its height. This will also prevent
MuseScore from automatically adding more space to avoid collisions, allowing you to manage this yourself.

See Spacers.

Don't Break

Currently disabled

In addition to the system, page, and section breaks familiar from MuseScore 2, the "Breaks & Spacers" palette now
contains a new "Don't Break" element. This allows you to force two measures to be kept together, for example, if there is
some complex passage that spans the measures and you want to make sure they are adjacent. If both measures don't fit
on a system, MuseScore moves them both to the next system. (currently, this leaves a "hole" at the end of the first staff -
is this a bug or is there some purpose behind it?)

Parts from Voices

In addition to the ability to generate parts from the different instruments in your score, you can now also associate a part
with a specific staff within the instrument or even a specific voice within a specific staff. This allows you to combine
multiple parts (e.g., Flute 1 & 2) onto a single staff in the score while still generating separate parts.

The Parts dialog now contains two sections at the bottom, Instruments in Score and Instruments in Part. Once you have
generated a part (or all parts) using the New and New All buttons, you can select any part at the top and use the controls
at the bottom to control not only what instrument is in the part, but also which staves and voices within the instrument are
included.

To add an instrument to a part, select it from "Instruments in Score" and press "+". To remove an instrument from a part,
select it from "Instruments in Part" and press "-". To customize the part at the staff or voice level, click the arrow next to
the instrument in "Instruments in Part" to expand the listing to show all staves and voices of the instrument. You can
remove a staff by selecting it and pressing "-", or remove a voice by unchecking it.

Limitations: If you select only voice 1 for a given staff, then only the content in voice 1 for that staff will be included in the
part. Thus, in order to share flute 1 & 2 on the same staff, you will need to enter all notes onto both voices, even in
passages where they share content. You also cannot enter the two parts as chords in the passages where they share
rhythms.

Explode and Implode

Explode has been updated to allow separation of voices as well as notes. See Explode.

The implode tool (Tools / Implode) works in one of two modes.

With a single staff selected, the implode command merges notes in different voices into chords where possible (when
notes are on the same beat and have the same duration). This is the same as recent versions of MuseScore, although
some bugs have been fixed.

With multiple staves selected, the implode command combines the content of the first four non-empty voices (on any
staves) into multiple voices on the top selected staff. This is different from MuseScore 2, where notes would be combined
into chords rather than using multiple voices, and thus required the rhythms to match. The MuseScore 3 approach
preserves the original rhythms even where they differ, and is intended to produce the expected results when combining
two different parts onto one staff for use with the parts from voices feature, or when reducing an open (four-stave) SATB
score into a closed (two-stave) version. To further merge the voices into chords where possible, simply run the command
again.

See Tools.

Insert mode

You can insert and delete notes and have the measure automatically expand or contract to accommodate the change.
This can be useful in creating unmetered music or in ordinary editing.

To insert a note before the currently-selected note, press Ctrl+Shift while adding the note normally. For example, in note
input mode, Ctrl+Shift+click will insert a note of the currently-selected duration at that location. Ctrl+Shift+B will insert a B of
the currently-selected duration before the note at the current cursor position. You can also switch to Insert mode using the
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dropdown menu next to the note input button on the toolbar. In this mode, all notes you add act as if you were pressing
Ctrl+Shift - they are inserted rather than replacing the existing notes or rests at that location.

To delete notes, you must be in normal (not note input) mode. Select either a single note or a range and press Ctrl+Del.

See Note input modes, Remove selected range (Tools)

Split/Join Measures

To split a measure before a given note, simply insert a barline from the palette at that point while holding Ctrl. For example,
you can select the note, and Ctrl+double-click the barline in the palette, or Ctrl+drag the barline to the note. You can also
use Tools → Measure → Split Measure Before Selected Note/Rest.

To join two measures, Ctrl+Del the barline between them. You can also use the menu command Tools → Measure → Join
Measures.

See Measure operations.

Timeline

The Timeline presents a graphical overview of your score. To access it, use View →Timeline (F12). The top portion of the
Timeline shows the location of tempo, key, and time signature changes as well as rehearsal marks, repeats, and double
barlines. The bottom portion shows the staves of your score, with non-empty measures highlighted. You can click
anywhere within this view to jump to the corresponding spot in the score.

See Timeline

Score Comparison Tool

The Score Comparison Tool (View / Score Comparison Tool) allows you to compare two versions of a score to find the
differences between them. Select the two scores you want to compare and whether you want to compare the current
version or the last saved version (note you can compare the current version of a score against the last saved version of
the same score to see what you have changed since the last save), then click the Compare button. A list of differences
will be displayed to the right. The score view will automatically change to Documents Side by Side, with the two scores
you have selected displayed within. Double-click on a difference from the list and both score views will automatically pan
to show you the changed element, which will also be highlighted.

Normally you would want the default Intelligent comparison, which displays the differences in human-readable format (e.g.
"Measure 1: Note: property pitch changed from B4 to C5"). There is also a Raw mode to show the results according to the
actual XML code.

See Score comparison.

Mixer

See Mixer.

Piano Roll Editor

See Piano roll editor (preliminary page).

Capo changes

Capo changes are now a property of staff text, and can be used to automatically change the pitch of all notes that follow
them, up until another capo change.

See Capo playback.

Fretboard Diagrams

New UI. See Fretboard diagrams.

External links

Release notes for MuseScore 3.x
Transitioning from version 2 to version 3

Known limitations of MuseScore 3.x

While all members of the development team did their best to make the software easy to use and bug-free, there are some
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known issues and limitations in MuseScore 3.x.

Local time signatures

The local time signature feature, which allows you to have different time signatures in different staves at the same time, is
very limited. You can only add a local time signature to measures that are empty, and only if there are no linked parts.
When adding notes to measures with local time signatures, you can enter notes normally via note input mode, but copy
and paste does not work correctly and may lead to corruption or even crashes. The join and split commands are disabled
for measures with local time signatures.

Regroup Rhythms

The Regroup Rhythms command found under the Tools menu may have unintended side effects, including changing the
spelling of pitches and deleting some elements like articulations, glissandos, tremolos, grace notes and, esp. on undo,
ties. Use this tool with caution on limited selections, so that you can tell if any unwanted changes are made.

Tablature staff linked with standard staff

When entering multiple-note chords on a standard staff in a linked staff/tablature system, the notes should be entered in
order from the top (first) string to the bottom string to ensure correct fret assignment.

This limitation does not apply if entering notes directly onto a tablature staff, or when using an unlinked staff/tablature
system.

Mixer

Changing settings in the mixer other than the sound doesn't mark the score 'dirty'. That means if you close a score you
may not get the warning "Save changes to the score before closing?". Changing mixer values are also not undoable.

Header & footer

There is no way to edit Header and Footer in a WYSIWYG manner. The fields in Format → Style → Header, Footer are
plain text. They can contain "HTML like" syntax, but the text style, layout, etc. can't be edited with a WYSIWYG editor.

Upgrade from MuseScore 1.x or 2.x

How to upgrade MuseScore

Download and install the latest version from the download  page as described at Installation.

Installing MuseScore 3 won't uninstall 1.x nor 2.x —all three versions can coexist peacefully and can even be used in
parallel. So this isn't really an upgrade but an installation of a new and different program.

Opening 1.x or 2.x scores in MuseScore 3

MuseScore 3 significantly improved the typesetting quality to make scores attractive and easier to read. Improvements
cover many items such as beam slope, stem height, layout of accidentals in chords and general note spacing. However,
this means that sheet music made with MuseScore 1.x or 2.x looks slightly different from sheet music made with 3.x.

It also means that scores saved with 3.x won't open with 1.x nor 2.x.

To prevent you from accidentally overwriting your 1.x or 2.x scores, 3.x treats them as an import, which means:

The score gets marked as being modified, even if you haven't changed anything
On exiting MuseScore you're asked to save the score (as a result from the above)
MuseScore uses the "Save As" dialog to save it, not the "Save" dialog
MuseScore uses the score's title to create a default filename rather than taking the old filename

Relayout

If you did not manually adjust the layout of a 1.x or 2.x score, then MuseScore uses the 3.x typesetting engine to layout
the score. If you did touch the layout of the 1.x or 2.x score, the individual adjustments you may have made should remain
after opening it in MuseScore 3.x, but due to slight changes in the surrounding layout they may still not appear correct in
context. If you wish to reset even manual adjustments to use the 3.x typesetting engine throughout, select the complete
score with the shortcut Ctrl+A (Mac: Cmd+A) and reset the layout with Ctrl+R (Mac: Cmd+R).

Note: When you open a 1.x or 2.x file in MuseScore 3, it will ask you if you want to reset the layout to the defaults.

Getting the sound from MuseScore 1.x
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While the sound in 2.x/3.x has been much improved, you may still prefer the sound from MuseScore 1.x. In that case, you
can get the 1.x sound in 3.x by downloading the 1.3 SoundFont and add it in 3.x. You can do this in two steps:

1. Download the 1.3 SoundFont named TimGM6mb
2. Install and use the TimGM6mb SoundFont in 2.0

Known incompatibilities

Hardware incompatibilities

The following software is known to crash MuseScore on startup:

Samson USB Microphone, driver name "Samson ASIO Driver", samsonasiodriver.dll. More info
Digidesign MME Refresh Service. More info
Windows XP SP3 + Realtek Azalia Audio Driver. More info
Wacom tablet. More info  and QTBUG-6127

Software incompatibilities

Maple virtual cable is known to prevent MuseScore  from closing properly.
KDE (Linux) window settings can cause the whole window to move when dragging a note. Changing the window
settings of the operating system  avoids the problem.
Nitro PDF Creator may prevent MuseScore 2 from starting  on Windows 10, if being used as the default printer.
Same for Amyumi/Quickbooks PDF Printer, see here  and also some cloud printing services, see here .
Creative Sound Blaster Z Series ASIO driver may prevent MuseScore 2 from starting  on Windows 10.
Untrusted Font Blocking policy prevents MuseScore 2 from starting  (except in debug mode, i.e. using the -d
option) on Windows 10. (Solution in the links provided here )
The SteelSeries Engine 3 Audio Visualizer will prevent MuseScore from starting up, or cause MuseScore to crash if
the Audio Visualizer is started when MuseScore is already running.

AVG Internet Security hangs MuseScore

MuseScore requires access to your internet connection with AVG. MuseScore doesn't need an internet connection to
function, but if AVG blocks it, MuseScore hangs.

If AVG prompts you, Allow MuseScore and check "Save my answer as a permanent rule and do not ask me next time."

If it doesn't prompt you anymore,

1. Open the AVG user interface (right-click on the AVG icon, close to your clock -> Open AVG User Interface)
2. Click on Firewall
3. Click Advanced Settings
4. Click Applications
5. Find MSCORE.EXE in the list and double-click it
6. Change Application Action to Allow for All

Font problem on macOS

MuseScore is known to display notes as square when some fonts are damaged on macOS.
To troubleshoot this issue:

1. Go to Applications -> Font Book
2. Select a font and press ⌘+A to select them all
3. Go to File -> Validate Fonts
4. If any font is reported as damaged or with minor problems, select it and delete it
5. Restart MuseScore if necessary

In this forum article , a user believes to have found the font "Adobe Jenson Pro (ajenson)" to be the culprit, regardless of
not being reported as broken, or problematic as per the above validation, and solved the problem by deleting that font, so
this is worth checking too.

Font problem on Linux

If the default desktop environment application font is set to bold, MuseScore will not display the notes properly.
To troubleshoot this issue (gnome 2.*/MATE users):

1. Right-click on your desktop and select Change Desktop background
2. Click on Fonts tab
3. Set Regular style for Application font
4. Restart MuseScore if necessary

For GNOME 3/SHELL users
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1. Open the shell and open "Advanced Settings"
2. Click on the Fonts option in the list
3. Set the default font to something non-bold
4. Restart MuseScore if necessary

Save As dialog empty on Linux

Some users reported that the Save As dialog is empty on Debian 6.0 and Lubuntu 10.10.
To troubleshoot this issue:

1. Type the following in a terminal

which mscore

2. The command will answer with the path of mscore. Edit it with your preferred text editor and add the following line at
the beginning

export QT_NO_GLIB=1

Launch MuseScore and the problem should be solved.

Glossary

The glossary is a work in progress—please help if you can. You can discuss this page in the documentation forum .

The list below is a glossary of frequently used terms in MuseScore as well as their meaning. The differences between
American English and British English are marked with "(AE)" and "(BE)", respectively.

A

Acciaccatura

 A short →grace note which appears as a small note with a stroke through the stem. It is quickly executed and
technically takes no value from its associated note.

Accidental
A sign appearing in front of a note that raises or lowers its pitch. The most common accidentals are →sharps, →flats
or →naturals, but double sharps and double flats are also used. Also →koron, and →sori and other quarter tone
accidentals. Accidentals affect all notes on the same →staff position only for the remainder of the measure in which
they occur, but they can be canceled by another accidental. In notes tied across a →barline, the accidental
continues across the →barline to the tied note, but not to later untied notes on the same →staff position in that
measure.

Ambitus
Note (or vocal) range used in a →staff. Used particularly in Early Music

Anacrusis
See →Pickup measure.

Anchor
The point of attachment to the score of objects such as Text and Lines: When the object is dragged, the anchor
appears as small brown circle connected to the object by a dotted line. Depending on the object selected, its anchor
may be attached to either (a) a note (e.g. fingering), (b) a staff line (e.g. staff text), or (c) a barline (e.g. repeats).

Appoggiatura
A long →grace note which takes value from its associated note. Its functions include: passing tone, anticipation,
struck suspension, and escape tone.

Arpeggio
An arpeggio tells the performer to break up the chord into the constituent notes, playing them separately and one
after the other. An arrow on the arpeggio indicates the direction in which the player should play the notes of the
chord.
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B

Bar (BE)
See →measure.

Barline
Vertical line through a →staff, staves, or a full →system that separates →measures.

Beam
Notes with a duration of an →eighth  or shorter either carry a →flag or a beam. Beams are used for grouping
notes.

BPM
Beats Per Minute is the unit for measuring tempo, traditionally counted in quarter note durations. See →metronome
mark

Breve
Brevis

A double whole note or breve is a note that has the duration of two whole notes.

C

Caesura
A caesura (//) is a brief, silent pause. Time is not counted for this period, and music resumes when the director
signals.

Cent
An interval equal to one hundredth of a semitone.

Chord
A group of two or more notes sounding together. To select a chord in MuseScore, press Shift and click on a note. In
the Inspector, however, the word "Chord" only covers notes in the same voice as the selected note(s).

Clef
Sign at the beginning of a →staff, used to tell which are the musical notes on the lines and between the lines.
Clefs are very useful for →transposition.

Concert pitch
Enables you to switch between concert pitch and transposing pitch (see Concert pitch and Transposition).

Crotchet (BE)
See →Quarter note.

D

Double Flat
A double flat (♭♭ or �) is a sign that indicates that the pitch of a note has to be lowered two semitones.

Double Sharp
A double sharp (♯♯ or �) is a sign that indicates that the pitch of a note has to be raised two semitones.

Demisemiquaver (BE)
A thirty-second note.

Duplet
See →tuplet.

Dynamic
A symbol indicating the relative loudness of a note or phrase of music—such as mf (mezzoforte), p (piano), f (forte)
etc., starting at that note.

Dynamic, Single note
A dynamic marking which applies only to one note—such as sfz (sforzando), fp (fortepiano) etc.

E

Edit mode
The program mode from which you can edit various score elements.

Eighth note
A note whose duration is an eighth of a whole note (semibreve). Same as a quaver (BE).

Endings
See →volta.

Enharmonic notes
Notes that sound the same pitch but are written differently. Example: G♯ and A♭ are enharmonic notes.

F

Flag
See →beam.

Flat
Sign (♭) that indicates that the pitch of a note has to be lowered one semitone.

G
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Grace note
Grace notes appear as small notes in front of a normal-sized main note. See →acciaccatura and →appoggiatura.

Grand Staff (AE)
Great Stave (BE)

A system of two or more staves, featuring treble and bass clefs, used to notate music for keyboard instruments and
the harp.

H

Half Note
A note whose duration is half of a whole note (semibreve). Same as a minim (BE).

Hemidemisemiquaver (BE)
A sixty-fourth note.

I

Interval
The difference in pitch between two notes, expressed in terms of the scale degree (e.g. major second, minor third,
perfect fifth etc.). See Degree (Music)  (Wikipedia).

J

Jump
In MuseScore, "jumps" are notations such as "D.S. al Coda", found in the "Repeats & Jumps" palette.

K

Key Signature
Set of →sharps or →flats at the beginning of the →staves. It gives an idea about the tonality and avoids repeating
those signs all along the →staff.
A key signature with B flat means F major or D minor tonality.

Koron
An Iranian →accidental which lowers the pitch of a note by a quarter tone (in comparison to the →flat which lowers a
note by a semitone). It is possible to use this accidental in a →key signature.
See also →Sori.

L

Longa
A longa is a quadruple whole note.

Ledger Line
Line(s) that are added above or below the staff.

M

Measure (AE)
A segment of time defined by a given number of beats. Dividing music into measures provides regular reference
points to pinpoint locations within a piece of music. Same as → bar (BE).

Metronome mark
Metronome marks are usually given by a note length equaling a certain playback speed in →BPM. In MuseScore,
metronome marks are used in Tempo texts.

Minim (BE)
See →Half note.

N

Natural
A natural (♮) is a sign that cancels a previous alteration on notes of the same pitch.

Normal mode
The operating mode of MuseScore outside note input mode or edit mode: press Esc to enter it. In Normal mode you
can navigate through the score, select and move elements, adjust Inspector properties, and alter the pitches of
existing notes.

Note input mode
The program mode used for entering music notation.

O

Operating System
OS

Underlying set of programs which set up a computer, enabling additional programs (such as MuseScore). Popular
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OSes are Microsoft Windows, macOS, and GNU/Linux.
Not to be confused with a sheet music →system.

P

Part
Music to be played or sung by one or a group of musicians using the same instrument. In a string quartet, 1st part =
Violin 1, 2nd part = Violin 2, 3rd part = Viola, 4th part = Cello, in a choir there might be parts for soprano, alto, tenor
and bass. A part has one or more →staves (e.g. Piano has 2 staves, Organ can have 2 or 3 staves).

Pickup Measure (also known as an Anacrusis or Upbeat)
Incomplete first measure of a piece or a section of a piece of music. See Measure duration and Create new score:
Pickup measure. Also Exclude from measure count.

Q

Quadruplet
See →tuplet.

Quarter note
A note whose duration is a quarter of a whole note (semibreve). Same as a crotchet (BE).

Quaver (BE)
See →eighth note.

Quintuplet
See →tuplet.

R

Respell Pitches
Tries to guess the right accidentals for the whole score (see Accidentals).

Rest
Interval of silence of a specified duration.

Re-pitch mode
Allows you to rewrite an existing passage of music by changing the note pitches without altering the rhythm.

S

Semibreve (BE)
A whole note (AE). It lasts a whole measure in 4/4 time.

Semiquaver (BE)
A sixteenth note.

Semihemidemisemiquaver (Quasihemidemisemiquaver) (BE)
An hundred and twenty eighth note.

Sextuplet
See →tuplet.

Slash chord
See Slash chord  (Wikipedia).

Slash notation
A form of music notation using slash marks placed on or above/below the staff to indicate the rhythm of an
accompaniment: often found in association with chord symbols. There are two types: (1) Slash notation consists of a
rhythm slash on each beat: the exact interpretation is left to the player (see Fill with slashes); (2) Rhythmic slash
notation indicates the precise rhythm for the accompaniment (see Toggle rhythmic slash notation).

SFZ
A virtual instrument format supported by MuseScore (along with →SoundFonts). An SFZ library consists of one or
more SFZ text files, each defining a particular instrument setup, and many audio sound samples.

Sharp
Sign (♯) that indicates that the pitch of a note has to be raised one semitone.

Slur
A curved line over or under two or more notes, meaning that the notes will be played smooth and connected
(legato).
See also →tie.

Sori
An Iranian →accidental which raises the pitch of a note by a quarter tone (in comparison to the sharp which raises it
by a semitone). It is possible to use this accidental in a →key signature.
See also →Koron.

SoundFont
A virtual instrument format supported by MuseScore (along with →SFZ). A SoundFont is a special type of file
(extension .sf2, or .sf3 if compressed) containing sound samples of one or more musical instruments. In effect, a
virtual synthesizer which acts as a sound source for MIDI files. MuseScore 2.2 comes with the SoundFont
"MuseScore_General.sf3" pre-installed.

Spatium (plural: Spatia) / Space / Staff Space / sp. (abbr./unit)
The distance between the midpoints of two lines of a music staff (or one-quarter the size of the full five-line staff,
assuming a hypothetical staff line thickness of 0). The sizes of most elements in the score are based on this setting
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(see Page settings).
Staff (AE) / Staves (plural)

A set of lines and spaces, each representing a pitch, on which music is written. In ancient music notation (before
11th century) the staff may have any number of lines.

Staff Space
See Spatium (above).

Stave (BE)
See Staff (above).

Step-time input
MuseScore's default note input mode, allowing you to enter music notation one note (or rest) at a time.

System
Set of staves to be read simultaneously in a score.
See also →Operating System (OS).

T

Tie

A curved line between two or more notes on the same pitch to indicate a single note of combined duration:

Quarter note + Tie + Quarter note = Half note
Quarter note + Tie + Eighth note = Dotted Quarter note
Quarter note + Tie + Eighth note + Tie + 16th note = Double Dotted Quarter note
See also →slur.

Transposition

The act of moving the pitches of one or more notes up or down by a constant interval. There may be several
reasons for transposing a piece, for example:

1. The tune is too low or too high for a singer. In this case the whole orchestra will have to be transposed as well
—easily done using MuseScore.

2. The part is written for a particular instrument but needs to be played by a different one.
3. The score is written for an orchestra and you want to hear what the individual instruments sound like. This

requires changing the transposing instrument parts to concert pitch.
4. A darker or a more brilliant sound is desired.

Triplet
See →tuplet.

Tuplet
A tuplet divides its next higher note value by a number of notes other than given by the time signature. For example
a →triplet divides the next higher note value into three parts, rather than two. Tuplets may be: →triplets, →duplets,
→quintuplets, and other.

U

Upbeat
See →pickup measure.

V

Velocity
The velocity property of a note controls how loudly the note is played. This usage of the term comes from MIDI
synthesizers. On a keyboard instrument, it is the speed with which a key is pressed that controls its volume. The
usual scale for velocity is 0 (silent) to 127 (maximum).

Voice
Polyphonic instruments like Keyboards, Violins, or Drums need to write notes or chords of different duration at the
same time on the same →staff. To write such things each horizontal succession of notes or chords has to be written
on the staff independently. In MuseScore you can have up to 4 voices per staff. Not to be confused with vocalists,
singing voices like soprano, alto, tenor and bass, which are better viewed as instruments.

Volta
In a repeated section of music, it is common for the last few measures of the section to differ. Markings called voltas
are used to indicate how the section is to be ended each time. These markings are often referred to simply as
→endings.

External links

http://www.robertcarney.net/musical-terms-definitions.htm
https://en.wikipedia.org/wiki/List_of_musical_symbols
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